
General	Ledger	Help
Whatever	the	size	of	your	business,	General
Ledger	and	Financial	Reporter	handle	all	your
financial	record-keeping	and	reporting
needs.	More...

javascript:void(0);


Getting	Started
What's	New	in	General	Ledger	2012
About	Designing	Your	General	Ledger
About	Setting	Up	General	Ledger
General	Ledger	Setup	Options
About	Transaction	Processing	in	General	Ledger
About	General	Ledger	Reports
About	Financial	Reporter

	



How-To	Articles
Importing	Data	to	General	Ledger
Adding	Account	Balances	and	Quantities	to	a	New	General	Ledger
Adding	a	New	Account
Adding	a	Journal	Entry
Posting	Transaction	Batches
Looking	Up	Transactions	Posted	to	General	Ledger	Accounts
Performing	Period	End	Maintenance

	



Using	G/L	Screens
Setup	Screens
Accounts	Screens
Periodic	Processing	Screens
Transactions	Screens
Reports	Screens



Home	>	What's	New	in	General	Ledger	2012



What's	New	in	General	Ledger	2012



In	Product	Update	1
We've	revised	General	Ledger	help	to	improve	search	results,	enhance
the	readability	of	help	topics,	and	make	it	easier	for	you	to	find	important
information	and	instructions.

Plus,	we've	added	two	new	user's	guides,	available	in	Docs\61A\ENG:

General	Ledger	User's	Guide
Financial	Reporter	User's	Guide



In	the	2012	Release
General	Ledger	2012	includes	the	following	new	features	and
improvements:

Includes	Sage	300	ERP	Intelligence	Reporting.	If	you	install
General	Ledger,	Sage	300	ERP	Intelligence	Reporting	is
automatically	installed.
New	Exclude	Inactive	Accounts	option	for	the	Chart	of	Accounts
report.	You	can	now	exclude	inactive	accounts	from	the	Chart	of
Accounts	report.
New	batch	reversal	feature.	You	can	now	reverse	a	whole	batch	or
an	individual	entry	in	a	batch.



Upgrading	from	an	Earlier	Version?
If	you	are	upgrading	from	version	5.6,	see	Changes	in	General
Ledger	6.0.
If	you	are	upgrading	from	version	5.5,	see	Changes	in	General
Ledger	5.6.
If	you	are	upgrading	from	version	5.4,	see	Changes	in	General
Ledger	5.5.
If	you	are	upgrading	from	version	5.3,	see	Changes	in	General
Ledger	5.4.
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Getting	Started
Find	help,	documentation,	tips,	and	resources	to	get	General	Ledger	up
and	running	quickly	and	easily.

Support	and	Resources

Finding	Help	and	Documentation

Data	Entry	Tools	and	Shortcuts

Keyboard	Shortcuts	for	Detail	Tables

Setting	Finder	Criteria

General	Ledger	Menu	Commands

Working	with	Detail	Entry	Tables
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Support	and	Resources
Use	the	links	below	to	find	instructions,	software	training,	one-on-one
support,	technical	specifications,	or	other	resources	to	get	Sage	300	ERP
working	smoothly	for	your	business.

Your	Sage	Business	Partner	is	also	an	excellent	resource	to	consult
when	you	have	questions	about	Sage	300	ERP.



How	can	we	help	you?
I'm	setting	up	Sage	300	ERP	and	need	information	or	assistance

I'm	looking	for	instructions	to	complete	a	task	in	Sage	300	ERP

I	think	something	is	broken,	or	I'm	getting	error	messages

I’m	looking	for	downloads,	updates,	or	technical	specifications

I	want	to	become	a	more	skilled	user	of	Sage	300	ERP

I	want	to	share	knowledge	with	other	Sage	300	ERP	users

I	want	to	contact	a	Sage	300	ERP	representative

Related	Topics
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Finding	Help	and	Documentation
You	can	find	information	about	setting	up	and	using	Sage	300	ERP	in	the
Sage	300	ERP	Learning	Center	and	in	the	product	documentation
included	with	this	release.

Note:	For	technical	support,	visit	Customer	Support	or	contact	your
Sage	business	partner.

http://na.sage.com/sage-300-erp/product-support


The	Sage	300	ERP	Learning	Center
The	Learning	Center	is	where	you'll	find	documentation	for	new	product
features	and	modules	in	the	Sage	300	ERP	Portal.	It	features	articles	and
information	about	the	portal,	shortcuts,	snapshots,	and	Inquiry.

You	view	the	Learning	Center	in	one	of	the	following	ways:
Open	the	Sage	300	ERP	Portal,	and	on	the	welcome	bar	at	the	top	of
the	screen,	click	Help	>	Learning	Center.
On	the	tab	menu	 	for	any	portal	tab,	click	Help.



Context-Sensitive	Help
Sage	300	ERP	features	context-sensitive	help	that	you	can	use	to	quickly
open	and	view	articles	and	information	directly	from	Sage	300	ERP
screens.

In	the	Sage	300	ERP	Portal,	click	Help	on	the	tab	menu	 	to	view
help	for	the	current	screen.
On	the	Sage	300	ERP	Desktop,	press	F1	to	view	help	for	the	current
screen.



Product	Documentation
Sage	300	ERP	includes	guides	in	printable	PDF	format,	including	the
Installation	and	Administration	Guide,	Upgrade	Guide,	and	other
documentation	related	to	installation	and	setup.

These	guides	are	available	in	the	Docs	folder	on	the	Sage	300	ERP
server,	and	online	in	the	Sage	Customer	Portal.

To	view	the	guides	in	the	Docs	folder:
On	the	Windows	taskbar,	click	Start	>	Programs	>	Sage	300	ERP	>
Documentation.

https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm
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Data	Entry	Tools	and	Shortcuts
Use	these	tools	and	shortcuts	to	speed	up	data	entry	in	Sage	300	ERP.

Data	Entry	Tools	and	Shortcuts
Tool Shortcut

Key
Description

Drilldown	 n/a The	Drilldown	 	button	appears	beside	some
data	entry	fields	and	in	some	column	headings	in
transaction	detail	entry	tables.	Click	it	to	view
details	of	the	record	or	transaction	in	the
corresponding	field.	More...

Finder	 F5 The	Finder	 	appears	in	some	data	entry	fields,
and	in	some	table	headings	in	transaction	entry
screens.	Click	it	when	you	want	to	look	up
records	you	can	select	for	a	field.	More...

Tip:	For	additional	instructions	on	using	the
Finder	to	select	records,	press	F1	when	the
Finder	screen	appears.

Go	 F7 The	Go	 	button	appears	on	screens	where	you
must	enter	information	(such	as	filter	criteria)
before	viewing	records	that	match	the
information	you	enter.	More...

Navigation n/a Click	the	Previous	and	Next	buttons	to	navigate
through	a	list	of	existing	records,	or	click	the	First
and	Last	buttons	to	navigate	to	the	first	and	last
records.	More...

New	 n/a Click	the	New	 	button	or	select	New	from	a
menu	to	begin	creating	a	new	record.

javascript:void(0);
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Zoom	 F9 Click	the	Zoom	 	button	or	press	the	F9	key	to
view	or	enter	supplementary	information	for	a
transaction	detail	or	for	a	field.	More...

After	viewing	or	editing	the	information	in	the
detail	screen,	you	can	press	F9	to	close	the
screen.

Related	Topics
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Keyboard	Shortcuts	for	Detail	Tables
Use	the	following	keyboard	shortcuts	to	navigate	in	detail	tables.

Key Menu
Command

Action

Ins/Insert New Insert	a	blank	row	to	add	a	new
record.

Del/Delete Delete Remove	the	selected	row.

Up	or	Down	Arrow 	 Go	up	or	down	one	row.

Left	or	Right	Arrow 	 Go	left	or	right	one	column.

Pg	Up 	 Go	to	the	top	row	in	view.

Pg	Dn 	 Go	to	the	bottom	row	in	view.

Home First Go	to	the	first	row	in	a	list.

End Last Go	to	the	last	row	in	a	list.

Tab	or	Enter;

Shift+Tab	or
Shift+Enter

	 Go	to	the	next	or	previous	column
in	a	list.

Related	Topics

javascript:mc3.Click()


Home	>	Getting	Started	>	Setting	Finder	Criteria



Setting	Finder	Criteria
To	help	you	search	quickly	through	a	long	list	of	records,	you	can	use
criteria	to	restrict	the	records	that	are	displayed	in	the	Finder	and	when
you	use	the	navigation	buttons.

However,	at	other	times,	if	the	Finder	uses	criteria,	it	might	not	display	all
the	records	you	expect	to	see.

To	check	or	remove	the	criteria:
1.	 Click	the	Finder	 .
2.	 Click	the	Set	Criteria	button.
3.	 On	the	screen	that	appears,	click	the	Clear	button.

For	instructions	on	setting	criteria,	click	the	Help	button	when	the	Set
Criteria	screen	appears.

Related	Topics
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General	Ledger	Menu	Commands
The	following	commands	appear	on	the	File,	Settings	(when	available),
and	Help	menus	on	Sage	300	ERP	screens.

Note:	Menu	names	and	commands	may	differ	by	screen.



File	Menu
File	Menu	Commands

Command Description Notes

Close Closes	the	current
form.

You	can	also	press	Alt+F4	to	close	a
screen.

Customize Lets	you	hide	or
display	fields	for
users	by	UI	Profile
ID.

Click	File	>	Customize	to	hide	fields
on	an	open	screen	for	users	assigned
to	a	UI	Profile	ID	for	that	screen.

When	these	fields	are	hidden,	data
that	would	normally	appear	in	these
fields	cannot	be	printed.

For	more	information,	see	the	help	for
the	UI	Profile	Maintenance	screen	in
the	System	Manager	help.

Export Exports	data
records	to	other
Sage	300	ERP
databases	and	non-
Sage	300	ERP
programs.

Click	File	>	Export	to	export	data.
For	example,	you	could	export
purchase	statistics	for	use	in
spreadsheet	or	database	software.

Note:	You	cannot	export	serial	or	lot
numbers	for	kit	components.

Import Imports	data
records	from	other
databases	and	from
non-Sage	300	ERP
programs.

Click	File	>	Import	to	import	data.
For	example,	you	could	use	a
spreadsheet	to	enter	current
requisitions	or	purchase	orders	when
setting	up	your	system,	and	then
import	the	transactions	later.

Note:	You	cannot	import	serial	or	lot



numbers	for	kit	components.

Print Prints	the	current
report,	list,	or
screen.

On	screens	with	a	corresponding
report,	click	File	>	Print	to	open	the
report	screen,	which	you	use	to	select
report	options	(if	applicable)	before
printing	the	report.

Print
Setup

Selects	a	printer
and	sets	printing
options.

Click	File	>	Print	Setup	to	set	up
your	printer.	You	can	select	the
default	printer	or	select	another	from
the	list	of	installed	printers.

For	more	information	about	print
options,	refer	to	your	operating
system	documentation.

Save Saves	the	entries	or
changes	you	have
made	to	the	current
screen.

If	you	have	just	entered	a	new	record,
Add	appears	instead	of	Save.



Settings	Menu
Settings	Menu	Commands

Command Description Notes

Auto	Clear Creates	a	new	entry
automatically	when
you	post	a
transaction.

Use	the	Auto	Clear	option	to
streamline	data	entry	in	transaction
entry	screens.

If	Auto	Clear	is	turned	on,	all
fields	are	cleared	each	time
you	post	a	transaction,
allowing	you	to	immediately
begin	entering	another
transaction.
If	Auto	Clear	is	turned	off,
transaction	information
remains	on	the	screen	after
you	post	it.	Click	the	New
button	to	begin	entering
another	transaction.

Clear	Saved
Settings

Restores	default
settings	for	a	report.

This	command	is	available	for
forms	and	for	some	reports.

Save
Settings	as
Defaults

Saves	the	current
report	settings	as
personal	defaults.

This	command	is	available	for
forms	and	for	some	reports.



Help	Menu
Help	Menu	Commands

Command Description

About Displays	version	and	copyright	information	for	the	current
screen	and	program.

Contents Opens	Help.

Using	Help Opens	Help	to	an	introductory	topic	on	how	to	use	Help.

Related	Topics
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Working	with	Detail	Entry	Tables
The	first	tab	of	each	transaction	entry	screen	in	Sage	300	ERP	contains
a	detail	entry	table	that	shows	the	document	details	in	tabular	format.

In	most	cases,	you	can	enter	all	the	necessary	details	for	a	document
right	on	the	table.

Tip:	If	there	are	more	columns	than	can	be	displayed	at	one	time,	you
can	use	the	horizontal	scroll	bar	at	the	bottom	of	a	list	to	view	the
additional	columns.	You	can	also	rearrange	the	order	of	columns,	or
change	column	widths,	consistent	with	how	you	enter	data.

You	can	also	view	and	edit	all	the	fields	for	a	single	detail	on	a	separate
Detail	Items/Taxes	screen.	To	view	this	screen,	select	a	detail	line	and
click	the	Item/Tax	button	below	the	table,	or	press	F9.

Note:	You	use	the	Detail	Items/Taxes	screen	to	view	or	change	tax
information	for	a	detail.	Detail	tax	fields	do	not	appear	in	the	detail	table.

To	add	details	using	the	detail	table,	do	one	of	the	following:
If	a	blank	line	is	highlighted,	tab	to	the	Item	Number	field,	then	either
type	the	item	number	or	select	it	from	the	Finder.	Enter	the	remaining
information	for	the	detail.
To	start	a	new	line,	press	Insert	or	tab	through	the	end	of	the	last	line
on	the	table.

If	you	want	to	insert	a	new	line	in	a	specific	location,	highlight	the	line
above	the	location,	and	then	press	Insert.

Note:	A	detail	line	is	saved	as	you	enter	it	on	the	detail	entry	table.

To	edit	details	using	the	detail	table:
Select	the	line	you	want	to	edit,	and	then	enter	your	changes	on	that
line.



Note:	For	information	about	using	your	keyboard	to	move	within	a	detail
table,	see	Keyboard	Shortcuts	for	Detail	Tables

To	delete	details	using	the	detail	table:
1.	 Select	the	line	you	want	to	delete.
2.	 Press	the	Delete	key	on	your	keyboard.
3.	 If	you	see	a	message	asking	you	to	confirm	the	deletion,	click	Yes.

To	edit	item	information	or	detail	tax	information	using	the	Detail
Items/Taxes	screen:
1.	 Select	the	detail	on	the	table,	and	then	either	click	the	Item/Tax

button,	or	press	F9.
2.	 Edit	the	item	information	and/or	change	the	Tax	Class	or	Tax

Included	options	for	the	detail.

Related	Topics
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Setting	Up	General	Ledger
Use	General	Ledger	Setup	screens	to	set	up	accounts,	options,	and
security	authorizations	that	determine	how	General	Ledger	processes
transactions	and	interacts	with	other	Sage	300	ERP	modules.

About	Setting	Up	General	Ledger

About	Designing	Your	General	Ledger

About	Fiscal	Years	and	Periods

General	Ledger	Security	Authorizations

Options

Account	Segments

Account	Structures

Source	Codes

Source	Journals

Account	Groups

Revaluation	Codes

Optional	Fields
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About	Setting	Up	General	Ledger
After	installation,	you	take	the	following	general	steps	to	set	up	General
Ledger.



Step	One:	Activate	General	Ledger	for	Your
Database
This	step	adds	the	database	tables	required	by	the	General	Ledger
application.	Click	the	Data	Activation	icon	in	the	Administrative	Services
folder	to	start	the	activation.

Activation	requires	the	following	information:

The	current	fiscal	year.
The	starting	date	of	the	oldest	fiscal	year	for	which	you	want	to	keep
data.

Note:

Make	sure	you	enter	the	starting	date	for	the	first	period	in	your	fiscal
year.	For	example,	if	your	year	starts	in	April,	specify	April	1	of	the	first
year	that	you	want	data.

General	Ledger	creates	a	calendar	for	the	year	before	the	oldest	year
you	specify,	so	you	can	post	the	opening	entries	for	the	oldest	fiscal
year.



Step	Two:	Select	Configuration	and	Processing
Options
Decide	on	the	options	you	need,	including	whether	to	use	the	sample
chart	of	accounts	shipped	with	General	Ledger,	whether	to	use	account
groups,	how	many	account	segments	to	use,	what	account	segments	to
use,	whether	to	print	batches	before	posting,	whether	to	allow	posting	to
previous	years.

Use	the	following	screens	in	the	G/L	Setup	folder	to	select	options	and
configure	General	Ledger:

First,	use	the	G/L	Options	screen	to	select	basic	processing	options
and	define	all	the	segments	used	in	your	General	Ledger	account
numbers.

Next,	use	the	Segment	Codes	screen	and	then	the	Account	Structure
screens	to	define	a	structure	for	your	chart	of	accounts.

Note:	After	adding	segment	codes	and	account	structure	codes,
open	the	G/L	Options	screen	to	specify	the	default	structure	code
on	the	Segments	tab.

Use	the	Source	Codes	and	Source	Journal	Profiles	screens	to	define
source	codes	and	reports	for	sorting	and	printing	the	details	of	posted
transactions.
Use	the	Account	Groups	screen	to	assign	accounts	to	groups.
Use	the	remaining	icons	to	set	up	recurring	entries,	revaluation
codes,	and	optional	fields.



Step	Three:	Add	Accounts
Add	general	ledger	accounts	using	the	Accounts	screen	in	the	G/L
Accounts	folder.



Step	Four:	Add	Historical	Data
In	General	Ledger,	you	must	enter	at	least	the	year-to-date	balances	in
each	of	your	ledger	accounts.

Related	Topics
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About	Designing	Your	General	Ledger
Before	you	begin	setting	up	any	part	of	your	general	ledger,	design	your
chart	of	accounts,	and	select	system-wide	options.



Designing	a	Chart	of	Accounts
How	you	organize	your	chart	of	accounts	depends	on	how	you	intend	to
use	particular	features	of	the	General	Ledger	system.	You	must	decide:

Which	accounts	you	need.
Which	account	segments	each	account	requires.
How	you	will	assign	account	numbers.

Begin	by	listing	the	accounts	you	need,	and	then	decide	on	an	account
numbering	scheme	that	suits	your	financial	reporting	requirements.

If	you	do	not	have	an	accountant	to	assist	you,	use	one	of	the	sample
data	charts	of	accounts	as	a	guideline	for	designing	your	own	chart	of
accounts.	Print	the	sample	charts	of	accounts	by	opening	G/L	Reports	>
Chart	of	Accounts.

Important!	Design	your	chart	of	accounts	carefully.	It	is	much	easier	to
move	accounts	around	before	entering	them,	than	to	change	them
afterward.

Selecting	System-Wide	Options
You	must	choose	some	system-wide	options	in	System	Manager's
Common	Services	before	setting	up	your	General	Ledger.	These	include:

Multicurrency	setting.	With	multicurrency	turned	on,	you	can
process	transactions	in	more	than	one	currency.	If	you	select
multicurrency,	you	must	also	select	your	home	currency	(called	the
functional	currency).	You	make	this	selection	on	the	Company	Profile
screen	in	Common	Services.
Number	of	fiscal	periods.	Select	either	12	or	13	periods	for	your
fiscal	year.	You	make	this	selection	on	the	Company	Profile	screen.
Currency	codes,	rate	types,	tables,	and	rates.	You	maintain	all
currency	information	using	the	Currency	screens.	For	information,
see	Common	Services	help,	or	refer	to	the	System	Manager	help.

Note:	You	do	not	have	to	create	fiscal	calendars	before	you	activate



General	Ledger.	General	Ledger	creates	fiscal	calendars	during
activation	based	on	the	number	of	years	of	account	history	you	want	to
add.

Related	Topics
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About	Fiscal	Years	and	Periods
Sage	300	ERP	lets	you	use	a	12	or	13	period	year,	depending	on	your
requirements.	The	fiscal	calendar	for	Sage	300	ERP	is	maintained	by
Common	Services,	not	by	the	General	Ledger	program.

You	select	the	number	of	periods	for	your	company	on	the	Common
Services	Company	screen,	on	the	Options	tab.	If	you	change	this	setting,
the	next	fiscal	year	you	create	will	have	the	new	number	of	periods.

You	can	lock	and	unlock	individual	fiscal	periods	with	the	Common
Services	Calendar	screen.

Select	12	if	your	fiscal	year	is	divided	into	calendar	months.
Select	13	if	your	fiscal	year	is	divided	into	4-week	periods,	or	if	you
currently	use	12	periods	but	want	to	change	(you	will	need	to	enter
historical	figures	recalculated	over	13	periods).	If	you	select	13,	you
must	also	select	the	Quarter	With	4	Periods.

In	either	case,	General	Ledger	provides	two	additional	periods:	one	for
year-end	adjustments,	and	one	for	closing	entries.



Current	Fiscal	Year
When	you	first	select	a	newly	created	company,	Common	Services
Activation	prompts	you	for	the	starting	date	of	your	fiscal	year.	Sage	300
ERP	uses	the	starting	date	you	specify	to	create	the	current	fiscal	year	in
the	fiscal	calendar.	General	Ledger	activation	uses	this	date	and	the
Oldest	Fiscal	Year	Starting	Date	to	determine	how	many	fiscal	calendars
it	needs	to	create.

For	example,	if	your	year	starts	in	April,	and	it	is	now	June,	2001,	your
current	fiscal	year	is	2002.	General	Ledger	creates	calendars	for	prior
fiscal	years	up	to	the	current	year,	and	it	also	creates	a	calendar	for	the
current	fiscal	year	if	one	does	not	already	exist.

Note:	The	Current	Fiscal	Year	you	specify	during	activation	is	used	only
to	create	the	correct	fiscal	calendars.	It	is	not	the	current	fiscal	period
after	activation.	When	activation	is	finished,	General	Ledger	sets	the
current	fiscal	year	to	the	year	before	the	oldest	fiscal	year	you	specified,
so	you	can	enter	the	opening	balances	for	your	ledger.

The	current	fiscal	year	in	the	General	Ledger	program	is	the	year	to
which	you	are	posting	transactions.	At	any	time,	you	can	check	which
year	is	current	by	looking	on	the	Posting	tab	of	the	G/L	Options	screen.

The	only	way	to	change	the	current	year	is	to	use	the	Create	New	Year
screen.	Create	New	Year	closes	the	income	and	expense	accounts	to
retained	earnings,	and	makes	the	new	year	the	current	year.	You	cannot
post	to	a	future	year.

You	cannot	move	the	current	year	to	a	prior	year,	although	you	can	post
to	prior	years.	When	you	post	to	a	prior	year,	General	Ledger
automatically	generates	any	necessary	closing	entries	to	retained
earnings.

To	avoid	prior-year	posting	when	adding	historical	data	(and	all	the
additional	closing	entries	it	would	create),	General	Ledger	activation	sets
the	current	fiscal	year	to	the	year	before	the	oldest	fiscal	year	you
specified,	so	you	can	enter	the	opening	balances	for	your	ledger.



Oldest	Fiscal	Year	Starting	Date
General	Ledger	uses	the	Oldest	Fiscal	year	Starting	Date	for	two
separate	purposes:

To	create	fiscal	calendars	that	begin	with	this	month	and	date.

General	Ledger	creates	calendars	for	the	current	year	and	all
previous	years	to	one	year	before	the	date	you	enter	here.	The	year
prior	to	the	Oldest	Fiscal	Year	is	required	for	opening	balances,	which
you	post	to	period	12	or	13	of	the	year.

To	set	the	current	fiscal	year	to	oldest	year	so	that	you	can	enter	your
prior-year	data	and	opening	balances.

The	best	way	to	add	prior-year	data	is	to:

Set	the	fiscal	year	to	the	first	year,	enter	and	post	final-period
balances,	then	create	the	next	year	(thereby	closing	the	current-year
income	and	expense	accounts	to	retained	earnings	and	moving	the
current	fiscal	year	to	the	newly	opened	year).
Enter	and	post	period	net	changes	for	each	of	the	prior	years,
creating	a	new	year	after	entering	each	year's	batches	to	close	to
retained	earnings	and	advance	the	current	fiscal	year.
Enter	and	post	current-year	transactions	(or	period	net	changes)	up
to	the	current	period.

Example:

For	example,	if	your	fiscal	year	starts	on	April	1,	and	you	want
comparative	figures	from	April	1,	2002,	enter	04/01/2002.

If	you	do	not	want	to	enter	any	prior-year	data,	enter	the	current	year.
Note	that	you	cannot	change	to	an	earlier	date	after	activation.



Related	Topics
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General	Ledger	Security	Authorizations
If	security	is	turned	on	for	your	Sage	300	ERP	system,	the	system
administrator	must	assign	users	security	authorization	for	General
Ledger	screens.

For	information	on	turning	on	security,	setting	up	security	groups,	and
assigning	authorizations,	refer	to	the	System	Manager	help.

Note:	To	change	the	print	destination	for	forms	and	reports,	you	must
have	Change	Print	Destination	security	authorization	for	Administrative
Services.

To	view	records	and	to	print	reports	in	General	Ledger,	you	must	belong
to	a	security	group	with	Common	Inquiry	authorization.	Common	Inquiry
permission	by	itself	does	not	let	you	edit	any	General	Ledger	records.	To
edit	records	or	perform	processing	tasks,	the	system	administrator	must
grant	the	group	access	to	additional	tasks	from	the	following	list:

General	Ledger	Security	Authorizations
Security

Authorization
Description

Account
Maintenance

Update	General	Ledger	account	information	entered	on
the	Accounts	screen;	access	the	Account	Mapping
screen;	view	and	print	from	setup	screens.

Balance	Sheet
Snapshot

View	the	Balance	Sheet	snapshot	in	the	Sage	300	ERP
Portal.

Common
Inquiry

If	a	group	has	access	only	to	Common	Inquiry,	users
who	belong	to	that	group	will	not	be	able	to	update	G/L
accounts,	setup	screens,	setup	reports,	or	the	Account
Mapping	screen.

If	a	group	has	access	to	any	General	Ledger	function,
users	who	belong	to	that	group	will	automatically	have
access	to	Common	Inquiry,	too.

Create	New Use	the	Create	New	Year	screen;	view	and	print	from



Year setup	screens.

Dashboard Use	the	Executive	Dashboard	on	the	Sage	300	ERP
Dashboard	page.	The	Sage	300	ERP	Dashboard	page
is	on	the	Sage	300	ERP	Dashboard	Center,	at
http://AccpacDashboard/.	Users	with	access	to	G/L
Dashboard	can	access	dashboard	pages	(if	any)	based
on	data	stored	in	General	Ledger.

Export
General
Ledger	Data

Use	the	File	>	Export	menu	command	on	General
Ledger	screens.

Financial
Reporter

Use	Financial	Reporter	to	customize	and	print	Sage
300	ERP	financial	reports.

G/L	Security
Maintenance

Assign	accounts	to	other	users.

History/Budget
Inquiry

View	the	Chart	of	Accounts,	Account	History	Inquiry,
and	Budget	Maintenance	screens;	access	Source
Currency	Inquiry	and	Fiscal	Set	Comparison	screens;
print	the	Chart	of	Accounts	and	Trial	Balance	reports;
view	and	print	from	setup	screens.

History/Budget
Maintenance

Use	the	Account	History	Inquiry,	Budget	Maintenance,
Source	Currency	Inquiry,	Fiscal	Set	Comparison,	and
Trial	Balance	screens;	view	and	print	setup	information
and	the	Chart	of	Accounts.

Import
General
Ledger	Data

Use	the	File	>	Import	menu	command	on	General
Ledger	screens.

Income
Statement
Snapshot

View	the	Income	Statement	snapshot	in	the	Sage	300
ERP	Portal.

Journal	Entry Use	the	Journal	Entry,	Recurring	Entries,	Create
Allocation	Batch,	Create	Revaluation	Batch,	Create
Recurring	Entries	Batch,	Retrieve	G/L	Batch,	Batch	List,
Batch	Listing,	and	Batch	Status	screens;	view	and	print



from	setup	screens.

Journal	Entry
Inquiry

View	the	Batch	List	screen;	view	entries	on	the	Journal
Entry	and	Recurring	Entries	screens;	print	Batch	Status
and	Batch	Listings	reports;	view	and	print	from	setup
screens.

Journal
Posting

Use	the	Post	Batches	screen	and	inquiries	associated
with	posted	transactions.

Note:

Journal	Entry	rights	are	not	automatically	given
when	Journal	Posting	is	assigned.
You	must	set	batch	status	to	Ready	to	Post	before
posting	a	batch.	A	separate	right,	Set	Batch	Ready
to	Post,	is	required.

Period	End
Maintenance

Use	the	Period	End	Maintenance	screen;	view	and	print
from	setup	screens.

Sage	300	ERP
Inquiry

Query	General	Ledger	data	in	the	Sage	300	ERP
Portal.

If	you	also	have	Export	Processing	authorization	for
General	Ledger,	print	or	export	the	results	of	these
queries.

Set	Batch
Ready	to	Post

Set	batches	ready	to	post.

Setup
Maintenance

Edit	information	on	the	G/L	Options,	Segment	Codes,
Source	Codes,	Source	Journal	Profiles,	Revaluation
Codes,	Account	Structures,	and	Optional	Fields
screens.

Transaction
Inquiry

View	transaction	history;	print	the	Transactions	Listing
and	Posting	Journals;	view	and	print	from	setup
screens.

Transaction Access	the	Consolidate	Posted	Transactions	screen;



Maintenance view	and	print	Accounts	and	Transaction	History;	print
the	Transactions	Listing	and	Posting	Journals;	view	and
print	from	setup	screens;	use	the	Clear	History	screen
to	clear	printed	posting	journals.

Transaction
Optional
Fields

Add	or	delete	optional	fields	for	the	Journal	Entry,
Recurring	Entries,	Create	Allocation	Batch,	Create
Revaluation	Batch,	and	Create	Recurring	Entries	Batch
screens.

Transaction
Optional
Fields

Add	or	delete	optional	fields	for	the	Journal	Entry,
Recurring	Entries,	Create	Allocation	Batch,	Create
Revaluation	Batch,	and	Create	Recurring	Entries	Batch
screens.

Related	Topics
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General	Ledger	Setup	Options
Select	options	that	specify	how	records	and	transactions	are	processed
in	General	Ledger.

About	Provisional	Posting

General	Ledger	Setup	Options

About	General	Ledger	Security

Turning	on	G/L	Security
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About	Provisional	Posting
Sage	300	ERP	lets	you	post	transactions	on	a	provisional	basis	to	test
their	effects	on	your	ledger	before	you	post	the	actual	financial	amounts
permanently.

This	feature	is	particularly	useful	when	you	are	doing	period-end	or	year-
end	adjustments,	and	want	to	ensure	that	you	have	entered	all	the
transactions	you	need	before	you	post	them.

You	select	the	Allow	Provisional	Posting	option	on	the	G/L	Options
screen.

Provisionally	posted	amounts	are	stored	with	the	accounts	in	a
provisional	fiscal	set,	and	can	be	included	on	normal	General	Ledger
reports	and	inquiries	that	show	the	net	result	of	the	batch	posting	on	the
ledger's	accounts.

If	you	do	not	use	the	Force	Listing	of	Batches	option,	you	can	post
batches	provisionally	only	if	you	have	printed	listings	for	them	or	you
have	selected	the	Ready	to	Post	option	for	the	batches	on	the	Journal
Entry	screen.

A	provisionally	posted	batch	is	maintained	separately	from	actual
postings,	and	its	status	shows	it	has	been	provisionally	posted.	When
you	are	satisfied	that	the	entries	in	the	batch	are	correct,	you	can	post
the	batch	to	update	actual	financial	amounts	in	the	actual	fiscal	sets.
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General	Ledger	Setup	Options
Before	you	set	up	your	general	ledger,	you	must:

Decide	which	ledger	options	you	need.	For	more	information,	see
About	Designing	Your	General	Ledger.
Design	your	account	number	format,	specifying	the	size	of	your
account	numbers	and	how	the	numbers	are	segmented.	For	more
information,	see	About	Account	Segments	and	About	Account
Structures.

You	specify	most	General	Ledger	setup	options	using	the	G/L	Options
setup	screen.	However,	a	few	system-wide	settings	are	defined	in
Common	Services.	For	more	information	on	Common	Services,	see	the
System	Manager	Help.	For	more	information	about	using	the	G/L	Options
screen,	see	G/L	Options	Screen.



Ledger	Options	Specified	in	Common	Services
You	specify	the	following	information	and	options	in	Common	Services:

Whether	your	company	uses	multicurrency	accounting.
The	number	of	fiscal	periods	in	your	business	year.
The	start	and	end	dates	of	accounting	periods.
If	you	use	Sage	300	ERP	Transaction	Analysis	and	Optional	Field
Creator,	all	optional	fields	that	you	will	use	in	General	Ledger	and	in
subledgers.



General	Ledger	Account	and	Ledger	Options
You	specify	the	following	account	and	ledger	options	using	the	G/L
Options	setup	screen:

Whether	your	general	ledger	uses	multicurrency	accounting
Default	rate	type
Whether	to	use	account	groups
Whether	to	maintain	quantities
Number	of	decimal	places	in	quantities
Default	closing	(retained	earnings)	account
Reporting	rounding	account	(euro	functional	currency	only)
G/L	Security	(and	the	resulting	default	access	to	accounts)

For	more	information,	see	About	Setting	Up	General	Ledger.



General	Ledger	Account	Segment	Options
You	specify	the	following	account	segment	options	using	the	G/L	Options
setup	screen:

Default	structure	code
Account	segment
Segment	delimiter
Segment	description	table
Segment	number
Segment	name
Length
Use	in	closing	(Yes/No)

For	more	information,	see	About	Account	Segments.



General	Ledger	Posting	Options
You	specify	the	following	posting	options	using	the	G/L	Options	setup
screen:

Lock	budget	sets
Allow	posting	to	previous	years
Allow	provisional	posting
Force	listing	of	batches
Years	of	fiscal	sets
Years	of	transaction	detail
Edit	imported	entries
Default	source	code

For	more	information,	see	About	Transaction	Processing	in	General
Ledger.

Related	Topics
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About	General	Ledger	Security
G/L	Security	is	a	feature	of	General	Ledger	that	lets	you	limit	the
accounts	that	individual	users	can	view	or	work	with	to	minimize	the	risk
of	unauthorized	activity.

With	G/L	Security,	you	can:

Assign	account	access	rights	to	individual	users	to	control	which
accounts	they	can	view	and	work	with.
Block	off	entire	account	segments	or	only	the	most	sensitive
accounts	(for	example,	Payroll,	Sales,	Retained	Earnings,	Common
Stock	and	Preferred	Stock).



Default	Account	Access
You	select	the	option	to	use	G/L	Security	and	set	a	default	level	of	access
to	accounts	using	the	Account	tab	of	the	G/L	Options	screen.

You	can	set	the	default	account	access	as	follows:

All	Accounts.	Allows	all	Sage	300	ERP	users	unrestricted	access	to
General	Ledger	accounts	unless	you	set	up	restrictions	in	the	G/L
Account	Permissions	screen.

Note:	You	do	not	require	permission	for	all	accounts	to	perform
periodic	maintenance	functions,	such	as	deleting	inactive	accounts.
However,	occasionally,	you	may	find	that	you	cannot	edit	or	delete	a
structure	code,	segment,	or	source	code	because	it	is	used	by	an
account	that	you	cannot	see.	In	this	case,	a	user	with	access	to	all
accounts	must	modify	the	accounts	that	use	the	code	or	segment
you	are	trying	to	delete.

No	Accounts.	Prevents	all	Sage	300	ERP	users	except	user	ADMIN
from	seeing	accounts	and	account	data	in	General	Ledger	and
subledger	applications	unless	you	grant	individual	access	rights	to
accounts	in	the	G/L	Account	Permissions	window.

If	you	choose	No	Accounts,	other	Sage	300	ERP	users	cannot	enter
Accounts	Receivable	invoices	or	post	transactions	unless	you	assign
them	permissions.



Granting	Permissions	to	Specific	Users
When	you	turn	on	G/L	Security,	the	next	time	you	sign	into	the	company
database,	an	Account	Permissions	icon	appears	in	the	G/L	Accounts
folder	that	lets	you	assign	access	rights	to	accounts.

You	assign	access	depending	on	your	security	needs.	For	example,	you
can	set	up	identical	access	rights	for	all	Sage	300	ERP	users	within	a
department,	division,	or	business	unit	that	restrict	access	to	accounts
outside	that	group.	For	maximum	security,	you	can	block	your	entire	chart
of	accounts	to	all	Sage	300	ERP	users	except	the	ADMIN	user.

You	can	test	the	effects	of	the	G/L	security	options	you	select	by	logging
on	to	Sage	300	ERP	as	a	user	other	than	ADMIN	and	checking	which
accounts	are	visible	in	the	General	Ledger	Chart	of	Accounts	window.

If	you	selected	No	Accounts,	you	will	not	see	any	account	numbers	in
the	Finder	or	in	the	Chart	of	Accounts	screen.

G/L	Security	and	Rollup	Accounts
If	you	are	using	G/L	Security	and	want	to	create	rollup	accounts,	you
must	have	access	rights	to	view	all	member	accounts	of	the	rollup
account	in	order	to	view	the	rolled	up	balances	in	the	higher	level
account.

If	a	roll	up	account	is	accessible	under	the	user’s	security	rights,	all	of	its
member	accounts	are	also	assumed	to	be	accessible.

How	Access	Restrictions	Affect	Sage	300	ERP	Users
Account	access	restrictions	affect	Sage	300	ERP	user	activities	in	the
following	ways:

Account	lookup	and	inquiry.	Users	cannot	look	up	restricted
account	numbers	in	Finders	or	perform	account	inquiries	in	General
Ledger.

If	users	enter	restricted	account	numbers	into	fields,	they	will	see	an
error	message	stating	that	the	specified	account	does	not	exist	in	the
General	Ledger.



Adding	new	accounts.	Users	cannot	add	new	accounts	that	fall
within	a	restricted	segment	range.
Posting	and	other	batch-related	activities.	Posting	is	limited	to
batches	that	do	not	contain	restricted	accounts.	Users	cannot	view	a
batch	that	contains	transactions	with	restricted	account	numbers.	The
batch	will	not	appear	in	batch	list	windows.

Even	if	the	user	has	Journal	Posting	rights,	they	cannot	post	batches
if	G/L	Security	has	been	set	to	No	Accounts.

Invoice	entry.	Users	cannot	enter	invoices	for	restricted	accounts	in
Purchase	Orders	or	Accounts	Receivable.
Importing	and	exporting	account	data.	Users	cannot	import	and
export	data	for	restricted	accounts.
Report	generation.	Restricted	account	ranges	do	not	appear	in
financial	reports	created	using	Financial	Reporter.

Security	for	Accounts	that	Use	Blank	Segments
If	you	use	a	mix	of	account	structures	in	your	chart	of	accounts,	you	need
to	consider	how	the	program	handles	accounts	that	do	not	contain	all	the
segments	you	use	in	your	system.

If	an	account	number	does	not	include	a	particular	segment,	say	division,
the	program	considers	this	segment	blank.	Unless	you	specifically	restrict
blank	values	for	the	division	segment,	the	segment	will	be	allowed.

Example:

For	the	sample	company,	SAMLTD,	account	1000	contains	only	the
account	segment.	If	you	do	not	restrict	blank	division	and	region
segments	and	the	account	segment	1000	is	allowed,	account	1000	will
be	visible.

To	allow	accounts	that	include	division	100	-	but	restrict	those	that	do
not	contain	the	division	segment	-	you	would	set	account	permissions
as	follows:

If	the	default	access	set	on	the	G/L	Options	screen	is	All	Accounts:



Allow Segment From To

No Division 	 ZZZ

Yes Division 100 100

All	division	segments	with	a	blank	value	are	restricted.

If	the	default	access	is	No	Accounts:

Allow Segment From To

Yes Account 	 ZZZZ

Yes Region 	 ZZ

Yes Division 100 100

No Division 	 	

Note:	The	order	of	permissions	for	the	division	segment	is
important.
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Turning	on	G/L	Security
G/L	Security	is	a	feature	of	General	Ledger	that	lets	you	limit	the
accounts	that	individual	users	can	view	or	work	with	to	minimize	the	risk
of	unauthorized	activity.

With	G/L	Security,	you	can:

Assign	account	access	rights	to	individual	users	to	control	which
accounts	they	can	view	and	work	with.
Block	off	entire	account	segments	or	only	the	most	sensitive
accounts	(for	example,	Payroll,	Sales,	Retained	Earnings,	Common
Stock	and	Preferred	Stock).

Note:	G/L	Security	is	separate	from	the	security	you	use	to	authorize
users	to	view	or	work	with	General	Ledger	screens.	You	assign	security
for	General	Ledger	screens	in	Administrative	Services,	as	you	do	for
other	Sage	300	ERP	modules.

Before	you	start

To	turn	on	G/L	Security:
1.	 Open	General	Ledger	>	G/L	Setup	>		Options.
2.	 On	the	Account	tab:

a.	 Select	the	G/L	Security	option.
b.	 From	the	Default	Access	list,	select	the	default	level	of	account

access	to	permit	all	users.	More...

3.	 Click	Save.
4.	 Close	and	then	reopen	your	company	database.

After	turning	on	G/L	Security
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Account	Segments
An	account	number	consists	of	between	one	and	ten	parts	called
segments.	Add	and	set	up	these	account	segments,	and	then	define
account	structures	that	specify	the	various	combinations	of	segments
used	in	your	account	numbers.

About	Account	Segments

About	Segment	Codes

Adding	Segment	Codes

Deleting	Segment	Codes



Home	>	Setting	Up	General	Ledger	>	Account	Segments	>	About	Account	Segments



About	Account	Segments
An	account	number	consists	of	from	one	to	ten	parts	called	segments.
Each	segment	can	be	up	to	15	characters	long.	You	define	account
segments	on	the	Segments	tab	of	the	G/L	Options	screen.

Valid	segment	codes	could	be	the	codes	for	all	departments	in	the
company,	the	company’s	division	codes,	etc.

Once	you	define	account	segments,	you	must:

Use	the	G/L	Account	Structures	screen	to	define	account	structures
—the	various	combinations	of	segments	used	in	your	account
numbers.
Use	the	G/L	Segment	Codes	screen	to	specify	which	account
segments	are	used	by	individual	account	numbers,	and	the	order	in
which	segments	appear.

Account	Number	Size
The	maximum	number	of	segments	you	can	define	depends	on	the
edition	of	Sage	300	ERP	you	use:

In	Sage	300	Premium	ERP,	you	can	maintain	up	to	10	segments.
In	Sage	300	Advanced	ERP,	you	can	maintain	up	to	4	segments.
In	Sage	300	Standard	ERP,	you	can	maintain	up	to	3	segments.

If	you	are	using	Sage	300	Premium	ERP,	your	individual	account
numbers	cannot	exceed	45	characters	(including	delimiter	characters).
However,	most	General	Ledger	reports	that	include	account	numbers
assume	your	numbers	will	be	24	characters	or	fewer.	If	you	use	longer
numbers,	you	will	have	to	modify	your	reports.	If	you	define	10	segments,
it	is	unlikely	that	any	of	your	account	numbers	will	contain	all	10.

You	can	use	up	to	15	characters	in	a	single	segment.
Individual	account	numbers	can	contain	from	one	to	ten	segments,
and	you	can	vary	the	number	and	order	of	segments	used	in	account
numbers	in	the	same	general	ledger.



The	following	chart	shows	a	typical	segment	organization:

Seg. Description Length

1
2
3

Account
code
Department
Division

4
3
2

Account	Number	Format
One	segment	of	the	account	number	is	called	the	account	segment.	This
segment	identifies	the	exact	purpose	of	the	account	(such	as	petty	cash).

You	specify	the	number	of	the	account	segment	in	the	Account	Segment
field	on	the	Segments	tab	of	the	G/L	Options	screen.	Every	account
number	and	account	number	structure	you	add	must	include	the	account
segment.

Other	account	segments	can	identify	divisions,	departments,	warehouse
locations,	and	so	on.

The	delimiter	character	is	used	to	separate	the	segments	of	the	account
number	during	entry	and	display,	and	on	reports,	making	it	easier	to	read.

You	can	use	each	account	number	segment	you	define	to	select	and	sort
accounts	that	appear	on	reports	and	inquiries.

If	your	account	numbers	have	two	defined	segments,	you	might	have	the
following	petty	cash	account	numbers:

Dept.	Seg. Account	Number Account	Description

15

20

25

1000

1000

1000

Petty	Cash,	Office

Petty	Cash,	Plant

Petty	Cash,	Job	Site



In	this	example,	one	segment	identifies	the	department,	and	the	other	is
the	account	segment.	Additional	account	number	segments	can
distinguish	other	functional	areas	within	the	company.

The	following	example	shows	a	three-segment	account	number:

A-15-1000

Single-Segment	Account	Numbers
A	single-segment	account	number	has	only	an	account	segment.	You
cannot	create	account	structure	codes	or	segment	codes	for	a	single-
segment	account	number.

You	cannot	close	single-segment	income	and	expense	accounts	by
account	number	segment	such	as	by	department.	Instead,	G/L	closes	the
accounts	to	the	default	closing	account	specified	on	the	Account	tab	of
the	G/L	Options	screen.

Changing	Segments
At	any	time,	you	can	add	new	segments,	change	segment	descriptions,
delete	a	segment,	providing	it	is	not	assigned	to	an	account	number
structure,	or	change	the	length	of	a	segment,	providing	it	is	not	used	in
an	account	number	structure.

Account	Structures
An	account	structure	identifies	which	account	segments	are	used	by
particular	accounts	in	your	general	ledger,	and	the	order	of	those
segments	in	the	account	number.

Account	structures	let	you	use	different	numbers	of	account	segments	in
your	codes	within	the	same	General	Ledger.

The	number	of	account	structures	you	can	define	is	determined	by	the
version	of	Sage	300	ERP	you	are	using	(3,	4,	or	an	unlimited	number).

The	following	example	illustrates	how	account	structures	work.

If	you	defined	four	account	segments	on	the	G/L	Options	screen:

You	can	define	one	account	structure	that	uses	only	two	segments	in



account	numbers	(such	as	the	account	segment	and	the	department
segment).
You	can	define	another	structure	for	account	numbers	that	have	four
segments,	such	as	the	account	segment,	and	segments	for	the
department,	sales	region,	and	product	type.

Related	Topics
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About	Segment	Codes
When	you	use	the	G/L	Accounts	screen	to	add	General	Ledger	account
numbers,	the	program	checks	the	Segment	Codes	table	to	be	sure	that
the	segment	codes	(such	as	the	department	numbers)	are	valid.

If	a	segment	code	is	not	valid,	General	Ledger	does	not	let	you	add	the
account.

Note:	The	only	segment	that	is	not	validated	is	the	account	segment.

The	Account	Segment
The	account	segment	is	the	portion	of	the	General	Ledger	account
number	that	identifies	the	account	type	as	one	of	the	income,	expense,
asset,	and	liability	accounts	that	record	the	company's	business
transactions.	For	example,	if	you	have	account	numbers	with	two
segments,	one	segment	may	be	the	account	segment,	and	the	other
segment	may	identify	the	department.

Every	account	number	requires	an	account	segment.	If	your	account
numbers	have	only	one	segment,	that	segment	is	the	account	segment.

Related	Topics
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Adding	Segment	Codes
After	defining	segments	using	the	G/L	Options	screen,	you	can	add	valid
codes	to	identify	the	accounting	entities	the	segment	represents.	For
example,	you	might	enter	10,	20,	30,	and	40	as	codes	for	the	segment
that	represents	the	four	regions	in	your	company.

Before	you	start

To	add	segment	codes:
1.	 Open	General	Ledger	>	G/L	Setup	>		Segment	Codes.
2.	 From	the	Segment	Name	list,	select	the	segment	for	which	you	want

to	enter	valid	codes.
3.	 If	you	are	entering	codes	for	the	first	time	for	this	segment,	click	in

the	table	or	press	the	Tab	key	to	insert	the	first	line	in	the	table.

If	you	are	editing	existing	codes,	click	the	line	you	want	to	change,	or
click	in	the	table	and	press	the	Insert	key	to	add	a	code.

4.	 In	the	Segment	Code	column,	enter	or	change	the	code.
The	code	must	be	the	length	you	specified	for	the	segment.

5.	 Tab	to	the	Description	field,	and	then	enter	a	description	for	the
code.

6.	 Press	the	Tab	key,	and,	if	the	segment	is	used	in	closing	accounts,
enter	the	retained	earnings	account	number	to	which	this	segment
code	closes.

Note:	You	cannot	select	an	account	to	which	posting	is	prohibited.

7.	 If	you	want	to	add	another	code,	press	the	Insert	key,	and	then	repeat
steps	4,	5,	and	6.

8.	 When	you	have	added	all	the	codes	for	a	segment,	click	Save.

After	adding	segment	codes
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Deleting	Segment	Codes
Before	you	start

To	delete	a	segment	code:
1.	 Open	General	Ledger	>	G/L	Setup	>		Segment	Codes.
2.	 From	the	Segment	Name	list,	select	the	segment	for	which	you	want

to	delete	a	segment	code.
3.	 In	the	table,	select	the	particular	code	you	want	to	delete.
4.	 Press	the	Delete	key.

After	deleting	segment	codes

Related	Topics
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Account	Structures
After	creating	account	segments,	define	account	structures	that	specify
the	various	combinations	of	segments	used	in	your	account	numbers.

About	Account	Structures

Adding	Structure	Codes

Deleting	Structure	Codes
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About	Account	Structures
Account	number	structures	let	you	use	different	account	segments	for
different	groups	of	account	numbers.

You	use	the	Account	Structures	screen	to	define	account	structure	codes
that	are	used	to	format	account	numbers.

The	structure	specifies:

Which	segments	appear	in	the	account	number.
The	order	in	which	the	segments	appear.

You	must	assign	an	account	structure	to	each	account	that	you	add	to
General	Ledger.	(You	specify	which	account	structure	an	account	uses
when	you	add	the	account	using	the	G/L	Accounts	screen.)

Note:	General	Ledger	does	not	let	you	add	an	account	if	its	account
number	does	not	match	the	format	of	the	assigned	account	structure.



Guidelines	for	Creating	Account	Structures
You	can	use	more	than	one	account	number	structure	within	the
same	General	Ledger.

For	example,	you	can	define	one	account	structure	that	uses	only
two	segments	in	account	numbers	(such	as	the	account	segment	and
a	department	segment),	and	another	structure	for	account	numbers
that	have	four	segments	(such	as	the	account	segment,	and
segments	identifying	the	department,	sales	region,	and	product	type).

Tip:	Normally,	you	use	the	same	structure	for	all	accounts	in	the
same	account	group.

Each	structure	can	use	any	combination	of	the	account	segments
you	have	defined,	arranged	in	any	order,	and	containing	up	to	45
characters	(including	delimiters).

Individual	account	numbers	cannot	exceed	45	characters	(including
delimiter	characters),	so	if	you	defined	10	segments,	it	is	unlikely	that
any	of	your	account	numbers	could	contain	all	10.

You	can	add	new	account	structures	at	any	time,	but	you	can	change
existing	structure	definitions	only	if	you	have	not	added	accounts	that
use	the	structure.
The	order	in	which	you	select	the	segments	determines	their	order
within	the	account	structure.
When	defining	an	account	structure,	move	the	segments	in	the	exact
order	you	want	them	to	appear.
You	cannot	change	the	structure	attached	to	an	account.

Maximum	Number	of	Account	Structures
Depending	on	the	edition	of	Sage	300	ERP	you	are	using,	you	can
define:

Up	to	three	account	structures	in	Sage	300	Standard	ERP.
Up	to	four	account	structures	in	Sage	300	Advanced	ERP.



Unlimited	account	structures	in	Sage	300	Premium	ERP.

Related	Topics
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Adding	Structure	Codes
You	use	the	Account	Structures	screen	to	define	account	structure	codes
that	are	used	to	format	account	numbers.

The	structure	specifies:

Which	segments	appear	in	the	account	number.
The	order	in	which	the	segments	appear.

You	must	assign	an	account	structure	to	each	account	that	you	add	to
General	Ledger.	(You	specify	which	account	structure	an	account	uses
when	you	add	the	account	using	the	G/L	Accounts	screen.)

Before	you	start

To	add	account	structure	codes:
1.	 Open	General	Ledger	>	G/L	Setup	>		Account	Structures.
2.	 In	the	Structure	Code	field,	type	a	code	to	identify	the	new	account

structure,	and	then	press	the	Tab	key.

You	can	use	up	to	six	alphanumeric	characters	for	the	code.

Tip:	To	add	a	different	code	than	the	one	displayed,	click	the	New
button	beside	the	Structure	Code	field.

3.	 Enter	a	description	for	the	structure	code,	using	up	to	60	characters.

4.	 If	you	want	to	use	this	code	as	the	default	structure	code,	select	Use
As	Company	Default	Structure.

Note:	After	you	have	assigned	a	default	structure,	you	can	change
the	default	structure	only	on	the	Segments	tab	of	the	G/L	Options
screen.

5.	 In	the	Choose	The	Segments	To	Be	Added	To	This	Account	box,
highlight	the	segments	to	include	in	the	account	structure,	in	the
order	you	want	them	to	appear,	and	then	click	Include.

javascript:void(0);


6.	 Click	Add.

After	adding	account	structure	codes

Related	Topics
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Deleting	Account	Structure	Codes
You	can	delete	an	account	structure	only	if	no	account	uses	it.

Before	you	start

To	delete	an	account	structure	code:
1.	 Open	General	Ledger	>	G/L	Setup	>		Account	Structures.
2.	 Use	the	navigation	buttons	or	the	Finder	for	the	Structure	Code	field

to	display	the	structure	code	you	want	to	delete.
3.	 Click	Delete.

Related	Topics
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Source	Codes
Set	up	source	codes	that	identify	the	source	(or	type)	of	transaction
details	in	General	Ledger.

About	Source	Codes

Adding	Source	Codes

Deleting	Source	Codes
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About	Source	Codes
Source	codes	are	used	in	General	Ledger	to	identify	the	source	(or	type)
of	transaction	details.	You	can	print	source	journals	that	include	all
transactions	with	particular	source	codes.

You	define	source	codes	before	you	enter	and	post	accounting
transactions.

Note:	General	Ledger	comes	with	a	set	of	source	codes	already
defined.	You	can	view	the	predefined	source	codes	by	clicking	the
Finder	in	the	Source	Code	field	in	the	Source	Codes	screen.

Important!	When	you	post	a	transaction,	the	G/L	journal	entry	that	is
created	includes	the	description	specified	for	the	source	code.	For	this
reason,	before	you	assign	a	source	code	to	a	subledger	transaction
type,	you	should	make	sure	that	the	source	code	description	correctly
describes	the	transaction	type.

All	transactions	entered	in	General	Ledger	must	use	a	source	code	that
begins	with	"GL"	to	identify	the	transaction	with	the	General	Ledger
program.

General	Ledger	automatically	adds	new	source	codes	found	in	subledger
transactions	during	posting.

Note:	When	you	activate	Project	and	Job	Costing,	the	system	creates
default	source	codes	in	General	Ledger.	When	you	save	changes	to	the
codes	in	Project	and	Job	Costing,	the	changes	are	also	effected	in
General	Ledger.

Imported	transactions	must	also	contain	source	codes.	You	can	define	or
import	the	source	codes	you	want	to	use	in	imported	transactions	using
the	G/L	Source	Codes	screen.



Using	Source	Codes	for	Reporting
Source	codes	allow	you	to	organize	and	print	source	journals	of	posted
transactions	according	to	transaction	type	(for	example,	sales,	checks,	or
cash	receipts).

Use	source	journals	to	group	transactions	for	analysis	and	auditing
requirements.	Batch	listings	and	posting	journals	group	transactions	only
by	time	of	entry.

Related	Topics
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Adding	Source	Codes
Source	codes	are	used	in	General	Ledger	to	identify	the	source	(or	type)
of	transaction	details.	You	can	print	source	journals	that	include	all
transactions	with	particular	source	codes.

You	define	source	codes	before	you	enter	and	post	accounting
transactions.

Before	you	start

To	add	source	codes:
1.	 Open	General	Ledger	>	G/L	Setup	>		Source	Codes.
2.	 Click	the	New	 	icon	for	the	Source	Code	field,	and	then	type	a	four-

character	source	code.

Note:	The	first	two	characters	of	the	code	must	identify	the	source
ledger	(such	as	GL	or	AR).	The	second	two	characters	identify	the
transaction	type.

3.	 Enter	a	description	for	the	code.
4.	 Click	Add.

After	adding	source	codes

Related	Topics
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Deleting	Source	Codes
Before	you	start

To	delete	a	source	code:
1.	 Open	General	Ledger	>	G/L	Setup	>		Source	Codes.
2.	 Use	the	Finder	or	the	navigation	buttons	for	the	Source	Code	field	to

display	the	source	code	you	want	to	delete.
3.	 Press	the	Delete	key.
4.	 Click	Yes	to	confirm	your	choice	when	prompted.

After	deleting	source	codes

Related	Topics
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Source	Journal	Profiles
You	can	define	an	unlimited	number	of	reports,	called	source	journals,
that	you	can	use	to	meet	a	variety	of	transaction	reporting	requirements.

About	Source	Journals

Adding	Source	Journal	Profiles
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About	Source	Journals
You	can	define	an	unlimited	number	of	reports,	called	source	journals,
that	you	can	use	to	meet	a	variety	of	transaction	reporting	requirements.

Source	journals	list	posted	batch	entries	by	their	source	codes.	Typical
source	journals	are	a	cash	receipts	journal,	a	cash	disbursements
journal,	and	a	check	register.	You	construct	the	source	journals	by
entering	a	list	of	source	codes	to	be	included	in	each	source	journal.

You	can	select	transactions	within	the	predefined	source	journals	by
account	number,	segment,	account	group,	fiscal	period,	reference,	date,
batch	number,	and	posting	sequence	number.

You	can	also	include	transaction	optional	fields,	account	optional	fields,
select	account	groups	by	sort	code	range,	and	use	rolled	up	amounts.

In	a	multicurrency	system,	you	can	also	select	and	report	source	journal
transactions	by	their	source	currency.

Other	examples	of	source	journals	you	can	print	include:

All	details	that	have	the	same	source	code,	such	as	all	credit	card
payments,	all	credit	memos,	and	all	checks.
All	details	entered	on	a	particular	day	(specifying	all	source	codes	for
a	single	date).
All	details	entered	in	a	particular	batch.
All	details	that	contain	a	common	reference.
All	details	posted	to	a	division,	department,	or	any	accounting	entity
associated	with	a	segment.
You	can	include	Transaction	Optional	Fields	data	with	any	of	the
journals.

Note:	You	do	not	have	to	define	source	journals.



Changing	the	Standard	Source	Journal	Reports
If	you	want	to	change	the	information	in	a	report,	or	the	order	that	the
report	is	sorted	(beyond	the	choices	provided	by	the	G/L	program),	you
can	define	a	new	report,	or	modify	an	existing	report.	General	Ledger
report	definitions	are	found	in	the	ENG	subdirectory	of	the	program
directory.	The	program	directory	is	in	the	installation	folder	under	GLxxx,
where	xxx	is	the	version	number	of	the	General	Ledger	program.

Related	Topics
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Adding	Source	Journal	Profiles
You	can	define	an	unlimited	number	of	source	journals	to	meet	a	variety
of	transaction	reporting	requirements.	More...

Before	you	start

To	add	source	journal	profiles:
1.	 Open	General	Ledger	>	G/L	Setup	>		Source	Journal	Profiles.
2.	 Click	the	New	button	for	the	Profile	field,	and	then	type	the	title	to

use	for	this	journal	in	the	field.	(You	can	change	the	title	at	any	time.)

3.	 In	the	table,	in	the	Source	Codes	field,	type	the	source	codes	for	the
transactions	that	you	want	included	in	the	source	journal,	or	select
the	codes	using	the	Finder.

You	can	include	up	to	50	source	codes	in	the	definition	for	a	single
journal.

3.	 Press	the	Insert	key	to	start	a	line	for	a	new	source	code.

After	adding	source	journals

Related	Topics
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Account	Groups
Add	and	set	up	account	groups	to	classify	account	balances,	and	to
support	reports	such	as	income	statements	and	balance	sheets.

About	Account	Groups

Setting	Up	General	Ledger	to	Use	Account	Groups

Adding	Account	Groups

Changing	Sort	Codes
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About	Account	Groups
Sage	300	ERP	uses	account	groups	to	classify	account	balances:

On	the	financial	statements	that	come	with	Financial	Reporter.

The	sample	statements	are	designed	for	Sage	300	ERP	sample
data,	and	retrieve	data	using	standard	account	groups.

To	use	the	statements	with	your	own	data,	you	must	either:

Assign	the	same	standard	account	groups	to	your	accounts.
Customize	the	sample	statements	to	match	the	account	groups	that
you	have	set	up	for	your	company.

In	the	Income	Statement	and	Balance	Sheet	snapshots	that	you	view
in	the	Sage	300	ERP	portal.

These	snapshots	retrieve	data	from	a	set	of	group	categories	that	are
linked	to	general	ledger	accounts	through	the	standard	account
groups.

If	you	plan	to	use	the	Income	Statement	and	Balance	Sheet
snapshots,	note	that	before	you	configure	the	snapshots,	you	must:

Assign	all	account	groups	to	appropriate	categories	from	the
standard	set	of	group	categories	that	comes	with	General	Ledger.
You	can	assign	any	number	of	account	groups	to	the	same
category.
Assign	all	general	ledger	accounts	to	appropriate	account	groups.

Otherwise,	the	snapshots	may	display	incorrect	information,	or	no
information.

Customizing	Account	Groups
You	can	use	account	groups	whether	or	not	you	also	use	Financial
Reporter's	standard	financial	statements	or	data	snapshots.

If	you	do	not	plan	to	use	the	General	Ledger	snapshots	or	the	standard
reports	that	come	with	Financial	Reporter,	you	can	add	any	new	account
groups	that	you	need,	or	delete	any	account	groups	that	you	do	not	need.



You	can	reassign	account	groups	to	different	group	categories.	However,
we	recommend	that	you	consider	such	reassignment	very	carefully.

Note:	You	cannot	change	the	standard	set	of	account	categories	or	the
sort	codes	that	come	with	General	Ledger.

Note	the	following	additional	characteristics	of	account	groups:

You	can	change	the	descriptions	for	the	account	groups	to	suit	your
business	needs.
One	account	group	can	be	used	by	many	accounts.
One	sort	code	can	be	used	by	many	account	groups.
The	system	assigns	the	Unclassified	account	group	to	accounts	that
use	a	blank	account	group	code.

Related	Topics
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Setting	Up	General	Ledger	to	Use	Account
Groups
Sage	300	ERP	uses	account	groups	to	classify	account	balances:

On	the	financial	statements	that	come	with	Financial	Reporter.
In	the	Income	Statement	and	Balance	Sheet	snapshots	that	you	view
in	the	Sage	300	ERP	portal.

For	more	information	about	group	categories,	see	About	Account
Groups.

To	set	up	General	Ledger	to	use	account	groups:
1.	 Select	the	option	to	use	account	groups	in	General	Ledger.	More...

2.	 If	you	plan	to	use	the	Income	Statement	or	Balance	Sheet	snapshots,
ensure	that	group	categories	are	assigned	to	all	account	groups.
More...

3.	 Assign	each	General	Ledger	account	to	an	account	group.	More...

Related	Topics

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:mc25.Click()


Home	>	Setting	Up	General	Ledger	>	Account	Groups	>	Adding	Account	Groups



Adding	Account	Groups
If	you	use	account	groups	in	General	Ledger,	you	must	assign	every
account	to	a	group.

Note:	The	system	assigns	the	Unclassified	account	group	to	accounts
that	use	a	blank	account	group	code.

To	add	your	own	account	groups:
1.	 Open	General	Ledger	>	G/L	Setup	>		Account	Structures.
2.	 In	the	Account	Group	field,	enter	up	to	12	characters	to	define	the

account	group	code.

The	code	can	consist	of	alphabetical	or	numerical	characters,	or	a
combination	of	both.

The	standard	account	groups	are	numbered	01	to	26.	You	can
continue	the	sequence,	or	create	a	different	set	of	codes.

3.	 In	the	Description	field,	type	a	description	for	the	new	group.
4.	 In	the	Group	Category	field,	select	the	category	to	use	to	classify

this	group	of	accounts	in	data	snapshots.
5.	 Click	Add.

Related	Topics
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Changing	Sort	Codes
You	can	change	the	order	in	which	accounts	appear	on	reports,	and	you
can	insert	new	account	groups	within	an	existing	sort	order.

You	change	sort	codes	only	in	the	Change	Sort	Codes	screen.

To	change	the	sort	code	for	account	groups:
1.	 Open	General	Ledger	>	G/L	Setup	>		Account	Groups.
2.	 Click	the	Change	Sort	Codes	button	to	display	the	Change	Sort

Codes	screen.
3.	 Double-click	in	the	New	Sort	Code	column	for	the	account	group	you

are	changing.
4.	 Change	the	code,	then	tab	out	of	the	column.

The	account	group	moves	to	its	new	position	in	the	list.

5.	 Assign	the	same	sort	code	to	the	other	account	groups	in	the	set.
6.	 Click	the	Process	button	to	save	your	changes.

Related	Topics
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Revaluation	Codes
Revaluation	codes	store	information	for	General	Ledger	to	use	when	you
revalue	multicurrency	accounts	due	to	changes	in	exchange	rates.
Revaluation	codes	determine	the	currency	table	(set	up	in	the	Currency
forms	in	Common	Services)	to	use	for	revaluation,	and	include	the	rate
type,	source	code,	and	exchange	gain	and	exchange	loss	accounts	to
use	for	revaluing	different	currencies.

Adding	Revaluation	Codes

Deleting	Revaluation	Codes
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Adding	Revaluation	Codes
Use	the	G/L	Revaluation	Codes	screen	to	set	up	revaluation	codes.	You
assign	these	codes	to	multicurrency	accounts	to	specify	how	to	revalue
functional	currency	balances	when	exchange	rates	change.

Before	you	start

To	add	revaluation	codes:
1.	 Open	General	Ledger	>	G/L	Setup	>		Revaluation	Codes.
2.	 Click	the	New	button	for	the	Revaluation	Code	field,	and	then	type

the	new	revaluation	code.	You	can	use	up	to	six	characters	(letters
and	numbers)	for	the	code.

You	can	also	just	type	the	code	and	press	the	Tab	key.

3.	 In	the	Description	field,	enter	a	short	description	of	the	code,	using
up	to	60	characters.

4.	 In	the	Rate	Type	field,	select	a	rate	type	that	has	been	defined	for
currencies	in	Common	Services.

The	rate	type	determines	which	exchange	rate	table	will	be	used	for
revaluations.

5.	 In	the	Source	Code	field,	specify	the	source	code	to	assign	to	all
transactions	created	with	this	revaluation	code.

6.	 Enter	or	select	the	accounts	to	which	to	post	exchange	gains	and
losses.

Note:	The	labels	for	the	exchange	gain	and	loss	fields	will	be	either
Unrealized	or	Recognized,	depending	on	the	Gain/Loss	Accounting
Method	option	selected	in	the	Company	Profile.

Important!	You	cannot	specify	an	account	to	which	posting	is
prohibited.

7.	 Click	Add.
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After	adding	revaluation	codes

Related	Topics
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Deleting	Revaluation	Codes
Before	you	start

To	delete	a	revaluation	code:
1.	 Open	General	Ledger	>	G/L	Setup	>		Revaluation	Codes.
2.	 In	the	Revaluation	Code	field,	use	the	Finder	or	the	navigation

buttons	to	display	the	revaluation	code	you	want	to	delete.
3.	 Click	Delete.
4.	 At	the	Confirmation	message	that	appears,	click	Yes.
5.	 Select	another	code	for	deletion,	or	click	Close.

After	deleting	revaluation	codes

Related	Topics
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Optional	Fields
If	you	use	Transaction	Analysis	and	Optional	Field	Creator,	set	up
optional	fields	that	you	can	use	to	store	additional	information	with
General	Ledger	records	and	transactions.

About	Optional	Fields	in	G/L

Value	Set	and	Auto	Insert	Values
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About	Optional	Fields	in	General	Ledger

Note:	You	can	set	up	and	use	optional	fields	only	if	Transaction
Analysis	and	Optional	Field	Creator	is	installed.

In	General	Ledger,	you	can	assign	an	unlimited	number	of	optional	fields
to	an	account	to	store	additional	information	that	your	company	wants	to
track	for	the	account.

Account	Optional	Fields.	Account	optional	fields	provide	a
convenient	means	to	customize	your	General	Ledger	system	by
letting	you	store	an	unlimited	number	of	additional	pieces	of
information	with	account	records.

Transaction	Optional	Fields.	General	Ledger	also	retains	optional
field	information	for	transactions	(including	those	created	in	other
Sage	300	ERP	modules	and	sent	to	General	Ledger)	if	the	optional
fields	used	in	the	transaction	details	match	those	used	in	General
Ledger.	More...

In	General	Ledger,	setting	up	optional	fields	is	a	three-step	process.	You
must:

1.	 Set	up	system-wide	optional	fields	in	Common	Services.	More...

2.	 Set	up	optional	fields	for	use	with	General	Ledger	accounts	and
transactions.	More...

3.	 Assign	both	types	of	optional	fields	to	specific	accounts	using	the
Accounts	screen.
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Setting	Up	Optional	Fields	for	Use	in	General
Ledger
You	can	set	up	an	unlimited	number	of	optional	fields	for	General	Ledger,
provided	they	are	first	set	up	in	Common	Services	for	system-wide	use.

After	you	set	up	optional	fields	for	your	Sage	300	ERP	system,	you	use
the	G/L	Optional	Fields	screen	to	define	the	optional	fields	you	will	use	to
customize	your	chart	of	accounts	and	to	store	additional	information	with
general	ledger	transaction	details.	(See	G/L	Optional	Fields	Screen

Note:	If	the	G/L	Optional	Fields	screen	is	open,	other	users	cannot	run
any	processes	in	General	Ledger.	Also,	you	can	modify	optional	field
records	only	when	all	other	users	have	left	General	Ledger,	and	all
other	General	Ledger	screens	are	closed.



Assigning	Optional	Fields	to	Accounts
When	you	have	defined	optional	fields	for	use	in	General	Ledger,	you	can
assign	the	optional	fields	to	particular	accounts.

You	use	the	Optional	Fields	tab	on	the	Accounts	screen	to	assign
optional	account	fields.	You	can	include	optional	account	fields	on
your	printed	chart	of	accounts,	and	when	you	print	the	Chart	of
Accounts	Detail	-	Long	Form	report,	you	can	choose	whether	to
include	the	optional	account	and	transaction	details	fields	(and	their
values)	that	are	defined	for	each	account.	You	can	also	use	optional
account	fields	as	selection	criteria	when	printing	other	types	of
reports.
You	use	the	Transaction	Details	Optional	Fields	tab	on	the	Accounts
screen	to	assign	optional	transaction	fields.	If	an	account	to	which
you	have	assigned	optional	transaction	fields	is	used	in	a	transaction
detail,	you	can	edit	the	optional	field	information	for	the	detail.
Create	Accounts.	The	Create	Accounts	Preview	screen	lets	you
specify	optional	field	information	for	the	accounts	you	are	creating.

The	program	assigns	to	the	new	accounts	the	optional	accounts
fields	and	optional	transaction	details	fields	set	for	the	"model"
accounts	using	the	segment	specified	in	the	Default	Options	From
field.

Note:	If	an	optional	field	has	been	set	up	as	a	required	field,	the
optional	field	must	be	entered	or	the	account	cannot	be	added	or	saved.



Including	Optional	Fields	in	G/L	Transactions
You	can	use	optional	fields	in	transaction	details	if	any	optional	fields	are
assigned	to	the	account	used	in	the	detail.	Note	the	particular	behavior	of
optional	fields	in	each	transaction	screen,	as	follows:

Journal	Entry.	The	Optional	Fields	check	box	on	the	Journal	Entry
detail	table	and	on	the	G/L	Journal	Detail	screen	shows	whether	a
detail	account	uses	optional	transaction	fields.

Note:

The	program	sets	this	optional	fields	indicator.	You	cannot	change
the	entry	in	the	check	box,	but	if	the	field	is	selected,	you	can	click
the	zoom	button	beside	the	check	box,	and	then	edit	or	delete
optional	fields	used	for	the	detail.	You	cannot	add	transaction
optional	fields	that	are	not	assigned	to	the	account.

Journal	Entry	accepts	optional	field	information	from	transactions
you	create	in	Sage	300	ERP	subledgers,	provided	they	match	the
transaction	optional	fields	specified	for	the	account.	(The
information	is	transferred	to	General	Ledger	when	you	create	a
batch	of	general	ledger	transactions	in	a	subledger.)

When	you	post	the	journal	entry,	the	program	saves	the	optional	field
information.	(Note	that	the	Post	To	Account	option	for	the	account
must	be	set	to	Detail	to	save	the	optional	field	information.)

Create	Allocation	Batch.	The	Optional	Fields	check	box	on	this
screen	indicates	whether	your	accounts	use	one	or	more	optional
transaction	fields,	and	whether	they	are	set	up	for	automatic	insertion
in	transactions.

Note:

You	cannot	change	the	entry	in	the	check	box,	but	if	the	field	is
selected,	you	can	edit	or	delete	the	optional	fields	used	with	the
transaction.	You	can	also	add	any	optional	fields	that	are	defined	for



transaction	details	on	the	G/L	Optional	Fields	screen.

The	fields	you	specify	are	used	for	all	the	accounts	included	in	the
allocation.

When	you	process	the	allocation,	if	the	specified	optional	fields
match	the	transaction	optional	fields	defined	for	the	accounts	used	in
the	allocation,	the	optional	field	information	is	included	in	the	journal
entry	for	the	accounts.

Create	Revaluation	Batch.	The	Optional	Fields	column	on	this
screen	indicates	whether	optional	transaction	details	fields	have	been
defined	for	the	exchange	gain	account	or	the	exchange	loss	account
for	a	selected	revaluation	code.	If	at	least	one	optional	transaction
field	is	defined,	you	can	add	or	delete	optional	fields	for	a	revaluation
batch.

Note:	You	can	add	only	optional	transaction	fields	that	are	defined
for	the	exchange	gain	and	exchange	loss	accounts	assigned	to	the
revaluation	code.

Optional	field	information	specified	for	the	revaluation	is	included	in
the	journal	entry	details	generated	for	an	account	only	if	the	optional
fields	in	the	revaluation	match	the	optional	transaction	fields	defined
for	the	exchange	gain	or	exchange	loss	accounts.

Recurring	Entries	(Setup	screen).	The	Optional	Fields	check	box
on	this	screen	indicates	whether	transaction	optional	fields	are
defined	for	the	account	used	in	a	recurring	entry	detail.	You	can	add
or	delete	optional	fields	for	the	recurring	entry.

Note:	You	can	add	only	transaction	optional	fields	that	are	defined
for	the	account.

Create	Recurring	Entries	Batch.	Recurring	entries	use	the	optional
transaction	details	fields	and	values	specified	for	the	recurring	entry
code.	You	can	edit	the	default	fields	and	values	in	Journal	Entry,	as
for	any	other	journal	entry.



Validating	Optional	Field	Values
The	program	displays	the	default	value	associated	with	each	optional
field	used.	You	can	accept	or	change	the	value,	as	you	require.

If	an	optional	field	is	validated,	you	must	specify	an	optional	field	value
that	has	been	defined	in	Common	Services.	If	the	Optional	Field	is
validated	and	allows	blanks,	you	can	also	leave	the	optional	field	value
blank.

If	the	optional	field	is	not	validated,	you	can	select	an	optional	field	value
that	has	been	defined	in	Common	Services,	or	can	enter	any	value
providing	you	do	not	exceed	the	length	specified	for	the	optional	field.



Deleting	Optional	Fields
You	can	delete	General	Ledger	optional	fields	only	if	they	are	not	used	by
any	accounts	or	in	any	unposted	transactions.

You	must	remove	the	optional	fields	from	the	accounts	and	transactions
where	they	are	used	before	you	can	delete	them	using	the	G/L	Optional
Fields	screen.
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Value	Set	and	Auto	Insert	Values
If	you	use	Transaction	Analysis	and	Optional	Field	Creator,	the	Value	Set
field	appears	on	screens	where	optional	fields	are	used,	and	indicates
whether	a	default	value	is	specified	for	a	selected	optional	field.

Select	this	option	if	the	optional	field	has	a	default	value.	If	the	optional
field	is	validated,	you	can	specify	only	values	that	are	specified	for	the
optional	field	in	Common	Services.

The	following	table	explains	the	relationship	between	the	Value	Set	and
Auto	Insert	fields.

Value	Set	and	Auto	Insert	Values
Value	Set
and	Auto
Insert
Values

Optional	Field	For:
Accounts

Optional	Field	For:
Transaction	Details

Value	Set	=
Yes

and

Auto	Insert	=
Yes

When	you	create	a	new
account,	the	optional	field
and	its	default	value
appear	on	the	Optional
Fields	tab	on	the	G/L
Accounts	screen.

When	you	create	a	new
account,	the	optional	field
and	its	default	value	appear
on	the	Trans.	Optional
Fields	tab	of	the	G/L
Accounts	screen.

Value	Set	=
Yes

and

Auto	Insert	=
No

If	you	add	or	save	an
account,	you	must	change
Auto	Insert	to	Yes.

When	you	create	a	new
account,	the	optional	field
will	not	appear	on	the
Trans.	Optional	Fields	tab	of
the	G/L	Accounts	screen.

If	you	manually	insert	this
optional	field	for	the	new
account,	the	value	you
defined	in	the	Default	Value
field	will	be	inserted.



Value	Set	=
No

Default	Value	is	blank. Default	Value	is	blank.

You	can	enter	the	optional
field	value	on	the	Trans.
Optional	Fields	tab	of	the
G/L	Accounts	screen,	or
directly	in	a	transaction.

Related	Topics
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Adding	and	Maintaining	Accounts
Use	General	Ledger	Accounts	screens	to	set	up	and	maintain	the
General	Ledger	accounts	that	make	up	your	chart	of	accounts.

About	Entering	Account	Balances,	Historical	Data,	and
Quantities

Adding	Account	Balances	and	Quantities	to	a	New	General
Ledger

Information	Stored	in	G/L	Accounts

Specifying	a	Currency

Adding	Accounts

Maintaining	Accounts

Budgets
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Data,	and	Quantities



About	Entering	Account	Balances,	Historical
Data,	and	Quantities
Before	you	can	use	General	Ledger,	you	must	at	least	enter	beginning
balances	for	the	current	fiscal	year.

If	you	intend	to	enter	period	data	for	previous	years,	do	so	first.	Entering
last	year’s	ending	balances	establishes	the	current	year’s	beginning
balances.

Warning!	Do	not	post	historical	data	if	you	have	already	entered
current‐year	opening	balances	and	transactions,	because	doing	so	will
overstate	account	balances.



Entering	Historical	Data
You	add	historical	data	if	you	want	to	do	previous-year	comparisons.	If
you	do	not	want	to	add	data	for	previous	years,	you	can	simply	enter
current-year	opening	balances.

Historical	amounts	include	the	opening	and	closing	balances	for	the
previous	years	and	the	net	changes	and	balances	for	each	fiscal	period
of	the	previous	years.	To	add	the	historical	amounts,	you	enter	and	post
the	historical	opening	balances	and	period	net	changes	as	journal	entries
using	the	General	Ledger	Journal	Entry	screen.

Note:	If	you	want	to	show	source-currency	balances	for	all	past	periods,
you	must	enter	transactions	in	each	of	the	originating	currencies,	along
with	the	exchange	rate	at	the	time,	and	the	functional-currency
equivalent	amount.

Modifying	Historical	Data
If	you	need	to	change	account	data	for	the	previous	year	after	you	have
created	your	chart	of	accounts,	you	should	enter	the	adjustments	in	a
batch,	and	then	post	the	batch	to	the	previous	year.



Entering	Current-Year	Opening	Balances	and
Year-To-Date	Transactions
When	you	set	up	a	General	Ledger	system	partway	through	a	fiscal	year,
you	must	enter	the	transaction	data	for	the	current	year	to	date,	in
addition	to	the	closing	balances	from	the	previous	year.

You	can:

Enter	all	the	current-year	transactions,	one	at	a	time,	period	by
period.

This	method	provides	a	complete	audit	trail	for	current-year
transactions.

Enter	all	the	transactions	for	the	current	period,	and	the	net	changes
for	the	earlier	periods	in	the	current	year.

This	method	provides	an	audit	trail	for	current-period	transactions,
and	creates	accurate	balances	for	previous	periods	in	the	current
year.	You	can	print	comparative	financial	statements	for	all	the
current-year	periods	to	date,	and	detailed	audit	trail	reports	for	the
current	period.

Enter	the	net	change	(net	increase	or	decrease)	for	each	account	in
each	period	to	date,	including	the	current	period.

This	method	produces	accurate	balances	for	each	account	in	each
period	of	the	current	year,	allowing	you	to	print	comparative	financial
statements.	However,	it	does	not	provide	transaction	detail	(such	as
date,	reference	code,	and	description)	for	the	audit	trail	reports.

Enter	the	net	change	between	the	opening	and	current	balances	for
each	account.

This	is	the	quickest	method,	but	it	does	not	let	you	print	financial
statements	for	past	periods	in	the	current	year	and	does	not	provide
transaction	detail	for	audit	trail	reports.	Using	this	method,	you	would
have	to	rely	on	your	manually	prepared	financial	statements	for
comparisons.



For	the	steps	involved	in	adding	historical	information	to	General	Ledger,
see	Adding	Account	Balances	and	Quantities	to	a	New	General	Ledger.

Related	Topics
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Adding	Account	Balances	and	Quantities	to	a
New	General	Ledger
Before	you	can	use	General	Ledger,	you	must	at	least	enter	beginning
balances	for	the	current	fiscal	year.

If	you	intend	to	enter	period	data	for	previous	years,	do	so	first.	Entering
last	year’s	ending	balances	establishes	the	current	year’s	beginning
balances.

Warning!	Do	not	post	historical	data	if	you	have	already	entered
current‐year	opening	balances	and	transactions,	because	doing	so	will
overstate	account	balances.

Before	you	start

To	add	existing	account	balances	and	quantity	data	to	a	new
general	ledger:
1.	 Start	Sage	300	ERP,	using	the	year-end	date	of	the	year	before	the

earliest	fiscal	year	for	which	you	want	to	post	transactions.

2.	 Create	and	post	closing	balances	to	the	year	before	the	first	full	year
for	which	you	want	account	data.	More...

3.	 Run	Create	New	Year	(in	the	G/L	Periodic	Processing	folder)	to
create	the	opening	balances	for	your	first	full	year	of	period	balances,
and	to	advance	the	current	year.	More...

4.	 Create	and	post	the	net	changes	for	each	successive	period	in	the
first	year	of	data,	then	close	the	year	by	running	Create	New	Year.
More...

Note:	Repeat	this	step	for	each	prior	year	of	data.

5.	 Print	balance	sheets	and	income	statements	for	all	past	years,	and
compare	them	to	your	existing	statements.

Note:	To	use	the	financial	statements	shipped	with	General	Ledger

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);


sample	data,	you	must	select	the	Use	Account	Groups	option	in	the
G/L	Options	screen,	and	assign	each	G/L	account	to	a	group	using
the	G/L	Accounts	screen.

After	adding	account	balances	and	quantities

Related	Topics
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Information	Stored	in	General	Ledger	Accounts
When	adding	an	account	in	General	Ledger,	you	specify	the	following
information:

Account	number
Account	description	(name	of	the	account)
Account	structure	(account	segments	used	in	the	account	number)
Account	status
Active	or	inactive
Account	type	(Balance	sheet,	income	statement,	or	retained
earnings)
Account	allocation	instructions	(if	you	want	to	reallocate	the	account
balance)
Currency	information	for	the	account	(in	multicurrency	ledgers)
Normal	type	of	account	balance	(debit	or	credit)
Whether	to	close	by	segment	code	(if	it	is	an	income	statement
account)
Whether	to	post	all	details	to	the	account	in	detail,	consolidate	them,
or	prohibit	them
Whether	the	account	is	a	control	account
Whether	to	maintain	quantity	information	for	the	account
Whether	the	account	is	a	rollup	account	or	a	member	of	a	rollup
account

For	more	information	about	these	options,	see	G/L	Accounts	Screen.

General	Ledger	also	stores	the	following	information	for	each	account:

Amounts	that	reflect	the	actual	monetary	transactions	of	the	company
Amounts	that	have	been	provisionally	posted	to	accounts
Optional	quantity	information,	such	as	number	of	units	sold	or
purchased	per	fiscal	period

Budget	information



Note:

The	number	of	years	of	data	you	can	maintain	depends	on	the
edition	of	Sage	300	ERP	you	use:

In	Sage	300	Premium	ERP,	you	can	maintain	99	years	of	data.
In	Sage	300	Advanced	ERP,	you	can	maintain	7	years	of	data.
In	Sage	300	Standard	ERP,	you	can	maintain	7	years	of	data.

Related	Topics
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Specifying	a	Currency
You	can	specify	which	currencies	are	valid	for	an	account.

Tip:	When	an	amount	is	posted	in	a	valid	source	currency,	the	system
creates	Source,	Functional,	and	Equivalent	fiscal	sets	to	store	original
and	converted	currency	amounts.	You	can	save	disk	space	by	reducing
the	number	of	valid	source	currencies	for	an	account.

Before	you	start

To	specify	a	valid	currency	for	an	account:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Accounts.
2.	 On	the	Currency	tab:

a.	 Specify	whether	to	allow	posting	from	all	currencies	defined	in
Common	Services,	or	only	specific	currencies.

b.	 Specify	the	default	currency	to	appear	during	transaction	entry.

3.	 Use	the	table	to	specify:

Each	of	the	currencies	in	which	you	want	to	enter	transactions	(if
you	chose	specified	currencies)

Which	currencies	you	want	to	revalue	automatically	for	the	account
(if	any).

Double-click	or	press	the	Spacebar	to	turn	on	Revaluation	for	a
particular	currency.

4.	 Click	Save.

Related	Topics
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Adding	Accounts
Add	accounts	to	record	information	for	different	transaction	types	in	your
general	ledger.

Adding	a	New	Account

Assigning	Optional	Fields	to	an	Account

About	Rollup	Accounts

Adding	a	Rollup	Account

Creating	Accounts	Automatically



Home	>	Adding	and	Maintaining	Accounts	>	Adding	Accounts	>	Adding	a	New	Account



Adding	a	New	Account
You	must	assign	an	account	structure	code	to	each	new	account.	The
account	structure	code	verifies	the	account	number	when	you	enter	it,
and	determines	how	the	number	is	displayed	in	windows	and	printed	on
reports.

You	set	up	segment	validation	rules	using	the	Segment	Codes	screen	in
the	G/L	Setup	folder.

Before	you	start

To	add	a	new	account	to	the	General	Ledger:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Accounts.
2.	 In	the	Account	field,	type	the	new	account	number,	and	then	press

the	Tab	key.

You	can	type	account	numbers	with	or	without	the	delimiter	character
used	to	separate	account	number	segments.

Tip:	If	you	add	another	account	immediately	after	finishing	these
steps,	click	the	New	icon	to	refresh	the	screen	so	that	you	can	enter
new	information.

3.	 Enter	a	description	for	the	account.
4.	 Fill	in	the	fields	on	the	Detail	tab,	as	follows:

a.	 If	you	have	more	than	one	segment	in	your	account	numbers,	use
the	Finder	for	the	Structure	Code	field	to	choose	the	account
structure	that	matches	the	segments	in	the	account	you	are	adding.

b.	 In	the	Normal	Balance	field,	specify	whether	this	account	normally
has	a	debit	or	a	credit	balance.

c.	 In	the	Account	Type	field,	select	Income	Statement,	Balance
Sheet,	or	Retained	Earnings	for	this	account.

d.	 If	you	use	account	groups,	use	the	Finder	for	the	Account	Group
field	to	select	the	account	group.

javascript:void(0);


e.	 In	the	Post	to	Account	field,	select	Detail,	Consolidated,	or
Prohibited.

Note:	You	cannot	post	to	a	prohibited	account.

5.	 Select	the	following	additional	options	on	the	Details	tab,	and	fill
corresponding	tabs,	as	needed:

a.	 If	you	want	to	allocate	balances	from	this	account	automatically,
select	the	Auto	Allocation	option,	and	then	fill	out	the	Allocation
tab	that	appears.

Important!	To	allocate	balances	by	quantity,	you	must	also	select
the	Maintain	Quantities	option	for	all	accounts	associated	with
the	account	allocation,	and	ensure	that	they	all	use	the	same	unit
of	measure.

b.	 If	this	is	a	control	account,	select	the	Control	Account	option.
Then,	on	the	Subledger	tab	that	appears,	specify	the	subledgers
that	use	the	account.

c.	 If	this	is	a	multicurrency	account,	select	the	Multicurrency	option.
Then,	on	the	Currency	tab	that	appears,	specify:

The	currencies	that	can	be	posted	to	the	account.
Whether	the	account	is	subject	to	revaluation.

d.	 To	designate	an	account	as	a	rollup	account,	select	the	Rollup
option.	Then	add	member	accounts	on	the	Rollup	tab	that	appears.
(For	more	information,	see	Adding	a	Rollup	Account.)

6.	 If	you	use	optional	fields:

Use	the	Optional	Fields	tab	to	specify	the	optional	fields	to	use	for
additional	information	you	want	to	store	with	the	account.
Use	the	Trans.	Optional	Fields	tab	to	specify	the	transaction
optional	fields	and	their	default	values	to	use	in	details	you	post	for
this	account.

7.	 When	you	have	finish	adding	required	information	on	all	the	tabs,
click	Add,	or	click	Save.



After	adding	a	new	account

Related	Topics
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an	Account



Assigning	Optional	Fields	to	an	Account

Note:	You	can	set	up	and	use	optional	fields	only	if	Transaction
Analysis	and	Optional	Field	Creator	is	installed.

In	General	Ledger,	you	can	assign	an	unlimited	number	of	optional	fields
to	an	account	to	store	additional	information	that	your	company	wants	to
track	for	the	account.

Account	Optional	Fields.	Account	optional	fields	provide	a
convenient	means	to	customize	your	General	Ledger	system	by
letting	you	store	an	unlimited	number	of	additional	pieces	of
information	with	account	records.

Transaction	Optional	Fields.	General	Ledger	also	retains	optional
field	information	for	transactions	(including	those	created	in	other
Sage	300	ERP	modules	and	sent	to	General	Ledger)	if	the	optional
fields	used	in	the	transaction	details	match	those	used	in	General
Ledger.	More...

Before	you	start

To	assign	optional	fields	to	an	account:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Accounts.
2.	 Use	the	Optional	Fields	tab	to	add	optional	fields	to	store	custom

information	for	the	account,	as	follows:

a.	 In	the	Optional	Fields	column,	use	the	Finder	to	select	optional
account	fields	that	you	have	defined	using	the	G/L	Optional	Fields
setup	screen.	When	you	choose	an	optional	field,	the	program	fills
in	the	description	and	the	default	value	for	the	optional	field.

b.	 To	change	the	value	for	the	optional	field,	use	the	Finder	in	the
Value	column	to	select	a	different	value.	More....

3.	 Use	the	Trans.	Optional	Fields	tab	to	add	optional	fields	to	be	used	in
transaction	details	that	use	the	account.

To	use	the	same	optional	fields	for	transaction	details	as	you	use	for
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the	account,	click	the	Replace	Optional	Fields	button.	Providing	you
have	set	up	matching	optional	fields	for	accounts	and	transaction
details	in	G/L	Optional	Fields,	the	program	replaces	the	optional
fields	on	this	tab	with	optional	fields	that	match	those	used	on	the
Optional	Fields	tab.	(If	an	optional	account	field	has	no	matching
optional	transaction	field	in	G/L	Optional	Fields,	the	field	is	not	used
for	transaction	details.)

4.	 On	the	Detail	tab,	for	the	Post	To	Account	option,	select	Detail.

Important!	General	Ledger	does	not	keep	optional	field	information
for	consolidated	transactions.

After	assigning	optional	fields

Related	Topics
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About	Rollup	Accounts
A	rollup	account	lets	you	consolidate	or	"roll	up"	account	balances	and
quantities	(if	applicable)	to	provide	a	summary	balance,	and	it	can	be
used	for	classification,	budgeting,	and	reporting.

Rollup	is	multi-level.	Not	only	can	you	add	member	accounts	to	a	rollup
account,	you	can	add	member	accounts	to	an	accountʹs	member
accounts,	creating	a	tree	structure	on	the	Rollup	tab	in	the	account
record.	The	tree	shows	the	relationships	between	accounts.

To	hide	the	tree,	click	the	Hide	Tree	button.
To	view	the	tree,	click	the	Show	Tree	button.
You	can	double-click	an	account	number	in	the	tree	to	open	the	G/L
Rollup	Accounts	screen,	where	you	can	add	member	accounts	to	the
rollup	account.

You	can	also	open	the	G/L	Rollup	Accounts	screen	from	the	table	in	any
of	the	following	ways:

By	double-clicking	the	member	account.
By	highlighting	the	account,	and	then	clicking	the	Rollup	zoom
button.
By	highlighting	the	account,	and	then	pressing	Shift+F9.

Note:	An	account	cannot	be	a	rollup	member	of	itself.	If	an	account
exists	on	the	Rollup	tab,	you	cannot	add	it	again.

To	view	details	about	the	currency	of	a	multicurrency	member	account,
highlight	the	account	on	the	Rollup	tab,	and	then	click	the	Currency
button.

Note:	Member	accounts	of	a	rollup	account	cannot	be	multicurrency
unless	the	rollup	account	itself	is	also	multicurrency.	Multicurrency
transactions	of	rollup	member	accounts	must	be	rolled	up	properly	to
their	parent	rollup	accounts.	Therefore,	if	any	member	of	a	rollup
account	is	multicurrency,	the	parent	rollup	account	must	also	be



multicurrency.

Related	Topics
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Adding	a	Rollup	Account
A	rollup	account	lets	you	consolidate	or	"roll	up"	account	balances	and
quantities	(if	applicable)	to	provide	a	summary	balance,	and	it	can	be
used	for	classification,	budgeting,	and	reporting.

Before	you	start

To	select	member	accounts	for	a	rollup	account:

1.	 Open	General	Ledger	>	G/L	Accounts	>		Accounts.
2.	 Use	the	Finder	for	the	Account	field	to	select	the	account	you	are

designating	as	a	rollup	account.
3.	 On	the	Detail	tab,	select	the	Rollup	option.
4.	 On	the	Rollup	tab	that	appears,	add	member	accounts	in	one	of	the

following	ways:

To	add	individual	member	accounts,	click	the	first	blank	line	in	the
table,	then	use	the	Finder	in	the	Account	column	to	select	each
account	in	turn.

To	select	a	range	of	member	accounts,	click	the	zoom	 	button	for
the	Select	Member	Accounts	for	the	Rollup	Account	field,	and
then	use	the	G/L	Account	Selector	screen	that	appears	to	add
member	accounts.	More...

5.	 Click	Save.
The	new	member	accounts	now	appear	in	the	tree	as	well	as	in	the
table	on	the	Rollup	tab.

Tip:	To	hide	the	tree,	click	the	Hide	Tree	button.	To	view	it	again,
click	Show	Tree.
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Related	Topics
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Automatically



Creating	Accounts	Automatically
Before	you	start

To	create	accounts	automatically:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Create	Accounts.
2.	 Use	the	Finders	in	the	From	Accounts	With	Structure	Code	and

Create	Accounts	With	Structure	Code	fields	to	select	a	structure
code	on	which	to	base	the	model	accounts.

3.	 In	the	Select	Account	Range	area:
a.	 In	the	Select	By	field,	specify	Account	Number,	Account	Group,	or

Sort	Code-Account	Group
b.	 In	the	From	and	To	fields,	enter	the	ranges	for	that	selection.

4.	 Select	Default	Subledger	Details	and	Default	Currency	Details
options	(optional).

5.	 If	you	want	to	review	existing	accounts	along	with	the	accounts	to	be
added,	select	the	Include	Existing	Accounts	option.

6.	 Use	the	table	to	specify	the	segments	you	want	to	create.
7.	 Click	Preview.

The	program	displays	a	message	telling	you	how	many	preview
accounts	it	created.

Note:	If	your	existing	chart	of	accounts	contains	no	accounts	with
the	required	segments	in	the	specified	range,	the	program	does	not
create	any	new	accounts.

8.	 Click	Close	to	close	the	message.
9.	 Use	the	G/L	Create	Accounts	Preview	screen	to:

Change	the	accounts	before	you	add	them	permanently.	More...

Specify	optional	field	information	for	the	accounts	to	be	created.
More...
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10.	 To	print	the	preview	information,	click	Print.
On	the	Print	Create	Accounts	Preview	Information	screen	that
appears:

a.	 Choose	sorting	options	and	the	range	of	accounts	you	want	to
print.

b.	 Select	whether	you	want	to	print	subledger	or	currency	information.
c.	 Click	Print.
d.	 Click	Close	to	return	to	the	G/L	Create	Accounts	Preview	screen

11.	 When	you	have	finished	selecting	or	adjusting	the	accounts	you	want
to	create,	click	Close	to	return	to	the	G/L	Create	Accounts	screen.
In	the	G/L	Create	Accounts	screen,	all	the	fields	are	now	dimmed—
you	cannot	change	them.	However,	you	can	click	Preview	to	return
to	the	Preview	screen.

12.	 Click	Process	to	add	the	accounts	to	your	chart	of	accounts.
If	processing	is	successful,	the	program	creates	the	accounts,	and
then	displays	a	message	telling	you	processing	has	finished	and	the
number	of	new	accounts	that	were	created.

If	there	is	an	error	in	processing	the	accounts,	you	are	returned	to	the
G/L	Create	Accounts	screen,	but	all	fields	are	dimmed.	Click	Preview
to	view	and	remove	any	unsuitable	accounts,	or	click	Clear	to	abort
the	process.	(Some	accounts	may	have	been	added	to	your	Chart	of
Accounts.)

13.	 When	processing	is	successful,	click	Close	to	close	the	message.
A	message	asks	whether	you	want	to	clear	the	temporary	file.	You
must	clear	the	preview	accounts	before	you	can	create	another	set	of
accounts.	If	you	click	No,	you	are	returned	to	the	G/L	Create
Accounts	screen,	but	(as	before)	all	the	fields	are	dimmed.

14.	 Click	Clear	to	delete	the	temporary	file	so	that	you	can	create	a
different	set	of	accounts	in	the	future.

After	creating	accounts	automatically
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Related	Topics
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Maintaining	Accounts
Set	up	account	permissions,	specify	closing	accounts,	define
reallocations,	and	perform	other	tasks	to	maintain	and	modify	accounts	in
General	Ledger.

Changing	Account	Information

Closing	Accounts	to	Specific	Segments

Defining	Account	Reallocations

Deleting	an	Account

Deleting	Member	Accounts	from	a	Rollup	Account

Setting	Account	Permissions



Home	>	Adding	and	Maintaining	Accounts	>	Maintaining	Accounts	>	Changing	Account
Information



Changing	Account	Information
Use	the	G/L	Accounts	screen	to	update	information	for	an	existing
account.

Note:	You	cannot	turn	off	the	Multicurrency	option	or	the	Maintain
Quantity	option	for	an	account	after	you	turn	them	on.

Before	you	start

To	update	an	account	record:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Accounts.
2.	 In	the	Account	field,	type	the	account	number,	and	then	press	the

Tab	key.
3.	 Update	the	tabs	in	the	account	record,	as	needed.	More...
4.	 When	you	have	finished	updating	the	account,	click	Save.

Related	Topics
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Closing	Accounts	to	Specific	Segments
A	closing	account	is	a	retained	earnings	account	to	which	you	post	the
difference	between	the	sums	of	revenue	and	expense	account	balances
when	you	close	these	accounts	at	year	end.

You	can	specify	separate	closing	accounts	for	different	divisions	or
departments	of	your	company	using	the	Segment	Codes	screen.	For
example,	if	one	segment	of	your	account	numbers	represents	company
divisions,	you	can	close	revenue	and	expense	accounts	to	retained
earnings	accounts	by	division.

Before	you	start

To	close	accounts	to	a	specific	segment:
1.	 Open	General	Ledger	>	G/L	Setup	>	Options.
2.	 On	the	Segments	tab,	in	the	Use	in	Closing	column,	mark	the

segment	as	a	closing	segment.
3.	 Click	Save,	and	then	click	Close.
4.	 Open	General	Ledger	>	G/L	Setup	>	Segment	Codes.
5.	 In	the	Segment	Name	field,	select	the	segment	you	marked	as	a

closing	segment.
6.	 In	the	table	on	the	G/L	Segment	Codes	screen,	enter	all	the	codes

that	can	be	used	for	the	segment,	specifying	the	retained	earnings
account	to	which	each	segment	closes.

7.	 Click	Save,	and	then	click	Close.
8.	 Open	General	Ledger	>	G/L	Accounts	>	Accounts.
9.	 For	each	revenue	and	expense	account	that	includes	the	segment	in

the	account	number,	in	the	Close	to	Segment	field,	select	the
closing	segment.

Note:	Any	accounts	for	which	you	do	not	specify	a	segment	will
close	to	the	default	closing	account,	which	is	defined	on	the
Account	tab	of	the	G/L	Options	screen.

javascript:void(0);


10.	 Click	Save,	and	then	click	Close.

Related	Topics
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Reallocations



Defining	Account	Reallocations
General	Ledger	lets	you	allocate	the	balance	of	an	account	periodically	to
other	accounts,	for	example,	to	allocate	income	and	expense	account
balances	from	head‐office	accounts	to	department	accounts,	or	to
allocate	profits	to	partners.

To	define	account	reallocations:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Accounts.
2.	 In	the	Account	field,	select	the	account	from	which	you	want	to

allocate	amounts	automatically.

3.	 On	the	Detail	tab,	select	Auto	Allocation,	if	it	is	not	already	selected.
When	you	select	the	allocation	option,	the	Allocation	tab	becomes
available.

4.	 On	the	Allocation	tab,	enter	reallocation	details	as	follows:

a.	 In	the	Source	Code	field,	select	the	source	code	to	use	for	the
allocation	transactions.

b.	 In	the	Allocate	By	field,	specify	whether	to	reallocate	amounts
based	on	the	account	balance	or	on	the	account	quantities.	More...

Account	Balance.	This	selection	distributes	the	balance	in	the
account	to	the	target	accounts	based	on	the	percentages	that	you
specify	on	the	Allocation	tab.	(For	example,	you	could	distribute
25%	of	the	balance	to	each	of	four	accounts.)	This	choice
distributes	balances	only,	and	does	not	distribute	quantities.

Account	Quantities.	This	selection	distributes	the	net	quantity	in
an	account	to	the	target	accounts	according	to	the	percentages
that	you	specify.	It	then	distributes	the	account	balance	to	the
target	accounts	based	on	the	quantities	that	were	distributed.

Important!	All	accounts	must	maintain	quantities,	and	they
must	use	the	same	unit	of	measure.

c.	 List	the	accounts	to	which	you	are	allocating	balances,	together



with	the	reference,	description,	and	percent	of	the	account	balance
or	quantity	that	you	want	to	assign	to	each	transaction	detail.

Note:	The	total	percent	allocated	must	be	100%.

5.	 When	you	have	finished	defining	the	reallocations,	click	Save.

Related	Topics

javascript:mc42.Click()


Home	>	Adding	and	Maintaining	Accounts	>	Maintaining	Accounts	>	Deleting	an	Account



Deleting	an	Account
You	cannot	delete	a	General	Ledger	account	unless:

The	current-year	opening	and	current	balance	for	the	Actual	fiscal	set
of	the	account	are	both	zero.
No	transactions	have	been	posted	to	the	Actual	fiscal	set	of	the
account	in	the	current	year.
The	account	is	not	assigned	as	the	Default	Closing	Account	(on	the
G/L	Options	screen.)

These	restrictions	preserve	the	integrity	of	your	data,	and	preserve	the
audit	trail.

You	can	delete	an	account	with	quantities	in	the	Quantity	fiscal	set	and
with	amounts	in	any	of	the	budget	fiscal	sets.

Before	you	start

To	delete	an	account:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Accounts.
2.	 In	the	Account	field,	type	the	account	number,	and	then	press	the

Tab	key.

Tip:	You	can	type	account	numbers	with	or	without	the	delimiter
character	used	to	separate	account	number	segments.

3.	 Click	Delete.
4.	 When	prompted	to	confirm	that	you	want	to	delete	the	account,	click

Yes.

Related	Topics
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Accounts	from	a	Rollup	Account



Deleting	Member	Accounts	from	a	Rollup
Account

To	delete	a	member	account	from	a	rollup	account:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Accounts.
2.	 Use	the	Finder	for	the	Account	field	to	select	the	rollup	account.
3.	 To	delete	individual	members,	highlight	the	account	in	the	table.
4.	 Press	the	Delete	key	on	your	keyboard.

Warning!	Do	not	click	the	Delete	button,	or	you	will	delete	the	rollup
account	with	all	its	members.
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Setting	Account	Permissions

Important!	G/L	Account	Permissions	is	part	of	G/L	Security,	an	option
that	you	select	on	the	Account	tab	of	the	G/L	Options	screen.	The	G/L
Account	Permissions	icon	appears	in	the	G/L	Accounts	folder	only	after
you	select	the	Use	G/L	Security	option,	and	then	close	and	reopen	the
company	database.

You	assign	permissions	to	accounts	and	segments	depending	on	the
default	access	set	on	the	G/L	Options	screen.	If	default	account	access
is:

All	Accounts,	you	need	to	restrict	specific	Sage	300	ERP	users	in	the
G/L	Account	Permissions	screen.

No	Accounts,	you	need	to	grant	individual	access	rights	to	accounts
in	the	G/L	Account	Permissions	screen.	Without	specific	permission,
Sage	300	ERP	users	cannot	post	transactions	to	accounts.

Before	you	start

To	set	account	permissions:

1.	 Open	General	Ledger	>	G/L	Accounts	>		Account	Permissions..
2.	 In	the	User	ID	field,	select	the	user	for	which	you	want	to	set

permissions:

Tips:

If	you	have	already	added	user	IDs	to	G/L	Security,	you	can
browse	through	the	list	of	user	IDs	using	the	navigation	buttons,	or
use	the	Finder	to	select	a	user	ID.
If	you	have	not	added	the	user	ID	for	which	you	want	to	set
permissions,	click	the	Zoom	 	button	for	the	User	ID	field	to
display	all	Sage	300	ERP	user	IDs,	and	then	use	the	Finder	to
select	the	ID	you	need.
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3.	 Use	the	Segment	tab	to	allow	or	deny	user	access	to	ranges	of
account	segments—for	example,	to	restrict	access	to	a	particular
department.	More...

4.	 Use	the	Account	tab	to	allow	or	deny	user	access	to	ranges	of
account	numbers—for	example,	to	allow	access	to	accounts
receivable	sales	accounts.	More...

5.	 Click	the	Test	button	to	test	the	account	segments	you	have
specified.

The	G/L	Permissions	Finder	lists	only	the	accounts	this	user	has
permission	to	see	and	work	with.

After	setting	account	permissions

Related	Topics
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Budgets
Create	and	set	up	budgets	for	your	General	Ledger	accounts.

About	Budgets

About	Fiscal	Sets

Types	of	Fiscal	Sets

Budget	Methods

Editing	Budget	Data
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About	Budgets
You	use	the	Budget	Maintenance	screen	to	enter	budgets	for	your
accounts	for	any	year	defined	in	the	fiscal	calendar.

You	can	maintain	up	between	one	and	five	budget	sets	for	each	account,
depending	on	your	edition	of	Sage	300	ERP.	If	you	are	using	Sage	300
Premium	ERP,	you	can	create	up	to	five	optional	budgets	for	an	account.

Note:	You	cannot	add,	change,	or	delete	information	contained	in	a
locked	budget	set.	(The	Posting	tab	on	the	G/L	Options	screen	tells	you
which	budget	sets,	if	any,	are	locked.)

You	decide	the	type	of	information	each	budget	contains.	For	example,
you	might	set	up	an	original	budget,	an	adjusted	budget,	and	a	forecast.

Tip:	If	you	create	roll-up	budgets,	use	a	separate	budget	set.

The	Budget	Maintenance	screen	provides	calculation	methods	and	tools
to	help	you	create	budgets.	You	can:

Type	the	budget	amounts	in	the	Budget	Amount	column	for	each
period.
Let	the	system	calculate	budget	amounts	based	on	specified
amounts	and	percentages	using	any	combination	of	budget	methods.
(For	information	about	specific	budget	methods,	see	Budget
Methods.)
Use	the	Fiscal	Set	Lookup	feature	to	display	actual	and	budget	sets
for	any	account	in	the	general	ledger,	and	then	use	one	of	the	Copy
methods	to	move	the	lookup	amount	into	your	new	budget.
Use	the	Import	and	Export	choices	on	the	File	menu	to	transfer
General	Ledger	accounts	and	budget	figures	to	and	from	non-Sage
300	ERP	programs.	For	example,	you	can	export	account	data	to	a
spreadsheet,	manipulate	it,	and	then	import	it	as	budget	data.

Note:	If	you	import	budget	information	into	General	Ledger	from	a
spreadsheet,	you	must	supply	the	account	number,	fiscal	set	and



year,	and	currency	code	and	type	in	the	file,	along	with	the	budget
amounts.

See	the	System	Manager	help	for	information	about	importing	budget
data.

Note:	You	must	enter	credit	amounts	as	negative	numbers.



Future	Year	Budgets
In	addition	to	current-year	budgets,	you	can	create	budgets	for	an
unlimited	number	of	future	years	if	you	are	using	Sage	300	Premium
ERP.

These	future	year	budgets	consume	disk	space,	so	you	should	add	them
only	when	necessary.

Note:	You	must	create	the	future	year	before	you	can	add	the	budgets.
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About	Fiscal	Sets
General	Ledger	stores	the	totals	of	all	transaction	amounts	for	each
account	in	records	called	fiscal	sets.	General	Ledger	automatically	adds
the	fiscal	sets	you	require	when	you	post	transactions	to	general	ledger
accounts,	create	new	fiscal	years,	set	up	budgets,	and	otherwise	create
account	data	for	current	and	previous	years.

A	fiscal	set	contains	the	following	data:

The	opening	balance	for	the	year,	an	adjustment	amount,	and	a
closing	entry.
The	net	changes	for	periods	1	through	15	for	the	year.
The	net	changes	resulting	from	adjustments	for	the	fiscal	year	end.
The	net	changes	resulting	from	transferring	income	and	expense
account	balances	to	retained	earnings	(closing	entries).

Note:	Each	fiscal	set	stores	12	or	13	periods	of	accounting	transaction
summary	data,	depending	upon	whether	the	ledger	uses	12	or	13
periods.	In	addition,	each	fiscal	set	has	an	adjustment	period	and	a
closing	period.



Types	of	Fiscal	Sets
Each	single‐currency	general	ledger	account	has	more	than	one	fiscal
set,	because	each	fiscal	set	stores	only	one	set	of	numbers	for	one	fiscal
year	and	an	account	can	have	different	types	of	fiscal	sets.

Example:

For	a	given	single‐currency	account,	in	addition	to	the	current	year’s
transactions,	you	can	maintain	the	following	information	in	your	General
Ledger:

Fiscal	sets	containing	an	account’s	history	for	two	years.
Quantities	for	the	account.
Two	sets	of	budget	amounts	for	the	account.

Two	years	of	historical	amounts	plus	the	current	year’s	amounts	make
up	three	actual	fiscal	sets.	Two	years	of	historical	quantities	plus	the
current	year’s	quantities	make	up	three	quantity	fiscal	sets.	The	two
budgets	make	up	two	budget	fiscal	sets.	You	have	a	total	of	eight	fiscal
sets	for	the	account.

Multicurrency	accounts	have	additional	fiscal	sets	that	hold	amounts
posted	to	the	account	in	each	source	currency	used	with	the	account.
Designating	an	account	as	a	multicurrency	account	causes	the	system	to
create	source‐currency	and	functional‐currency	equivalent	fiscal	sets	for
the	account	as	required.

If	you	selected	the	euro	as	your	functional	currency	and	specified	a
reporting	currency,	General	Ledger	maintains	a	fiscal	set	for	storing	the
reporting	currency	equivalent	of	each	period	to	let	you	display	balances
and	net	changes	in	the	reporting	currency.

For	a	quick	reference	to	the	types	of	fiscal	sets	and	their	codes,	see
Types	of	Fiscal	Sets.

Actual	Fiscal	Set



All	accounts	have	an	actual	fiscal	set.	The	amounts	stored	in	the	actual
fiscal	set	are	the	totals	of	all	transactions	posted	to	the	account.	Actual
fiscal	set	information	appears	on	General	Ledger	reports	such	as	the
Income	Statement	and	the	Balance	Sheet.	When	you	post	a	batch	of
transactions,	the	system	updates	the	actual	fiscal	sets.

Quantity	Fiscal	Set
If	you	want	to	store	quantity	data	with	general	ledger	accounts,	you	must
first	choose	the	option	to	maintain	quantities	on	the	G/L	Options	screen.
Then,	to	maintain	quantity	data	for	individual	accounts,	you	select	the
option	to	maintain	quantities	for	each	applicable	account.

You	enter	quantity	information	as	you	enter	monetary	amounts	in
transaction	batches.	Each	time	you	make	a	journal	entry	for	an	account
for	which	quantities	are	maintained,	General	Ledger	prompts	you	for	a
debit	or	credit	amount	and	a	quantity.	When	you	post	the	batch,	General
Ledger	updates	the	actual	and	the	quantity	fiscal	sets.

Budget	Fiscal	Sets
You	can	maintain	up	to	five	budget	fiscal	sets	(identified	by	the	numbers
1	through	5)	for	each	account.	You	decide	how	many	of	the	five	you	want
to	use	and	the	type	of	budget	information	you	want	to	keep	in	each.

Provisional	Fiscal	Set
The	provisional	fiscal	set	contains	amounts	that	have	been	provisionally
(temporarily)	posted	to	general	ledger	accounts.

Posting	and	Fiscal	Sets
General	Ledger	allows	you	to	post	amounts	temporarily	to	accounts	to
test	their	effects	on	financial	statements.	When	you	post	batches
provisionally,	General	Ledger	adds	the	transaction	amounts	to	the
provisional	fiscal	set	instead	of	to	the	actual	fiscal	set,	and	keeps	the
batches	available	for	further	editing	and	posting.

When	you	post	the	batch	permanently,	General	Ledger	removes	the
effects	of	provisional	posting.	You	can	print	financial	statements	that



include	provisional	amounts,	and	check	the	results	before	posting	the
transactions	permanently	to	ledger	accounts.	You	can	post	batches
provisionally	only	if	you	select	the	option	to	allow	provisional	posting.

Related	Topics
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Types	of	Fiscal	Sets
Each	account	has	many	fiscal	sets.

Each	single‐currency	general	ledger	account	has	more	than	one	fiscal
set,	because	each	fiscal	set	stores	only	one	set	of	numbers	for	one	fiscal
year	and	an	account	can	have	different	types	of	fiscal	sets.

Multicurrency	accounts	have	additional	fiscal	sets	that	hold	amounts
posted	to	the	account	in	each	source	currency	used	with	the	account.

Types	of	Fiscal	Sets
Code Description

A An	Actual	fiscal	set	stores	one	year	(12	or	13	periods	plus	a	14th
period	for	adjusting,	and	a	15th	period	for	closing	revenue	and
expense	accounts)	of	actual	monetary	data	for	one	general
ledger	account	in	home	currency.

R Reporting	currency	(only	available	if	you	selected	the	euro	as
your	functional	currency	and	specified	a	reporting	currency	in	the
Company	Profile	screen	in	Common	Services).

Q A	Quantity	fiscal	set	stores	quantity	information	related	to	the
actual	amounts.	If	you	use	quantities,	each	actual	fiscal	set	is
paired	with	a	quantity	fiscal	set.

P The	Provisional	fiscal	set	temporarily	stores	amounts	from
provisional	batch	postings.

PQ A	Provisional	Quantity	fiscal	set	stores	provisionally‐posted
quantities.

1 Budget	Fiscal	Set	1	stores	planning	information.	Depending	on
the	edition	of	Sage	300	ERP	you	are	using,	you	can	store	up	to
five	separate	budgets	in	sets	1	through	5.	You	might	want	to	use
budget	set	1	to	store	your	original	budgets.

2 Budget	Fiscal	Set	2.	You	might	want	to	use	this	budget	set	to



store	your	revised	budgets.

3 Budget	Fiscal	Set	3.	You	might	want	to	use	this	budget	set	to
store	forecasts.

4 Budget	Fiscal	Set	4.	You	might	want	to	store	budgeted	quantity
information	for	the	account.

5 Budget	Fiscal	Set	5.

Related	Topics
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Budget	Methods
On	the	G/L	Budget	Maintenance	screen,	you	select	a	budget	method	to
specify	budget	method	options	that	are	used	to	calculate	budget	period
amounts.	

For	more	information	about	using	this	screen,	see	G/L	Budget
Maintenance	Screen.

Budget	Methods
Option How	to	Use How	G/L	Calculates	Budget

Amounts

Base,
Amount
Increase

When	you	select	this	option,
the	Base	Amount	and
Amount	Increase	fields
appear.

In	the	Base	Amount
field,	enter	the	base
amount	you	want	to
begin	with	(that	is,	the
base	amount	you	want	to
use	to	calculate	the
budget	for	Period	1).
In	the	Amount	Increase
field,	enter	the	amount
by	which	the	base
amount	should	be
increased.

General	Ledger	uses	the	base
amount	you	specify	as	the
Period	1	Budget	Amount.

To	calculate	the	budget
amount	for	Period	2,
General	Ledger	adds	the
amount	increase	to	the
base	amount.
To	calculate	the	budget
amount	for	Period	3,
General	Ledger	adds	the
amount	increase	to	the
Period	2	amount.
General	Ledger	continues
to	calculate	budget
amounts	in	this	manner
until	all	periods	have	a
budget	amount.

Base,
Percent
Increase

When	you	select	this	option,
the	Base	Amount	and	%
Increase	fields	appear.

General	Ledger	multiplies	the
base	amount	by	the	percent
increase	to	calculate	the	Period
1	budget	amount.



In	the	Base	Amount
field,	enter	the	base
amount	you	want	to
begin	with	(that	is,	the
base	amount	you	want	to
use	to	calculate	the
budget	for	Period	1).
In	the	%	Increase	field,
enter	the	percentage	(in
decimal	notation)	by
which	the	base	amount
should	be	increased.

To	calculate	the	budget
amount	for	Period	2,
General	Ledger	multiplies
the	Period	1	amount	by	the
percent	increase.
To	calculate	the	Period	3
budget	amount,	General
Ledger	multiplies	the
Period	2	amount	by	the
percent	increase.
General	Ledger	continues
to	calculate	budget
amounts	in	this	manner
until	all	periods	have	a
budget	amount.

Copy,
As	Is

Select	this	option	to	copy	or
add	the	amounts	in	each
period	of	the	Inquiry	Amount
column	into	the
corresponding	periods	of	the
Budget	Amount	column.

General	Ledger	copies	the
exact	amounts	in	each	period
of	the	Inquiry	Amount	fields
into	the	corresponding	periods
of	the	Budget	Amount	fields.

Copy,
Amount
Increase

When	you	select	this	option,
the	Amount	Increase	field
appears.	In	this	field,	enter
the	amount	by	which	the
period	amounts	should	be
increased.

General	Ledger	adds	the
period	amount	in	each	Inquiry
Amount	field	to	the	amount	in
the	Amount	Increase	field,
and	then	copies	the	result	into
the	Budget	Amount	field	for
the	corresponding	period.

Copy,
Percent
Increase

When	you	select	this	option,
the	%	Increase	field
appears.	In	this	field,	enter
the	percentage	by	which	the
period	amounts	should	be

General	Ledger	multiplies	the
amount	in	the	Inquiry	Amount
field	for	each	period	by	the
percentage	in	the	%	Increase
field,	and	then	copies	the	result



increased. into	the	Budget	Amount	field
for	the	corresponding	period.

Copy,
Prorated
Spread

When	you	select	this	option,
the	Spread	Amount	field
appears.	In	this	field,	enter
the	amount	you	want	to
prorate	to	the	individual
periods.

Note:	In	a	multicurrency
system,	you	must	enter	the
source	and	functional
equivalents	of	other
currencies	separately	if	you
want	both	sets	of	numbers.

To	calculate	the	functional
equivalent	from	a	source
amount,	inquire	on	the
source	amount,	and	then	use
the	percent	increase	budget
method.	If	the	rate	is	less
than	one,	use	a	negative
percent	increase	(calculated
by	subtracting	the	rate	from
1).

General	Ledger	performs	a
weighted	distribution	of
amounts	based	on:

The	period	amount	in	the
Inquiry	Amount	field.
The	sum	of	period	amounts
in	all	the	Inquiry	Amount
fields.
The	amount	you	specify	in
the	Spread	Amount	field.

The	system	uses	the	following
equation	to	compute	each
period's	budget	amount:

(Period	inquiry	amounts	x
Spread	amount	for	period)	/
Sum	of	amounts	(all	periods)

In	other	words,	a	ratio	(weight
factor)	is	calculated	by	dividing
each	individual	period’s	inquiry
amount	by	the	sum	of	the
inquiry	amounts	for	all	periods.
That	weight	factor	is	then
multiplied	by	the	spread
amount	you	specify	to	arrive	at
each	period’s	budget	amount.

Fixed
Amount

When	you	select	this	option,
the	Fixed	Amount	field
appears.	In	this	field,	enter	a
fixed	amount.

General	Ledger	adds	the	fixed
amount	you	specify	to	the
Budget	Amount	field	for	each
period.



Spread
Amount

When	you	select	this	option,
the	Spread	Amount	field
appears.	In	this	field,	enter
an	spread	amount.

General	Ledger	distributes	the
spread	amount	you	specify
evenly	across	the	Budget
Amount	fields	for	all	periods.

Note:	If	the	amount	cannot	be
divided	evenly,	the	remainder	is
added	into	the	last	period.

Related	Topics
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Editing	Budget	Data
You	can	maintain	up	between	one	and	five	budget	sets	for	each	account,
depending	on	your	edition	of	Sage	300	ERP.	If	you	are	using	Sage	300
Premium	ERP,	you	can	create	up	to	five	optional	budgets	for	an	account.

Note:	You	cannot	add,	change,	or	delete	information	contained	in	a
locked	budget	set.	(The	Posting	tab	on	the	G/L	Options	screen	tells	you
which	budget	sets,	if	any,	are	locked.)

Before	you	start

To	edit	budget	data:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Budget	Maintenance.
2.	 In	the	Account	field,	select	the	account	for	which	you	are	entering

budget	information.
3.	 Display	the	budget	set	you	want	to	edit.	More...

4.	 Enter	data	for	each	period	in	the	budget	set.	More...

Tips:

Click	the	Clear	button	to	remove	figures	entered	previously	on	the
screen.
Click	the	Delete	button	to	remove	the	budget	record	completely.
(This	action	will	free	up	disk	space.)
Use	the	Fiscal	Set	Lookup	section	to	look	up	current	or	previous-
year	actual	or	budget	figures	from	any	account.	When	you	click
the	Go	 	button	beside	the	Fiscal	Set	Lookup	fields,	the	Inquiry
Amount	column	displays	amounts	from	your	inquiry	that	can	help
you	prepare	the	budget	for	the	account	you	are	working	with.

You	can	also	inquire	on	an	account's	rolled	up	amounts.	Select
the	Use	Rolled	Up	Amounts	option,	and	then	click	the	Go	
button	to	see	rolled	up	budget	figures.	Budgets	for	the	member
accounts	are	rolled	into	the	rollup	account	for	inquiry	purposes.
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If	you	have	security	authorization	for	the	rollup	account,	you
automatically	have	access	to	member	accounts.

5.	 When	you	are	satisfied	with	the	budget	data,	click	Add	or	Save.
You	can	continue	to	manipulate	the	amounts	in	the	Budget	Amount
fields	using	various	budget	methods,	or	by	manually	changing	the
amounts.

6.	 When	you	are	satisfied	with	the	result,	click	Add	or	Save.

Related	Topics

javascript:mc48.Click()


Home	>	Entering	and	Posting	General	Ledger	Transactions



Entering	and	Posting	General
Ledger	Transactions
Use	General	Ledger	Transactions	screens	to	enter	and	post	batches	of
journal	entries,	and	to	review	and	edit	transaction	information	before
posting.

About	Transaction	Processing	in	General	Ledger

Adding	a	New	Batch

Editing	a	Batch

Deleting	a	Batch

Adding	a	Journal	Entry

Posting	Transaction	Batches

Drilling	Down	from	Journal	Entries	to	Source	Transactions

Reversing	a	Posted	Batch	or	Journal	Entry

About	Recurring	Entries

Setting	Up	Recurring	Entries

About	Viewing	Batch	Information

About	Importing	Batches
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About	Transaction	Processing	in	General	Ledger
A	General	Ledger	batch	is	a	group	of	journal	entries,	each	of	which
contains	at	least	two	transaction	details:	one	for	the	debit	amount	and
one	for	the	credit	amount.

Journal	entries	do	not	affect	G/L	account	balances	until	you	post	the
batches.



Posting	Batches
When	General	Ledger	posts	a	batch,	all	entries	that	cannot	be	posted	are
added	to	a	new	batch.	Print	the	posting	journal	for	a	list	of	all	posted
transactions	and	all	errors	that	the	program	encountered.

The	posting	process	consolidates	details	for	accounts	using	the	Post	To
Account	In	Consolidated	option	(selected	on	the	Detail	tab	of	the	G/L
Chart	of	Accounts	screen).

Posting	changes	the	status	of	posted	batches	to	Posted	on	the	Batch
Status	report.



Batch	Errors
If	you	use	the	Force	Listing	Of	Batches	option,	all	batches	to	be	posted
must	be	error-free,	and	you	must	have	printed	listings	for	them	before
trying	to	post	them.

If	you	do	not	use	the	option	and	you	post	a	batch	that	contains	errors,	the
correct	entries	will	be	posted,	and	entries	containing	errors	will	be	placed
in	a	new	batch,	which	uses	the	next	available	batch	number.

Note:	General	Ledger	cannot	detect	some	errors	until	you	post	the
batch,	and	these	errors	are	not	reported	on	the	batch	listing.



Posting	Sequences	and	Entry	Numbers
A	unique	posting	sequence	number	is	assigned	to	each	posting	run.	The
number	is	printed	on	the	posting	journal	and	appears	on	the	G/L	Batch
List	screen,	allowing	you	to	specify	which	journals	to	print,	as	well	as	to
track	data.

A	unique	posting	entry	number	(consisting	of	the	posting	sequence
number	and	the	entry	number),	indicating	the	order	of	posting,	is
assigned	to	each	entry	that	is	posted.



Previous-Year	Posting
When	amounts	are	posted	to	revenue	and	expense	accounts	for	a
previous	year,	this	screen	also	creates	the	closing	entries	for	those
accounts,	and	adjusts	the	retained	earnings	account	for	the	year.	Closing
transactions	are	listed	on	the	posting	journal.



Provisional	Posting
Provisional	posting	copies	Actual	fiscal	set	amounts	to	a	Provisional
fiscal	set,	and	updates	the	Provisional	fiscal	set	so	you	can	see	the
combined	effect.

Batches	are	not	deleted	when	you	post	them	provisionally,	and	you	can
make	changes	to	them,	if	necessary,	before	permanently	posting	them.
On	the	Batch	Status	report,	they	are	marked	as	provisionally	posted,	and
the	date	and	the	posting	sequence	number	are	included.

You	can	include	provisional	transactions	on	the	Batch	Status	and	Trial
Balance	reports.

Provisional	Posting	is	not	available	in	an	ICT	company.



Reversing	Entries
Before	you	can	post	reversing	entries	that	span	two	fiscal	years,	you
must	first	create	a	new	year	using	the	Create	New	Year	screen.	If	you	do
not	create	a	new	year	first,	posting	creates	an	error	batch	for	the
reversing	entries,	which	you	can	post	later.

Note:	Provisional	posting	does	not	post	reversing	entries	across	a	fiscal
year	boundary—only	within	a	fiscal	year.



Intercompany	Transactions	(ICT)	Batches
Important!	You	can	enter	intercompany	transactions	only	in	the
company	for	which	you	activated	Intercompany	Transactions.	If	you	are
working	with	a	company	for	which	Intercompany	Transactions	has	not
been	activated,	the	ICT	fields	do	not	appear	on	G/L	forms	and	reports.

If	you	use	Sage	300	ERP	Intercompany	Transactions:

Additional	fields	appear	on	the	G/L	Journal	Entry	screen,	letting	you
identify	the	originating	company	for	the	batch	and	a	destination
company	and	route	number	for	each	transaction.
You	use	the	ICT	A/P	Post	Batches	screen	to	post	intercompany
batches.

Note:	If	Intercompany	Transactions	is	activated	for	the	open	company,
you	can	post	only	intercompany	batches	and	transactions.

When	you	post	an	intercompany	batch,	Sage	300	ERP	creates	batches
for	the	originating	company	and	for	the	destination	company	in	their
respective	General	Ledgers.	It	also	creates	a	posting	journal	in
Intercompany	Transactions	that	shows	what	happened.

If	you	selected	Post	G/L	Batches	for	the	originator	and	the	destination
companies	in	ICT	Options,	Sage	300	ERP	will	also	post	these	batches
for	you	in	the	remote	General	Ledgers.

The	program	generates	descriptions	for	the	batch,	entry,	and	line	for	the
originating	and	destination	companies,	as	shown	in	the	following
examples:

Batch	description.	The	generated	G/L	batch	description	will	be:
From	ICT	Company	companyID	(GI	post	seq	>nnn	batch	x.

where	companyID	is	the	ID	code	of	the	originator,	nnn	is	the
sequence	number,	and	x	is	the	batch	number.

Entry	description.	The	generated	entry	description	will	be	the	same
as	that	in	the	ICT	G/I	entry.



Line	description.	The	generated	line	description	will	be	the	same	as
that	in	the	ICT	G/I	line.
Line	comment.	The	generated	line	comment	will	be	the	same	as
that	in	the	ICT	G/I	line.

Related	Topics
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Adding	a	New	Batch
Sage	300	ERP	General	Ledger	is	a	batch‐oriented	accounting	system.
You	group	financial	transactions	together	and	enter	them	in	batches
before	you	post	them	to	general	ledger	accounts.	You	use	the	G/L
Journal	Entry	screen	to	add	batches	directly	into	General	Ledger.	

Before	you	start

Important!	When	creating	a	new	batch,	you	must	use	the	batch
number	assigned	by	the	system.

To	add	a	new	batch,	follow	one	of	these	procedures:
1.	 Open	General	Ledger	>	G/L	Transactions	>		Journal	Entry.
2.	 Click	the	New	 	button	beside	the	Batch	field.
3.	 Enter	a	description	for	the	batch.

Or

1.	 Open	General	Ledger	>	G/L	Transactions	>		Batch	List.
2.	 Click	the	New	button.
3.	 When	the	Journal	Entry	screen	appears,	enter	a	batch	description.

Note:	You	do	not	click	the	New	 	button	in	the	Journal	Entry	screen
because	a	new	batch	has	already	been	created.

After	creating	a	new	batch

Related	Topics
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Editing	a	Batch
You	use	the	Journal	Entry	screen	to	edit	all	types	of	General	Ledger
batches,	whether	they	were	created	by	another	Sage	300	ERP	subledger
or	imported	from	a	non-Sage	300	ERP	program,	provided	that	they	have
not	been	posted	or	deleted,	or	set	Ready	to	Post	(on	the	Batch	List
screen).	More...

Note:	You	can	edit	batches	that	have	been	provisionally	posted.

Before	you	start

To	edit	the	contents	of	an	existing	batch:
1.	 Open	General	Ledger	>	G/L	Transactions	>		Journal	Entry.

Tip:	Alternatively,	if	the	Batch	List	screen	is	open,	you	can	select
the	batch	from	the	list,	and	then	click	Open.

2.	 In	the	Batch	Number	field,	use	the	Finder	or	the	navigation	buttons
to	display	the	batch	you	want	to	edit,	or	type	the	batch	number.

You	can	now	select	an	entry	from	the	batch.

3.	 In	the	Entry	Number	field,	use	the	Finder	or	the	navigation	buttons
to	display	the	entry	you	want	to	edit,	or	type	the	entry	number	in	the
field.

The	journal	entry	is	now	available	for	editing.

4.	 Edit	the	header	information	or	the	details	for	the	selected	entry,	as
needed.	

Tips:

To	delete	the	entire	entry,	click	Delete.
To	delete	the	existing	details	for	the	entry,	click	Clear.
To	view	all	the	information	for	a	single	detail	without	needing	to
scroll,	select	the	detail	on	the	table,	and	then	click	Detail.	(Click

javascript:void(0);
javascript:void(0);


Close	when	you	want	to	return	to	the	Journal	Entry	screen.)
To	view	or	edit	optional	field	information	for	a	detail,	select	the
detail,	and	then	click	the	Optional	Fields	zoom	 	button.

5.	 When	you	have	finished	making	changes,	click	Save,	and	then	click
Close.

After	editing	a	batch
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Deleting	a	Batch
You	can	delete	General	Ledger	batches	that	you	have	not	yet	posted.

Tip:	You	use	the	Clear	History	screen	in	the	G/L	Periodic	Processing
folder	to	clear	posted	batches.

Before	you	start

To	delete	a	batch,	follow	one	of	these	procedures:
1.	 Open	General	Ledger	>	G/L	Transactions	>		Journal	Entry.
2.	 In	the	Batch	Number	field,	use	the	Finder	or	the	navigation	buttons

to	display	the	batch	you	want	to	delete,	or	type	the	batch	number.
3.	 Click	Delete.

All	transactions	in	the	batch	are	deleted.

Or

1.	 Open	General	Ledger	>	G/L	Transactions	>		Batch	List.
2.	 Select	(highlight)	the	batch	you	want	to	delete	on	the	Batch	List

screen.

Clear	the	option	Show	Posted	And	Deleted	Batches	to	limit	the
display	to	batches	that	have	not	been	posted.

3.	 Click	Delete.

After	deleting	a	batch

Related	Topics
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Adding	a	Journal	Entry
A	journal	entry	in	General	Ledger	is	like	a	manual	journal	entry.	The	sum
of	the	debits	equals	the	sum	of	the	credits.	Each	debit	line	and	each
credit	line	in	a	journal	entry	is	called	a	detail.	You	use	the	G/L	Journal
Entry	screen	to	maintain	batches,	journal	entries,	and	journal	entry
details.

To	add	a	journal	entry:
1.	 Open	General	Ledger	>	G/L	Transactions	>		Journal	Entry.
2.	 Beside	the	Batch	field,	click	the	New	 	button.

General	Ledger	provides	the	next	batch	number,	and	moves	to	the
Batch	Description	field.

3.	 Enter	a	description	for	the	batch.
4.	 Enter	header	information	for	the	entry,	as	follows:

a.	 Beside	the	Entry	Number	field,	click	the	New	 	button.

General	Ledger	inserts	the	next	entry	number.

b.	 Enter	a	description	for	the	entry.

c.	 If	you	use	Sage	300	ERP	Intercompany	Transactions,	use	the
Finder	for	the	Originator	field	to	select	a	company.
Transactions	in	an	intercompany	batch	can	have	different
originating	companies.

Note:	The	Originator	field	appears	only	if	you	install	and	activate
Intercompany	Transactions.

d.	 In	the	Date	field,	specify	the	date	of	the	journal	entry.
e.	 Use	the	Year/Period	field	to	specify	the	fiscal	year	and	period	to

which	to	post	the	transaction.	(The	default	fiscal	year	and	period	is
determined	by	the	date	you	entered	in	the	Date	field.)

f.	 Enter	the	source	code	for	the	transaction,	or	use	the	Finder	to



select	it.

General	Ledger	displays	the	default	source	code	from	the	Posting
tab	of	the	Options	screen,	but	you	can	change	the	code.

g.	 Select	Normal	or	Quick	as	the	entry	mode.
This	option	controls	the	number	of	fields	visited	when	you	are
adding	new	transaction	details.

h.	 If	the	transaction	should	be	reversed	in	the	next	fiscal	period	(for
example,	if	the	entry	is	an	accrual),	select	the	Auto	Reverse
option.

5.	 Enter	debit	and	credit	information	in	the	detail	table.

Tip:	Click	the	Detail	button	to	open	the	Journal	Detail	screen,
where	you	can	add	and	edit	details	without	having	to	scroll	to	view
all	the	information	for	a	detail.

Note:	If	you	have	a	multicurrency	ledger	and	you	are	entering
details	for	a	multicurrency	account,	you	can	select	the	source
currency,	the	rate	type,	and	the	rate	for	each	detail.	Each	detail	can
use	a	different	source	currency,	and	you	can	override	the	displayed
exchange	rates	as	required.

6.	 To	view	or	edit	optional	fields	for	a	selected	detail,	click	the	Optional
Fields	zoom	 	button,	or	press	Shift+F9.

The	Journal	Entry	Optional	Fields	screen	appears.

You	can	add	or	delete	optional	fields	for	the	detail.	However,	you	can
add	only	optional	transaction	fields	that	are	defined	for	the	account.

Note:

You	can	also	change	the	value	for	the	optional	field,	as	follows:

If	the	optional	field	is	validated,	you	must	specify	a	value	that	is
defined	for	the	optional	field	in	Common	Services.	If	the	optional
field	allows	a	blank,	you	can	also	leave	the	value	blank.



If	the	optional	field	is	not	validated,	you	can	select	a	defined	value,
or	you	can	enter	any	value,	providing	your	entry	does	not	exceed
the	length	specified	for	the	optional	field.

You	click	Close	to	return	to	the	Journal	Entry	screen.

7.	 Click	Add	or	Save.

After	adding	journal	entries

Related	Topics
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Posting	Transaction	Batches
The	process	of	transferring	information	from	a	batch	of	transactions	to
the	general	ledger	accounts	is	called	posting.	General	Ledger	lets	you
post	transactions	directly	to	accounts,	or	post	them	provisionally	to	test
their	effect.

You	use	the	Post	Batches	screen	to	post	all	or	a	range	of	unposted
batches.

You	can	also	post	individual	batches	using	the	G/L	Batch	List	screen.
However,	you	can	post	only	one	batch	at	a	time	using	that	screen.	(You
select	the	batch	you	want	to	post,	and	then	click	Post	or	Prov	Post	on	the
G/L	Batch	List.)

Note:	If	you	use	Intercompany	Transactions	and	you	are	posting	an
intercompany	batch,	the	Intercompany	Transactions	program	posts	the
batch,	as	ICT	posting	is	a	separate	process	from	G/L	posting.

Before	you	start

To	post	transaction	batches:
1.	 Open	General	Ledger	>	G/L	Transactions	>		Post	Batches.
2.	 Specify	the	batches	to	post	by	selecting	All	Batches	or	Range.

If	you	want	to	post	a	single	batch,	enter	the	same	batch	number	for
the	beginning	and	end	of	the	range.

3.	 Click	Post	to	post	batches	permanently.
Click	Provisional	Post	to	post	on	a	temporary	basis.
If	you	decide	not	to	post	batches,	click	Close.

After	posting	batches
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Drilling	Down	from	Journal	Entries	to	Source
Transactions
You	can	drill	down	from	posted	or	unposted	batches	in	General	Ledger	to
view	transactions	in	the	subledgers	where	the	source	transactions	were
created.	

To	drill	down	to	a	source	transaction:
1.	 Open	General	Ledger	>	G/L	Transactions	>		Journal	Entry.
2.	 In	the	Batch	Number	field,	select	a	batch	that	contains	transactions

created	in	another	Sage	300	ERP	ledger,	such	as	Accounts
Receivable	or	Purchase	Orders.

3.	 In	the	Entry	Number	field,	select	the	entry	you	want	to	view	in	the
source	ledger.

4.	 Click	the	Drilldown	button	beside	the	Entry	Number	field	to	display
the	original	transaction	in	the	source	ledger.



Home	>	Entering	and	Posting	Transactions	>	Reversing	a	Posted	Batch	or	Journal	Entry



Reversing	a	Posted	Batch	or	Journal	Entry
General	Ledger	makes	it	easy	to	reverse	any	of	the	transactions	in	a
posted	batch.

To	reverse	a	posted	batch	or	journal	entry:
1.	 Open	General	Ledger	>	G/L	Transactions	>		Batch	List.
2.	 Double-click	the	posted	batch	that	you	want	to	reverse,	or	that

contains	the	entry	you	want	to	reverse.

3.	 The	G/L	Journal	Entry	screen	appears,	displaying	the	batch.

4.	 If	you	want	to	reverse	an	individual	entry	in	the	batch,	select	the	entry
in	the	Entry	Number	field.

5.	 Click	Reverse.
The	Create	Reversing	Batch	screen	appears.

6.	 Select	one	of	the	Reverse	options	to	specify	which	of	the	following
you	want	to	reverse:

The	selected	entry	only.
The	whole	batch.

7.	 In	the	Batch	Number	field,	specify	the	reversing	batch	to	which	you
want	to	add	the	batch	or	entry	you	are	reversing.

You	can	create	a	new	reversing	batch	or	select	an	existing	reversing
batch.

8.	 In	the	Batch	Description	field,	enter	a	description	for	the	reversing
batch.

Note:	If	you	created	a	new	reversing	batch,	the	default	batch
description	is	REVERSE	BATCH,	but	you	can	change	this.

9.	 Specify	a	description	for	each	entry	you	are	reversing.	The	method
for	doing	this	depends	on	what	you	are	reversing:

Whole	batch.	Select	one	of	the	Entry	Descriptions	options	to



specify	a	method	for	generating	descriptions	for	the	entries	in	the
batch:

Original.	Each	entry	in	the	reversing	batch	has	the	same	entry
description	it	had	in	the	original	batch.
Original	with	Prefix.	Each	entry	in	the	reversing	batch	has	the
same	entry	description	it	had	in	the	original	batch,	preceded	by
the	prefix	you	enter.
New.	Each	entry	in	the	reversing	batch	has	the	entry	description
you	enter.

Individual	entry.	In	the	Entry	Description	field,	enter	a	description
for	the	entry	you	are	reversing.

10.	 Click	Process.

After	reversing	a	posted	batch	or	journal	entry
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About	Recurring	Entries
You	can	set	up	and	schedule	journal	entries	for	recurring	transactions
that	vary	little	from	period	to	period,	such	as	periodic	depreciation
charges	or	loan	repayments.

You	use	the	G/L	Recurring	Entries	screen	to	set	up	one	or	more	recurring
entry	records.	Later,	you	use	the	Create	Recurring	Entries	Batch	screen,
in	the	Periodic	Processing	folder,	to	create	a	batch	of	recurring
transactions.

You	can	also	schedule	reminders	for	users	who	are	responsible	for
processing	these	entries	periodically.	When	a	recurring	entry	comes	due,
Sage	300	ERP	reminds	these	users	to	create	batches	of	recurring
entries.	(For	information	about	scheduling	reminders,	see	the	System
Manager	help.)

Related	Topics
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Setting	Up	Recurring	Entries
You	use	the	G/L	Recurring	Entries	screen	to	set	up	journal	entries	for
transactions	that	recur	on	a	periodic	basis.

Setting	up	a	recurring	entry	is	similar	to	recording	a	journal	entry,	except
that	the	Recurring	Entry	screen	contains	additional	fields	for	identification
and	timing	of	the	recurring	transaction.

To	set	up	recurring	entries:
1.	 Open	General	Ledger	>	G/L	Setup	>		Recurring	Entries.
2.	 In	the	Recurring	Entry	Code	field,	enter	a	unique	code	that

represents	the	type	of	entry	you	are	creating.	Your	code	can	be	up	to
16	characters	long.

Example:	You	are	creating	a	recurring	entry	for	semi-annual
amortization.	Your	code	might	be	AMORT.

3.	 Enter	header	information	to	use	for	the	recurring	entries	as	follows:

a.	 In	the	Entry	Description	field,	enter	a	description	of	the	code,	up
to	60	characters	long.	Descriptions	help	to	identify	each	code.

b.	 In	the	Schedule	Code	field,	attach	a	processing	schedule	for	your
recurring	entry.

Either	click	the	Finder,	and	then	select	a	schedule	from	the	list,	or
click	the	Zoom	 	button	for	the	Schedule	Code	field,	and	then
create	a	schedule	for	this	recurring	entry.

c.	 In	the	Start	Date	field,	enter	the	date	that	the	recurring	entry	for
this	transaction	begins.	General	Ledger	checks	the	start	date	to
determine	if	the	recurring	entry	should	be	included	in	a	batch.

d.	 In	the	Expiration	Type	field,	select	No	Expiration	Date	if	you	have
no	end	date	in	mind	for	the	recurring	entry.	Otherwise,	select
Specific	Date	and	then	enter	an	expiration	date.

e.	 To	make	this	entry	temporarily	inactive,	select	the	Inactive	option.
You	can	activate	the	recurring	entry	later.	When	you	change	the



status,	the	start	date	is	automatically	updated	to	the	current
session	date,	but	you	can	change	the	date.

f.	 Enter	a	description	for	the	entry	(for	example,	"Monthly	service
charge").

g.	 In	the	Source	Code	field,	enter	or	select	the	source	code	to	use
with	the	recurring	entries	when	they	are	generated	(for	example,
GL-JE).

h.	 If	you	need	to	reverse	the	transaction	in	the	next	fiscal	period	(for
example,	for	some	kinds	of	accruals),	select	Auto	Reverse.

i.	 Select	Normal	or	Quick	Entry	as	the	entry	mode.	(Quick	entry
mode	saves	you	some	keystrokes	if	you	are	entering	similar
details.	The	program	copies	the	reference	and	description	for	each
detail	line	after	the	first.)

j.	 If	you	have	a	multicurrency	ledger,	select	the	type	of	exchange	rate
to	use	for	the	recurring	entries	from	the	Exchange	Rate	list.
More...

4.	 Enter	transaction	details	in	the	table,	or	click	the	Detail	button,	and
then	enter	the	details	in	the	separate	Recurring	Entry	screen	that
appears.

The	Optional	Fields	column	(or	the	check	box	in	the	separate	detail
screen)	indicates	whether	transaction	optional	fields	are	defined	for
the	account	used	in	a	recurring	entry	detail.	If	optional	fields	are
used,	you	can	use	the	Recurring	Entry	Optional	Fields	screen	to	view
or	change	the	optional	fields	for	the	entry.	More...

5.	 Click	Close	when	you	have	finished	adding	recurring	entries.

Related	Topics
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About	Viewing	Batch	Information
General	Ledger	has	several	screens	that	display	batch	and	journal	entry
information:

G/L	Batch	List.	This	screen	lists	all	the	batches	in	the	general
ledger,	in	order	by	batch	number,	together	with	information	about
each	batch,	such	as:

Batch	number
Batch	description
Source	ledger
Type	and	status
Whether	printed
Dates	created	and	last	edited
Whether	Ready	to	Post
Batch	total
Number	of	entries	and	errors

Batch	Status	Report.	This	report	shows	all	activity	that	has	taken
place	in	currently	unposted	batches,	and	in	batches	that	have	been
posted	or	deleted	since	the	last	time	the	report	data	was	cleared.

For	more	information	about	this	report,	see	G/L	Batch	Status	Report.

Batch	Listing	Report.	This	report	lists	the	contents	of	unposted
batches	and	identifies	errors.	Use	it	to	check	transaction	batches
after	retrieving	or	importing	batches	and	before	posting	any	batches.

For	more	information	about	this	report,	see	G/L	Batch	Listing	Report.

Posting	Journal.	This	report	lists	transactions	that	have	just	been
posted.

For	more	information	about	this	report,	see	G/L	Posting	Journals
Report.

Tip:	You	can	also	view	posted	transactions	by	printing	the	G/L
Transaction	Listing,	by	printing	source	journals,	or	by	using	the



Transaction	History	screen.

Related	Topics
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About	Importing	Batches
You	can	use	the	Import	command	on	the	G/L	Journal	Entry	File	menu	to
transfer	to	General	Ledger	batches	of	transactions	that	were:

Exported	by	Sage	300	ERP	ledgers	at	other	physical	locations.
Created	by	non-Sage	300	ERP	programs.

After	importing	the	transactions,	you	can	edit,	print	and	post	them	in
Sage	300	ERP	General	Ledger.

Note:	If	the	batch	file	does	not	contain	valid	data,	it	is	not	imported.

Tip:	To	see	how	the	data	records	should	be	organized,	we	recommend
that	you	export	a	record	from	Sage	300	ERP	in	the	format	that	you	want
to	import.	(For	more	information	on	creating	batches	for	importing,	see
the	"Import	Data	into	Sage	300	ERP"	topic	in	the	System	Manager
help.)



Importing	Batches	from	Another	Location
Generally,	you	use	the	Import	feature	to	transfer	Sage	300	ERP	batches
that	are	created	in	another	location	for	posting	to	your	General	Ledger.	(If
your	subledgers	are	in	the	same	database	as	your	General	Ledger,	they
create	batches	directly	in	General	Ledger.)

Import	batches	can	be	created	off-site	in	one	of	two	ways:

By	using	the	G/L	Journal	Entry	screen	in	the	remote	site	to	create	the
batch.Then,	you	use	the	Export	command	on	the	Journal	Entry
screen's	File	menu	to	create	a	batch	that	can	be	imported	by	your
General	Ledger.
By	creating	a	General	Ledger	batch	in	a	database	that	does	not	have
General	Ledger	activated.	For	example,	if	you	have	a	branch	office
database	that	contains	Accounts	Receivable	or	Accounts	Payable
ledgers—but	no	General	ledger—Sage	300	ERP	will	create	a	G/L
import	batch	file	when	you	create	a	batch	for	posting	to	General
Ledger.

Import	batches	created	automatically	by	Sage	300	ERP	are	in	CSV	text
format	(comma	separated	values).

If	you	are	exporting	a	batch	manually	(using	the	File	>	Export	command
in	the	Journal	Entry	screen),	you	can	choose	from	a	variety	of	formats.
However,	if	you	are	creating	the	file	for	Sage	300	ERP,	there	is	no	reason
to	use	another	format.



Importing	Batches	from	Non-Sage	300	ERP
Programs
The	only	way	to	transfer	batches	created	by	non-Sage	300	ERP
programs	into	General	Ledger	is	to	import	them.

As	with	transactions	generated	by	Sage	300	ERP	subledgers,	the	source
code	attached	to	the	detail	indicates	the	transactions’	source	ledger	and
type.	You	must	define	your	source	codes	in	the	source	program,	and	then
add	them	to	General	Ledger	before	you	export	transactions.

Related	Topics
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Importing	and	Exporting	General	Ledger	Data
Import	account	records,	transaction	batches,	and	other	records	into
General	Ledger	from	files	created	by	other	programs,	and	export	General
Ledger	data	for	use	in	other	programs.

About	Importing	and	Exporting	G/L	Data

Importing	Data	to	General	Ledger

Exporting	General	Ledger	Data

Creating	a	GIFI	Export	File
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About	Importing	and	Exporting	General	Ledger
Data
You	can	import	account	records,	transaction	batches,	and	other	records
into	an	Sage	300	ERP	database	from	files	created	by	other	programs.
You	can	also	export	data	from	a	Sage	300	ERP	database	for	use	in	other
programs.

You	can	use	this	feature	to	speed	up	your	initial	ledger	setup,	especially	if
you	are	converting	data	from	a	non-Sage	300	ERP	database	to	Sage	300
ERP	General	Ledger.

For	example,	you	can:

Export	account	data	to	a	spreadsheet	program,	work	with	the	data,
then	import	it	back	into	General	Ledger	as	budget	figures	for	a	new
fiscal	year.
Add	a	new	department	to	your	chart	of	accounts	by	exporting	an
existing	department	set,	changing	the	department	account	number
segment,	then	re-importing	the	file.

Note:	If	importing	fails,	the	system	creates	a	restart	record.	You	must
remove	the	restart	record	before	you	can	perform	another	import
successfully.	You	can	remove	the	record	either	by	correcting	the	error
that	caused	the	restart	record	in	the	first	place	(for	example,	an	error	in
the	file	you	are	trying	to	import),	or	by	deleting	the	record	in	the	Restart
Maintenance	screen.

General	Ledger	lets	you	import	information	from	a	variety	of	file	formats
(such	as	CSV	or	spreadsheet	files).

For	more	detailed	information	on	importing	data	into	Sage	300	ERP,
including	the	required	formats	and	contents	of	import	files,	see	the
System	Manager	help.
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Importing	Data	to	General	Ledger
Use	the	Import	command	to	transfer	data,	such	as	account	master
information	and	transaction	batches,	from	non-Sage	300	ERP	programs
to	Sage	300	ERP	General	Ledger.	Transferring	this	information	to	Sage
300	ERP	is	called	importing.

Example:	One	common	use	of	the	Export/Import	functions	is	to	export
account	balances	(or	net	amounts)	to	a	spreadsheet	for	analysis	and
manipulation.	Then,	import	this	information	as	next	year's	budget
information.

Tip:	If	you	often	import	the	same	data,	you	can	create	a	script	to	speed
up	the	process.	The	fields	selected	when	you	create	the	script	appear	in
the	Import	dialog	box.

To	import	account	information	or	transactions,	follow	these	general
steps:
1.	 Open	the	screen	for	the	data	you	want	to	import.
2.	 Click	File	>	Import.

The	Import	dialog	box	appears.	The	information	columns	are	dimmed
until	you	select	a	file	or	database	to	import.

3.	 In	the	Type	field,	select	the	format	of	the	data	you	are	importing.
4.	 Select	an	action	from	the	drop-down	list:

To	import	new	records,	select	Insert.
To	overwrite	existing	records,	select	Update.
To	import	new	records	and	update	existing	records,	select	Insert
and	Update.

5.	 Click	the	Browse	button,	and	then	specify	one	of	the	following,
depending	on	the	type	of	data	you	are	importing:

Access	database
Excel	file



A	path	or	database	(for	a	CSV	import)

In	the	Import	dialog	box,	the	columns	are	no	longer	dimmed,	and	you
can	edit	them.	(For	example,	you	can	right-click	on	cells	in	the
Contents	column	to	change	values.)

6.	 Click	OK	to	import	the	data.
A	message	appears,	displaying	the	number	of	updates	and
insertions,	and	the	number	of	items	processed.
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Exporting	General	Ledger	Data
General	Ledger	lets	you	export	data,	such	as	account	master	information
and	transaction	batches,	to	files	that	can	be	read	and	used	by	other
programs.	Transferring	this	information	to	non-Sage	300	ERP	databases
is	called	exporting.

Example:	One	common	use	of	the	Export/Import	functions	is	to	export
account	balances	(or	net	amounts)	to	a	spreadsheet	for	analysis	and
manipulation.	Then,	import	this	information	as	next	year's	budget
information.

Before	you	start

To	export	General	Ledger	information,	follow	these	general	steps:
1.	 Open	the	screen	for	the	data	you	want	to	export.
2.	 Click	File	>	Export.
3.	 In	the	Export	dialog	box	that	appears,	select	a	file	format	from	the

Type	list.
4.	 Click	Browse,	and	then	specify	the	location	and	file	to	export	to.
5.	 Click	the	plus	signs	beside	items	that	have	them	to	expand	the	list	of

fields.
6.	 If	there	are	fields	that	you	do	not	want	to	export,	clear	the	checkbox

for	that	field.

Note:	Items	with	a	star	beside	the	check	mark	are	key	fields	that
you	must	export.

7.	 To	change	the	criteria	for	exported	data,	click	the	Set	Criteria	button.
8.	 Click	OK	to	begin	the	export.

When	the	export	is	finished,	you	receive	a	message	that	displays	the
number	of	records	exported.
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Creating	a	GIFI	Export	File
General	Ledger	allows	companies	to	export	a	General	Index	of	Financial
Information	(GIFI)	file	as	part	of	their	electronic	tax	return	for	Canadian
T2	Corporate	Income	Tax	Returns.

General	Ledger	includes	a	GIFI	macro	in	Excel	that	allows	you	to
associate	GIFI	codes	to	each	account	in	your	chart	of	accounts.

To	create	a	GIFI	export	file:
1.	 Start	Excel.
2.	 Open	Program	Files	>	Sage	300	ERP	>	Macros	>	GIFI.XLS.
3.	 If	a	security	warning	appears	saying	that	macros	have	been	disabled,

click	Enable	Content.
4.	 Click	the	Retrieve	Accounts	button.
5.	 At	the	Open	Company	prompt:

a.	 Enter	your	User	ID	and	password,	the	code	for	the	company
database	you	want	to	export	information	from,	and	the	session
date.

b.	 Click	OK.

This	step	clears	the	worksheet	and	retrieves	account	information
from	the	database	you	specified.

6.	 For	each	account	in	the	chart	of	accounts	that	does	not	have	a	GIFI
Code,	assign	a	GIFI	code	as	follows:

a.	 Double-click	the	blank	cell	in	column	C	to	display	a	list	of	GIFI
codes	you	can	choose	from.

b.	 Click	the	code	you	want	to	assign	to	the	account.

Important!	Make	sure	that	you	include	all	accounts	from	the	chart
of	accounts.

7.	 When	you	have	assigned	GIFI	codes	to	all	the	accounts	in	your	chart
of	account,	click	the	Export	button.



A	GIFI	Export	dialog	box	appears.

8.	 In	the	Fiscal	Year	field,	enter	the	fiscal	year	for	which	you	are	filing
income	tax,	and	then	click	OK.

9.	 In	the	Save	As	dialog	box:
a.	 Navigate	to	the	location	where	you	want	to	save	the	file.
b.	 In	the	File	Name	field,	accept	the	default	name	or	type	a	different

file	name.
c.	 Make	sure	that	the	file	type	is	GIFI	file.
d.	 Click	Save.

A	Ready	status	appears	at	the	bottom	of	your	Excel	screen	if	the
accounts	in	your	file	balance	(that	is,	total	assets	equal	total
liabilities	plus	total	equity).

A	warning	message	appears	if	your	accounts	do	not	balance.

10.	 If	you	receive	the	warning	message:

a.	 Click	OK.
b.	 Check	whether	you	have	omitted	one	or	more	accounts	from	your

chart	of	accounts.
c.	 Repeat	steps	3	through	8.

When	you	reach	step	5,	make	sure	that	you	include	all	accounts
from	the	chart	of	accounts.

11.	 Close	the	GIFI	file,	and	exit	Excel.

To	include	this	file	with	your	electronic	tax	return,	open	the	T2	program,
and	retrieve	the	GIFI	file.
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Looking	Up	Information	in	General	Ledger
Look	up	transactions,	balances,	account	history,	and	other	information	in
General	Ledger.

Looking	Up	Transactions	Posted	to	General	Ledger	Accounts

Viewing	Chart	of	Accounts	Information

Viewing	G/L	Account	History

Viewing	Source-Currency	Balances	for	a	Multicurrency
Account

Comparing	Two	Fiscal	Sets
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to	General	Ledger	Accounts



Looking	Up	Transactions	Posted	to	General
Ledger	Accounts
Use	the	G/L	Transaction	History	screen	to	display	all	transactions	posted
to	selected	account	in	a	particular	year	and	fiscal	period	(unless
transactions	were	consolidated).

To	look	up	transaction	history	for	an	account:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Transaction	History..
2.	 If	this	is	an	Intercompany	Transactions	company,	select	the	company

code	in	the	Company	field.
3.	 In	the	Account	field,	enter	or	select	the	number	of	the	account	you

want	to	inquire	on.
4.	 In	the	Period	Ending	field,	select	the	year	and	period	for	which	you

want	to	view	transactions.
5.	 You	can	use	filters	to	restrict	the	list	to	transactions	with	a	particular

source	code	or	source	currency	(if	you	have	a	multicurrency	ledger),
as	follows:

To	view	only	one	type	of	transaction,	use	the	Finder	in	the	Source
Code	field	to	select	the	source	code	you	use	for	that	type.
If	General	Ledger	is	multicurrency,	and	you	selected	a
multicurrency	account,	use	the	Finder	for	the	Currency	field	to
select	the	currency	of	the	transactions	you	will	view.
If	you	selected	a	rollup	account	and	you	want	to	view	transactions
of	rollup	members,	select	the	Use	Rolled	Up	Amounts	option,
then	click	the	Go	 	button.

Results	appear	automatically	in	the	detail	table	when	you	change	any
of	these	selection	fields.

6.	 Double-click	a	transaction	to	view	it	in	the	Journal	Entry	screen.

Tip:	You	can	drill	down	from	the	Journal	Entry	screen	to	view
transactions	sent	from	subledgers	in	the	original	entry	screens.
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Viewing	Chart	of	Accounts	Information
You	can	use	the	G/L	Chart	of	Accounts	screen	to:

List	all	the	accounts	in	the	general	ledger,	in	account	number	order,
beginning	with	the	account	you	specify.

View	detailed	information	for	a	selected	account.

To	view	Chart	of	Accounts	information:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Chart	of	Accounts..
2.	 If	you	want	to	view	your	chart	of	accounts	beginning	with	a	certain

account	number	(for	example,	to	start	the	list	from	revenue	and
expense	accounts)	enter	or	select	the	account	number	in	the
Starting	Account	field.

3.	 To	display	balances	as	of	a	certain	period	end,	specify	the	ending
year	and	period	in	the	Period	Ending	field.

4.	 To	display	only	rolled-	up	balances	(rather	than	individual	balances
for	members	of	rollup	accounts)	select	Use	Rolled	Up	Balances.

5.	 Click	the	Go	 	button.
6.	 View	account	information	as	follows:

Scroll	through	the	list	to	view	summary	information	for	each
account.
To	view	details	for	a	particular	account,	double-click	the	account,	or
select	it	and	then	click	Open.
To	view	transaction	history	for	a	selected	account,	click
Transactions.
To	compare	fiscal	sets	for	a	selected	account,	click	Comparison.
To	view	budget	information	for	a	selected	account,	click	Budget.
To	view	the	account	history	for	a	selected,	click	History.
To	view	all	the	source	currencies	that	have	been	posted	to	a
selected	account	in	the	selected	period,	click	Currency.



Related	Topics
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Viewing	G/L	Account	History
Use	the	G/L	Account	History	Inquiry	screen	to	display	balance	and	net
change	information	for	an	account.	More...

To	view	account	history:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Account	History	Inquiry.
2.	 In	the	Account	field,	enter	or	select	the	account	number	you	want	to

inquire	on.
3.	 In	the	Year	field,	select	the	fiscal	year	for	which	you	want	to	view

account	activity.

4.	 If	your	General	Ledger	and	the	selected	account	are	multicurrency,
select	a	currency	and	the	currency	type	(Source	or	Functional)	in
which	to	display	account	balances.

Note:

If	your	functional	currency	is	the	euro	and	a	reporting	currency	is
defined	in	Common	Services	(on	the	Company	Profile	screen),	you
can	select	Reporting,	Source,	or	Functional	as	the	currency	type.
If	your	functional	currency	is	the	euro	and	you	have	a	single
currency	system	you	can	choose	Functional	or	Reporting	as	the
currency	type.

5.	 If	the	Show	Quantity	option	is	available,	select	it	to	view	information
for	quantities	posted	to	the	account.

Note:	You	can	select	the	Show	Quantity	option	for	a	rollup	account
even	if	it	does	not	use	the	Maintain	Quantities	option.	General
Ledger	checks	whether	any	of	the	member	accounts	maintain
quantities.	If	they	do,	their	quantities	are	rolled	up	along	with	their
account	balances,	if	you	also	select	the	Use	Rolled	Up	Amounts
option.
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6.	 If	you	selected	a	rollup	account	and	you	want	to	see	rolled-up
amounts	for	the	account,	select	the	Use	Rolled	Up	Amounts	option.

7.	 Double-click	a	period	to	open	the	G/L	Transaction	History	screen,
where	you	can	view	detailed	history	for	the	account	and	period.

Related	Topics
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Viewing	Source-Currency	Balances	for	a
Multicurrency	Account
In	a	multicurrency	General	Ledger,	you	can	display	source-currency	and
reporting-currency	balances	for	multicurrency	accounts.	More...

To	view	source-currency	account	balances:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Source	Currency

Inquiry.
2.	 In	the	Account	field,	enter	or	select	the	number	of	the	account	you

want	to	inquire	on.
3.	 In	the	Period	Ending	field,	select	the	year	and	period	for	which	you

want	to	view	balances.

4.	 If	you	selected	a	rollup	account	and	you	want	to	include	balances	for
member	accounts,	accounts,	select	the	Use	Rolled	Up	Amounts
option.

Rolled-up	amounts	then	appear	in	the	Source	Balance	and
Equivalent	Balance	columns.

5.	 To	view	detailed	information	for	the	account,	period,	and	currency	in
the	Transaction	History	screen,	double-click	the	line	for	the	currency.
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Comparing	Two	Fiscal	Sets
Use	the	G/L	Fiscal	Set	Comparison	screen	to	display	account	information
for	two	fiscal	sets,	comparing	the	net	changes	or	period	balances.	More...

To	compare	two	fiscal	sets:
1.	 Open	General	Ledger	>	G/L	Accounts	>		Fiscal	Set	Comparison.
2.	 In	the	Account	field,	enter	an	account	number	you	want	to	view,	or

use	the	Finder	to	select	one.

If	you	choose	a	rollup	account,	the	Use	Rolled	Up	Amounts	option
appears.

3.	 Select	the	Use	Rolled	Up	Amounts	option	(if	it	appears),	if	you	want
to	view	rolled-up	amounts	for	this	account.

4.	 Select	the	type	of	comparison	to	perform:

Select	Net	Change	to	compare	account	activity	between	two	fiscal
sets.
Select	Balance	to	view	changes	in	the	account	balance	for	two
fiscal	sets.

5.	 Use	the	Fiscal	Set	1	and	Year	fields	to	select	the	type	of	fiscal	set
and	the	year	for	the	first	fiscal	set	of	the	pair	you	are	comparing.

6.	 Use	the	Fiscal	Set	2	and	Year	fields	to	select	the	type	of	fiscal	set
and	the	year	for	the	second	fiscal	set.

7.	 If	General	Ledger	and	the	selected	account	are	multicurrency:

In	the	Currency	Type	field,	specify	whether	to	display	balances	in
the	source	currency	amounts	or	in	their	functional	currency
equivalents.

In	the	Currency	field,	specify	the	currency	of	the	balances	or	net
changes	that	you	want	to	view.

Note:	Transactions	can	be	posted	to	multicurrency	accounts	in
various	currencies.	When	you	specify	a	source	currency	in	the
Currency	field,	the	program	displays	only	balances	or	net	changes
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for	transactions	posted	to	the	account	in	that	currency.	You	can
choose	to	view	source	currency	amounts	or	their	functional
currency	equivalents.

8.	 Click	the	Go	 	button	to	display	the	accounts	you	have	specified.

Related	Topics
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Period-End	Procedures
Use	General	Ledger	Periodic	Processing	screens	to	perform	tasks	that
are	part	of	your	regular	period‐end	procedures,	such	as	clearing	history,
creating	general	ledger	batches,	and	deleting	inactive	records.

Performing	Period	End	Maintenance

Performing	Year	End	Processing

About	Consolidating	Transactions

Consolidating	Transactions

Clearing	General	Ledger	History

Creating	an	Allocation	Batch

Creating	a	Batch	of	Recurring	Entries

Creating	a	New	Year

Multicurrency	Procedures
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Performing	Period	End	Maintenance
Use	the	G/L	Period	End	Maintenance	screen	to:

Delete	unneeded	accounts,	transaction	details,	and	fiscal	sets.
Reset	the	current	batch	number	to	1.

Warning!	Period-end	maintenance	permanently	deletes	information
from	General	Ledger.	Before	performing	period-end	maintenance,	back
up	your	data.

You	can	perform	period-end	maintenance	after	creating	a	new	year	at	the
end	of	a	fiscal	year,	or	as	needed.

Before	you	start

To	perform	period-end	maintenance:
1.	 Open	General	Ledger	>	G/L	Periodic	Processing	>		Period	End

Maintenance.
2.	 Select	the	procedures	you	want	to	perform:

Delete	Inactive	Accounts.	You	can	delete	an	account	only	if	it:
Has	an	Inactive	status.
Has	zero	balances	for	the	current	year,	and	for	all	previous	years
for	which	you	retain	transaction	data.
Is	not	assigned	as	the	default	closing	account	on	the	G/L	Options
screen.	(If	necessary,	you	can	assign	a	different	account	number
to	be	the	default	account.)

Delete	Transaction	Detail	History	/	Delete	Fiscal	Set	History.
General	Ledger	deletes	historical	financial,	quantity,	and	budget
details	that	are	older	than	the	number	of	years	you	specified	for	the
Years	of	Fiscal	Sets	and	Years	of	Transaction	Detail	options	on	the
Posting	tab	of	the	G/L	Options	screen.
Reset	Batch	Number.	Use	this	option	to	set	the	batch	number
back	to	1.
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3.	 Click	Process.

Related	Topics
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Performing	Year	End	Processing
At	the	end	of	a	fiscal	year,	you	must	close	the	income	and	expense
accounts	for	the	old	year,	and	open	them	for	the	next	fiscal	year.

To	maintain	clear	and	complete	accounting	records,	there	are	other
procedures	you	should	follow	at	year	end.

Before	you	start

To	perform	year-end	processing:

1.	 Open	General	Ledger	>	G/L	Periodic	Processing	>		Create	New
Year.
a.	 Click	Process.
b.	 When	processing	has	finished,	click	Close.

2.	 Open	General	Ledger	>	G/L	Reports	>		Batch	Status.
a.	 Print	the	Batch	Status	report	for	the	transactions	created	by	the

Create	New	Year	screen.
b.	 Click	Close.

3.	 Open	General	Ledger	>	G/L	Reports	>		Posting	Journals.
a.	 Print	the	posting	journal	created	for	the	transactions	created	by	the

Create	New	Year	screen.
b.	 Click	Close.

4.	 Open	General	Ledger	>	G/L	Periodic	Processing	>		Period	End
Maintenance.
a.	 Select	Delete	Inactive	Accounts,	Delete	Transaction	Detail

History,	Delete	Fiscal	Set	History.
b.	 Click	Process	to	clear	prior-year	fiscal	sets	and	transaction	details

that	have	been	kept	for	the	number	of	years	specified	on	the
Posting	tab	of	the	G/L	Options	screen.

c.	 When	processing	has	finished,	click	Close.
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5.	 Back	up	your	data.

Related	Topics
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About	Consolidating	Transactions
Use	the	G/L	Consolidate	Posted	Transactions	screen	to	reduce	detail	in
reports	by	consolidating	(combining)	details	in	the	accounts	for	which	you
do	not	need	a	permanent	record	of	every	transaction.

If	you	have	some	accounts	that	you	consolidate	regularly	because	they
accumulate	detail	that	you	do	not	need,	you	should	consider	using	the
option	to	consolidate	those	accounts	during	posting.

Note:	When	you	consolidate	posted	transactions,	you	lose	the	ability	to
drill	down	to	the	original	transaction	in	the	source	ledger,	and	you	also
lose	any	optional	fields	posted	with	the	transaction.



About	Source	Journals	and	Consolidation
If	you	consolidate	details,	either	during	posting	or	at	period	end	using	the
Consolidate	Posted	Transactions	screen,	the	source	journal	cannot	print
the	batch	number	with	the	consolidated	details.

The	journal	also	cannot	print	the	posting	sequence	number	of
consolidated	transactions.

To	include	consolidated	transactions	on	a	source	journal,	when	you	print
the	source	journal,	you	must	specify	a	blank	as	the	starting	batch	or
posting	sequence	number	on	the	Ranges	tab	of	the	Source	Journal
Report	screen.



Effects	of	Consolidation
When	General	Ledger	consolidates	a	group	of	transactions,	the	individual
details	are	erased	and	cannot	be	listed	on	source	journals	or	on	the
Posted	Transactions	Listing.

Consolidation	removes	the	posting	entry	numbers	and	batch	entry
numbers	associated	with	details:

The	new	posting	sequence	number	is	0.
The	batch	number	and	entry	number	on	reports	is	CNSLD.
The	description	and	reference	fields	are	set	to	CONSOLIDATED.

To	determine	how	a	transaction	was	consolidated,	check	its	description
and	posting	sequence	number.

A	transaction	created	by	the	Consolidate	Posted	Transactions	screen
has	the	description	"CONSOLIDATED"	and	has	a	posting	sequence
number	of	0.	The	batch	number	is	000000.
A	transaction	consolidated	during	posting	has	the	description
"CONSOLIDATED	POSTING"	and	it	has	a	posting	sequence	number.



Consolidating	during	Posting
General	Ledger	also	lets	you	consolidate	transactions	during	batch
posting.

Use	the	Post	To	Account	In	Consolidated	option	on	the	Detail	tab	of
the	G/L	Chart	of	Accounts	screen	to	identify	the	accounts	you	want	to
consolidate	when	you	post	batches.

The	batch	number	and	entry	number	used	on	reports	is	CNSLD.
The	description	and	reference	fields	are	set	to	CONSOLIDATED
POSTING.



Recovering	Disk	Space	after	Consolidation
Consolidation	does	not	reduce	the	disk	space	taken	up	by	transactions.
Instead,	it	frees	up	space	within	the	existing	file,	so	the	file	will	not
continue	to	grow.

If	you	need	to	free	up	space	occupied	by	transactions,	you	must:

1.	 Consolidate	posted	transactions.
2.	 Use	the	database	utilities	for	your	database	to	reduce	the	file	size.

Related	Topics

javascript:mc65.Click()


Home	>	Period	End	Procedures	>	Consolidating	Transactions



Consolidating	Transactions
Use	the	G/L	Consolidate	Posted	Transactions	screen	to	reduce	detail	in
reports	by	consolidating	(combining)	details	in	the	accounts	for	which	you
do	not	need	a	permanent	record	of	every	transaction.

Important!	When	you	consolidate	transactions,	you	lose	any	optional
field	information	that	was	posted	with	the	transactions.

Before	you	start

To	consolidate	transactions:
1.	 Open	General	Ledger	>	G/L	Periodic	Processing	>		Consolidate

Posted	Transactions.
2.	 In	the	Consolidate	for	field,	specify	how	to	select	accounts	for

consolidation.

You	can	by	account	number	or	by	segment.

3.	 In	the	From	and	To	fields,	specify	the	range	of	account	numbers	or
segments	for	which	to	consolidate	posted	transactions.

4.	 In	the	Through	Period	Ending	field,	specify	the	last	fiscal	year	and
period	through	which	to	consolidate	transactions.

5.	 Use	the	Consolidate	By	fields	to	specify	whether	to	consolidate	by:
Account	and	fiscal	period,	where	all	transactions	for	the	same
account	and	fiscal	period	are	consolidated	into	one	transaction.	If
you	are	consolidating	by	account	and	fiscal	period,	enter	the	source
code	to	assign	to	consolidated	transactions.
Account,	fiscal	period	and	source	code,	where	transactions	are
consolidated	only	if	they	have	the	same	source	code.
Account,	fiscal	period,	and	source	ledger,	where	transactions	are
consolidated	if	they	share	the	same	source	ledger.	If	you	are
consolidating	by	account,	fiscal	period,	and	source	ledger,	select
the	ledgers	whose	transactions	you	are	consolidating,	as	well	as
the	source	code	to	assign	to	consolidated	transactions	from	the
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source	ledger.

If	you	use	a	multicurrency	ledger,	amounts	are	also	consolidated	by
source	currency.

6.	 Click	Process.

Related	Topics
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Clearing	General	Ledger	History
Use	the	G/L	Clear	History	screen	to:

Clear	all	information	for	printed	posting	journals.
Clear	information	for	deleted	and	posted	batches	(up	to	and	including
the	batch	number	you	specify).

Warning!	Information	and	statistics	that	match	the	criteria	you	specify
are	deleted	permanently.

Clear	history	at	the	end	of	a	fiscal	year	or	as	needed.

Before	you	start

To	clear	history:
1.	 Open	General	Ledger	>	G/L	Periodic	Processing	>		Clear	History.
2.	 If	you	want	to	clear	printed	posting	journals,	select	Clear	Printed

Posting	Journals	and	specify	the	posting	sequence	number	through
which	to	clear	history.

Important!	After	clearing	posting	journals,	you	can	no	longer	print
them.	Make	sure	you	have	copies	of	all	posting	journals	before	you
continue.

3.	 If	you	want	to	clear	deleted	and	posted	batches,	select	Clear
Deleted	And	Posted	Batches	and	specify	the	batch	number	through
which	to	clear	history.

4.	 Click	Process.
General	Ledger	clears	all	records	that	match	the	criteria	you
specified.	If	you	cleared	deleted	and	posted	batches,	those	batches
are	removed	from	the	G/L	Batch	List	and	from	the	G/L	Batch	Status
report.
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Related	Topics
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Creating	an	Allocation	Batch
Use	the	G/L	Create	Allocation	Batch	screen	to	create	a	batch	of
transactions	that	allocates	balances	in	accounts	that	use	the	Auto
Allocation	option	to	other	accounts,	and	creates	the	offsetting	details.
General	Ledger	calculates	the	amounts	to	distribute	to	each	account
based	on	the	information	entered	on	the	Allocation	tab	on	the	G/L
Accounts	screen	for	the	source	accounts.

Before	you	start

To	create	an	allocation	batch:
1.	 Open	General	Ledger	>	G/L	Periodic	Processing	>		Create

Allocation	Batch.
2.	 In	the	Batch	Description	field,	enter	a	brief	description	for	the	batch

using	up	to	60	characters.
3.	 In	the	Create	Batch	For	field,	specify	whether	to	use	the	full	account

number	or	one	of	the	account	segments	to	select	accounts	from
which	to	reallocate	balances.

4.	 Use	the	From	and	To	fields	to	specify	the	range	of	account	numbers
or	account	number	segments.

5.	 If	you	use	optional	fields,	check	or	change	the	optional	field
information	that	will	be	included	with	the	generated	transactions.
More...

6.	 Specify	the	journal	entry	date	and	the	fiscal	year	and	period	to	which
to	post	each	entry.

7.	 In	the	Allocation	Method	field,	specify	whether	to	allocate	account
balances,	quantities,	or	both	the	balances	and	the	quantities.

If	you	allocate	account	quantities,	also	specify	the	range	of	fiscal
periods	for	determining	the	net	changes	in	quantity.

8.	 Click	Process	to	generate	the	batch.

After	creating	an	allocation	batch
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Related	Topics
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Creating	a	Batch	of	Recurring	Entries
Use	the	G/L	Create	Recurring	Entries	Batch	screen	to	create	a	journal
entry	batch	consisting	of	a	single	recurring	entry	or	a	range	of	recurring
entries.

To	create	a	batch	of	recurring	entries:
1.	 Open	General	Ledger	>	G/L	Periodic	Processing	>		Create

Recurring	Entries	Batch.
2.	 In	the	Run	Date	field,	enter	that	date	to	determine	which	recurring

entries	are	due	to	be	processed.	It	includes	all	entries	up	to	the	date
specified.

3.	 Use	the	From	Recurring	Entry	Code	and	To	Recurring	Entry
Code	fields	to	specify	range	of	codes	for	which	to	process	recurring
entries.

Tip:	To	process	a	single	recurring	entry	code,	enter	the	same	code
in	both	fields.

4.	 In	the	Method	field,	specify	how	to	create	the	batch:

Default.	If	you	select	this	method,	the	batch	will	be	appended	to	an
open	batch	if	both	batches	have	the	same	run	date;	otherwise,	a
new	batch	is	created.
Create	a	New	Batch.	If	you	select	this	method,	a	new	batch	is
created.
Add	to	an	Existing	Batch.	If	you	select	this	method,	you	use	the
adjacent	field	that	appears	to	specify	an	existing	open	batch	to
which	to	add	this	batch.	(The	run	date	for	the	existing	batch	can	be
different	than	the	batch	you	are	creating.)

5.	 Click	Process.

Note:	Any	transactions	details	optional	fields	and	values	specified
for	the	recurring	entry	code	will	be	used	in	the	resulting	transaction
details.



Related	Topics
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Creating	a	New	Year
At	the	end	of	a	fiscal	year,	you	use	the	Create	New	Year	screen	to	create
and	post	a	batch	of	transactions	to	close	income	and	expense	accounts
and	enter	the	opening	account	balances	for	the	new	fiscal	year.

Note:	The	Create	New	Year	screen	does	not	check	account
permissions.

If	you	use	single-segment	account	numbers,	all	accounts	are	closed	to
the	default	closing	account	specified	on	the	G/L	Options	screen.	If	you
use	multi-segment	account	numbers,	you	provide	information	on	three
separate	screens	to	specify	the	retained	earnings	account	to	which	an
account	is	closed.	More...

Before	you	start

To	create	a	new	year:
1.	 Open	Common	Services	>	Fiscal	Calendar,	and	then:
a.	 Create	a	fiscal	calendar	for	the	next	year.
b.	 Ensure	that	the	closing	period	for	the	current	year	is	not	locked.

2.	 Open	General	Ledger	>	G/L	Periodic	Processing	>		Create	New
Year.

3.	 Click	Proceed.
Each	transaction	detail	is	assigned	the	source	code	GL-CL,	and	is
posted	to	the	closing	period.

After	creating	a	new	year

Related	Topics
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Multicurrency	Periodic	Processes
This	section	describes	processes	that	you	may	need	to	perform	in	a
multicurrency	ledger	at	year	end	or	period	end.

About	Converting	to	Euro

Switching	the	Currency	Translation	Method

About	Revaluation

Creating	a	Revaluation	Batch
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About	Converting	to	Euro
If	your	company	is	based	or	operating	in	the	euro	zone	(that	is,	a	member
country	of	the	European	Monetary	Union),	and	you	want	to	maintain
accounts	and	financial	statements	both	in	euro	units	and	national
currency	units,	the	Company	Profile	screen	in	Common	Services
provides	options	that	let	you:

Select	the	euro	as	your	functional	(home)	currency
Select	your	national	currency	as	a	reporting	currency.

Sage	300	ERP	supports	the	euro	but	does	not	provide	a	conversion	utility
to	automate	the	transition	from	a	previous	functional	currency	to	the	euro.
If	you	already	have	a	Sage	300	ERP	General	Ledger	in	another	currency,
and	you	need	to	convert	your	functional	currency	to	euro,	you	must	set
up	a	new	general	ledger	by:

1.	 Printing	your	old	general	ledger	in	your	home	currency	to	ensure	that
you	have	all	closing	balances	on	hand.

2.	 Creating	a	new	general	ledger,	selecting	the	euro	as	your	functional
currency	and	designating	a	reporting	currency.	Your	new	general
ledger	can	be	set	up	with	any	starting	date	for	the	fiscal	year	as	long
as	you	enter	opening	balances	with	detail	lines	later	than	January	1,
1999.

3.	 Using	the	closing	balance	from	all	financial	reports	to	enter	opening
balances	in	euro.

You	can	add	opening	balances	to	the	first	period	of	the	new	fiscal
year.	If	you	convert	to	the	euro	immediately	after	closing	a	year,	you
need	to	transfer	only	balance	sheet	balances	to	the	new	general
ledger.
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Switching	the	Accounting	Method	for	Foreign
Currency	Translation
In	this	topic,	we	use	an	example	to	explain	the	procedure	for	switching
the	gain/loss	accounting	method	for	currency	translation.	More...

Example:

Sample	Company	Ltd	is	a	multicurrency	company.	Its	functional
currency	is	Canadian	dollars.

In	the	fiscal	year	2019,	Sample	Company	Ltd	used	the	Realized
and	Unrealized	Gain/Loss	accounting	method.	The	company
revalues	balances	of	monetary	accounts	once	a	year.

There	is	only	one	US	customer,	and,	as	of	December	31,	2019,	their
balance	in	USD	is	1,000.00	with	CAD	equivalent	of	1,500.00.
Sample	Company	Ltd	maintains	a	USD	bank	account,	with	a
balance	in	the	account	of	5,000.00	as	of	December	31,	2019.

The	CAD	equivalent	functional	amount	is	6,750.00.

Sample	Company	Ltd	wants	to	switch	to	the	Recognized
Gain/Loss	accounting	method	as	of	January	1,	2020.

Before	you	start

Steps	to	take	in	2019:

1.	 In	Accounts	Receivable,	revalue	the	balances	of	your	accounts
receivable.

Assume	that	the	exchange	rate	on	December	31,	2019	is	1	USD	=
1.4000	CAD.	Thus,	when	revaluation	is	performed	in	A/R,	the
following	reversing	G/L	entry	is	created	on	December	31,	2019:

G/L	Account Source
Currency

Functional
Currency
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	 Debit Credit Debit Credit
Receivables	Control 0.00 0.00 0.00 100.00
Unrealized	Exchange
Loss

0.00 0.00 100.00 0.00

[(1.4000	x	1,000)	-	1,500	=	100.00]

2.	 In	General	Ledger:
a.	 Open	General	Ledger	>	G/L	Periodic	Processing	>		Create

Revaluation	Batch,	and	then	revalue	the	balance	of	USD	bank
accounts,	using	1	USD	=	1.4000	CAD	as	the	exchange	rate	for
Year/Period	2019-12.

The	G/L	revaluation	creates	the	following	reversing	entry	on
December	31,	2019:

G/L	Account Source
Currency

Functional
Currency

	 Debit Credit Debit Credit
USD	Bank 0.00 0.00 250.00 0.00
Unrealized	Exchange
Gain

0.00 0.00 0.00 250.00

[(5,000	x	1.4000)	-	6,750	=	250.00]

b.	 Open	General	Ledger	>	G/L	Reports	>		Trial	Balance	Report,
and	then	print	the	report.

The	report	shows	the	following	entries:

G/L	Account Source
Currency

Functional
Currency

	 Debit Credit Debit Credit
USD	Bank 5,000.00 	 7,000.00 	
Receivables	Control 1,000.00 	 1,400.00 	
Unrealized	Exchange
Gain

	 	 	 250.00

Unrealized	Exchange 	 	 100.00 	



Loss

c.	 Open	General	Ledger	>	G/L	Periodic	Processing	>		Create	New
Year,	and	then	click	Process.

Steps	to	take	in	2020:

1.	 In	General	Ledger,	post	the	reversing	revaluation	entries	created	by
the	2019	revaluation:

G/L	Account Source
Currency

Functional
Currency

	 Debit Credit Debit Credit
Receivables	Control 0.00 0.00 100.00 0.00
Unrealized	Exchange
Loss

0.00 0.00 0.00 100.00

[(1.4000	x	1,000)	-	1,500	=	-100.00]

G/L	Account Source
Currency

Functional
Currency

	 Debit Credit Debit Credit
USD	Bank 0.00 0.00 100.00 250.00
Unrealized	Exchange
Gain

0.00 0.00 250.00 0.00

[(5,000	x	1.4000)	-	6,750	=	250.00]

2.	 In	Common	Services:
a.	 Open	Company	Profile,	and	then	click	the	Options	tab.
b.	 In	the	Gain/Loss	Accounting	Method	field,	select	Recognized

Gain/Loss.
c.	 Click	Save.

3.	 In	General	Ledger:
a.	 On	the	G/L	Accounts	screen,	create	new	accounts	for	Recognized

Exchange	Gain	and	Recognized	Exchange	Loss.



b.	 On	the	Revaluation	Codes	screen,	modify	existing	revaluation
codes	or	create	new	ones.

c.	 Assign	the	new	revaluation	codes	to	the	new	exchange	gain	and
loss	accounts.

4.	 In	Accounts	Receivable:
a.	 Modify	existing	account	sets	or	create	new	account	sets	for	the

USD	customers.
b.	 Revalue	the	balances	of	your	accounts	receivable.

In	our	example,	we	assume	that	the	exchange	rate	on	January	31,
2020	is	1	USD	=	1.6500	CAD.	Thus,	when	revaluation	is	performed
in	Accounts	Receivable,	the	following	General	Ledger	entry	is
created	on	January	31,	2020:

G/L	Account Source	Currency Functional	Currency
	 Debit Credit Debit Credit

Receivables	Control 0.00 0.00 150.00 0.00
Exchange	Gain 0.00 0.00 0.00 150.00
[(1.6500	-	1.5000)	x	1,000	=	-150.00]	

5.	 In	General	Ledger:
a.	 Revalue	the	balance	of	the	USD	Bank	account	using	1	USD	=

1.6500	CAD	as	the	exchange	rate	for	Year/Period	2020-01.	The
General	Ledger	revaluation	creates	the	following	entry	on	January
31,	2020:

G/L	Account Source	Currency Functional	Currency
	 Debit Credit Debit Credit

USD	Bank 0.00 0.00 1,500.00 0.00
Exchange	Gain 0.00 0.00 0.00 1,500.00
[(5,000	x	1.650)	-	6,750	=	-1500.00]	

b.	 Print	the	Trial	Balance	report.

The	multicurrency	accounts	display	the	following	values	for



January	31,	2020:

G/L	Account Source
Currency

Functional
Currency

	 Debit Credit Debit Credit
USD	Bank 5,000.00 	 8,250.00 	
Receivables	Control 1,000.00 	 1,650.00 	
Unrealized	Exchange
Gain

	 	 	 0.00

Unrealized	Exchange
Loss

	 	 0.00 	

Exchange	Gain 	 	 	 1,650.00
Exchange	Loss 	 	 0.00 	
[(5,000	+	1,000)	x	1.6500	-	(1,500	+	6,750)	=	1,650.00]

Important!
At	the	transaction	date,	each	asset,	liability,	revenue,	or	expense
arising	from	a	foreign	currency	transaction	of	the	recording	entity
should	be	translated	into	functional	currency	using	the	exchange
rate	in	effect	at	the	date	of	the	transaction.
At	each	balance	sheet	date,	recorded	balances	of	monetary	assets
and	liabilities	that	are	denominated	in	a	currency	other	than	the
functional	currency	of	the	recording	entity	should	be	adjusted	to
reflect	the	current	(spot)	exchange	rate.	The	resulting	exchange
gain	or	loss	should	be	included	(that	is,	recognized)	in	the	net
income	for	the	current	period.
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About	Revaluation
Use	the	G/L	Create	Revaluation	Batch	screen	to	revalue	the	functional-
currency	equivalents	of	each	specified	source-currency	amount	using	the
exchange	rate	you	enter.

When	you	create	a	revaluation	batch,	General	Ledger:

Recalculates	the	functional-currency-equivalent	values	of	source-
currency	account	balances	at	new	exchange	rates.
Creates	a	transaction	for	the	difference	between	the	old	functional-
currency-equivalent	and	the	new	value,	posting	the	difference	to	the
account	being	revalued	and	to	the	unrealized	exchange	gain/loss
accounts	or	to	the	recognized	exchange	gain/loss	accounts.

The	revaluation	code	assigned	to	an	account	determines:

The	rate	type	that	is	used	to	display	the	default	exchange	rate.
The	source	code	to	assign	to	revaluation	transactions.
The	exchange	gain/loss	accounts	to	which	exchange	differences	are
posted.



Revaluation	Methods
The	Gain/Loss	Accounting	Method	selected	for	your	company	(in	the
Company	Profile	screen	in	Common	Services)	determines	how	exchange
gains	and	losses	are	calculated.	The	choices	are:

Realized/Unrealized	Gain/Loss	Method.	This	method	records
transactions	for	the	unrealized	gains	and	losses	in	each	fiscal	period
you	revalue.	Revaluation	creates	an	automatically	reversing	entry	for
the	difference	between	the	original	functional‐currency	equivalent
balance	and	the	revalued	functional‐currency	equivalent	balance	in
each	fiscal	period	you	revalue.	Because	the	transactions
automatically	reverse,	the	effect	of	revaluation	is	completely	backed
out	in	the	fiscal	period	following	the	last	fiscal	period	you	specify	for
revaluation.

Note:

If	you	revalue	accounts	in	the	last	period	of	a	year,	you	must	create
the	new	year	before	you	post	the	revaluation	batch	because	the
reversing	entry	will	be	posted	to	the	new	year.

You	must	specify	unrealized	exchange	gain	and	loss	balance	sheet
accounts	for	a	revaluation	code	before	you	can	create	a	revaluation
batch	using	that	code.

Recognized	Gain/Loss	Method.	Under	this	method,	revaluation
transactions	are	considered	permanent,	so	no	reversing	entries	are
created.

Entries	are	assigned	to	the	next	open	batch,	which	you	can	view,
edit,	and	post	in	the	same	way	as	other	batches.

Note:	You	must	specify	recognized	gain	and	loss	income	statement
accounts	for	a	revaluation	code	before	you	can	create	a	revaluation
batch	using	that	code.

The	program	uses	the	session	date	to	determine	the	default	period



for	revaluation.	If	you	specify	a	range	of	periods,	the	system	warns
you	to	check	your	selection	carefully,	because	the	transactions	will	be
revalued	permanently.

As	an	extra	precaution,	the	system	does	not	allow	you	to	use	the
Create	Revaluation	Batch	screen	if	there	are	any	unposted
revaluation	entries.	You	must	delete	or	post	any	existing	revaluation
entries	first.

Note:	If	you	choose	the	Recognized	Gain/Loss	Method,	and	then	save
the	Company	Profile,	you	cannot	revert	to	the	Realized/Unrealized
Gain/Loss	method.	Also,	you	must	specify	Exchange	Gain	and
Exchange	Loss	accounts	for	each	revaluation	code.	(The	program	does
not	use	the	Unrealized	Gain/Loss	accounts	specified	under	the
Realized	and	Unrealized	Gain/Loss	method	as	default	Exchange	Gain
and	Exchange	Loss	accounts.)



Forcing	Revaluation	of	Multicurrency	Account
Balances
The	Create	Revaluation	Batch	screen	provides	an	option	that	lets	you
force	the	revaluation	of	account	balances,	for	example,	before	preparing
financial	statements.

When	you	revalue	a	currency	without	forcing	revaluation,	only	accounts
that	satisfy	all	the	following	conditions	are	revalued:

The	account	falls	within	the	range	of	accounts	you	specify	on	the
Create	Revaluation	Batch	screen.
The	account	posts	to	the	selected	currency.	(That	is,	the	currency	is
listed	on	the	currency	tab	of	the	G/L	Accounts	screen.)
Revaluation	is	set	to	Yes	for	the	selected	currency	on	the	G/L
Accounts	screen.
A	revaluation	code	has	been	assigned	to	the	account	for	the	selected
currency	on	the	G/L	Accounts	screen.

When	you	force	revaluation,	only	accounts	that	satisfy	all	the	following
conditions	are	revalued:

The	account	falls	within	the	range	of	accounts	you	specify	on	the
Create	Revaluation	Batch	screen.
The	account	posts	to	the	selected	currency.

Revaluation	is	set	to	No	for	the	selected	currency	on	the	G/L	Account
screen.

If	the	currency	is	not	listed	(even	if	the	account	accepts	posting	from
all	currencies),	the	account	is	not	revalued.

The	default	revaluation	code	you	specify	on	the	Create	Revaluation
Batch	screen	is	used	to	revalue	the	accounts.
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Creating	a	Revaluation	Batch
Use	the	G/L	Create	Revaluation	Batch	screen	to	revalue	the	functional-
currency	equivalents	of	each	specified	source-currency	amount	using	the
exchange	rate	you	enter.

When	you	create	a	revaluation	batch,	General	Ledger:

Recalculates	the	functional-currency-equivalent	values	of	source-
currency	account	balances	at	new	exchange	rates.
Creates	a	transaction	for	the	difference	between	the	old	functional-
currency-equivalent	and	the	new	value,	posting	the	difference	to	the
account	being	revalued	and	to	the	unrealized	exchange	gain/loss
accounts	or	to	the	recognized	exchange	gain/loss	accounts.

The	revaluation	code	assigned	to	an	account	determines:

The	rate	type	that	is	used	to	display	the	default	exchange	rate.
The	source	code	to	assign	to	revaluation	transactions.
The	exchange	gain/loss	accounts	to	which	exchange	differences	are
posted.

Before	you	start

To	create	a	batch	of	revaluation	transactions:
1.	 Open	General	Ledger	>	G/L	Periodic	Processing	>		Create

Revaluation	Batch.
2.	 In	the	Batch	Description	field,	type	a	brief	description	for	this

revaluation	(such	as	Currency	devaluation	05/05/2019).	You	can	use
up	to	60	characters	for	the	description.

3.	 Tab	to	the	first	line	in	the	table.
4.	 In	the	Currency	Code	field,	type	or	select	the	code	for	the	source

currency	that	you	are	revaluing.
5.	 In	the	Revalue	By	field,	specify	how	to	select	accounts	for

revaluation.
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You	can	select	accounts	by	account	number	or	by	segment.

6.	 In	the	From	and	To	fields,	specify	a	range	of	account	numbers	or
segment	codes	to	revalue.

7.	 If	you	use	optional	fields,	check	or	change	the	optional	fields
assigned	to	the	revaluation	batch.	More...

Note:	Optional	field	information	is	included	in	the	journal	entry
details	only	if	the	optional	fields	in	the	revaluation	match	the
transaction	optional	fields	assigned	to	the	affected	exchange
gain/loss	accounts.

8.	 Specify	the	Revaluation	Code.	The	code	you	select	determines	the
rate	type	to	use	when	revaluing	balances,	as	well	as	the	source	code
and	exchange	gain	or	loss	account	to	which	to	post	the	resulting
transactions.

9.	 Use	the	Fiscal	Year,	From	Period,	and	To	Period	fields	to	specify
the	fiscal	year	and	the	range	of	fiscal	periods	to	include	in	the
revaluation.

10.	 In	the	J/E	Date	field,	enter	the	journal	entry	date.	(The	default	date	is
the	session	date.)

11.	 In	the	Revaluation	Rate	and	Rate	Date	fields,	enter	the	exchange
rate	and	date	at	which	to	revalue	account	balances.

12.	 Specify	whether	or	not	to	force	currency	revaluation.	More..

13.	 Enter	as	many	currencies	as	you	need	to	revalue,	and	then	click
Process.

After	creating	a	revaluation	batch

Related	Topics
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Printing	General	Ledger	Reports
Use	General	Ledger	Reports	screens	to	print	reports	of	general	ledger
transactions	and	maintain	your	audit	trail.

About	General	Ledger	Reports

About	Reporting	Currency

General	Ledger	Reports

Printing	Tips
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About	General	Ledger	Reports
General	Ledger	prints	two	main	types	of	reports:

Audit	reports	that	provide	you	with	transaction	listings	and	status
information	(such	as	batch	listings,	posting	journals,	source	journals,
the	chart	of	accounts,	and	the	trial	balance).
Financial	statements	(such	as	balance	sheets,	income	statements,
and	statements	of	changes	in	financial	position).

For	an	introduction	to	Financial	Reporter,	which	you	use	to	print
these	statements,	see	About	Financial	Reporter.

If	you	have	a	multicurrency	ledger,	these	reports	can	also	include	source
and	functional-currency	(home	currency)	information	(on	letter	size,	legal
size,	or	A4	paper).

Note:

Posting	journals	are	required	reports	that	provide	the	audit	trail	for
batches.
You	cannot	print	batch	listings	for	deleted	and	posted	batches.	If
you	need	to	list	a	posted	batch,	set	up	a	source	journal	that	includes
all	the	source	codes	likely	to	have	been	used	in	the	batch,	then
choose	the	batch	number	as	the	first	means	of	selection	when	you
are	preparing	to	print	the	journal.
Source	journals	do	not	include	comments	or	transactions	that	were
consolidated	on	posting.	If	you	need	this	additional	information,	print
the	posting	journal.
Batch	listings	are	optional	unless	you	select	the	Force	Listing	Of
Batches	option	for	General	Ledger.	If	you	use	the	Force	Listing	Of
Batches	option,	you	must	print	every	batch	before	you	can	post	it.

After	you	list	a	batch,	its	status	will	be	Printed	on	the	batch	status
report.



Related	Topics
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About	Reporting	Currency
The	reporting	currency	is	a	Currency	Type	option	that	appears	in
General	Ledger	to	enable	euro-based	companies	operating	in	a
European	Monetary	Union	member	state	to	report	transaction	amounts
and	account	balances	in	their	national	currency	while	using	the	euro	as
their	functional	(home)	currency.

The	Reporting	option	is	available	only	in	multicurrency	ledgers	if	the
euro	is	your	functional	currency	and	you	specified	a	reporting	currency.
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General	Ledger	Reports
Use	General	Ledger	Reports	screens	to	print	reports	of	general	ledger
transactions	and	maintain	your	audit	trail.

Account	Groups	Report

Account	Structures	Report

Batch	Listing	Report

Batch	Status	Report

Chart	of	Accounts	Report

Create	Accounts	Preview	Report

Optional	Fields	Report

Options	Report

Posting	Journals	Report

Recurring	Entries	Report

Revaluation	Codes	Report

Segment	Codes	Report

Source	Codes	Report

Source	Journal	Profiles	Report

Source	Journals	Report

Transaction	Details	Optional	Fields	Report

Transactions	Listing	Report

Trial	Balance	Report
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Printing	the	G/L	Account	Groups	Report
The	G/L	Account	Groups	report	lists	account	group	codes,	along	with
their	descriptions,	sort	codes,	and	group	categories.

Before	you	start

To	print	the	G/L	Account	Groups	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Account	Groups.
2.	 In	the	Select	By	field,	specify	whether	to	select	and	list	account

groups	by	account	group	or	by	sort	code	and	account	group.	one	of
the	following:

3.	 Use	the	From	and	To	fields	to	specify	the	range	of	account	groups	or
sort	code	and	account	group	(depending	on	your	choice	in	the	Select
By	field)	to	include	on	the	report.

4.	 Click	Print.
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Printing	the	G/L	Account	Structures	Report
The	G/L	Account	Structures	report	lists:

The	account	structure	codes	in	the	range	you	selected.
The	description	for	each	code.
The	segments	included	in	each	account	structure,	in	the	order	they
appear.

Every	account	you	define	must	have	at	least	one	structure	code.

Before	you	start

To	print	the	Account	Structures	report:

1.	 There	are	two	ways	to	open	the	Account	Structures	Report	screen:

Open	General	Ledger	>	G/L	Setup	>		Account	Structures,	and
then	click	File	>	Print.
Open	General	Ledger	>	G/L	Reports	>		Account	Structures.

2.	 Use	the	From	Structure	Code	and	To	Structure	Code	fields	to
specify	the	range	of	account	structure	codes	to	include	on	the	report.

3.	 Click	Print.

Related	Topics
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Printing	the	G/L	Batch	Listing	Report
The	Batch	Listing	report	lists	the	contents	of	open	(unposted)	and	posted
batches.	Use	it	to	check	batches	before	you	post	them.

Batch	listings	are	optional	unless	you	select	the	Force	Listing	Of	Batches
option	for	General	Ledger.	If	you	use	the	Force	Listing	Of	Batches	option,
you	must	print	every	batch	before	you	can	post	it.

Note:

Some	printing	options	are	not	available	or	are	restricted	for
Intercompany	Transactions	(ICT)	companies.	More...

Before	you	start

To	print	the	Batch	Listing	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Batch	Listing.

Tip:	You	can	also	open	the	Batch	Listing	Report	screen	from	the
G/L	Batch	List	screen.	(Click	File	>	Print.)

2.	 Use	the	From	and	To	fields	to	specify	batch	selection	criteria,	as
follows:

a.	 Specify	a	range	of	batch	numbers.
b.	 Specify	a	range	of	source	ledgers.	More...
c.	 Specify	a	range	of	batch	creation	dates.

The	default	range	includes	all	batches	from	the	first	day	of	the
fiscal	year	to	the	session	date.

3.	 In	the	Include	section,	specify	optional	information	to	include	in	the
report.	More...

4.	 Select	the	types	of	batches	you	want	to	print.	More...
5.	 Select	the	status	of	the	batches	you	want	to	print.	More...
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6.	 If	your	General	Ledger	is	multicurrency,	select	Functional	or	Source
and	Functional	in	the	Currency	section.

7.	 If	you	selected	Source	and	Functional	for	the	currency,	specify	a
paper	size.	More...

8.	 Click	Print.

Note:	The	status	of	listed	batches	will	be	"Printed"	on	the	batch
status	report.

After	printing	the	Batch	Listing	Report

Related	Topics
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Printing	the	G/L	Batch	Status	Report
The	G/L	Batch	Status	report	shows	all	activity	that	has	taken	place	in	all
currently	unposted	batches,	and	in	batches	that	were	posted	or	deleted
since	the	last	time	the	report	data	was	cleared.

Note:

Some	printing	options	are	not	available	or	are	restricted	for
Intercompany	Transactions	(ICT)	companies.	More...

Before	you	start

To	print	the	Batch	Status	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Batch	Status.

Tip:	You	can	also	open	the	Batch	Status	Report	screen	from	the
G/L	Batch	List	screen.	(Click	File	>	Print	Batch	Status	Report.)

2.	 Use	the	From	and	To	fields	to	specify	batch	selection	criteria:
a.	 Specify	a	range	of	batch	numbers.	The	default	range	includes	all

open	batches.
b.	 Specify	a	range	of	source	ledgers.	More...
c.	 Specify	a	range	of	batch	creation	dates.

The	default	range	includes	all	batches	from	the	first	day	of	the
fiscal	year	to	the	session	date.

3.	 Select	the	types	of	batches	you	want	to	print.	More...
4.	 Select	the	status	of	the	batches	you	want	to	print.	More...
5.	 Click	Print.

After	printing	the	Batch	Status	Report
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Related	Topics
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Printing	the	G/L	Chart	of	Accounts	Report
The	Chart	of	Accounts	Report	lists	all	or	a	range	of	General	Ledger
accounts	according	to	the	selection	criteria	and	the	sort	and	format
criteria	you	specify.

At	printing	time,	you	can	select	accounts	by	account	number,	segment,
account	group,	account	sorted	group,	or	optional	field.	Then	specify	the
type	of	report	and	range	of	entries,	either	accounts	or	segments,	you
want	to	print.

Before	you	start

To	print	the	Chart	of	Accounts	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Chart	of	Accounts.
2.	 In	the	Report	Format	field,	select	one	of	the	following	formats	from

the	list:

Detail	–	Short	Form.	Shows	basic	setup	information,	including
account	number,	description,	status,	account	configuration,	and
consolidation	and	allocation	options.
Detail	–	Long	Form.	Prints	short	form	information	plus	account
groups	and	segment	closed	to.

You	can	also	choose	whether	to	include	the	optional	account	and
transaction	details	fields	(and	their	values)	that	are	defined	for	each
account.

Valid	Currencies.	Shows	the	currencies	that	are	valid	for	each
multicurrency	account,	whether	revaluation	is	allowed,	and,	if	so,
the	revaluation	code.
Allocation.	Shows	the	accounts	to	which	balances	are	allocated,
along	with	the	percentages	going	to	each	account.
Control	Account	Subledgers.	Lists	the	control	accounts	in	the
general	ledger,	along	with	the	subledgers	that	use	them.
Fiscal	Set	Comparison.	Lets	you	compare	the	net	changes	in
accounts	for	two	fiscal	sets.	Your	choices	for	comparison	are

javascript:void(0);


Actual,	Budget	1	through	Budget	5,	Provisional,	Quantity,	and
Provisional	Quantity.

Fiscal	set	comparison	options	include	Budget	sets	2	through	5	only
if	you	are	using	Sage	300	Premium	ERP.

Rollup	Accounts.	A	report	that	shows	all	rollup	accounts	and	their
directly	related	rollup	member	accounts.	You	can	also	print	a	list	of
all	rollup	accounts	related	to	a	member	account	or	to	a	group	of
member	accounts.

3.	 If	you	selected	Fiscal	Set	Comparison	as	the	report	format,	on	the
screen	that	appears,	specify	the	two	sets	of	figures	you	want	to
compare:

a.	 In	the	Compare	Fiscal	Set	1	and	Compare	Fiscal	Set	2	fields,
specify	the	fiscal	set	data	type.

b.	 Specify	the	year	for	each	fiscal	set	you	are	comparing.
c.	 If	General	Ledger	is	multicurrency:

i.	 In	the	Using	field,	specify	whether	to	display	figures	in
Functional	or	Source	currency

ii.	 In	the	For	Currency	field,	specify	the	currency.
If	the	euro	is	your	functional	currency	and	you	specified	a
reporting	currency,	you	can	select	the	Reporting	Currency	option.
The	report	then	prints	amounts	in	the	reporting	currency
(obtained	from	the	reporting	fiscal	set).

4.	 To	exclude	accounts	that	have	zero	balances	and	that	had	no
transactions	in	the	specified	period	range,	select	Exclude	Accounts
with	No	Activity.

Note:	You	must	select	the	same	year	in	both	the	From	field	and	the
To	field.

5.	 To	print	a	set	of	common	account	groups,	but	not	other	account
groups,	select	Select	Account	Groups	by	Sort	Code	Range.

Note:	All	account	groups	in	the	set	must	use	the	same	sort	code	to



print	in	order	of	sort	code.

6.	 To	exclude	inactive	accounts,	select	Exclude	Inactive	Accounts.
7.	 If	you	use	optional	fields	and	you	are	printing	the	long	form	of	the

report,	you	can	include	optional	field	information	on	the	report.

Click	the	Include	Optional	Field	option	to	include	this	information	on
the	report.

8.	 If	you	are	printing	the	Rollup	Accounts	report,	in	the	Show	field,
select	Members	or	Rollup	Accounts.

9.	 Select	the	sort	order	for	the	report,	and	a	range	of	the	item	by	which
you	are	sorting.	More...

10.	 Select	accounts	by	specifying	ranges	of	account	groups,	account
sorted	groups,	account	number	segments	(that	you	have	not	already
been	specified	as	the	sort	order),	or	the	range	of	optional	fields.

11.	 Click	Print.

Related	Topics
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Printing	the	G/L	Create	Accounts	Preview
Report
You	print	this	report	when	you	are	creating	accounts	by	copying	a	set	of
model	account	using	the	Create	Accounts	screen,	and	you	want	to	print	a
listing	of	the	preview	accounts	before	you	generate	them.

For	more	information,	see	Creating	Accounts	Automatically.
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Printing	the	G/L	Optional	Fields	Report
This	report	lists	the	optional	account	fields	and	the	optional	transaction
fields	you	have	defined	for	General	Ledger.

Before	you	start

To	print	the	Optional	Fields	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Optional	Fields.
2.	 Click	Print.

Related	Topics

javascript:void(0);
javascript:mc77.Click()


Home	>	Printing	Reports	>	General	Ledger	Reports	>	Options	Report



Printing	the	G/L	Options	Report
The	G/L	Options	report	lists	the	options	selected	and	information	entered
on	the	G/L	Options	screen,	including	the	following:

Account	number	segments	defined	for	your	ledger,	and	the
descriptions	associated	with	those	segments.
Which	(if	any)	budget	sets	are	locked.
Posting	preferences.

Before	you	start

To	print	the	Options	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Options.

Tip:	You	can	also	open	the	Options	Report	screen	by	clicking	File	>
Print	on	the	G/L	Options	screen.

2.	 Click	Print.
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Printing	the	G/L	Posting	Journals	Report
Posting	journals	provide	an	audit	trail	report	of	all	posted	General	Ledger
transactions	that	you	have	not	yet	cleared	from	your	system.

You	can	reprint	journals	as	often	as	you	need,	until	you	clear	them	using
the	G/L	Clear	History	screen.

In	multicurrency	ledgers,	you	can	print	both	source-currency	and
functional-currency	information	on	journals	(on	letter,	ledger,	or	A4
paper).

Note:

Some	printing	options	are	not	available	or	are	restricted	for
Intercompany	Transactions	(ICT)	companies.	More...

Before	you	start

To	print	posting	journals:
1.	 Open	General	Ledger	>	G/L	Reports	>		Posting	Journals.
2.	 Select	the	type	of	journal	you	want	to	print.	More...
3.	 Specify	whether	to	order	the	report	by	posting	sequence	or	account

number.
4.	 Specify	the	range	of	posting	sequences	to	include	in	the	report.

5.	 Select	Reprint	Previously	Printed	Journals	to	print	journals	that
have	already	been	printed	to	a	printer	or	file,	or	if	you	are	printing	the
Posting	Journal	Errors	report.

6.	 Select	Include	Trans.	Optional	Fields	to	print	information	from
optional	fields	posted	with	transaction	details.

Note:	This	option	is	not	available	for	an	ICT	company.

7.	 If	you	are	printing	the	journal	for	an	ICT	company,	select	a	format
from	the	ICT	Expansion	field.	More...
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Note:	If	you	are	not	printing	the	journal	for	an	ICT	company,	skip
this	step.

8.	 If	you	have	a	multicurrency	ledger,	in	the	Currency	section,	specify
whether	to	print	amounts	in	your	functional	currency	or	in	both	source
and	functional	currency.

Note:	If	the	euro	is	your	functional	currency	and	a	reporting
currency	is	specified	for	your	system,	you	can	select	Reporting	to
print	amounts	in	your	reporting	currency	from	the	reporting	fiscal
set.

9.	 If	you	selected	Source	and	Functional	as	the	Currency	option,	specify
a	paper	size.

10.	 Click	Print.

After	printing	posting	journals

Related	Topics
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Printing	the	G/L	Recurring	Entries	Report
The	recurring	entries	report	lists	recurring	journal	entries	set	up	using	the
G/L	Recurring	Entries	screen.

This	report	lists	recurring	entries	by	code,	states	which	account(s)	the
codes	pertain	to,	and	shows	the	type	of	schedule	and	its	frequency.	It	can
also	include	optional	fields	entered	with	transaction	details,	if	you	choose
to	include	them.

Before	you	start

To	print	the	Recurring	Entries	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Recurring	Entries.
2.	 In	the	From	Recurring	Entry	Code	and	To	Recurring	Entry	Code

fields,	specify	the	range	of	recurring	entry	setup	codes	to	include	on
the	report.

3.	 If	you	want	to	print	the	schedule	associated	with	each	recurring
charge,	select	Include	Schedules.

4.	 If	you	want	to	include	optional	field	information	with	each	recurring
entry	detail	that	uses	them,	select	Include	Trans.	Optional	Fields.

5.	 Click	Print.
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Printing	the	G/L	Revaluation	Codes	Report
This	report	lists	specified	revaluation	codes	and	the	information	entered
to	define	them	in	a	multicurrency	ledger.

Before	you	start

To	print	the	Revaluation	Codes	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Revaluation	Codes

Report.

Tip:	You	can	also	click	File	>	Print	on	the	Revaluation	Codes
setup	screen	to	open	the	report	screen.

2.	 Specify	the	range	of	revaluation	codes	to	include	on	the	list.

3.	 Click	Print.

Related	Topics
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Printing	the	G/L	Segment	Codes	Report
The	G/L	Segment	Codes	report	lists	information	about	a	range	of
segment	codes	you	specify.

Before	you	start

To	print	the	G/L	Segment	Codes	report:
1.	 Open	General	Ledger	>	G/L	Reports	>	Segment	Codes.

Tip:	You	can	also	click	File	>	Print	on	the		Segment	Codes	setup
screen.

2.	 Specify	whether	include	codes	for	all	segments	or	a	range	of	codes
for	a	particular	segment.

3.	 Click	Print.

Related	Topics

javascript:void(0);
javascript:mc80.Click()


Home	>	Printing	Reports	>	General	Ledger	Reports	>	Source	Codes	Report



Printing	the	G/L	Source	Codes	Report
This	report	lists	a	range	of	source	codes	and	their	descriptions.

Before	you	start

To	print	the	Source	Codes	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Source	Codes.

Tip:	You	can	also	open	this	screen	by	click	File	>	Print		on	the
Source	Codes	setup	screen.

2.	 Enter	the	range	of	source	codes	to	include	on	the	report.

3.	 Click	Print.

Related	Topics
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Printing	the	G/L	Source	Journal	Profiles	Report
This	report	lists	information	for	a	selected	range	of	source	journals.

Before	you	start

To	print	the	Source	Journal	Profiles	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Source	Journal	Profiles.

Tip:	You	can	also	open	this	screen	by	clicking	File	>	Print	on	the
Source	Journal	Profiles	setup	screen.

2.	 Enter	the	range	of	source	journal	profiles	to	print.

3.	 Click	Print.

Related	Topics
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Printing	the	G/L	Source	Journals	Report
Source	journals	list	the	details	of	posted	transactions	for	the	source
codes	that	you	included	in	the	source	journal	definition.

You	can	customize	a	source	journal	at	print	time	by	choosing:

The	sorting	order	of	the	report.	(By	account	number,	segment,	or
account	group.)
Account,	segment,	account	group,	or	account	optional	field	ranges.
Fiscal	period,	reference,	transaction	date,	posting	sequence,	and
batch	number	ranges.

Before	you	start

To	print	the	Source	Journals	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Source	Journals.

2.	 On	the	Journal	tab:

a.	 In	the	Profile	field,	select	the	type	of	journal	to	print.
b.	 In	the	Use	Report	field,	type	a	report	format	or	use	the	Browse

button	to	select	it.	More...

Note:	You	can	select	one	of	the	report	formats	that	are	shipped
with	General	Ledger,	or	you	can	choose	a	custom	format	that
your	company	has	created.

c.	 If	your	General	Ledger	is	multicurrency,	in	the	Currency	field,
select	Functional	or	Source	and	Functional.
The	Reporting	option	is	available	only	in	multicurrency	ledgers	if
the	euro	is	your	functional	currency	and	you	specified	a	reporting
currency.

Note:	The	Reporting	option	uses	the	letter-size	report	format
(GLSJ01F)	and	prints	debit	and	credit	amounts	from	the	reporting
fiscal	set.
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3.	 On	the	Account	tab:

a.	 Specify	whether	to	sort	the	report	by	Account	Number,	by
Segment,	or	by	Account	Group.

b.	 Specify	a	range	of	account	numbers	or	segment	codes.

c.	 If	you	want	to	select	accounts	by	a	range	of	sort	codes,	select
Select	Account	Groups	By	Sort	Code	Range,	and	then	specify
the	range.

Note:	The	Account	Group	option	in	the	Sort	By	section	changes
to	Account	Sorted	Group	when	you	select	this	option.

d.	 If	you	want	to	include	optional	field	information	that	was	posted	with
transaction	details,	select	Include	Trans.	Optional	Fields.

e.	 In	the	segment	table,	specify	the	segment	names	and	ranges	of
segment	codes	by	which	to	select	accounts.

f.	 in	the	account	optional	fields	table,	enter	a	range	of	account
optional	fields	by	which	to	select	accounts,	or	leave	the	table	blank.
(The	table	appears	only	if	you	use	Transaction	Analysis	and
Optional	Field	Creator.)

4.	 On	the	Ranges	tab,	specify	ranges	of	fiscal	periods,	references,
dates,	posting	sequences,	batch	numbers,	(and	source	currencies,
for	a	multicurrency	ledger).

Important!	If	you	print	entries	for	consolidated	transactions,	you
must	enter	000000	in	the	Batch	Number	From	field.

5.	 Click	Print.

Related	Topics
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Printing	the	G/L	Transaction	Details	Optional
Fields	Report
This	report	lists	transactions	that	use	optional	transaction	fields	and
optional	field	values	that	you	specify.

Before	you	start

To	print	the	Transaction	Details	Optional	Fields	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Transaction	Details

Optional	Fields.
2.	 Use	the	Sort	By	fields	to	specify	the	order	in	which	to	list	information

on	the	report.	More...

3.	 If	you	are	sorting	the	report	by	account	number	or	by	segment,	in	the
adjacent	From	and	To	fields:
If	you	are	sorting	by	account	number,	specify	the	range	of	accounts
to	include.
If	you	are	sorting	by	account	segment,	specify	which	account
segment	to	select	by,	and	then	specify	a	range	of	segment	codes.

4.	 If	your	General	Ledger	is	multicurrency,	specify	the	report	currency.
More...

5.	 In	the	From	Period	and	To	Period	fields,	specify	the	year	and	range
of	fiscal	periods	for	the	report.

If	you	have	created	the	next	year,	you	can	select	the	adjustment	or
closing	periods.

6.	 To	select	accounts	by	a	range	of	sort	codes,	select	Select	Account
Groups	By	Sort	Code	Range,	and	then	in	the	From	and	To	Sort
Code	-Account	Group	fields,	specify	the	range	of	sort	codes.
If	you	are	sorting	the	report	by	account	number	or	segment,	and	not
by	sort	code	range,	select	a	range	of	account	groups,	or	accept	the
default	range	to	include	all	account	groups.

7.	 In	the	segment	table,	select	ranges	of	segment	codes	if	you	want	to
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restrict	the	report	to	accounts	with	particular	segment	codes.
8.	 In	the	optional	fields	tables,	specify	up	to	three	optional	fields	and	the

range	of	optional	field	codes	for	which	you	wish	to	include
transactions	in	the	report.

Only	posted	transactions	that	use	the	specified	optional	transaction
fields	and	values	will	appear	on	the	report.

9.	 Click	Print.

Related	Topics
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Printing	the	G/L	Transactions	Listing	Report
The	G/L	Transactions	Listing	report	lists	the	net	changes,	balances	and
transaction	details	for	accounts	in	a	range	of	fiscal	periods	you	specify.

Before	you	start

To	print	the	G/L	Transactions	Listing	report:
1.	 Open	General	Ledger	>	G/L	Reports	>	Transactions	Listing.
2.	 Specify	the	order	in	which	to	sort	transactions.	More...

3.	 Specify	the	range	of	fiscal	periods	to	print.

Note:	If	you	are	printing	period	12	details,	select	ADJ	to	include
adjustment	entries,	or	CLS	to	include	adjustment	and	closing
entries.

4.	 Indicate	whether	to	print	additional	information	on	the	report.	More...
5.	 Select	the	currency	in	which	to	print	the	report.	More...
6.	 Select	other	options	to	specify	what	information	appears	in	the	report,

and	how	information	is	displayed.	More...
7.	 If	you	want	to	include	a	specific	range	of	segment	codes	and/or

account	optional	fields,	specify	the	ranges	to	include.

8.	 Click	Print.

After	printing	this	report

Related	Topics
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Printing	the	G/L	Trial	Balance	Report
This	report	prints	a	trial	balance	report	or	worksheet	that	lists	selected
account	balances	for	a	specified	fiscal	period.	Print	it	at	the	end	of
accounting	periods,	when	you	are	ready	to	calculate	adjusting	entries.

Before	you	start

To	print	the	Trial	Balance	report:
1.	 Open	General	Ledger	>	G/L	Reports	>		Trial	Balance.
2.	 Select	the	report	format.	More...

3.	 In	the	Print	field,	select	the	type	of	report	to	print.
You	can	select	Balances	as	of	Year/Period	or	Net	Changes	for	the
Period.	If	you	selected	Worksheet	or	Provisional	Worksheet	as	the
report	format,	you	must	print	Balances	as	of	Year/Period.

4.	 In	the	For	Year/Period	field,	select	the	period	end	for	the	report.

Note:	If	you	are	printing	a	Net	Changes	report,	you	specify	a	range
over	which	to	compare	balances.

5.	 Use	the	Sort	By	fields	to	specify	how	to	sort	information	on	the
report.	More...

6.	 If	you	want	to	list	accounts	that	have	zero	balances	and	no	postings
in	the	current	year,	select	Include	Accounts	With	No	Activity.

7.	 To	print	amounts	and	quantities	for	a	rollup	account,	rolling	up	its
member	accounts	into	a	single	amount	or	quantity,	select	Use	Rolled
Up	Amounts.

Note:	The	debits	and	credits	on	the	report	may	not	balance	if	any
account	is	a	member	of	more	than	one	rollup	group.

8.	 If	you	are	printing	net	changes	for	the	period	and	you	do	not	want	to
include	totals	for	net	income	or	loss	in	your	report,	clear	the	Include
Net	Income	(Loss)	Total	for	Listed	Accounts	option.
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Note:	Skip	this	step	if	you	are	printing	a	worksheet	or	a	provisional
worksheet.

9.	 Specify	whether	to	order	the	report	by	account	number,	segment,
account	group,	or	account	sorted	group,	or	optional	field,	and	specify
a	range	of	accounts	in	that	order.

10.	 Specify	the	range	of	accounts,	segment	codes,	account	groups,
account-sorted	group,	and	optional	fields	you	want	to	print.

11.	 Click	Print.

Related	Topics
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Printing	Tips
Select	report	printing	options	and	print	destinations.

Report	Printing	Options

Selecting	a	Print	Destination

Selecting	a	Printer	for	Reports
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Report	Printing	Options
You	can	print	Sage	300	ERP	data	in	a	variety	of	reports	to	view	key
information.	Printed	reports	also	serve	as	a	source	of	backup	information
in	case	your	data	is	damaged	on	your	computer.

Sage	300	ERP	provides	four	destinations	for	printing	reports.	You	can

Print	directly	to	a	printer,	(to	laser	printers	on	8.5"	x	11"	paper,	or	to
dot	matrix	printers)	to	obtain	permanent	copies	of	the	information.
Display	the	information	on	your	screen,	for	a	quick	review.
Print	to	a	file	that	you	can	save,	print	later,	or	import	into	another
program.
Print	to	an	e-mail	to	send	to	another	user	or	office.

For	instructions	on	specifying	the	print	destination	for	Sage	300	ERP
reports,	see	Selecting	a	Print	Destination.

If	you	print	reports	to	a	physical	printer,	you	can	also	specify	a	particular
printer	to	use	for	printing	a	report.	For	instructions,	see	Selecting	a
Printer	for	Reports.

Related	Topics
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Selecting	a	Print	Destination
You	can	print	Sage	300	ERP	reports	to	a	printer,	to	the	screen,	to	a	file,
or	as	an	attachment	to	an	e-mail	message.

Note:	You	must	be	assigned	to	a	security	group	that	has	authorization
to	change	the	print	destination,	or	the	only	destination	available	will	be	a
physical	printer.

To	set	the	Sage	300	ERP	print	destination	to	Printer:

Note:	These	instructions	assume	that	you	have	set	up	printers	in
Microsoft	Windows.

1.	 On	the	Sage	300	ERP	Desktop	menu,	click	File	>	Print	Destination.
2.	 Select	Printer,	and	then	click	OK.

When	you	next	print	from	Sage	300	ERP,	the	report	will	be	sent	to	the
Windows	default	printer.

Tip:	If	you	want	to	confirm	the	destination	printer,	page	size,	and
orientation	each	time	you	print	a	report,	on	the	Desktop,	click	View	>
Preferences,	and	then	select	Confirm	on	print.

To	print	to	the	screen	(display	reports	on	your	monitor):
1.	 On	the	Sage	300	ERP	Desktop	menu,	click	File	>	Print	Destination.
2.	 Click	Preview.

Note:	For	Web-based	clients,	the	Preview	screen	appears	first	when
you	click	the	Print	button.

Tip:	You	can	print	a	report	displayed	in	the	Preview	window	by	clicking
the	Print	Report	 	button.

To	print	to	a	file:



1.	 On	the	Sage	300	ERP	Desktop	menu,	click	File	>	Print	Destination.
2.	 Click	File,	then	enter	the	drive,	directory,	and	file	name,	or	use	the

Browse	button	to	scroll	through	the	list	of	directories	and	files	to
select	the	file	you	want	to	use.

Note:	You	can	enter	the	name	of	a	non-existent	file	or	directory	to
be	created	by	the	system	when	you	print.	When	you	print	to	a	file,
the	report	is	assigned	a	unique	name,	for	example,	CS1000.TXT.

To	print	reports	as	attachments	to	e-mail	messages:
1.	 On	the	Sage	300	ERP	Desktop	menu,	click	File	>	Print	Destination.
2.	 Select	E-mail	to	create	a	file	that	can	be	attached	to	an	e-mail.
3.	 Select	either	Adobe	Acrobat	(PDF)	or	Rich	Text	Format	(RTF)	as

the	file	format	for	the	e-mail	attachment.	More...

4.	 Click	OK.

When	you	print	using	an	e-mail	destination	Sage	300	ERP	creates	a	PDF
or	RTF	version	of	the	report,	opens	your	default	e-mail	program,	and
attaches	the	report	file	to	a	new	e-mail	message.	More...

In	Microsoft	Windows,	the	default	e-mail	program	is	set	in	Internet
Options,	in	the	Control	Panel.

Related	Topics
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Selecting	a	Printer	for	Reports
When	your	print	destination	is	Printer,	Sage	300	ERP	prints	reports	to	the
Windows	default	printer,	unless	you	have	assigned	a	specific	printer	to	a
report.

The	ability	to	assign	different	printers	to	different	reports	at	print	time
means	that	you	are	not	limited	to	printing	to	the	default	printer.	For
example,	you	can	use	a	different	printer	to	print	item	labels	than	you	use
to	print	inventory	worksheets.

To	assign	a	specific	report	to	a	specific	printer:
1.	 Open	the	report	screen	that	you	want	to	assign	to	a	printer.

2.	 On	the	report	screen,	click	File	>	Print	Setup.
The	program	displays	the	Windows	default	printer,	but	you	can
change	the	printer	for	a	specific	report.

3.	 Select	the	Specific	Printer	option,	and	then	select	from	the	list	the
printer	to	use	for	this	report.

The	printer	list	includes	all	printers	that	have	been	added	to	the
Printers	and	Faxes	list	in	Windows.

4.	 Select	a	paper	source	if	you	want	to	use	a	particular	paper	tray	or
paper	stock	for	this	report.

5.	 Click	OK	to	close	the	Print	Setup	screen.

To	clear	the	assigned	printer	for	a	specific	report:
1.	 On	the	Sage	300	ERP	desktop,	select	(highlight)	the	icon	for	the

report.
2.	 On	the	Desktop	Object	menu,	click	Restore	Defaults,	or	right-click

the	report	icon,	and	then	click	Restore	Defaults	on	the	list	that
appears.

3.	 In	the	Restore	Defaults	dialog	box,	select	the	Print	Settings	option,
then	click	OK.



The	print	setup	for	that	report	is	reverted	to	the	desktop	default.

To	have	the	program	prompt	you	to	specify	a	printer	and	print
options	each	time	you	print:
On	the	Sage	300	ERP	Desktop	View	menu,	click	Preferences	>	Confirm
On	Print.

Related	Topics
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Financial	Reporter
Financial	Reporter	is	a	powerful	reporting	tool	that	you	can	use	to
manipulate,	format,	graph,	and	print	general	ledger	data.	You	can	use
Financial	Reporter	to	create	financial	statements	and	statement
specifications	in	Microsoft	Excel	that	display	data	from	Sage	300	ERP
General	Ledger.

About	Financial	Reporter

Information	Included	On	Financial	Statements

Sample	Financial	Statements

Printing	Financial	Statements

Designing	Financial	Statements

Financial	Reporter	Tutorial

Troubleshooting
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About	Financial	Reporter
Financial	Reporter	is	a	powerful	reporting	tool	that	you	can	use	to
manipulate,	format,	graph,	and	print	general	ledger	data.	You	can	use
Financial	Reporter	to	create	financial	statements	and	statement
specifications	in	Microsoft	Excel	that	display	data	from	Sage	300	ERP
General	Ledger.

Financial	Reporter	includes	the	following	screens	for	working	with
financial	statements:

G/L	Print	Financial	Statements.	You	use	the	G/L	Print	Financial
Statements	screen	to	print	financial	statements.

Note:	All	Sage	300	ERP	financial	statements	are	Excel
spreadsheet	files	that	contain	the	functions	required	to	read	general
ledger	data.

You	can	print	using	one	of	the	sample	statements	that	come	with
General	Ledger,	or	you	can	use	a	custom	report	specification	that
you	create	using	the	G/L	Statement	Designer.

For	more	information	about	the	sample	statements	that	are	included
with	General	Ledger,	see	Sample	Financial	Statements.

For	instructions	on	printing	financial	statements,	see	G/L	Print
Financial	Statements	Screen.

G/L	Statement	Designer.	The	G/L	Statement	Designer	is	an	add-in
program	that	works	with	Microsoft	Excel.	You	use	it	to	create
customized	statement	specifications,	and	you	can	use	it	to	generate
the	statements.

When	you	open	the	Statement	Designer	from	the	Financial	Reporter
folder,	and	then	click	Start,	Excel	opens	with	the	Financial	Reporter
functions	automatically	loaded.	These	functions	let	you	retrieve	and
work	with	data	from	your	Sage	300	ERP	company	database.

Note:



The	spreadsheet	add-in	is	available	only	when	you	start	Excel	from
the	Statement	Designer	screen	inSage	300	ERP.

Microsoft	Excel	is	not	included	with	Sage	300	ERP	General	Ledger.
If	you	want	to	use	Excel	to	create	financial	statements,	you	must
purchase	it	separately.	(You	can	install	Excel	before	or	after
installing	General	Ledger.)

For	more	information,	see	G/L	Statement	Designer.

After	you	create	a	report	using	the	Statement	Designer,	you	can	print	it	at
any	time	using	the	Print	Financial	Statements	screen	or	using	the	FR
View	command	from	the	FR	menu	in	Excel.

Note:	There	are	some	differences	when	printing	a	statement	using	the
Print	Financial	Statements	screen	compared	with	using	the	Statement
Designer.	For	more	information,	see	About	Printing
Financial	Statements

Important!	You	must	purchase	and	install	Microsoft	Excel	separately
before	you	can	use	the	Statement	Designer.



Key	Financial	Reporter	Concepts
Financial	Reporter	is	based	upon	a	few	simple	concepts:

Excel	Worksheets	with	Financial	Reporter	functions.	Financial
statements	are	Microsoft	Excel	spreadsheets	that	use	special
functions	to	extract	data	from	the	Sage	300	ERP	company	database.

You	can	place	Financial	Reporter	functions	anywhere	in	a
spreadsheet.	The	spreadsheet	program	looks	up	the	General	Ledger
values	when	it	recalculates	the	spreadsheet.	For	information	on
Financial	Reporter	functions,	see	Financial	Reporter	Functions.

You	can	also	use	any	other	spreadsheet	functions	you	want	to	further
manipulate	that	data.

Financial	Statement	Specifications.	A	financial	statement
specification	is	a	structured	description	of	a	statement	you	want	to
produce.	Financial	Reporter	creates	a	report	based	on	the	statement
specification	and	the	options	you	select	when	you	print	or	view	the
final	statement.

Statement	specifications	allow	you	to	assign	default	functions	and
formulas	to	columns	of	the	spreadsheet,	and	to	specify	whether	a
range	of	accounts	will	be	expanded	to	many	rows	on	a	final
statement.

Statement	specifications	make	statements	easier	to	create	and	more
flexible,	but	you	do	not	have	to	use	them.	You	can	view	an	account
balance	just	by	inserting	a	formula	in	a	single	cell,	and	then
recalculating	the	worksheet.

It	is	our	assumption	that	most	of	the	statements	you	create	will	be
generated	from	statement	specifications.

For	more	information	about	financial	statement	specifications,	see
About	Financial	Statement	Specifications.

Flexible	Data	Selection.	Financial	Reporter	lets	you	choose	and
restrict	data	at	print	time	by	account	segment	range,	account	group,
fiscal	period,	and	by	fiscal	set	(actual	or	provisional	amounts).



Note:

When	designing	statements,	keep	in	mind	that	a	generalized
financial	statement	can	be	printed	with	the	actual	or	provisionally-
posted	amounts	of	any	particular	department	or	division.	However,
the	transaction‐related	commands,	FRTRN,	FRTRNA,	FRTRNDR,
and	FRTRNCR,	do	not	handle	provisional	amounts.	If	you	use
these	commands,	only	actual	amounts	are	included	in	the	report.
If	you	include	rollup	accounts,	be	sure	you	designed	the	rollup
group	in	such	a	way	that	you	do	not	end	up	with	doubled	amounts
in	the	report.
When	creating	a	financial	report,	you	can	enter	formulas	that	allow
you	to	drill	down	to	associated	transactions	in	the	resulting	report.



Producing	Financial	Statements
Producing	financial	statements	from	General	Ledger	data	involves	three
broad	processes:

1.	 Designing	the	chart	of	accounts.
2.	 Creating	a	financial	statement	specification.
3.	 Printing	the	financial	statement.

Designing	the	Chart	of	Accounts
When	you	set	up	the	ledger,	decide	on	an	account-numbering	and
classification	scheme	to	suit	your	financial	reporting	needs.	A	well-
designed	chart	of	accounts	will	simplify	the	job	of	designing	and
maintaining	financial	statement	specifications.

Important!	Make	sure	that	the	account	segment	is	the	first	segment	in
the	account	structures	you	create.	Financial	Reporter	can	select
accounts	more	easily	when	the	account	segment	is	first.

For	more	information	on	designing	the	chart	of	accounts,	see	About
Designing	Your	General	Ledger.

Creating	a	Financial	Statement	Specification
A	financial	statement	specification	defines	the	format	and	contents	of	a
financial	statement.

Financial	Reporter	includes	several	sample	report	specifications	that	you
can	use	to	print	standard	financial	statements.

If	you	want	to	create	special	statements	for	your	company,	we	suggest
that	you	customize	one	of	these	standard	statements.

For	an	overview	and	a	few	short	lessons	on	creating	financial	statements,
see	the	Financial	Reporter	Tutorial.

For	more	detailed	information	on	creating	specifications,	see	Designing
Financial	Statements.



Printing	Financial	Statements
After	creating	specifications,	use	the	Print	Financial	Statements	screen	to
select	the	specification	you	want	to	print.

To	print	a	statement,	you	select	the	report	you	want	to	print,	select	from	a
variety	of	print	options,	and	then	click	Print.	Excel	gets	the	data,	prints	it,
and	returns	you	to	the	Company	Desktop.

For	more	information	about	printing	financial	statements,	see	About
Printing	Financial	Statements.

Related	Topics
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Information	Included	On	Financial	Statements
Financial	statements	can	include	as	many	columns	of	data	as	you	need,
and	can	contain	the	following	account	and	other	information:

Current	or	historical	balances	for	a	single	account	or	range	of
accounts.
Net	changes	for	a	fiscal	period,	quarter,	half-year,	or	year.
Balances	or	net	changes	in	functional	currency	or	any	of	the	source
currencies	defined	in	a	multicurrency	ledger.
Balances	or	net	changes	in	the	reporting	currency	(if	you	specified
the	euro	as	your	functional	currency	and	selected	a	reporting
currency	in	the	Company	Profile).
Comparative	figures	from	complete	or	to-date	time	periods.
Budget	figures	from	fiscal	sets.
Quantities.
Company	information,	such	as	the	name,	address,	telephone
number,	and	company	contact.
The	start	and	end	dates	of	a	given	fiscal	period.
The	exchange	rate,	given	a	particular	currency,	rate	type,	functional
currency,	and	date.

Note:	Accounts	with	zero	balances	are	not	included	on	the	report.

You	can	select	a	variety	of	options	for	printing	a	financial	statement,
including:

The	fiscal	year	and	period.
Whether	to	print	separate	reports	for	each	individual	segment	or
account	group,	or	a	single	consolidated	report.
Whether	to	include	provisionally	posted	transactions	and	rollup
amounts.



Data	Selection	Criteria
Financial	Reporter	not	only	gives	you	access	to	data,	it	allows	you	to
select	data	at	print	time	using	a	number	of	powerful	features.

The	first	set	of	criteria	you	can	use	is	in	the	report	specification	itself.

You	can	restrict	the	accounts	specified	on	a	financial	report	by	using
selection	criteria.

For	example,	you	can	select	only	those	accounts	in	a	specified	range
that	have	ACCTTYPE="Income"	AND	ACTIVESW="Yes".

Alternatively,	you	can	select	only	those	accounts	with	a	debit	or	credit
balance.

You	can	exclude	report	lines	based	on	their	contents.

For	example,	you	could	remove	a	line	from	your	reports	if	the	value	in
each	column	on	the	line	is	zero,	or	you	could	exclude	a	line	if	it
represents	less	than	5%	of	the	total	of	column	G.

You	can	use	the	FRPOST,	FRTRN,	FRTRNA,	FRTRNDR,	FRTRNCR
commands	to	select	by	posted	fields.	For	more	information,	see
Financial	Reporter	Functions.



Consolidating	Accounts
Financial	Reporter	lets	you	specify	whether	particular	accounts	or	groups
of	accounts	are	listed	separately,	consolidated,	or	subtotaled	whenever
the	value	of	a	particular	account	segment	changes.

Related	Topics
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Sample	Financial	Statements
Financial	statements	are	Microsoft	Excel	spreadsheets	that	use	special
functions	to	extract	data	from	the	Sage	300	ERP	company	database.

General	Ledger	includes	the	following	standard	financial	statements.
English-language	statements	are	located	in	the	ENG	subfolder	of	the
General	Ledger	program	folder.	If	are	using	another	supported	language
version	of	Sage	300	ERP,	you'll	find	your	statements	in	a	language-
specific	folder.	For	example,	French	statements	are	located	in	the	FRA
subfolder	and	work	with	French-language	Excel.

Balance	Sheets
Income	Statements
Financial	Analysis	Statements
Financial	Forecasts

Important!
The	sample	statements	are	designed	for	Sage	300	ERP	sample	data,
and	retrieve	data	using	standard	account	groups.

To	use	the	statements	with	your	own	data,	you	must	either:

Assign	the	same	standard	account	groups	to	your	accounts.
Customize	the	sample	statements	to	match	the	account	groups	that
you	have	set	up	for	your	company.

To	modify	a	sample	statement,	first	copy	the	file	and	then	save	it	with	a
new	file	name.



Balance	Sheets
General	Ledger	includes	standard	balance	sheet	statements	and
summaries.

The	sample	summaries	include:

A	regular	size	balance	sheet	that	summarizes	the	company's	assets,
liabilities,	and	equity	at	a	specific	point	in	time.
A	common	size	balance	sheet,	which	includes	a	regular	size	balance
sheet,	and	separate	reports	listing	asset	line	items	as	a	percentage
of	total	assets,	and	liability	line	items	as	a	percentage	of	total
liabilities.
Common	size	balance	sheets	that	also	include	graphical	summaries,
statements	for	specified	periods,	comparisons	of	current	and
previous	year	amounts,	and	comparisons	of	current	year	and	budget
amounts.

Note:	All	sample	balance	sheets	include	the	profit	or	loss	for	the	period.

Balance	Sheet	Statements

Balance	Sheet	Summaries
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Income	Statements
General	Ledger	includes	standard	income	statements	and	income
statement	summaries.

The	sample	summaries	include:

A	regular	size	income	statement	that	summarizes	the	company's
profit	or	loss	for	a	specified	period.
A	common	size	income	statement,	which	includes	a	regular	size
income	statement,	and	separate	reports	listing	line	items	as	a
percentage	of	sales	revenue.
Common	size	income	statements	that	also	include	graphical
summaries,	statements	for	specified	periods,	comparisons	of	current
and	previous	year	amounts,	and	comparisons	of	current	year	and
budget	amounts.

Tip:	You	can	use	Excel	formulas	and	functions	to	display	amounts	as
percents	or	ratios.

	Standard	Income	Statements

Income	Statement	Summaries
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Financial	Analysis	Statements
Analysis	statements	display	financial	ratios	used	by	financial	managers	to
evaluate	a	company's	performance.

Financial	Ratios
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Financial	Forecasts
Use	financial	forecasting	you	to	assess	your	current	operating
performance,	and	project	how	your	business	will	perform	in	the	future.

Forecast.xls	creates	a	forecasted	income	statement	and	balance	sheet.
The	statements	include	actuals	for	the	current	and	previous	years,	and
projected	amounts	for	the	next	three	years	based	on	the	percentage	of
sales	revenue	growth.

Note:	The	forecasting	method	assumes	that	certain	expenses,	assets,
and	liabilities	maintain	a	constant	relationship	to	the	level	of	sales.	To
perform	what-if	analysis,	enter	projected	percentages	for	revenue
growth	and	other	line	items	in	the	Adjustments	area	of	the	statement
specification.

Related	Topics
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Printing	Financial	Statements
Use	the	G/L	Print	Financial	Statements	screen	to	print	financial
statements	included	with	Sage	300	ERP,	or	to	print	custom	statements
designed	using	the	Statement	Designer.

Note:	For	information	about	using	the	Statement	Designer	to	print
financial	statements,	see	About	Generating	Reports	from	Specifications
and	G/L	Statement	Designer.

About	Printing	Financial	Statements

About	the	Spec	Range

About	the	Report	Range	and	the	Print	Range

About	Verifying	Account	Data

Printing	a	Financial	Report

Setting	the	Spec	Range
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About	Printing	Financial	Statements

Important!	Printing	using	the	Statement	Designer	is	not	the	same	as
printing	using	the	Print	Financial	Statements	screen.

When	you	print	using	the	Statement	Designer:

You	can	generate	an	audit	information	tab	as	well	as	account	audit
information	in	the	first	column	of	the	report.

The	audit	information	tab	lists	information	such	as	the	print	ranges
and	any	specified	processing	order.

You	can	create	formulas	for	each	value	that	appears	in	the	report
range	instead	of	the	values	themselves.

This	means	that	you	can	update	the	report	simply	by	recalculating
the	spreadsheet.

Note:	Spreadsheet	formulas	make	the	spreadsheet	a	lot	larger.

If	you	generate	a	series	of	statements	for	a	group	of	departments,	the
separate	statements	are	generated	in	consecutive	sheets	in	an	Excel
workbook.

When	you	print	a	set	of	statements	using	the	G/L	Print	Financial
Statements	screen,	Financial	Reporter:

Repeats	the	report	generation	process	for	each	account	segment.
Prints	a	series	of	separate	statements.

For	instructions,	see	Printing	a	Financial	Statement.

Tip:	Keep	financial	ratios	and	graphs	in	a	formula	sheet.	(The	most
common	type	of	"formula-only"	report	is	one	that	keeps	financial	ratios.)

There	are	two	main	advantages	of	a	report	that	is	composed	only	of
formulas:

1.	 The	report	has	the	same	cell	references	each	time	you	use	it.



2.	 The	report	area	remains	intact	when	you	recalculate	the	report.	(If
you	generate	a	report	from	a	specification,	the	old	report	is	cleared
before	the	new	one	is	generated.)

Because	the	spreadsheet	remains	the	same	each	time	you	use	it,	you
can	include	graphs	in	your	reports	and	be	sure	of	the	data	you	are
referencing.



Printing	Reports	With	and	Without	a	Spec	Range
If	a	spreadsheet	has	formulas	only	(with	no	Spec	range),	you	cannot	use
FR	View	to	calculate	and	print	the	report.	Instead:

You	press	F9	to	calculate	the	values	of	the	formulas.
Financial	Reporter	recalculates	the	spreadsheet	when	you	print	the
report.
If	you	do	not	want	to	print	the	whole	spreadsheet,	you	can	use
Excel's	Set	Print	Area	command	to	define	the	area	you	wish	to	print.

If	the	spreadsheet	has	a	defined	Spec	range,	Financial	Reporter
automatically	regenerates	the	financial	statement	before	printing	it.	All	the
columns	included	the	Spec	range	are	included	on	the	printed	statement,
except	columns	A,	B,	C,	and	D.



Preparing	to	Print	Reports
If	report	information	extends	beyond	the	right	edge	of	the	spreadsheet
print	area,	it	may	be	cut	off.

You	can	modify	a	report	specification	to	make	sure	that	report	information
is	not	truncated	by:

Widening	the	spreadsheet	column	that	contains	the	extra-wide	result.

Redefining	the	Spec	range	to	include	the	columns	over	which	the
information	extends.

This	approach	works	because	the	right	print	area	boundary	of	a
financial	statement	that	is	generated	from	a	specification	is	the	same
as	the	Spec	range	boundary.

Related	Topics
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About	the	Spec	Range
The	Spec	range	is	a	named	range	of	spreadsheet	cells	that	begins	with
the	first	row	and	column	of	the	report	specification,	and	includes	all	cells
that	are	part	of	the	specification.

Before	you	can	generate	a	report	from	a	report	specification,	you	must
define	the	Spec	range	for	your	spreadsheet.

Note:	The	Spec	range	is	already	defined	in	all	financial	report
specifications	that	come	with	Financial	Reporter.

To	check	for	a	Spec	range:
1.	 On	Excel's	ribbon,	click	Formulas	>	Name	Manager.
2.	 If	"Spec"	is	not	listed	in	the	Name	Manager	window,	click	New,	and

then	define	the	Spec	range.



Layout	of	the	Spec	Range

The	first	four	columns	of	the	Spec	range	(A	through	D)	are	reserved	for
control	information	for	Financial	Reporter.

The	other	columns	form	a	template	that	determines	the	appearance	of
the	report	and	the	type	of	data	that	it	retrieves.

Note:	A	specification	can	begin	in	any	column	of	a	worksheet,	but	the
first	column	of	the	Spec	range	must	be	the	first	column	of	the
specification.	We	always	refer	to	the	first	column	of	the	specification	as
column	A.	(There	is	no	reason	why	you	should	start	a	specification
anywhere	else.)



Redefining	the	Spec	Range
If	you	want	to	redefine	the	spec	range	in	your	worksheet	after	generating
a	report,	use	the	FR	Clear	command	to	clear	up	the	report	area,	and
then	make	your	changes	to	the	spec	range.

Related	Topics
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About	the	Report	Range	and	the	Print	Range
The	Report	range	is	generated	from	the	Spec	range	when	you	print	the
financial	report.	It	contains	data	that	is	generated	by	the	report,	as	well	as
data	extracted	from	the	General	Ledger.

The	template	portion	of	the	specification	expands	in	the	final	report	to
display	the	actual	general	ledger	data.

The	control	information	in	the	first	four	columns	of	the	specification	is
replaced	by	audit	information	in	the	report	range—the	numbers	of	the
accounts	from	which	the	information	was	taken.

When	you	print	the	report,	Financial	Reporter	prints	all	but	the	first	four
columns	of	the	Report	range	(omitting	the	audit	information).

The	area	it	prints	is	called	the	Print	range.

Related	Topics
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About	Verifying	Account	Data
You	can	use	two	methods	in	Financial	Reporter	to	test	account
information	to	decide	whether	it	should	appear	in	a	report.

Use	a	formula	in	column	C	to	test	the	contents	of	a	line.	You	can
specify	conditions	for	excluding	generated	lines	from	a	report	based
on	the	contents	of	the	line.

For	more	information,	see	About	Columns	in	Report	Specifications.

Use	FR	functions	with	spreadsheet	functions.	Financial	Reporter
functions	can	replace	parameters	of	spreadsheet	functions,	so	you
can	test	the	contents	of	fields	before	printing	the	report,	or
manipulate	them	as	you	wish.

Example:

To	specify	that	a	balance	is	printed	only	if	it	exceeds	6000,	use
=IF(FRAMT("BALP","1000")>6000,FRAMT("BALP","1000"),0)

To	print	the	average	value	of	two	accounts,	use
=AVERAGE(FRAMT("BALP","1000"),FRAMT("BALP","2000"))

Related	Topics
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Printing	a	Financial	Statement
To	print	a	financial	statement	in	Financial	Reporter,	you	can	use	either	of
the	following	methods:

Use	the	G/L	Print	Financial	Statements	screen	to	specify	print	options
and	print	the	financial	statement.
Open	a	financial	statement	specification	in	the	Statement	Designer,
use	FR	View	to	generate	the	statement,	and	then	print.

The	following	procedure	describes	how	to	use	the	G/L	Print	Financial
Statements	screen.	For	information	about	using	the	Statement	Designer
to	print	financial	statements,	see	About	Generating	Reports	from
Specifications	and	G/L	Statement	Designer.

To	print	a	financial	statement:
1.	 Open	General	Ledger	>	Financial	Reporter	>	Print	Financial

Statements.
2.	 Click	Browse,	and	then	select	a	financial	statement	file.

For	a	list	of	sample	financial	statements	included	with	Sage	300
ERP,	see	Sample	Financial	Statements.

3.	 Under	Fiscal	Option,	specify	the	year	and	period	for	which	to	create
the	statement.

4.	 Under	Report	Type,	specify	whether	to	include	actual	or	provisional
amounts	in	the	report.	More...

5.	 Under	Report	As,	specify	whether	to	print	a	single,	consolidated
report,	or	to	print	separate	reports	for	different	account	number
segments.

Note:	The	Separate	option	is	available	only	after	you	select
Segment	in	the	Sort	By	area	of	the	screen,	and	then	enter	the
range	of	segments.	(This	option	is	not	available	if	you	select	the
Account	segment.)

javascript:void(0);


6.	 Under	Include,	select	the	Report	Options	and/or	DrillDown
Information	options	as	needed.	More...

7.	 Under	Sort	By,	specify	the	order	in	which	to	sort	records	in	the
printed	financial	statement.	More...

8.	 Specify	account	groups	or	sort	code	groups	to	include.	More...
9.	 In	the	table,	specify	optional	ranges	of	segments.	If	you	selected

Separate	under	Report	As	in	step	5,	you	can	double-click	the	Report
As	column	to	select	Separate	or	Consolidated.

10.	 Select	a	print	destination.
11.	 Click	Print.

Related	Topics
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Setting	the	Spec	Range
The	Spec	range	is	a	named	range	of	spreadsheet	cells	that	begins	with
the	first	row	and	column	of	the	report	specification,	and	includes	all	cells
that	are	part	of	the	specification.

Before	you	can	generate	a	report	from	a	report	specification,	you	must
define	the	Spec	range	for	your	spreadsheet.

To	define	the	Spec	range	in	a	Financial	Reporter	spreadsheet:
1.	 With	the	statement	spreadsheet	open	in	Excel,	select	the	complete

report	specification,	from	the	first	row	and	column	to	the	last	row	and
column.

2.	 On	the	Excel	Ribbon,	click	Formulas	>	Define	Name.
3.	 Type	Spec	as	the	range	name,	then	click	OK.

Important!	You	must	type	exactly	these	letters,	although	the
capitalization	doesn't	matter.

Note:	You	do	not	define	a	Report	range	for	the	spreadsheet.	Financial
Reporter	defines	the	Report	range	when	it	generates	the	report	from	a
specification.
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Designing	Financial	Statements
You	define	a	financial	statement	using	a	report	specification.	The
specification	tells	Financial	Reporter	what	data	is	included	on	the
statement,	and	how	it	should	be	formatted.

Because	the	specification	is	a	Microsoft	Excel	spreadsheet,	you	can	use
standard	worksheet	formulas,	formatting	commands,	and	graphing
abilities	to	modify	the	report,	and	you	can	create	multidimensional	models
to	perform	further	analysis	on	the	data.

Note:	Financial	Reporter	includes	a	set	of	standard	report	specifications
that	are	compatible	with	any	chart	of	accounts	that	uses	the	standard
account	group	classifications	and	user-defined	account	groups.	You	can
print	financial	statements	using	these	standard	reports,	or	you	can
customize	them.

About	Financial	Report	Specifications

About	Formatting	Financial	Statements

About	Generating	Reports	from	Specifications

About	Optional	Fields	in	Financial	Statements

About	Rounding	on	Balance	Sheets

About	Page	Layout

Consolidating	Multiple	Financial	Statements

Specifying	Column	and	Row	Contents

Retrieving	G/L	Account	Information

FR	Menu	Commands

Financial	Reporter	Functions



Account	and	Transaction	Fields
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About	Financial	Statement	Specifications
A	financial	statement	specification	is	a	structured	description	of	a
statement	you	want	to	produce.	Financial	Reporter	creates	a	report
based	on	the	statement	specification	and	the	options	you	select	when
you	print	or	view	the	final	statement.

Statement	specifications	allow	you	to	assign	default	functions	and
formulas	to	columns	of	the	spreadsheet,	and	to	specify	that	a	range	of
accounts	will	be	expanded	to	many	rows	on	a	final	statement.

Note:

You	do	not	need	to	create	a	statement	specification	to	extract	and	print
information.	You	can	extract	and	print	balances	from	General	Ledger	by
placing	a	few	formulas	in	a	spreadsheet,	recalculating	the	spreadsheet,
and	then	printing	from	Excel.

You	can	also	save	the	spreadsheet,	and	then	use	General	Ledger's
Print	Financial	Statements	screen	to	print	the	values	in	future.	If	the
worksheet	does	not	contain	a	statement	specification,	Financial
Reporter	simply	recalculates	the	spreadsheet,	and	prints	it	out.



Layout	of	a	Report	Specification
Spreadsheets	that	contain	statement	specifications	have	two	separate
regions:

The	Spec	range	is	the	region	containing	the	report	specification.
The	Report	range	is	the	region	containing	the	financial	statement
produced	from	the	report	specification.

The	Report	range	contains	a	third	range	called	the	Print	range,
which	excludes	all	audit	information	that	can	be	generated	in	the	first
columns	of	the	Report	range.

Tip:	Statements	that	are	not	generated	from	specifications	have	no
Spec	range,	but	you	can	set	a	print	range	to	restrict	the	size	of	the
worksheet	for	printing.

The	statement	specification	and	the	report	it	creates	both	reside	in	a
single	worksheet.

When	you	generate	a	financial	statement	from	a	specification,	the
Financial	Reporter	processes	all	the	specification	information	in	the	Spec
range,	and	creates	the	final	report	in	the	Report	range.

If	you	opt	to	create	a	separate	report	for	each	account	segment	when	you
generate	the	report,	Financial	Reporter	inserts	a	separate	worksheet	for
each	segment	into	a	new	workbook.



Rules	for	Defining	the	Spec	Range,	Report
Range,	and	Print	Range
The	following	principles	apply	to	the	ranges	in	a	financial	statement
specification:

The	Spec	range	can	occupy	any	columns.	A	specification	can
begin	in	any	column	of	a	spreadsheet.	The	only	requirement	is	that
the	first	column	of	the	Spec	range	must	be	the	first	column	of	the
specification.

For	more	information	about	the	Spec	range,	see	About	the	Spec
Range	and	Setting	the	Spec	Range.

The	Report	range	is	created	when	generating	the	report.	The
Report	range	is	generated	from	the	Spec	range	when	you	print	the
financial	report.	It	contains	data	that	is	generated	by	the	report,	as
well	as	data	extracted	from	the	General	Ledger.
The	Report	range	starts	in	column	E.	The	first	four	columns	of	the
Spec	range	(A	through	D)	are	reserved	for	control	information	for
Financial	Reporter.	All	other	columns	form	a	template	that	determines
the	appearance	of	the	report	and	the	kinds	of	data	that	will	appear.

The	Print	range	starts	in	column	E.	The	control	information	in	the
first	four	columns	of	the	specification	is	replaced	by	audit	information
in	the	report	range	when	you	use	the	FR	View	command.

Financial	Reporter	prints	a	smaller	area	of	the	worksheet	than	the
Report	range	because	it	excludes	columns	A	to	D.

The	Print	range	is	set	by	the	Spec	range.

Related	Topics
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About	Formatting	Financial	Statements
All	formatting	of	financial	statements	is	controlled	by	the	Financial
Statement	Designer's	formatting	commands.	For	more	information	about
controlling	tab	size,	tab	headings,	font	size,	and	style,	refer	to	the	help
and	documentation	for	Microsoft	Excel.

The	most	efficient	method	for	formatting	the	area	and	the	text	within	a
cell	is	to	create	a	style	that	includes	various	attributes	(such	as	bold	text,
currency	format,	right	alignment,	and	so	on),	and	then	apply	the	style	to
spreadsheet	cells.



Adding	Title	Lines
The	first	five	lines	of	the	report	specification	are	the	title	lines,	which	are
repeated	at	the	top	of	each	tab	of	the	report.

You	can	specify	up	to	five	lines	that	will	appear	at	the	top	of	each	tab	of	a
financial	statement.

You	can	only	define	one	set	of	title	lines	in	a	specification.	All	title	lines
must	be	together	(contiguous).

If	you	have	defined	more	than	one	set	of	title	lines,	Financial	Reporter
uses	the	last	set	in	the	specification.

Example:

The	Universal	Corporation
Balance	Sheet	As	of	October	31,	1999

	 Current	Balance
Petty	cash 274.57
Bank	account 8,437.54
Bank	account,	CAD	dollars 4,372.96
Total: 13,085.07

If	you	want	the	title	to	appear	only	on	the	first	tab	of	the	report,	leave	the
first	column	for	these	rows	blank.	The	rows	are	transferred	"as	is"	to	the
beginning	of	the	Report	range.

Note:	If	you	use	the	Financial	Reporter	\T	line,	you	cannot	separately
mark	a	group	of	cells	as	title	lines.	Title	lines	must	be	consecutive,	and
cannot	be	split	by	a	tab	break.



Adding	Explanatory	Comments	(..)
We	suggest	you	begin	every	specification	with	a	few	comment	lines
describing	it,	and	add	comments	throughout	to	explain	important	sections
of	your	specifications.

You	can	make	any	line	of	a	report	specification	a	comment	line	by
starting	column	A	with	two	periods.	For	example,	the	following	four	lines
are	in	cells	A1	through	A4	of	a	report	specification:



Grid	Lines	and	Other	Report	Formatting
You	specify	all	formatting	for	financial	reports	in	the	Financial	Statement
Designer's	using	Microsoft	Excel	formatting	commands.

For	example:

To	select	the	character	font,	bold	type,	left	or	right	alignment,	number
appearance,	cell	borders	and	patterns,	you	use	the	commands	in	the
Font	and	Alignment	groups	(on	the	Home	tab	of	the	Excel	ribbon).
To	turn	the	spreadsheet	grid	on	or	off	for	printing,	and	turn	on	or	off
the	row	and	column	labels,	you	select	options	in	the	Show	group	(on
the	View	tab	of	the	Excel	ribbon).
To	force	a	tab	breaks	in	the	printed	report,	use	the	Set	tab	Break
command	in	the	corresponding	position	of	the	report	specification.
Set	the	tab	break	in	column	A	of	the	spreadsheet.	(Note	that	the	cell
containing	the	tab	break	creates	a	vertical	tab	break	as	well	as	a
horizontal	one.)

All	formatting	applied	to	rows	or	columns	in	a	report	specification	is
applied	to	the	rows	and	columns	of	the	generated	report.

To	see	the	effect	of	all	tab	formatting	in	the	Financial	Report	Designer,
click	File	>	Print	to	see	a	preview	after	you	have	used	FR	View	to
generate	the	report.



Hiding	Columns	and	Rows
It	is	often	useful	to	have	statement	columns	and	rows	that	you	don't	want
printed	on	your	final	report.	For	example,	you	may	have	statement	rows
that	contain	intermediate	rounding	calculations.

To	hide	a	column,	you	can	do	either	of	the	following:
Right-click	the	column,	select	Column	Width,	and	then	set	width	to
0.
Click	and	drag	the	edge	of	the	column	until	its	width	is	0.

To	hide	a	row,	you	can	do	either	of	the	following:
Right-click	the	row,	select	Row	Height,	and	then	set	height	to	0.
Click	and	drag	the	top	or	bottom	edge	of	the	row	until	its	height	is	0.

Related	Topics
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About	Generating	Reports	from	Specifications
If	you	print	a	financial	statement	using	the	G/L	Print	Financial	Statements
screen,	you	do	not	see	the	report	specification.	Instead,	Financial
Reporter	opens	the	financial	specification	in	Microsoft	Excel,	processes
the	specification	commands	in	the	Spec	range	of	the	spreadsheet,	and
prints	the	report.

In	contrast,	if	the	spreadsheet	contains	no	Spec	range,	Financial
Reporter	recalculates	the	spreadsheet	for	the	ranges	of	accounts,
account	groups,	or	segments	specified	on	the	G/L	Print	Financial
Statements	screen,	and	then	prints	the	whole	spreadsheet,	or	the	print
area	defined	in	the	spreadsheet.

Depending	on	the	print	destination	you	specify	on	the	G/L	Print	Financial
Statements	screen,	you	can:

Preview	the	report	before	you	print	it.
Send	the	report	via	e-mail	to	a	recipient.
Print	directly	to	a	printer,	or	print	to	a	file.



Generating	Statements	Using	the	Financial
Statement	Designer
When	you	edit	a	report	specification	(using	the	Statement	Designer),	you
can	also	test	the	statement	specification	you	are	editing.

To	generate	the	final	report,	use	FR	View.	For	details	on	using	FR	View,
see	FR	Menu	Commands.

FR	View	generates	the	report	using	the	same	print	options	that	you	use
to	print	a	report	from	the	Print	Financial	Statements	screen.	However,	it
provides	two	additional	Include	options:

Audit	information.	If	you	select	this	option,	Financial	Reporter	lists
the	results	of	the	account	number	references	in	column	A	of	the
report	range	of	the	spreadsheet.	This	information	allows	you	to	check
the	numbers	of	all	accounts	included	in	your	statement	(as	long	as
you	enter	D	in	column	D	of	the	report).

Formulas.	If	you	select	this	option,	Financial	Reporter	inserts	a
formula	in	each	cell	of	the	final	report	where	you	need	to	insert
General	Ledger	information.	You	can	then	update	the	report	at	any
time	by	recalculating	the	spreadsheet.

Important!	Spreadsheets	with	formulas	are	much	larger	than
standard	report	specifications.	Generating	statements	that	include
formulas	also	takes	longer,	because	Excel	calculates	the	value	of
each	formula	as	it	generates	them.

After	you	generate	a	report,	you	can	preview	it	by	clicking	File	>	Print	in
Excel.



About	Using	Selection	Criteria
You	can	specify	selection	criteria	on	a	default	specification	line,	on
individual	specification	lines,	and	in	formulas.	With	all	these	possibilities
for	account	selection,	you	must	be	very	clear	which	criteria	are	actually	in
effect.

Important!	Accounts	must	meet	restrictions	and	criteria	specified	on
the	FR	View	screen.

The	first	restriction	you	place	on	account	selection	is	with	the	FR	View
screen	(or	with	the	G/L	Print	Financial	Statements	screen).	Report-level
account	range	filtering	is	in	effect	for	any	account	reference	that	specifies
a	range	of	accounts.

For	more	information,	see	About	Selection	Criteria	for	Filtering	Accounts.



Overriding	Account	Ranges
You	can	override	FR	View	screen	ranges	in	two	ways:

By	specifying	segment	codes	that	are	outside	the	ranges	defined	on
the	FR	View	screen.
By	using	the	$	prefix	in	individual	account	number	references.

Unless	you	override	the	FR	View	screen,	accounts	must	both	fall	within
the	specified	range	and	meet	other	criteria	specified	on	the	FR	View
screen.

If	you	specify	any	selection	criteria	in	column	B	of	a	default	specification
line,	that	criteria	is	in	effect	unless	you	override	it.

You	can	override	the	criteria	on	a	single	line	by	placing	a	new	criteria
expression	in	column	B.	The	criteria	expression	is	in	effect	only	for	the
line	on	which	you	define	it.	If	you	specify	a	criteria	for	a	single	formula	in
the	line,	the	line	criteria	is	ignored.

Related	Topics
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About	Optional	Fields	in	Financial	Reports
You	can	print	account	optional	fields	and	transaction	optional	fields	detail
using	Financial	Reporter.

You	can	retrieve	account	optional	fields	using	FRACCT	or	FRPOST.

Note:	A	field	name	for	an	account	optional	field	is	the	original
optional	field	name	with	the	prefix	A.	You	must	include	the	period
following	the	letter	A.

You	retrieve	transaction	optional	fields	using	FRPOST.

Note:	A	field	name	for	a	transaction	optional	field	is	the	original
optional	field	name	with	the	prefix	T.	You	must	include	the	period
following	the	letter	T.

If	an	FR	command	retrieves	data	from	more	than	one	transaction,	you
can	consolidate	optional	field	data	for	Amount,	Integer,	and	Number
optional	field	types	in	the	following	ways:

You	can	print	the	optional	field	value	of	the	first	retrieved	record	that
has	optional	field	values.

If	the	field	specified	in	the	first	parameter	of	the	FRACCT	or	FRPOST
command	is	an	amount,	integer,	or	number	field,	and	is	appended
with	U,	only	the	first	optional	field	value	is	reported.

You	can	print	a	consolidated	total	that	sums	up	all	values	from	the
retrieved	optional	fields.

If	the	specified	field	name	is	not	appended	by	anything	or	is
appended	by	C,	a	consolidated	total	is	printed.



Related	Topics
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About	Rounding	on	Balance	Sheets
If	you	have	spent	much	time	working	with	financial	statements,	you	know
that	balance	sheets	do	not	balance	when	you	round	account	totals.	You
always	have	to	force	a	balance	by	adding	a	rounding	difference	to	one	of
your	accounts	or	account	sections.

The	next	two	spreadsheet	examples	show	two	ways	to	ensure	that	your
balance	sheets	will	balance:

Example	1	shows	a	simple	mechanism	that	rounds	all	balances	on
the	statement,	and	then	forces	the	totals	of	rounded	assets	to
balance	rounded	liabilities.
Example	2	produces	a	more	theoretically	correct	balance	by
summing	all	unrounded	account	balances,	and	then	forcing	the
statement	to	balance	to	this	sum.

Example	2	makes	use	of	a	hidden	column	of	unrounded	account	data,
and	so	will	require	a	larger	spreadsheet	and	more	memory	to	run.

Example	1:	Forcing	a	Rounded	Balance	Sheet	to	Balance
This	sample	statement	rounds	and	sums	all	printed	figures	on	each	side
of	the	balance	sheet,	and	then	forces	liabilities	and	owner	equity	to
balance	with	the	assets.	Any	rounding	differences	are	lumped	with	owner
equity.

The	specification	for	the	statement	includes	a	few	rows	that	must	be
hidden	before	generating	the	final	report	(row	11	and	row	14).



This	specification	performs	the	following	actions:

1.	 Prints	the	rounded	balances	of	all	asset	accounts	it	retrieves	from	the
general	ledger	using	=ROUND(FRAMT("BALP"),-3).

The	-3	indicates	the	number	of	digits	to	the	left	of	the	decimal	place
to	which	the	value	is	rounded	(in	this	case,	thousands).

Because	D	is	specified	in	column	D,	each	account	is	printed	on	a
separate	line.	(This	is	on	row	5.)

2.	 Totals	the	rounded	balances	of	all	asset	accounts.	(Row	6.)
3.	 Prints	the	rounded	balances	of	all	liability	accounts	it	retrieves	from

the	general	ledger	using	the	same	formula.	Again,	each	account	is
printed	on	a	separate	line.	(Row	9.)

4.	 Totals	the	rounded	balances	of	all	liability	accounts.	(Row	10.)
5.	 Retrieves	a	single	balance	for	equity.	This	amount	is	calculated	on	a

hidden	row,	because	the	difference	between	the	rounded	assets	and
the	rounded	liabilities	plus	equity	will	be	added	to	the	equity	section.
(Row	11.)

6.	 Calculates	the	difference	between	the	balances.	(Row	14.)
7.	 Sums	the	difference	between	the	balances	and	the	equity	amount.

(Row	12.)
8.	 Displays	the	balance	for	total	liabilities	and	equity.	Since	this	balance

must	match	assets,	the	specification	uses	the	same	total.	(Row	13.)



Note:	If	any	accounts	are	missing	from	this	statement,	it	will	still
balance	(because	we	have	forced	a	balance	between	the	assets	and
the	liabilities	plus	equity).

Example	2:	Forcing	a	Balance	to	the	Rounded	Total	of
Unrounded	Account	Balances
The	following	statement	example	shows	another	way	to	set	up	a
rounding	mechanism	in	balance	sheets	to	handle	rounding	differences.

This	method	has	two	main	advantages	over	the	previous	example:

1.	 It	more	accurately	reflects	an	unrounded	balance	sheet,	because	the
final	balance	is	derived	by	summing	unrounded	balances,	instead	of
by	summing	rounded	ones.

2.	 It	is	self-auditing.

In	example	1,	you	are	forcing	assets	to	balance	liabilities	and	equity,	so
even	if	you	leave	accounts	off	the	statement,	the	report	will	balance.	In
example	2,	the	rounded	statement	will	nott	balance	if	you	leave	out	an
account.

Before	generating	the	final	report,	you	must	hide	column	F,	as	well	as
rows	6,	9,	and	10.	(See	the	final	report	example,	below.)	For	information
about	hiding	columns	and	rows,	see	About	Formatting	Financial
Statements.

This	specification	performs	the	following	actions:

1.	 Inserts	the	unrounded	balances	of	all	accounts	in	column	F	of	the



spreadsheet,	and	inserts	the	rounded	balances	of	all	accounts	in
column	G.

2.	 Calculates	a	rounded	sum	of	column	F	(in	G8)	and	column	G	(in	G9)
of	the	spreadsheet.

Note:	The	rounded	total	to	which	we	want	to	balance	is	the	total	in
G8.	The	total	in	G9	contains	the	cumulative	effect	of	all	rounding
differences.

3.	 Calculates	the	difference	between	the	rounded	totals	(G8	and	G9)	in
G10	of	the	spreadsheet.

4.	 Adds	the	difference	between	the	totals	to	the	last	range	of	accounts
(in	row	7	of	the	spreadsheet).

By	adding	the	rounding	difference	to	the	last	group	of	figures,	we	have
forced	the	figures	in	column	G	to	equal	the	total	in	G8.

You	handle	the	credit	side	of	the	balance	sheet	using	a	similar	approach,
summing	all	liabilities	with	owner	equity,	and	then	deciding	where	to	put
the	difference	between	the	sums	of	the	rounded	and	unrounded
balances.

The	generated	statement	includes	rows	and	columns	that	would	be
hidden	on	the	final	report	(shown	in	bold):

Rows	and	Columns	Hidden	on	Report
Description 	 Current

Balance

Cash 37,657.35 38,000

Receivables 89,576.73 90,000

	 356,526.85 357,000

Fixed	assets 	 356,000

Total	assets: 	 484,000

	 	 485,000

	 	 (1,000)



Related	Topics
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About	Page	Layout
The	File	>	Page	Setup	command	controls	the	page	layout	and	allows
you	to	set	headers,	footers,	and	margins	in	a	spreadsheet.



Printing	Column	Headings	with	Options/Set
Print	Titles
To	print	recurring	column	headings	at	the	top	of	each	page,	use	the
Financial	Statement	Designer's	Set	Print	Titles	feature.



Setting	Page	Breaks
If	you	set	a	page	break	in	the	report	template,	Financial	Reporter	treats
the	page	break	as	an	"As	is"	row.	and	inserts	it	in	the	corresponding	point
in	the	final	report.

The	main	use	of	page	breaks	is	to	begin	new	sections	of	a	statement	at
the	top	of	a	page,	or	to	ensure	that	all	columns	to	the	right	of	the	page
break	appear	on	a	separate	page.	Page	breaks	create	a	horizontal	and	a
vertical	division	where	you	insert	them	in	a	spreadsheet.

The	above	diagram	shows	the	effect	of	setting	two	page	breaks:	one	in
cell	A11,	which	creates	a	horizontal	break,	and	one	in	cell	H23,	which
also	creates	a	vertical	break.

Page	breaks	are	not	very	useful	for	statements	containing	account
references	that	are	expanded	into	many	rows.	They	work	best	for	starting
sections	of	a	report	on	a	new	page.

Generally,	for	multi-page	reports,	you	can	either	leave	the	pagination	to
the	Financial	Statement	Designer,	or	you	can	print	the	report	to	a	file	(or
copy	it	to	a	word	processor),	then	add	whatever	embellishments	you



want	in	the	report	file	before	printing	a	final	report.



Home	>	Financial	Reporter	>	Designing	Financial	Statements	>	Consolidating	Multiple
Financial	Statements



Consolidating	the	Financial	Statements	of
Multiple	Companies	in	Microsoft	Excel
These	instructions	assume	that	the	statement	you	are	consolidating
consists	of	a	single	worksheet	in	Excel.

To	consolidate	financial	statements:
1.	 In	Sage	300	ERP,	open	the	largest	company.
2.	 Open	General	Ledger	>	Financial	Reporter	>	Statement

Designer,	and	then	click	Start.
3.	 Open	the	financial	statement	that	you	want	to	consolidate,	and	save

it	as	a	new	workbook.

Tip:	Save	the	workbook	with	a	name	that	identifies	it	as	a
consolidated	statement.

4.	 Review	column	C	of	the	financial	statement	specification	to	make
sure	it	does	not	suppress	blank	links.	(You	use	a	Z	to	suppress	blank
lines.)

5.	 Turn	on	manual	calculation	in	Excel.	More...

You	can	recalculate	values	at	any	time	by	pressing	the	F9	key.

6.	 For	each	company	that	you	want	to	consolidate,	copy	the	worksheet
for	the	company	to	the	workbook	in	which	you	are	consolidating
statements.	More...

7.	 Rename	each	worksheet	for	the	company	it	represents,	saving	the
workbook	frequently.	(To	rename	the	worksheet,	right-click	the
worksheet	tab,	and	then	click	Rename.)

8.	 When	you	have	created	one	worksheet	for	each	company,	click	the
sheet	for	the	company	you	opened	in	Sage	300	ERP,	and	then	use
FR	View	to	generate	the	financial	statement.

For	more	information	about	FR	View,	see	FR	Menu	Commands.

9.	 Right-click	the	tab	for	the	first	sheet	in	the	workbook,	click	Insert,	and
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then	click	Worksheet	insert	a	blank	worksheet,	which	you	will	use	to
create	the	consolidated	statement.

10.	 Right-click	the	new	worksheet,	click	Rename,	and	then	type	a	name
for	the	worksheet.

Note:	These	instructions	use	Consol.	as	the	name	for	this
worksheet.

11.	 Generate	and	save	statements	for	each	additional	company	you	want
to	consolidate.	More...

12.	 Open	the	Consol.	worksheet	you	created,	and	then	open	a	new
window	for	each	worksheet,	arranging	them	so	they	are	all	in	view
and	their	contents	are	aligned.	More...

13.	 In	the	worksheet	that	contains	the	most	accounts,	select	and	copy
the	print	area.

14.	 In	the	Consol.	worksheet,	right-click	cell	A1,	and	then	select	Paste
Special	>	Values.

15.	 Without	deleting	any	blank	lines,	use	Excel	to	format	the	statement
as	needed.

Note:	You	may	have	to	insert	lines	for	accounts	that	appear	in	one
ledger,	but	not	in	others.

16.	 Clear	all	amounts	from	the	report.
17.	 Sum	the	accounts	for	like	accounts	across	all	worksheets,	so	that

totals	for	all	companies	appear	in	place	of	the	amounts	you	erased	in
the	previous	step.

Related	Topics
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Contents



Specifying	Column	and	Row	Contents
The	first	four	columns	of	a	financial	statement	specification	(usually
columns	A	through	D)	contain	important	control	information.	Learn	about
information	specified	in	these	columns.

About	Calculated	Columns

About	Default	Column	Specifications

Report	Specification	Columns

Sample	Default	Column	Specifications

Totaling	and	Subtotaling	Columns



Home	>	Financial	Reporter	>	Designing	Financial	Statements	>	Specifying	Column	and	Row
Contents	>	About	Calculated	Columns



About	Calculated	Columns
Calculated	columns	contain	figures	resulting	from	calculations	on	data	in
other	columns	of	the	statement.

To	define	a	calculated	column,	use	standard	spreadsheet	formulas	in	the
default	column	specification	row.	For	example:

	 Current
Balance

Last	Year
Balance

Curr/
LYear

Petty	cash 274.57 358.00 .77

Bank	account,
US	dollars

8,437.54 5,932.90 1.42

Bank	account,
CAD	dollars

4,372.96 3,665.39 1.19

		Total: 13,085.07 9,956.29 1.31

In	this	statement,	the	default	formula	for	the	last	column	(column	H	on	a
report	specification)	is	=(F1/G1).	The	formula	states	that	this	column
contains	the	value	of	column	F	divided	by	column	G.

When	the	report	is	generated,	Financial	Reporter	adjusts	the	relative	cell
references	on	each	line.



Using	Currency	Exchange	Rates	in	Column
Calculations
Financial	Reporter	can	use	exchange	rates	maintained	in	Sage	300	ERP,
so	you	can	create	financial	reports	in	any	currency	you	maintain,	using
the	exchange	rates	from	any	fiscal	period.

To	retrieve	exchange	rate	information,	you	use	the	FRRATE	function	to
get	exchange	rate	information.	For	more	information,	and	for	examples	of
how	to	use	this	function,	see	FRRATE	Function.

Note:	The	rate	returned	by	the	FRRATE	function	is	always	used	as	a
multiplier	to	convert	source	currency	to	functional,	even	if	you	defined
the	rate	as	a	divisor.	If	the	rate	is	defined	in	the	System	Manager	as	a
divisor,	Financial	Reporter	returns	the	reciprocal	of	the	rate.

Related	Topics
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About	Default	Column	Specifications
In	a	financial	statement	specification,	default	column	specifications	are
defined	in	the	first	line,	and	then	used	with	a	range	of	accounts	in	the	last
line.

The	following	example	illustrates	default	column	specifications	and
specification	lines	that	apply	to	a	range	of	accounts:

The	line	starting	with	two	backslashes	\\	in	column	A	contains	default
column	specifications.	These	default	column	specifications	are	in	effect
until	you	define	a	new	set	of	defaults.

To	use	the	currently	defined	default	column	specification,	you	simply	type
backslash	(\)into	a	cell,	as	in	the	last	line	of	the	example	above.

Note:

You	can	follow	\	with	-	or	+	to	print	the	inverse	or	the	absolute
value	of	the	formula	result.
Remember	that	the	actual	report	area	starts	from	column	E.



Advantages	of	Using	Default	Column
Specifications
Both	of	the	following	examples	print	exactly	the	same	information.	The
first	example	uses	a	complete	formula	to	get	each	value;	the	second
example	uses	default	column	specifications	and	an	account	reference	to
a	range	of	accounts.

For	each	of	the	following	examples,	assume	that	accounts	1100,	1200,
and	1400	are	consecutively	numbered	accounts	in	the	general	ledger.



Example	1:	Using	Formulas	to	Place	Values
In	this	example,	you	require	one	formula	to	print	each	piece	of
information:

To	print	the	current	balance	of	200	accounts,	along	with	their
descriptions,	you	would	require	400	formulas—and	you	would	have	to
change	the	specification	each	time	you	added	to	the	chart	of	accounts.



Example	2:	Using	Default	Column	Specifications
to	Place	Values
Inthis	example,	you	use	a	default	column	specification	to	place	values:

This	example	demonstrates	how	Financial	Reporter	lets	you	define	a
report	line	that	applies	to	a	range	of	accounts.	At	print	time	(or	when
using	FR	View	in	the	Financial	Statement	Designer),	the	single	line	will
be	expanded	to	as	many	lines	as	there	are	accounts	in	the	range.

In	other	words,	a	report	that	prints	the	current	balances	of	all	accounts	in
the	general	ledger	can	be	defined	by	a	single	line	that	specifies	the	range
of	all	accounts.

Note:

The	default	column	specifications	line	begins	with	two	backslashes
(\\).
The	default	column	specification	assigns	a	particular	formula	to	the
backslash	(\).	In	our	example,	the	formulas	have	used	only
Financial	Reporter	functions.

Alternatively,	you	could	assign	a	value	to	\,	or	make	use	of
spreadsheet	functions	in	your	formulas.	You	can	follow	\	with	-	or
+	to	print	the	inverse	or	the	absolute	value	of	the	formula	result.

The	default	column	specifications	are	exactly	the	same	as	the
formulas	in	the	first	example,	except	that	they	do	not	include	the
account	reference.

When	you	generate	the	statement,	Financial	Reporter	inserts	the
account	references	for	the	line	into	the	default	formula.

The	account	reference	is	for	a	range	of	accounts.	The	single	line	in
this	example	will	be	expanded	to	as	many	lines	as	there	are



accounts	in	the	range.
You	can	use	%%	to	specify	all	accounts	in	the	ledger.	For	more
information,	see	About	Account	Number	References.
Columns	B,	C,	and	D	may	contain	selection	criteria	that	affect	the
range	of	accounts	and	whether	the	final	value	will	be	printed	at	all.



Adding	Default	Information	for	Columns	B,	C,
and	D
The	following	example	illustrates	default	values	for	columns	B,	C,	and	D,
as	well	as	for	the	printed	columns	of	the	report:

Note	that	you	do	not	have	to	specify	a	backslash	(\)	in	columns	B,	C	or
D	to	inherit	the	defaults.	If	you	want	anything	but	the	default	values,	you
must	specify	the	information	you	want	to	display.

Financial	Reporter	evaluates	the	last	line	of	the	above	specification	and
performs	the	following	actions:

1.	 Evaluate	all	accounts	in	the	account	number	range	specified	in	row	3
to	see	that	they	are	type	"B"	accounts.

2.	 Get	the	account	balance	of	each	account	in	the	range	that	is	a
balance	sheet	account.

3.	 Total	the	balances—because	T	in	column	D	specifies	that	a	single
total	line	will	be	generated	from	the	account	range,	rather	than	one
line	for	each	account	to	list	the	details.

Note:	If	you	leave	column	D	blank,	or	specify	a	D,	Financial
Reporter	lists	all	details.

4.	 Check	whether	the	amount	in	column	F	is	zero	(because	of	the	Z	in
column	C).	If	it	is,	Financial	Reporter	does	not	print	the	line.

Financial	Reporter	looks	only	at	the	numbers	on	a	line	to	decide	if	zero-
suppression	should	take	place.	In	this	example,	the	description	in	column
E	does	not	affect	whether	the	line	is	printed.

If	you	do	not	want	to	suppress	zeroes	on	a	single	line,	enter	the	N	in
column	C	on	the	line	that	you	want	to	print.



For	details	on	specifying	selection	criteria	and	suppressing	lines,	see
About	Consolidating	Account	Ranges,	About	Excluding	Lines	from
Reports,	and	About	Selection	Criteria	for	Filtering	Accounts.

For	more	information	about	Financial	Reporter	functions,	see	Financial
Reporter	Functions.

Related	Topics
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About	Columns	in	Report	Specifications
Most	of	a	financial	report	specification	is	a	template	for	the	report	it
produces.	For	example,	all	report	formatting	(such	as	column	widths,
fonts,	highlighting	and	underlining)	appears	on	the	financial	report
specification.

The	first	four	columns	of	the	report	specification	(columns	A	through	D)
contain	important	control	information.

Note:	You	can	begin	a	specification	in	any	column,	as	long	as	the	Spec
range	begins	with	the	same	column.



Sample	Report	Specification
In	this	example,	row	1	is	a	default	row.	To	use	the	default	formulas	in
subsequent	rows,	place	a	backslash	in	the	appropriate	spreadsheet	cells.



Column	A
The	contents	of	column	A	of	each	row	(the	first	column	of	the	Spec
range)	determine	the	purpose	of	all	columns	in	the	row.	There	are	five
possible	types	of	rows	in	a	report	specification:

Comment	row.	If	column	A	starts	with	..	(two	periods),	the	row	is	a
comment	row.
"As	is"	row.	If	column	A	is	blank,	the	row	is	part	of	the	report	and	will
appear	"as	is"	on	the	final	report.
Default	row.	If	column	A	starts	with	\\,	the	row	is	used	for	setting	up
defaults	for	the	remaining	rows	on	the	report.

You	can	have	more	than	one	default	specification	row;	each	applies
to	the	rows	between	it	and	the	next	default	row.

Title	row.	If	column	A	starts	with	\T,	the	row	is	used	to	define	title
lines	on	the	final	report.	You	can	have	up	to	five	title	rows,	which	will
appear	at	the	top	of	each	tab	of	the	report	(immediately	under	the
header	lines).
Body	specification	row.	Rows	that	start	with	account	number
references	are	called	"body	specification	rows."

Note:

If	column	A	contains	any	other	data,	Financial	Reporter	assumes
that	the	data	is	a	reference	to	one	or	more	account	numbers.
If	an	account	number	appears	in	column	A,	it	generally	means	that
all	printed	columns	in	the	row	will	contain	data	from	that	account.



Columns	B,	C	and	D
Columns	B,	C	and	D	filter	accounts	specified	in	column	A	(columns	2
through	4	of	the	Spec	range)	to	refine	the	account	selection.	For
example:

Column	A	can	specify	a	range	of	accounts.
Column	B	can	contain	a	filter	to	restrict	the	range	of	accounts	in
column	A	to	a	particular	account	group	(or	to	an	account	type	or
account	name).

Column	B	can	also	refer	to	the	filter	for	posted	transactions,	if
Column	D	refers	to	listing	by	posted	transaction	details	or	by	posted
transaction	consolidated	details.

For	more	information,	see	About	Selection	Criteria	for	Filtering
Accounts.

Column	C	can	remove	any	lines	from	the	report	that	have	zero
balances	(use	Z	to	omit	zero-balance	lines)	or	meet	a	condition	such
as	"balances	less	than	$1,000".

Column	D	can	consolidate	the	balances	of	the	range	of	accounts,
consolidate	by	account	segment,	list	each	account	separately,
consolidate	all	values	from	retrieved	optional	fields,	or	print	the
optional	field	value	of	the	first	retrieved	record.	This	can	also	be
consolidated	by	transaction	date	and	posting	sequence.

Use	T	to	generate	a	single	total	line	for	an	account	range.	If	you
leave	column	D	blank,	or	specify	a	D,	Financial	Reporter	will	list	the
details	for	each	account	in	the	range.

Column	D	constants	for	use	in	the	spec	area	are	the	indicators	for	listing
by	transaction	details,	by	transaction	consolidated	total,	and	by
transaction	total.	Values	must	begin	with	P.

Column	D	Constants

List	By Cell	Value	of	Column	D



Transaction	details	in	posted	transaction
order

PD

Transaction	consolidated	total PT

Transaction	consolidated	by	account P(POSTRAN)

Transaction	consolidated	by	journal	date P(POSTDATE)

Transaction	consolidated	by	posting
sequence

P(POSTSEQ)

Transactions	can	also	be	listed	by	consolidated	account	segments	and
account	groups	as	listings	by	accounts.	When	consolidating	by	a	specific
account	order	in	listing	by	transactions,	the	column	D	value	must	start
with	P	instead	of	with	D.

Example:	P(ACSEGVAL02)	is	the	consolidation	of	transactions	with
account	segment	2	retrieving	records	from	a	transaction,	while
D(ACSEGVAL02)	is	the	consolidation	of	account	history	with	account
segment	2	retrieving	records	from	an	account.

To	list	the	details	by	transaction,	the	spec	must	provide	a	correct	sorting
order,	as	illustrated	in	the	following	table:

Sorting	Order

Exclusive	Sorting	Order Meaning

POSTTRAN By	Posted	Transaction,	in	account	order

POSTDATE By	Date	Order

POSTSEQ By	Posting	Sequence	Order



POSTACCT By	Account	Posting	Sequence

Note:

If	the	account	reference	is	specified	with	exclusive	sorting	order	at
column	A	from	a	spec	line	and	the	order	is	an	account	order	(for
example,	1000:9000|ACCT),	Financial	Reporter	does	not
generate	the	transaction	details	of	the	spec	line.
If	the	consolidation	value	in	column	D	is	P(POSTTRAN),	the
sorting	order	must	be	POSTTRAN.
If	the	consolidation	value	in	column	D	is	P(POSTDATE),	the
sorting	order	must	be	POSTDATE.
If	the	consolidation	value	in	column	D	is	P(POSTSEQ),	the	sorting
order	must	be	POSTSEQ.
If	the	consolidating	total	is	retrieved	by	any	defined	account
switches,	like	P(ACSEGVAL02),	it	can	be	sorted	by	any	defined
account	order,	similar	to	listing	by	accounts.
Listing	by	transaction	is	only	limited	to	the	inquiry	of	transaction
records	from	the	inquired	period.
Use	T	to	generate	a	single	total	line	for	an	account	range.	If	you
leave	column	D	blank,	or	specify	a	D,	Financial	Reporter	lists	the
details	for	each	account	in	the	range.



Column	E
The	report	template	actually	starts	in	Column	E,	the	fifth	column	of	the
Spec	range.	Any	value	or	formula	placed	in	the	report	template	area	is
part	of	the	final	report.

The	following	example	shows	a	report	specification	displayed	in	formula
view.

In	this	example,	the	first	three	lines	of	column	F	that	appear	on	the	report
are:

=FR("CONAME"),	a	Financial	Reporter	function	that	displays	the
company	name	on	the	statement.
The	text	"Schedule	of	Expenses."
The	text	and	function	""For	the	period	ending	"	&FR("END")."	The
function	inserts	the	period	end	date	from	the	database.

Row	9	of	the	specification	sets	the	default	contents	of	statement
columns.	Column	A	of	this	row	starts	with	two	backslashes.

The	next	row	with	text	contains	the	headings	for	columns	G,	H,	and	I.
These	headings	are	printed	"as	is."



Note:	You	use	formatting	commands	in	Excel	to	underline	these	column
headings.

The	next	row	with	text	will	be	expanded	on	the	printed	report	to	include
all	accounts	in	the	range	between	6000	and	6999	that	meet	other
selection	criteria	specified	in	cells	B,	C,	and	D,	or	entered	at	print	time	on
the	Print	Statements	screen.	In	the	spreadsheet's	formula	view,	the	row
looks	like	this:

The	backslash	(\)	in	the	three	columns	on	the	right	indicates	that	each
cell	value	will	be	generated	from	the	default	formula	set	for	the	column.
(Financial	Reporter	inserts	the	account	reference	in	column	A	into	any
default	formula	that	requires	the	account	reference	parameter.	For
example,	the	default	formula	for	column	G	is	=FRAMTA("NETP").
FRAMTA	is	a	Financial	Reporter	function	that	prints	the	account	period
balances	or	net	amounts	from	the	account	fiscal	sets.	In	this	case,	the
formula	specifies	the	net	amount	for	the	current	period.)

When	Financial	Reporter	processes	this	cell	of	the	statement	template,	it
expands	the	formula	with	the	account	reference	from	column	A.	(For
example,	=FRAMTA("NETP",	"6000").)

The	remaining	two	columns	also	use	a	default	formula;	in	this	case,
bringing	in	the	net	changes	for	the	quarter	to	date	and	the	year	to	date.

The	final	row	in	our	example	is	the	total	line:

Note:	You	use	formatting	commands	in	Excel	to	format	cells	with	top
and	bottom	borders.

Notice	also	that	the	total	formula	for	each	column	refers	to	a	single	cell
(or	list	of	cells)	in	the	specification	range.	In	our	example,	the	single	cell
in	the	specification	range	formula	will	be	replaced	in	the	report	range
formula	by	a	range	reference	that	contains	as	many	rows	as	there	are
accounts	in	the	account	range	specified	on	line	12.



Related	Topics
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Sample	Default	Column	Specifications
The	following	examples	illustrate	standard	financial	report	formats	and
the	column	specifications	you	use	to	produce	these	reports.



Example	1:	Balance	This	Period	and	Last	Period	
This	example	produces	a	comparative	balance	sheet.

Column	E	lists	the	current	balance.
Column	F	lists	the	balance	in	the	previous	period.



Example	2:	This	Year	/	Last	Year	Balances	with
Percentage	of	Total	Columns	
This	example	produces	a	comparative	balance	sheet	with	four	columns
of	data.

Column	G	lists	the	current	balances.
Column	I	lists	the	balances	for	the	corresponding	period	in	the
previous	year.
Columns	H	and	J	compare	each	account	as	a	percentage	of	the
totals	for	the	corresponding	year.

Note:	The	formulas	in	columns	H	and	J	illustrate	that	the	range	of
accounts	is	defined	in	row	3	of	the	report	specification,	and	the	total
calculation	is	in	row	4.	Financial	Reporter	recalculates	these	cell
references	for	the	generated	report.



Example	3:	Period	and	Year-to-Date	Expenses	
This	example	produces	a	comparative	expense	schedule	with	two
columns	of	data.

Column	E	lists	the	expenses	this	period.
Column	F	lists	the	expenses	year-to-date.



Example	4:	Current	Period	and	Year-to-Date
Expenses	as	a	Percentage	of	Sales	
This	example	produces	a	comparative	expense	schedule,	with	each
current	period	and	year-to-date	expense	listed	as	a	percentage	of	sales.

The	range	of	expense	accounts	is	defined	in	row	13,	and	uses	the
default	formulas	defined	in	row	11	of	the	report	specification.
The	total	sales	calculation	is	in	row	9.

Note:	Financial	Reporter	recalculates	all	formula	cell	references	for	the
generated	report.



Example	5:	Current	Period	and	Year-to-Date
Expenses	Compared	to	Last	Year	
This	example	produces	a	comparative	expense	schedule	with	six
columns	of	data.

Column	G	lists	the	current	period	expense.
Column	H	lists	the	expense	for	the	corresponding	period	in	the
previous	year.
Columns	J	and	K	list	the	year-to-date	expenses.
Columns	I	and	L	compare	each	amount	as	a	percentage	of	the
amount	in	the	previous	year.

Note:	The	range	of	expense	accounts	is	defined	in	row	21	of	the	report
specification,	but	the	formulas	in	I18	and	L18	reference	the	default
formula	cells	that	are	used	in	row	21.	Financial	Reporter	recalculates
these	cell	references	for	the	generated	report.



Example	6:	Side-by-Side	Departmental
Statements	
This	example	produces	a	side-by-side	departmental	comparative	balance
sheet	with	three	columns	of	data.

The	processing	order	is	set	in	column	A	to	Account	order.
Column	D	indicates	that	each	time	the	account	number	changes,
Financial	Reporter	should	create	a	new	line.
Column	E	lists	the	name	of	each	account.
Column	F	provides	the	current	balance	of	accounts	that	meet	the
criterion	of	Department	A.
Column	G	provides	the	balance	of	accounts	that	meet	the	criterion	of
Department	B.

Related	Topics
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About	Totals	and	Subtotals
Financial	statements	contain	columns	of	figures	that	are	subtotaled	and
totaled	according	to	account	type.

The	most	common	arithmetical	operation	involves	summing	the	balances
or	net	changes	of	groups	of	accounts	at	a	moment	in	time,	as	in	the
following	example:

	 Current	Balance Last	Year
Balance

Petty	cash 274.57 358.00

Bank	account,	US
dollars

8,437.54 5,932.90

Bank	account,	CAD
dollars

4,372.96 3,665.39

		Total: 13,085.07 9,956.29

If	this	was	a	spreadsheet,	you	would	place	a	formula	such	as
=SUM(B3:B5)	in	each	of	the	"total"	cells.	This	formula	would	add
together	the	values	in	cells	B3,	B4	and	B5,	and	display	the	total	in	B6.

Totaling	a	column	of	figures	with	Financial	Reporter	is	just	as	easy.	All
you	do	is	refer	to	the	cells	or	range	of	cells	in	the	specification,	and
Financial	Reporter	will	translate	the	cell	references	in	the	final	report.	You
may	refer	to	a	single	cell,	a	list	of	cells,	or	a	cell	range.

In	the	following	example,	the	formula	=SUM(F3)	will	be	translated	when
you	generate	the	report	to	the	appropriate	range	of	cells	in	the	Report
range	to	add	the	balances	of	all	accounts	in	the	range	1100	to	1300.



Note:

Excel	does	not	allow	you	to	specify	a	negative	range	of	cells	as	a
parameter	of	SUM.	For	example,	the	following	SUM	formula	will	not
work	in	Excel:	=SUM(-G10:G14).

You	can	fix	the	formula	by	moving	the	minus	sign	like	this:	=-
SUM(G10:G14).

In	summary,	to	perform	any	mathematical	operations	within	the	financial
report,	use	standard	spreadsheet	formulas	and	functions.

Related	Topics
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Retrieving	General	Ledger	Account	Information
In	the	Statement	Designer,	you	use	Excel	formulas	to	retrieve	company
account	record	information,	fiscal	set	values,	and	company	information
from	General	Ledger,	and	to	display	this	information	in	financial
statements.

Using	Formulas	to	Retrieve	G/L	Account	Information

About	Account	Number	References

About	Account	Order	in	Financial	Reports

About	Consolidating	Account	Ranges

About	Excluding	Lines	from	Reports

About	Selection	Criteria	for	Filtering	Accounts

About	Wildcard	Characters	in	Account	Numbers

Account	Reference	Syntax	and	Examples

Expression	Syntax	for	Selection	Criteria
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Using	Formulas	to	Retrieve	General	Ledger
Account	Information
In	the	Financial	Statement	Designer,	you	use	Excel	formulas	to	insert
account	record	information	or	fiscal	set	values	anywhere	in	a	financial
statement.

Example:

FRACCT("ACCTDESC","1000-333")	inserts	the	account
description	from	account	1000-333	(for	example,	"Cost	of	goods	sold").

FRAMT("ABALP.2019","1000-333")	inserts	the	actual
balance	of	account	1000-333	for	the	current	fiscal	period	for	the	year
2019.

You	can	also	insert	company	information	in	a	financial	statement.	For
example,	FR("Coname")	inserts	the	name	of	the	currently	open
company.

The	easiest	way	to	insert	Sage	300	ERP	financial	information	is	by	using
the	FR	Paste	function,	which	you	can	use	to	create	a	formula	quickly.	For
more	information,	see	About	FR	Paste.

To	specify	balances	and	quantities,	you	use	the	following	syntax:

Financial	Information	Syntax
Formula Sage	300

ERP
Financial
Information

Notes

PBALP Account
balance

If	BALP	is	specified	without	an	A	or	P	prefix
for	actual	or	provisional	amounts,	it	will	default
to	the	report	setting	chosen	at	print	time.

PBALP Provisional
balance

	



QABALP Actual
quantity

	

QPBALP Provisional
quantity

You	can	specify	budget	sets	according	to	the
edition	of	Sage	300	ERP	you	use:

Sage	300	Standard	ERP	includes	budget
sets	1	and	2
Sage	300	Advanced	ERPincludes	budget
sets	1,	2,	and	3
Sage	300	Premium	ERP)	includes	the
numbers	1	to	5	for	the	budget	sets	(for
example,	1BALP	or	2BALP)

Tip:	You	can	construct	your	financial	statements	by	placing	a	Financial
Reporter	function	at	each	point	where	you	want	to	print	financial
information.	However,	identifying	each	item	individually	can	be	a	time-
consuming	and	unnecessarily	rigid	way	to	create	a	statement.
Developing	a	statement	specification	with	default	formulas	for	each
column,	indicating	the	group	of	accounts	to	which	the	column	formulas
will	apply,	is	a	more	flexible	and	efficient	way	to	create	your	statement.

Related	Topics
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About	Account	Number	References
An	account	number	reference	specifies	the	accounts	from	which	you
want	to	retrieve	General	Ledger	data.

Tip:	In	the	Statement	Designer,	use	FR	Paste	to	specify	accounts	and
account	ranges	without	manually	entering	formulas.	For	more
information,	see	About	FR	Paste.



Specifying	Accounts	and	Ranges	of	Accounts
You	can	specify	a	single	account	number,	or	a	range	of	account	numbers
in	consolidated	(single-row)	or	detailed	(one	row	per	account)	format.

Example:

The	formula	=FRAMT("BALP","1200:1500")	retrieves	data
from	a	range	of	accounts	into	a	single	spreadsheet	cell.

When	specifying	account	groups,	you	can	use	these	formulas:

\\acctgroup	(sort	by	account	group)
\\acctgroupsort	(account-sorted	group)

The	rules	for	specifying	an	account	number	reference	are	the	same,
whether	the	reference	is	in	a	function	or	in	column	A	of	a	specification
row.

Example:

Column	A	of	a	specification	row	specifies	account	data	to	use	for	the
row:

A B C D

%-1000~1100 	 	 	

In	this	example,	%	is	a	wildcard	character	that	takes	the	place	of	one	or
more	characters.	For	more	information,	see	About	Wildcard	Characters
in	Account	Numbers.

In	column	D,	you	can	enter	D	to	specify	that	each	account	is	listed
separately,	or	T	to	specify	that	each	account	is	totaled	on	a	single	line.

For	more	information,	see	Account	Reference	Syntax	and	Examples.



Account	References	and	Performance
Financial	Reporter	can	generate	reports	faster	when	it	does	not	have	to
look	up	information	for	a	substantial	number	of	extra	accounts.	For	this
reason,	check	that	the	account	processing	order	in	the	report	matches
the	way	you	specify	account	references.

For	more	information,	see	About	Account	Order	in	Financial	Statements.



Restricting	Account	Selection
Financial	Reporter	selects	which	account	data	is	to	appear	in	a	financial
report	by	evaluating	three	separate	account	number	filters:

The	account	number	reference	in	column	A	of	the	report	line.
The	account	filtering	expression	in	column	B	(if	there	is	one).
The	print	range	options	for	the	entire	report.

Normally,	an	account	has	to	satisfy	the	requirements	of	all	three	filters	in
order	to	be	included	in	the	report.	However,	Financial	Reporter	also
provides	a	mechanism	for	specifying	a	report	range,	and	for	including
accounts	which	lie	outside	that	range.

The	easiest	way	to	add	account	numbers	to	a	financial	statement	is	using
FR	Paste.	For	more	information,	see	About	FR	Paste.

Specifying	Account	Structures
To	restrict	account	number	selection	to	a	particular	account	structure,	use
a	formula	such	as	aaaa[ACCT],	bbbb~cccc-A[MANU],	which
specifies	an	individual	account	number	and	a	range	of	account	numbers.
The	square	brackets	indicate	the	account	structure	codes	used	by	the
account	numbers.

Specifying	a	Segment	to	Override	a	Segment	Range
You	can	override	a	segment	range	specified	on	the	Print	Financial
Statements	screen	by	including	the	segment	values	you	want	on	the	line
in	the	column	A	account	number	reference.

Example:	If	you	want	to	compare	the	performance	of	each	department
to	the	total	sales	for	the	organization,	you	can	specify	the	total
organization's	sales	on	a	line	as	follows:	4000~4999-A,
4000~4999-B,	4000~4999-C,	4000~4999-D.	In	this
example,	you	would	print	reports	specifying	a	segment	range	of	A,	of	B,
and	so	on.



Turning	off	Report-level	Account	Range	Filtering
A	$	prefix	turns	off	report-level	account	range	filtering	for	the	particular
account	number	reference.	If	you	use	a	$	prefix,	any	account	numbers
that	match	the	account	reference	you	specify	and	match	the	selection
criteria	in	column	B	will	appear	on	the	report,	regardless	of	the
restrictions	imposed	by	Financial	Reporter	print	settings.

You	can	also	use	the	$	prefix	with	the	%%	wildcard	characters	to	include
any	account	in	the	ledger	allowed	by	the	criteria	in	column	B	for	the	row.
(%%	is	an	account	number	reference	that	includes	all	accounts,	no	matter
what	their	account	structure.)

Specifying	Ranges	of	Accounts	when	the	Account
Segment	is	not	First	in	the	Account	Structure
Account	references	work	best	when	the	account	segment	is	the	first
segment	of	your	account	numbers.	Not	only	is	it	easier	to	specify	account
ranges,	but	Financial	Reporter	processes	them	more	quickly	as	well.

If	you	do	not	have	the	account	segment	first,	you	can	still	specify	a	range
of	account	segment	codes	and	print	the	accounts	in	account	segment
order.

For	example:

4000~8000	specifies	all	accounts	with	an	account	segment	code
from	4000	to	8000,	no	matter	how	many	segments	are	in	the	number,
and	no	matter	where	the	account	segment	is	in	the	account	structure.
A~C-400~600|ACCT	specifies	all	accounts	with	an	account
segment	value	between	400	and	600,	and	with	a	Department
segment	value	from	A	to	C.	|ACCT	indicates	that	the	accounts	are
ordered	by	account	segment.
%-400~600-%|ACCT	specifies	account	segment	values	from	400
to	600,	no	matter	what	the	value	of	other	segments.	Again,	the
accounts	are	ordered	by	account	segment.
%%|ACCT	specifies	all	account	numbers	ordered	by	the	account
segment.	To	specify	a	range	or	account	segments,	add	a	criterion	in



column	B,	such	as	ACCTSEGVAL	>=	"4000"	AND
ACCTSEGVAL	>=	"6000".

The	last	example	is	the	most	flexible,	because	it	specifies	a	range	of
account	segment	values	no	matter	where	the	account	segment	lies	in	the
account	structure.	This	is	especially	useful	if	you	have	more	than	one
account	structure.

Related	Topics
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About	Account	Order	in	Financial	Statements
In	financial	statements,	Financial	Reporter	lists	ranges	of	accounts	in	the
order	set	in	the	financial	report	specification	or	(if	not	set	in	the
specification)	in	the	order	you	specify	when	printing.

You	can	sort	accounts	by	any	account	segments,	and	you	can	specify	a
range	of	values	for	each	segment	you	sort	by.	You	can	also	sort	by
account	group,	using	the	formula	\\acctgroup	or	by	account-sorted
group,	using	the	formula	\\acctgroupsort.

Example:

If	your	accounts	have	two	segments,	the	account	reference
100~120-A~B	generates	two	possible	account	listings,	depending	on
the	sort	order	you	specify:

If	accounts	are	sorted	by	segment	1,	they	are	listed	like	this:

100-A
100-B
120-A
120-B

If	accounts	are	sorted	by	segment	2,	they	are	listed	like	this:

100-A
120-A
100-B
120-B



Specifying	Order	at	Print	Time	or	in	the	Default
Row	Specification
The	default	order	for	processing	accounts	is	the	order	specified	at	print
time	on	the	Financial	Statements	screen	(or	the	FR	View	screen	when
editing	specifications).

You	can	also	enforce	the	order	of	processing	accounts	in	ranges	for	all	or
part	of	a	report	by	specifying	the	order	in	the	first	column	of	the	default
row	specification	(immediately	after	the	backslashes	"\\").

You	may	process	account	numbers	in	any	of	the	following	orders:

\\ACCTID	(account	number	order)
\\ACCT	(account	segment	order)
\\ACCTGROUP	(account	group	order)
\\ACSEGVALn	(account	segment	#n	order)
\\Segment_desc	(to	list	accounts	by	the	segment	with
description	Segment_desc.	For	example,	\\REGION)

The	order	you	specify	determines:

The	order	in	which	accounts	in	expanded	account	references	are
printed.
The	ease	(and,	consequently,	the	speed)	with	which	the	accounts
can	be	retrieved	by	Financial	Reporter.

In	the	following	example,	account	numbers	have	two	segments:	a
department	segment	and	an	account	segment.	The	department	segment
is	first	(not	recommended),	and	there	are	only	two	department	codes	in
the	ledger,	but	a	large	number	of	accounts.	The	first	account	segment	in
the	ledger	is	1000.

If	Financial	Reporter	processes	accounts	in	order	by	the	account
segment,	it	will	only	have	to	process	accounts	1000	through	1100
(specified	like	this).



A B C D

\\ACCT 	 	 	

	 	 	 	

%-1000~1100 	 	 	

The	accounts	will	appear	in	the	following	order	on	the	report	(by	account
segment,	then	by	department):

A-1000
B-1000
A-1100
B-1100

If,	on	the	other	hand,	Financial	Reporter	processes	accounts	in	account
number	order	(which	lists	the	department	segment	first)	it	will	have	to
scan	each	account	in	the	ledger	to	see	if	it	matches	the	range.

A B C D

\\ACCTID 	 	 	

	 	 	 	

%-1000~1100 	 	 	

The	final	report	will	also	be	in	account	number	order,	which,	in	this	case,
will	be	in	department	order	for	the	indicated	range.

A-1000
A-1100
B-1000
B-1100

The	order	of	segments	in	an	account	number	is	defined	by	the	account's
structure	code—not	by	the	order	of	segments	shown	on	the	G/L	Options
screen	in	General	Ledger.	Consequently,	if	you	have	different	structures
that	have	different	first	segments,	ACCTID	order	will	produce	odd	results,
and	you	should	order	accounts	by	a	particular	segment	or	by	account
group.



If	you	choose	to	print	by	the	account	segment,	the	order	for	processing	is
first	by	that	account	segment,	and	second	by	the	complete	account
number	(as	defined	by	its	structure).

If	you	print	by	the	account	group	code,	the	order	is	first	by	account	group,
second	by	account	segment	code,	and	third	by	account	number.

The	default	sort	order	remains	in	effect	until	you	specify	another	sort
order,	or	unless	it	is	overridden	in	a	specific	account	reference	(see	the
next	section).



Specifying	Account	Order	for	One	Account
Reference
You	can	choose	to	process	a	single	account	reference	in	a	different	order
than	indicated	by	a	default	row	specification	or	by	the	report	options	on
the	Financial	Statements	screen.

You	specify	a	processing	order	for	an	account	reference	by	placing	it
immediately	after	the	account	reference	Account	reference	|
Order.

Example:

1000-%	|ACCT	uses	account	order,	so	processes	only	account
1000.	Segment	2	will	appear	in	any	order.
1000-%	|ACSEGVAL2	uses	segment	2	order,	so	will	scan	all
account	numbers.	However,	segment	2	will	be	in	order.
1000:3000[REGION]	|ACCTID	uses	account	number	order
for	accounts	that	use	the	REGION	account	structure.	Will	only
process	particular	accounts	in	the	range.

Note:	If	the	account	reference	specifies	a	range	using	a	colon	:,	this
reference	will	be	processed	in	account	number	order	unless	you	set	an
order	for	the	reference	using	the	|	character	(no	matter	what	order	is
set	in	the	Print	dialog	box	or	in	the	default	row	specification).

As	you	can	see	from	these	examples,	the	way	you	reference	accounts
can	have	a	substantial	impact	on	performance.

For	information	on	specifying	account	references,	see	About	Account
Number	References.



Related	Topics
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About	Consolidating	Account	Ranges
You	can	perform	two	extremely	useful	operations	on	a	group	of	accounts.
You	can:

Consolidate	all	the	lines	of	an	account	range	instead	of	printing	out
the	details.
Print	subtotals	for	groups	of	accounts	according	to	changes	in
particular	account	segments.



Grouped,	Separate,	or	Summarized	Data
You	can	generate	separate	lines	for	each	account	in	an	account	range,
consolidating	the	account	reference	in	a	single	line,	consolidating
account	data	by	account	group,	or	you	can	consolidate	the	account	data
by	account	segment	code.

You	specify	this	choice	in	column	D	of	a	report	specification.	In	addition,
you	can	use	the	column	D	setting	to	override	the	account	order
processing	on	a	line-by-line	basis.

Column	D	Valid	Values
Value Description

D For	a	detail.	Prints	one	line	for	each	account
number.

RD For	a	rollup	account	detail.	Prints	all	the	top-level
rollup	details,	as	well	as	accounts	not	in	rollup
groups.

T For	a	total.	Consolidates	the	data.

D(ACCT) Consolidates	by	the	account	segment	code,	setting
the	account	number	sorting	order	to	account
segment	order	for	this	single	account	reference.

D(ACCTGROUP) Consolidates	by	the	account	group.

D(ACSEGVALn) Consolidates	by	account	segment	number	n.

D(AcctSegID) Consolidates	by	the	named	account	segment—for
example,	D(REGION).

PD Consolidates	by	transaction	details	in	posted
transaction	order.

PT Consolidates	by	transaction	consolidated	total.

P(POSTTRAN) Consolidates	by	transaction	consolidated	by
account.

P(POSTDATE) Consolidates	by	transaction	consolidated	by	journal



date.

P(POSTSEQ) Consolidates	by	transaction	consolidated	by	posting
sequence.

In	each	case	where	consolidation	is	performed	on	the	basis	of	a	property
of	the	account	number,	Financial	Reporter	processes	the	account
number	in	the	order	required	for	consolidation.	For	example,	if
consolidation	is	by	account	group,	the	account	numbers	are	processed	in
account	group	order.

Transactions	can	also	be	listed	by	consolidated	account	segments	and
account	groups	when	listing	by	accounts.	If	you	are	consolidating	by	a
specific	account	order	in	a	list	of	transactions,	the	value	in	Column	D
must	begin	with	a	“P”.	For	example:

P(ACSEGVAL02)	returns	transaction	records	consolidated	by
account	segment	2.
D(ACSEGVAL02)	returns	account	history	records	consolidated	by
account	segment	2.

FR	requires	a	correct	sorting	order	in	Column	D	in	order	to	list	details	by
transaction	through	field	consolidation,	as	follows:

Sorting	Order	for	Consolidating	Transactions
Exclusive	Sorting	Order Meaning

POSTTRAN By	posted	transaction	in	account	order

POSTDATE By	date	order

POSTSEQ By	posting	sequence	order

POSTACCT By	account	posting	sequence

Important!
The	sorting	order	must	be	POSTTRAN	if	the	consolidation	value	in
column	D	is	by	P(POSTTRAN).
The	sorting	order	must	be	POSTDATE	if	the	consolidation	value	in
column	D	is	by	P(POSTDATE).



The	sorting	order	must	be	POSTSEQ	if	the	consolidation	value	in
column	D	is	by	P(POSTSEQ).
Anything	that	appears	in	column	D	on	a	default	specification	line	will
be	used	by	all	subsequent	lines	unless	you	specifically	override	it.



Examples	of	"T"	and	"D"	Consolidation	Settings
The	following	examples	show	the	effect	of	T	and	D	settings	in	column	D
of	a	report	specification.

Displaying	Account	Balances	on	Separate	Lines
Specifying	D	in	column	D	lists	each	of	the	accounts	between	1100	and
1200	on	separate	lines.

	 Current	Balance

Petty	cash 274.57

Bank	account 8,437.54

Bank	account,	CAD
dollars

4,372.96

Total: 13,085.07

Displaying	Account	Totals	on	a	Single	Line
Specifying	T	in	column	D	indicates	that	all	accounts	in	the	range	are
consolidated.

The	resulting	report	totals	the	balances	of	all	the	accounts	between	1100
and	1200,	and	reports	the	total	on	a	single	line.

	



Current	Balance

Liquid	assets 13,085.07

Displaying	Accounts	in	Segment	Order,	Consolidated	by
Segment
Specifying	D(ACCT)	in	column	D	indicates	that	all	accounts	in	the
range	are	to	be	listed	in	account	segment	order	and	consolidated	by	the
account	segment.

	 Current
Balance

Petty	cash 274.57

Bank	account 12,810.50

Total: 13,085.07

Two	lines	are	printed	in	the	above	example,	because	there	are	two
account	numbers	with	an	account	segment	code	between	1100	and
1200.

The	first	account	segment	code	(1100)	is	for	petty	cash,	and	the	second
account	segment	code	(1200)	is	for	Bank	Accounts.	Two	separate
account	numbers	have	an	account	segment	code	of	1200,	but	these	two
accounts	(shown	in	the	previous	example)	have	been	consolidated.

D(ACCT)	summarizes	by	account	segment	code	all	other	segments
that	happen	to	be	within	the	ranges	specified	when	printing	the	report.

For	subsequent	rows,	the	order	will	revert	to	the	order	that	was	in	effect
prior	to	this	specification	row.
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About	Excluding	Lines	from	Reports
You	can	specify	conditions	to	exclude	generated	lines	from	a	report
based	on	the	contents	of	the	line.	You	define	the	criteria	for	excluding	a
report	line	by	adding	a	formula	to	column	C	of	the	line.

Suppressing	lines	with	zero	values.	To	specify	zero-line
suppression,	you	type	Z	in	column	C.	Financial	Reporter	suppresses
all	lines	with	a	value	of	zero.

If	you	do	not	want	to	suppress	zeros	on	an	individual	line,	but	you
specified	Z	in	the	default	specification,	type	N	in	column	C	of	the	line
you	want	printed.

Using	logical	value	formulas	to	include	and	exclude	lines.	You
can	place	a	logical	value	formula	(TRUE/FALSE)	in	column	C.	If	the
formula	in	column	C	returns	TRUE,	Financial	Reporter	does	not	print
the	line.	If	the	formula	returns	FALSE,	the	line	is	printed.

For	example,	=G12	<	F12	*	10%	will	check	if	the	value	in
column	F	is	less	than	10%	of	the	value	in	column	G.	If	the	statement
is	true,	the	line	will	be	omitted	from	the	report.

Note:	Anything	that	appears	in	column	C	on	a	default	specification	line
will	be	used	by	all	subsequent	lines	unless	you	specifically	override	it.

Related	Topics
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About	Selection	Criteria	for	Filtering	Accounts
You	use	the	selection	criteria	feature	in	Financial	Reporter	to	include
account	figures	in	a	report	based	on	settings	in	the	General	Ledger
account	master.

For	example,	you	could	use	the	selection	criteria	expression	ACCTTYPE
=	"B"	AND	ACTIVESW	=	"ACTIVE"	to	select	all	accounts	with
an	account	type	of	"B"	(for	balance	sheet)	and	an	active	switch	set	to
currently	active.

When	you	place	a	selection	criteria	expression	in	a	formula	or	on	a
statement	line,	Financial	Reporter:

1.	 Looks	up	the	account	identified	by	the	account	number	in	column	A
of	the	line	(or	by	a	formula).

2.	 Checks	to	see	that	the	account	master	information	matches	the
selection	criteria	you	have	specified.

You	can	include	selection	criteria	in	column	B	of	a	specification	(to	restrict
the	accounts	selected	from	the	Account	Code	reference	specified	in
column	A),	or	in	formulas	that	retrieve	account	balances,	net	amounts
and	quantities	from	posted	transactions,	or	net	amounts	from	General
Ledger.

Tips:

The	easiest	way	to	define	selection	criteria	is	to	use	FR	Paste.	For
more	information,	see	About	FR	Paste.
Generally,	you	should	not	use	selection	criteria	if	you	can	achieve
the	same	result	with	a	more	selective	account	number	reference.
You	can	improve	report	performance	by	being	more	precise	in	your
account	references	to	restrict	the	number	of	initial	account	lookups.
You	can	choose	report	criteria	variables	you	select	from	the	Preview
Financial	Reporter	screen	while	you	are	in	a	worksheet.	Financial
Reporter	recalculates	FR	commands	according	to	the	criteria	you
have	saved.	(For	example,	if	you	have	created	two	workbooks	for



different	years,	you	can	switch	between	the	workbooks	without
losing	the	value	of	FR	commands	after	running	FR	View.)



Using	Selection	Criteria	in	Column	B
You	can	use	selection	criteria	in	column	B	of	a	specification	to	restrict	the
accounts	selected	from	the	Account	Code	reference	specified	in	column
A.

Defining	a	default	expression	for	column	B	is	similar	to	defining	other
default	report	columns:	you	place	the	default	selection	criteria	expression
in	column	B	of	a	default	specification	line.

If	you	enter	criteria	on	a	default	line,	it	is	used	for	all	subsequent	lines
that	do	not	have	a	criteria	defined.	In	other	words,	if	you	do	not	want	the
default	expression	to	apply	to	a	line,	you	must	override	it	on	the	line.

Note:	You	do	not	need	to	type	\	on	lines	for	which	you	want	to	use	the
default	selection	criteria.



Using	Selection	Criteria	in	Formulas
You	can	also	use	selection	criteria	in	formulas	that	use	FRAMT,
FRAMTA,	FRCREDIT,	FRDEBIT,	FRTRN,	FRTRNA,	FRTRNCR,	and
FRTRNDR	functions	to	retrieve	account	balances,	net	amounts	and
quantities	from	posted	transactions,	or	net	amounts	from	General	Ledger.

If	you	paste	an	expression	into	a	formula,	the	selection	criteria	acts	on
the	formula	only.	If	you	paste	the	expression	into	column	B	of	a	statement
line,	the	selection	criteria	further	refines	the	account	number	reference
specified	for	the	current	line.

Related	Topics
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About	Wildcard	Characters	in	Account	Numbers
You	can	use	two	wildcard	characters	when	specifying	account	numbers:

The	underline	character,	_,	is	a	placeholder	for	one	character.
The	percent	character,	%,	is	a	placeholder	for	one	or	more
characters.

Example:

Using	Wildcard	Characters
Account
number

specification

Description

A123%[sc] Specifies	all	single	segment	account	numbers	starting
with	the	characters	“A123.”

D_6834 Specifies	all	single	segment	accounts	sharing	the	same
first	character	(D),	followed	by	one	character	of	any
value,	and	ending	with	the	same	four	characters
(6834).

Note:	You	cannot	use	the	Finder	with	FR	Paste	to	insert	wildcard
characters.	You	must	type	in	the	wildcard	characters	yourself.

"%%"	is	Not	a	Wildcard	Character

Although	%%	resembles	a	wildcard	character,	it	is	used	in	only	two	very
specific	ways:

%%	specifies	all	account	numbers	in	the	ledger.	(See	the	QUIKINC
and	QUIKBAL	statements	that	come	with	General	Ledger.)
6000%%	specifies	all	account	numbers	starting	with	6000—no
matter	how	many	segments	they	have.	(This	specification	has	the
same	effect	as	6000:6000.)



Example:

In	this	example,	account	number	selection	is	based	solely	on	the
account	group	specified	in	column	B.

A B

%% ACCTGRPCOD=1

%% ACCTGRPCOD=2

%% ACCTGRPCOD=3

Financial	Reporter	will	list	all	Current	assets,	then	all	Fixed	assets,	and,
finally,	all	Other	assets.

Unless	you	process	accounts	by	ACCTGROUP,	Financial	Reporter
must	scan	every	account	in	the	ledger	to	see	if	it	fits	the	criterion	in
column	B.

Tip:	To	get	the	best	performance	from	Financial	Reporter,	you	should
use	specific	account	references,	and	specify	account	processing	orders
that	complement	the	references.	For	more	information,	see	About
Account	Order	in	Financial	Statements.

Note	also	that	you	cannot	combine	account	reference	ranges	with
wildcard	characters.	For	example,	A123%:B567%	is	not	allowed.

However,	you	can	combine	account	references	in	a	list,	such	as
1000:1099,	1100~1199-B,	1250-A.
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Account	Reference	Syntax	and	Examples
Account	number	references	can	use	the	following	symbols:

Account	Reference	Symbols
Symbol Description

Hyphen
-

An	account	segment	separator	defined	on	the	G/L	Options
screen	in	General	Ledger.	(The	hyphen	is	the	default
separator.)

Colon	: Separates	account	numbers	in	a	range.

Tilde	~ Separates	segment	codes	in	a	segment	range.

Note:	All	examples	assume	that	segment	1	is	the	account	segment	and
segment	2	is	the	department	segment.



Standard	Account	References
Standard	Account	References

Format Description Examples

aaaaaaaa

or

aaaa-aaaa

A	specific	General
Ledger	account
number	composed	of
one	or	two	segments.

Account	numbers	can
be	entered	with	or
without	the	segment
separator	-.	However,
if	you	are	specifying
ranges	of	accounts,	we
suggest	you	include
separators	to	remove
ambiguity	from	your
specifications.

100-C

Account	100,	department	C.

aaaa-

A:bbbb-B

A	range	of	General
Ledger	accounts	and
departments.

When	creating	a
search	statement	from
the	information	you
enter,	Financial
Reporter	adds	Zs	to	the
last	number	in	the
range.	In	other	words,	it
searches	for	account
numbers	between
"aaaa-A	"	and	"bbbb-
BZZZZZZZZZZZZZZZ".

100:200

Accounts	between	100
and	200	(from	any
department)

100-A:200-F	

Accounts	with	an
account	segment	value
between	100	and	200,
and	with	a	Department
segment	value	between
A	and	F	(for	any	order
other	than	ACCTID
order).



If	the	order	is	ACCTID,
account	150-H	will	be
included	because	it	falls
between	100-A	and	200-
F.	However,	for	non-
ACCTID	order,	Financial
Reporter	takes	only
those	accounts	that	fall
within	both	ranges	(	the
range	of	accounts	and
the	range	of
departments),	so	that
100-A:200-F	is	the
same	as	100~200-
A~F	(shown	below).

If	the	order	is	ACCTID,
the	constraint	is
ACCTID	=>	100-A	and
ACCTID	<=	200-F.

aaaa%%

or

aaaa:aaaa

A	range	of	General
Ledger	account
numbers.	(The	wildcard
notation	%%	is	a
simpler	way	of
specifying	all	accounts
with	the	same
segment.)

100%%	or	100:100

All	accounts	that	start	with
100,	regardless	of	account
structure.

aaaa~bbbb-A A	range	of	General
Ledger	account
numbers	with	a	fixed
second	segment.

Financial	Reporter
retrieves	information

100~200-F

Accounts	in	department
F	with	an	account
segment	value	between
100	and	200,	and	with	a
department	segment



from	each	account
within	the	range	that
includes	the	second
segment	code.

code	of	F.

100~200-A~F	

Accounts	with	an
account	segment	code
between	100	and	200,
and	with	a	department
segment	code	from	A	to
F.

aaaa~bbbb A	range	of	General
Ledger	account
segment	codes.

Financial	Reporter
retrieves	all	accounts
matching	the	account
segment	you	specify,
no	matter	how	many
segments	are	in	the
number,	and	no	matter
where	the	account
segment	is	in	the
account	structure.

This	allows	you	to
specify	a	range	for	one
segment	(rather	than	a
range	of	complete
account	numbers),	and
is	particularly	useful
when	the	account
segment	is	not	the	first
segment	in	the	account
number.

4000~8000

Accounts	with	an	account
segment	code	from	4000	to
8000,	no	matter	how	many
segments	are	in	the	number,
and	no	matter	where	the
account	segment	is	in	the
account	structure.	For
example,	results	will	include
10-4000,	20-5000,	and	10-
6000	if	those	accounts	exist
in	General	Ledger.

aaaa[ACCT],
An	individual	account
number	and	a	range	of

	



bbbb~cccc-

A[MANU]

account	numbers.	The
square	brackets
indicate	the	account
structure	codes	used
by	the	account
numbers.

aaaa-%,

bbbb~cccc-

A~B,	gggg-D

A	set	of	ranges	and
individual	accounts	with
each	specification
separated	by	a	comma.
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About	Expression	Syntax	for	Selection	Criteria
The	easiest	way	to	create	a	selection	criteria	expression	is	to	use	FR
Paste.	For	more	information,	see	About	FR	Paste.

You	can	also	enter	expressions	directly	into	spreadsheet	cells.

A	simple	criteria	expression	looks	like	this:

ACCTTYPE	=	"I"

A	more	complex	one	looks	like	this:

ACCTTYPE	=	"I"	AND	QTYSW	=	"Yes"	OR	ACCTDESC

LIKE	"%sale%"

ACCTTYPE	and	QTYSW	(quantities	switch)	are	fields	in	the	account
master	file.	All	other	fields	in	this	file	are	listed	in	the	next	section.

Selection	criteria	use	account	master	fields	only.	For	more	information,
see	Account	Master	Fields.



Left-to-Right	Evaluation
Selection	criteria	expressions	are	evaluated	strictly	from	left	to	right
unless	brackets	are	added.	In	other	words,	the	above	example	will	be
evaluated	as:

(ACCTTYPE	=	"I"	AND	QTYSW	=	"Yes")	OR	ACCTDESC

LIKE	"%sale%

The	expression	will	select	all	accounts	that	contain	the	word	"sale"	in
their	description,	and	it	will	select	all	income	statement	accounts	that	also
store	quantities.

Note:	Criteria	are	case-sensitive,	so	a	description	with	“Sale”	will	be
excluded.



Brackets
You	may	use	brackets	to	change	the	order	of	evaluation.	For	example:

ACCTTYPE	=	"I"	AND	(QTYSW	=	"Yes"	OR	ACCTDESC

LIKE	"%sale%")

will	select	income	statement	accounts	that	store	quantities,	or	that
contain	the	word	"sale"	in	their	description.

All	the	relational	operators	work	with	all	the	field	types	except	for
switches	(like	QTYSW),	where	only	the	=	and	!=	(not	equal)	operators
apply.



Spaces
You	use	spaces	to	separate	field	names,	operators	and	constants	in
expressions.	For	this	reason,	if	you	are	comparing	a	string	that	includes
spaces,	you	must	enclose	the	entire	string	in	quotation	marks.



Quotation	Marks
Remember	that	criteria	are	text	parameters.	If	you	place	criteria	in
formulas,	you	must	enclose	criteria	text	in	quotation	marks.

If	you	paste	criteria	in	column	B,	you	will	notice	that	FR	Paste	inserts
them	as	formulas	containing	text.	For	example:

="(ACCTTYPE	=	""I""	AND	QTYSW	=	""Yes""	)"

FR	Paste	adds	an	extra	pair	of	quotation	marks	around	text	values	to
accommodate	spaces	within	the	text	strings.

If	you	paste	a	formula	with	criteria,	it	looks	like	this:

=FRACCT("ACCTDESC","","(ACCTTYPE	=	""I"")")

If	this	is	a	default	line	column	specification,	the	middle	parameter	in	the
formula	will	take	on	the	account	reference	specified	in	column	A.



LIKE
The	LIKE	operator	is	similar	to	the	=	operator,	except	the	second
operand	can	contain	the	wild	cards	%	and	_.

%	matches	any	group	of	characters.
_	matches	any	single	character.

So	ACCTDESC	LIKE	"%sale%"	is	true	for	any	accounts	with
descriptions	that	include	the	word	"sale."	This	would	include	"Product	B
sales,"	as	well	as	"Cost	of	sales."



Optional	Fields
Selection	criteria	can	also	include	optional	fields.	For	example,	the
following	expression	restricts	the	results	to	accounts	with	account
optional	field	ACCTCLASS	=	Sales:

A.ACCTCLASS	=	"Sales"

And,	the	following	expression	restricts	the	results	to	transactions	with
transaction	optional	field	QUANTITY<=	0:

T.QUANTITY	<=	0

For	more	information,	see	About	Optional	Fields	in	Financial	Reports.

Related	Topics
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FR	Menu	Commands
When	you	use	the	Statement	Designer	to	open	a	Microsoft	Excel
worksheet,	an	Add-Ins	tab	appears	on	the	Excel	ribbon.	On	this	tab,	the
FR	menu	displays	commands	you	can	use	to	create	and	edit	financial
reports	and	specifications.

FR	Menu	Commands

About	FR	Drilldown

About	FR	Paste

About	the	Fiscal	Designator

Using	FR	Paste	to	Insert	Information	in	Financial	Reports
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FR	Menu	Commands
When	you	use	the	Statement	Designer	to	open	a	Microsoft	Excel
worksheet,	an	Add-Ins	tab	appears	on	the	Excel	ribbon.	On	this	tab,	the
FR	menu	displays	commands	you	can	use	to	create	and	edit	financial
reports	and	specifications.

FR	Menu	Commands
Command Description Notes

FR	Clear Clears	the	report
range	from	a
previously	generated
financial	statement.

You	usually	use	FR	Clear
before	saving	a	final	version	of	a
specification	after	developing
and	testing	it.
You	do	not	need	to	use	FR
Clear	before	using	FR	View	to
generate	a	report.	However,	by
clearing	the	report	range	first,
you	save	a	smaller	spreadsheet
and	one	that	will	take	less	time
to	load	whenever	you	print	the
financial	report.

FR
Drilldown

Drill	down	to
transactions	after
generating	a	financial
statement	that
contains	formulas	for
transactions.

For	more	information,	see	About	FR
Drilldown.

FR	Help View	help	for	the
Financial	Statement
Designer.

	

FR
Options

Specify	whether	the
opening	budget	or
opening	quantity	for

Use	Budget	Opening	Balance.
Select	this	option	to	display	the
budget	amount	carried	forward



an	account	on	a
financial	statement
should	be	carried
forward	from	the
previous	year.

from	the	previous	year.
Use	Quantity	Opening
Balance.	Select	this	option	to
display	quantities	carried
forward	for	accounts	that	use
the	Maintain	Quantities	option.

Note:	If	you	change	a	selection,	run
FR	View	to	update	your	report.

FR	Paste Inserts	Financial
Reporter	functions,
account	numbers,
and	selection	criteria.

For	more	information,	see	About	FR
Paste	and	Using	FR	Paste	to	Insert
Information	in	Financial	Reports.

FR	View Opens	the	G/L
Financial	Statement
Designer	screen,
which	you	use	to
generate	financial
statements	from
report	specifications.

For	more	information,	see	G/L
Statement	Designer.
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About	FR	Drilldown
On	the	G/L	Print	Financial	Statements	and	Statement	Designer	screens,
you	can	select	the	DrillDown	Information	option	to	add	drilldown	link
comments	to	the	generated	report.

Drilldown	instructions	are	stored	in	the	comment	object	of	a	cell.	After
generating	a	report,	you	can	right-click	a	results	cell,	and	then	click	FR
DrillDown	to	view	transaction	details.

Note:	The	recipient	of	an	e-mailed	report	must	be	using	the	same
database,	with	General	Ledger	activated,	if	they	want	to	drill	down	to
underlying	transactions	in	the	report.

Warning!	A	spreadsheet	containing	a	large	number	of	drilldown	links
may	be	slow	to	open,	or	fail	to	open,	in	the	Statement	Designer	and	in
Microsoft	Excel.

When	you	use	the	Statement	Designer	to	open	a	Microsoft	Excel
worksheet,	an	Add-Ins	tab	appears	on	the	Excel	ribbon.	On	this	tab,	the
FR	menu	displays	commands	you	can	use	to	create	and	edit	financial
reports	and	specifications.	The	FR	Drilldown	command	appears	on	this
menu.	You	use	it	to	view	original	transactions	after	a	report	has	been
generated	in	the	Financial	Statement	Designer.

Note:	You	must	use	the	FR	View	command	to	generate	a	report	before
you	can	use	FR	DrillDown.



FR	DrillDown	Example
The	sample	spreadsheet	quickinc4.xls	uses	the	transaction	function
FRTRNA	to	demonstrate	drilldown.	In	the	sample	spreadsheet,	the
formula	FRTRNA("NETYTD)"	produces	a	statement	of	earnings	with
one	column	of	figures	showing	current	year-to-date	results.	The	comment
displayed	explains	how	to	drill	down	to	the	transaction.

To	see	how	FR	Drilldown	works,	perform	the	following	steps	in	the
sample	spreadsheet	quickinc4.xls:
1.	 On	the	Excel	ribbon,	on	the	Add-Ins	tab,	click	FR	>	FR	View.
2.	 Click	OK	to	run	FR	View.

The	report	is	generated.	Results	cells	where	FR	DrillDown	is
available	appear	with	a	red	mark	in	the	top	right	corner	of	the	cell.

3.	 Right-click	a	report	cell,	and	then	then	click	FR	DrillDown.
The	original	transaction	details	appear	in	a	new	window.



Formulas	that	Support	FR	Drilldown
FR	DrillDown	works	only	with	formulas	that	contain	the	following
transaction	functions:

FRTRN
FRTRNA
FRTRNCR
FRTRNDR

FR	DrillDown	is	not	available	for	formulas	that	contain	edited	versions	of
the	following	transaction	functions:

FRTRN
FRTRNA
FRTRNCR
FRTRNDR

The	following	are	examples	of	edited	commands:

=FRTRN("NETP")+100

=ROUND(FRTRN("NETP"),0)

For	information	about	other	menu	commands	in	the	Financial	Statement
Designer,	see	FR	Menu	Commands.

Related	Topics
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About	FR	Paste
When	you	use	the	Statement	Designer	to	open	a	Microsoft	Excel
worksheet,	an	Add-Ins	tab	appears	on	the	Excel	ribbon.	On	this	tab,	the
FR	menu	displays	commands	you	can	use	to	create	and	edit	financial
reports	and	specifications.

The	FR	Paste	command	appears	on	this	menu.	You	use	it	to	paste
formulas	into	spreadsheet	cells	to	retrieve	and	display	the	following
General	Ledger	data:

Account	numbers.	For	more	information,	see	About	Account
Number	References.
Account	selection	criteria	(query-by-example	expressions).	For
more	information,	see	About	Selection	Criteria	for	Filtering	Accounts.
Financial	Reporter	functions.	For	more	information,	see	Financial
Reporter	Functions.

Rolled	up	amounts.

Note:

On	the	FR	Paste	Function	screen,	use	the	Rolled	Up	Amounts
option	to	specify	whether	or	not	to	paste	rolled	up	balances	or
quantities	into	reports	for	rollup	accounts.	This	option	is	available
for	FRAMT,	FRAMTA,	FRCREDIT,	and	FRDEBIT	only.
Take	care	when	creating	the	rollup	group	to	avoid	ending	up	with
doubled	amounts	in	the	final	report.
Select	the	Rollup	Members	Account	option	to	include	balances
or	quantities	for	rollup	member	accounts	whose	balances	or
quantities	are	also	being	rolled	up	to	their	rollup	account	in	the
same	paste	function	in	the	report.

For	information	about	other	menu	commands	in	the	Financial	Statement
Designer,	see	FR	Menu	Commands.



Pasting	Single	Values	and	Default	Column
Specifications
The	following	are	typical	single	values	you	will	paste	in	a	financial	report:

Company	name
Period-end	date	(or	today's	date)
Division	or	department	for	which	the	report	is	printed
A	single	account	balance

For	each	of	the	above	items,	you	will	paste	a	complete	formula,	and	you
will	probably	not	have	to	edit	the	result.



Pasting	Column	Formulas
If	you	are	pasting	a	formula	to	use	as	a	default	column	specification,	do
not	enter	an	account	reference	(because	you	will	be	supplying	that	in
column	A	of	each	line	that	uses	the	default	column	specification).

For	example,	the	formula	for	a	single	cell	might	be
=FRAMT("BALP","1000"),	whereas	a	default	column	formula
would	be	=FRAMT("BALP").

For	instructions	on	using	FR	Paste,	see	Using	FR	Paste	to	Insert
Information	in	Financial	Reports.

Related	Topics
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About	the	Fiscal	Designator
When	you	use	the	Statement	Designer	to	open	a	Microsoft	Excel
worksheet,	an	Add-Ins	tab	appears	on	the	Excel	ribbon.	On	this	tab,	the
FR	menu	displays	commands	you	can	use	to	create	and	edit	financial
reports	and	specifications.

The	FR	Paste	command	appears	on	this	menu.	On	the	FR	Paste
Function	screen,	the	Fiscal	Designator	is	a	drop-down	list	that	appears
for	the	FRAMT,	FRAMTA,	FRDEBIT,	FRCREDIT,	FRTRN,	FRTRNA,
FRTRNCR,	and	FRTRNDR	functions.	The	list	shows	the	fiscal	set
options	you	can	select:

Budget	sets	1,	2,	3,	4,	and	5
A.	Actual	monetary	figures
P.	Provisionally-posted	monetary	figures
Q.	Quantities	(either	actual	or	provisional)
QA.	Actual	quantities
QP.	Provisionally-posted	quantities

Note:

The	FRTRN,	FRTRNA,	FRTRNCR,	and	FRTRNDR	functions	include
only	the	following	options:

A.	Actual	monetary	figures
Q.	Quantities	(either	actual	or	provisional)
QA.	Actual	quantities

Whether	actual	or	provisional	figures	or	quantities	appear	depends	on	the
default	you	select	on	the	Preview	Financial	Statements	screen	at	the	time
you	print	a	report.



Related	Topics
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Using	FR	Paste	to	Insert	Information	in	Financial
Reports
When	you	use	the	Statement	Designer	to	open	a	Microsoft	Excel
worksheet,	an	Add-Ins	tab	appears	on	the	Excel	ribbon.	On	this	tab,	the
FR	menu	displays	commands	you	can	use	to	create	and	edit	financial
reports	and	specifications.

The	FR	Paste	command	appears	on	this	menu.	You	use	it	to	paste
formulas	into	spreadsheet	cells	to	retrieve	and	display	General	Ledger
data.	For	more	information,	see	About	FR	Paste.

To	insert	information	using	FR	Paste:
1.	 In	the	Statement	Designer,	select	the	cell	where	you	want	to	insert

General	Ledger	data.
2.	 On	the	Excel	ribbon,	on	the	Add-Ins	tab,	click	FR	>	FR	Paste.

The	FR	Paste	Function	window	appears.	Below	the	Functions	list
and	available	selections,	a	cell	reference	(such	as	Cell	$A$1:)
and	formula	(such	as	FRACCT(""))	appear.	As	you	select	options,
this	area	is	updated	to	display	the	current	formula.

In	the	bottom	left	corner	of	the	screen,	the	function	builds	as	you
select	options.

3.	 From	the	Functions	list,	select	a	function,	account	reference,	or
selection	criteria	expression.

When	you	select	a	function,	available	options	and	parameters	for	the
function	appear	to	the	right	of	the	list.	Depending	on	your	selection,
these	may	include	account	numbers,	account	ranges,	selection
criteria,	currency	type,	and	other	options.

4.	 Specify	options	for	the	function,	account	reference,	or	expression.
For	more	information,	see	Financial	Reporter	Functions.

If	you	are	specifying	account	numbers,	you	can	specify	individual
account	numbers	or	a	range	of	account	numbers.



5.	 If	you	want	to	filter	an	account	or	account	range	by	specific	criteria,
click	the	Selection	Criteria	button,	and	then	specify	criteria	to	use.

6.	 When	you	have	created	the	formula,	paste	it	into	your	report	or
specification.

a.	 To	paste	the	formula	into	the	selected	cell	(listed	in	the	bottom	left
of	the	screen),	click	Paste.

b.	 To	select	a	different	cell,	click	Next	Row,	Prev	Row,	Next	Column,
or	Prev	Column	to	navigate	to	the	desired	cell,	and	then	click
Paste.

The	formula	you	created	is	pasted	into	the	financial	report	or
specification.

Related	Topics
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Financial	Reporter	Functions
Use	Financial	Reporter	functions	to	retrieve	data	from	General	Ledger,
including	transaction	and	optional	field	information.

Financial	Reporter	Functions

Financial	Reporter	Function	Notation

FRACCT	Function

FRAMTA	Function

FRAMT	Function

FRCREDIT	Function

FRDEBIT	Function

FRFISCAL	Function

FRPOST	Function

FRRATE	Function

FRSDESC	Function

FRTRNA	Function

FRTRNCR	Function

FRTRNDR	Function

FRTRN	Function

FR	Function
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Financial	Reporter	Functions
Accounts	in	General	Ledger	(G/L)	contain	two	main	types	of	data:

Master	information:	Account	name,	account	type,	and	other
information	regarding	the	account.
Fiscal	set	values:	Balances	and	net	amounts	for	each	general
ledger	account.

You	can	use	the	following	functions	in	Financial	Reporter	to	retrieve	data
from	General	Ledger,	including	transaction	and	optional	field	information.

Function Data	Retrieved

FR	Function G/L	Option	data,	company	data,	and	statement
print	options

FRACCT	Function Account	data,	including	account	optional	fields

FRAMT	Function	,
FRAMTA	Function	,
FRCREDIT	Function	,
FRDEBIT	Function

Fiscal	set	data

FRFISCAL	Function Fiscal	calendar	dates

FRPOST	Function Accounts	and	transaction	detail	data,	and
account	and	transaction	optional	field	data	from
posted	transactions

FRRATE	Function Exchange	rates

FRSDESC	Function Segment	code	descriptions

FRTRN	Function,
FRTRNA	Function,
FRTRNCR	Function,
FRTRNDR	Function

Transaction	detail	data	including	net	totals,	and
account	and	transaction	optional	fields	(but	not
provisional	amounts)

Tip:	In	Excel,	use	FR	Paste	(available	from	the	Financial	Statement
Designer's	FR	menu)	to	insert	a	Financial	Reporter	function	into	a



financial	statement.	From	the	FR	Paste	screen,	you	can	select	the
function,	its	arguments,	and	additional	report	options.	For	more
information,	see	About	FR	Paste.

Related	Topics
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Financial	Reporter	Function	Notation
Financial	Reporter	functions	use	the	following	typographic	conventions:

Convention Description

UPPERCASE Function	names	are	in	uppercase	letters.

(	) Function	arguments	are	listed	in	parentheses.

, All	arguments	are	separated	by	a	comma.

Most	argument	parameters	are	text,	so	are	either:

In	quotation	marks
A	reference	to	a	spreadsheet	cell	that	contains	a	text
value,	or	a	formula	that	returns	a	text	value

Note:	Excel	will	return	a	"#VALUE!"	error	if	you	specify
an	argument	that	does	not	exist.

Example:

FRACT(field	name,	account	number)

FRACCT(field	name,	account	number,	criteria,

format)

Related	Topics
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FRACCT	Function
This	function	retrieves	data	from	G/L	account	records,	including	account
optional	fields.	It	cannot	retrieve	data	from	transaction	optional	fields.



Syntax
FRACCT(field	name,	account	reference,	criteria,

formatted)

Note:	The	function	returns	a	blank	if	the	account	reference	is	missing,
the	account	does	not	exist,	or	if	no	accounts	exist	in	the	specified	range.



Arguments
Argument Description

field	name The	name	of	a	field	from	the	G/L	account	record,	including
account	optional	fields.

Tip:	Account	optional	fields	have	an	"A."	prefix.

account
reference

A	string	specifying	a	single	account	or	a	range	of	accounts.
SeeAbout	Account	Number	References.

Note:

For	a	range	of	accounts,	the	function	returnsonlythe
data	that	is	common	to	all	accounts.
If	the	account	does	not	exist,	FRACCT	returns	a	hyphen
(-).

criteria An	expression	that	imposes	selection	criteria	on	the
accounts.	The	account	reference	and	expression	together
determine	the	accounts	that	will	be	included	in	the
calculation.	See	About	Selection	Criteria	for	Filtering
Accounts.

formatted
(Optional)

Indicates	whether	the	return	value	should	be	formatted
according	to	the	presentation	defined	in	the	view.	If	omitted,
the	default	is	"Formatted."	Use	one	of	the	following
constructs:

"FORMATTED",	"F",	or	"FMT"
"UNFORMATTED",	"U",	or	"UNFMT"

Field	names	for	G/L	account	data
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Examples
Statement Return	Value

=FRACCT("ACCTDESC","1000-333") "Cost	of	goods
sold"

=FRACCT("QTYSW","1000-333","F') "Yes"

=FRACCT("ACCTTYPE",
"1000-333","FMT")

"Income"

=FRACCT("A.ACCTCLASS","4000") "Sales"

=FRACCT("ACCTDESC","1000-333:1000-400") Prints	a
description	that
includes	only
those	words
that	are
common	to
each	account	in
the	account
range.

For	example,	if
the	accounts	in
the	range	have
the	following
descriptions,
the	word
"Receivable"
would	be	the
return	value.

Accounts
Receivable:
customers
Accounts
Receivable:



employees
Receivable:
over	90
days

Related	Topics
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FRAMTA	Function
This	function	is	similar	to	FRAMT	Function.	It	has	the	same	arguments	as
FRAMT,	and	returns	the	same	data.	The	difference	is	that	the	sign	of	the
return	value	is	dependent	on	the	account	type	for	FRAMT,	but	not	for
FRAMTA.

FRAMTA	returns	all	debit	balances	as	positive	numbers,	and	all	credit
balances	as	negative	numbers,	making	it	easy	to	sum	a	range	of
accounts	without	regard	for	the	account	type.	By	contrast,	FRAMT
returns	debit	balances	in	credit	accounts	as	negative	numbers	and	credit
balances	in	credit	accounts	as	positive	numbers.



Syntax
FRAMTA(field	name,	account	reference,	criteria,

currency)

Note:	The	function	returns	0	if	the	account	reference	is	missing,	the
account	does	not	exist,	or	if	no	accounts	exist	in	the	specified	range.



Arguments
Argument Description

field	name The	name	of	a	field	from	the	General	Ledger	fiscal	sets	with
an	optional	fiscal	designator	prefix	and	optional	fiscal
year	suffix	(separated	from	the	field	name	with	a	period).

The	fiscal	designator	prefix	can	be:

A.	Actual	amount
R.	Rollup	amounts.	R	must	be	the	first	character	and
can	be	used	with	other	prefixes

Tip:	In	Excel,	if	you	use	the	FR	PASTE	screen	to	add
the	FRAMT	function	to	a	statement,	select	the	Use
Rolled	Up	Amounts	check	box.

P.	Provisional	amounts
Q.	Quantities	(either	actual	or	provisional,	depending	on
the	report	type)
QA.	Actual	quantities
QP.	Provisional	quantities
1	to	5.	Budget	set	number
The	number	of	available	budget	sets	varies	by	product
edition.

2	in	Sage	300	Standard	ERP
3	in	Sage	300	Advanced	ERP
5	in	Sage	300	Premium	ERP

Note:	If	no	prefix	is	supplied,	the	default	report	setting	is
used	(either	actual	or	provisional,	depending	on	the	type	of
report).	Similarly,	if	the	fiscal	prefix	is	"Q"	or	"RQ,"	actual	or
provisional	quantities	are	returned,	depending	on	the	type	of
report.
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The	fiscal	year	suffix	can	be:

YYYY.	A	specific	fiscal	year,	such	as	2010
Ln.n	years	ago	relative	to	the	current	fiscal	year;	for
example,	L1	is	last	year,	and	L2	is	2	years	ago
Nn.n	years	in	the	future	relative	to	the	current	fiscal
year;	for	example,	N1	is	next	year,	and	N2	is	the	year
after	next

Note:	If	no	suffix	is	supplied,	the	current	fiscal	year	is	used.

Example:	For	the	field	name	argument	ABALP.2008,
ABALP	is	the	combination	of	fiscal	set	prefix	and	field	name
referencing	the	actual	balance	for	the	current	period,	and
2008	is	the	fiscal	year	suffix.

account
reference

A	string	specifying	a	single	account	or	a	range	of	accounts.
See	About	Account	Number	References.

criteria
(Optional)

An	expression	that	imposes	selection	criteria	on	the
accounts	and	account	optional	fields.	The	account
reference	and	expression	together	determine	the	accounts
and	account	optional	fields	that	will	be	included	in	the
calculation.	See	About	Selection	Criteria	for	Filtering
Accounts.

currency
(Optional)

A	string	containing	the	currency	reference.	A	currency
reference	has	the	form	"CCC.T,"	where	CCC	is	a	3-
character	currency	code	(for	example,	CAD	for	Canadian
dollars,	or	USD	for	US	dollars),	and	T	is	the	currency	type
(also	known	as	the	currency	code	qualifier).

The	currency	type	can	be:

S.	Source	currency
E.	Functional	equivalent	of	the	source	amount
F.	Functional	currency	total	(including	functional
equivalents	of	all	source	amounts)



R.	Reporting	currency	total	(includes	reporting
equivalents	of	all	source	amounts)

Note:	This	option	is	only	available	if	you	select	the
Euro	as	your	functional	currency	and	specify	a
different	reporting	currency	in	Company	Profile.

Note:	If	no	currency	is	supplied,	functional	(home)	currency
is	used.

Fiscal	Set	Field	Names
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Examples
The	following	examples	show	the	differences	between	the	return	values
for	the	FRAMT	and	FRAMTA	functions.

AccountType Value FRAMT
Return	Value

FRAMTA
Return	Value

Debit 100	DR 100 100

Debit 100	CR -100 -100

Credit 100	CR 100 -100

Credit 100	DR -100 100

Related	Topics
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FRAMT	Function
This	function	retrieves	actual,	budget,	and	quantity	balances	and	net
amounts	from	General	Ledger	accounts	for	a	specified	period.

All	amounts	returned	by	FRAMT	respect	the	account	type.	Debit
balances	in	debit	accounts	and	credit	balances	in	credit	accounts	are
returned	as	positive	numbers;	credit	balances	in	debit	accounts	and	debit
balances	in	credit	accounts	are	returned	as	negative	numbers.

Although	FRAMT	is	similar	to	FRAMTA	Function,	FRAMTA	returns	all
debit	balances	as	positive	numbers	and	all	credit	balances	as	negative
numbers	regardless	if	the	account	is	a	debit	or	credit	type.

FRAMT	is	also	similar	to	FRTRN	Function,	but	FRAMT	retrieves	totals
from	account	history,	whereas	FRTRN	retrieves	totals	from	transaction
history.



Syntax
FRAMT(field	name,	account	reference,	criteria,

currency)

Note:	The	function	returns	0	if	the	account	reference	is	missing,	the
account	does	not	exist,	or	if	no	accounts	exist	in	the	specified	range.



Arguments
Argument Description

field	name The	name	of	a	field	from	the	General	Ledger	fiscal	sets	with
an	optional	fiscal	designator	prefix	and	optional	fiscal
year	suffix	(separated	from	the	field	name	with	a	period).

The	fiscal	designator	prefix	can	be:

A.	Actual	amount
R.	Rollup	amounts.	R	must	be	the	first	character	and
can	be	used	with	other	prefixes

Tip:	In	Excel,	if	you	use	the	FR	PASTE	screen	to	add
the	FRAMT	function	to	a	statement,	select	the	Use
Rolled	Up	Amounts	check	box.

P.	Provisional	amounts
Q.	Quantities	(either	actual	or	provisional,	depending	on
the	report	type)
QA.	Actual	quantities
QP.	Provisional	quantities
1	to	5.	Budget	set	number
The	number	of	available	budget	sets	varies	by	product
edition.

2	in	Sage	300	Standard	ERP
3	in	Sage	300	Advanced	ERP
5	in	Sage	300	Premium	ERP

Note:	If	no	prefix	is	supplied,	the	default	report	setting	is
used	(either	actual	or	provisional,	depending	on	the	type	of
report).	Similarly,	if	the	fiscal	prefix	is	"Q"	or	"RQ,"	actual	or
provisional	quantities	are	returned,	depending	on	the	type	of
report.
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The	fiscal	year	suffix	can	be:

YYYY.	A	specific	fiscal	year,	such	as	2010
Ln.n	years	ago	relative	to	the	current	fiscal	year;	for
example,	L1	is	last	year,	and	L2	is	2	years	ago
Nn.n	years	in	the	future	relative	to	the	current	fiscal
year;	for	example,	N1	is	next	year,	and	N2	is	the	year
after	next

Note:	If	no	suffix	is	supplied,	the	current	fiscal	year	is	used.

Example:	For	the	field	name	argument	ABALP.2008,
ABALP	is	the	combination	of	fiscal	set	prefix	and	field	name
referencing	the	actual	balance	for	the	current	period,	and
2008	is	the	fiscal	year	suffix.

account
reference

A	string	specifying	a	single	account	or	a	range	of	accounts.
See	About	Account	Number	References.

criteria
(Optional)

An	expression	that	imposes	selection	criteria	on	the
accounts	and	account	optional	fields.	The	account
reference	and	expression	together	determine	the	accounts
and	account	optional	fields	that	will	be	included	in	the
calculation.	See	About	Selection	Criteria	for	Filtering
Accounts.

currency
(Optional)

A	string	containing	the	currency	reference.	A	currency
reference	has	the	form	"CCC.T,"	where	CCC	is	a	3-
character	currency	code	(for	example,	CAD	for	Canadian
dollars,	or	USD	for	US	dollars),	and	T	is	the	currency	type
(also	known	as	the	currency	code	qualifier).

The	currency	type	can	be:

S.	Source	currency
E.	Functional	equivalent	of	the	source	amount
F.	Functional	currency	total	(including	functional
equivalents	of	all	source	amounts)



R.	Reporting	currency	total	(includes	reporting
equivalents	of	all	source	amounts)

Note:	This	option	is	only	available	if	you	select	the
Euro	as	your	functional	currency	and	specify	a
different	reporting	currency	in	Company	Profile.

Note:	If	no	currency	is	supplied,	functional	(home)	currency
is	used.

Fiscal	Set	Field	Names
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Examples

Statement Return	Value

=FRAMT("PBALP.L1","1000-33-
248";	"DEM.S")

The	provisionally-posted	balance	of
Deutsche	Marks	(in	source
currency)	to	account	1000-33-248
for	the	current	period	last	year

=FRAMT("QBALP","2000") The	quantity	balance	of	the	current
period	for	account	2000

=FRAMT("ABAL.2010","1000%%",
"(ACCTTYPE="B")")

The	total	actual	balance	for	all
balance	sheet	accounts	with
account	numbers	starting	with
"1000"	for	the	year	2010

Related	Topics
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FRCREDIT	Function
This	function	is	the	same	as	FRAMT	Function,	except	that	it	returns
values	for	only	those	accounts	that	have	credit	amounts	(balances	or	net
changes)—regardless	of	whether	the	account	is	a	debit	or	credit	account.

Note:	This	function	can	retrieve	budget	and	provisional	amounts,
calculate	balances,	and	include	rollup	amounts	and	rollup	members
accounts.



Syntax
FRCREDIT(field	name,	account	reference,

criteria,	currency)

Tip:	Use	the	criteria	argument	to	restrict	this	function	to	credit	(CR)
account	types.

FRCREDIT	returns	the	credit	value	of	the	account,	with	the	following
exceptions:

Returns	blank	if	the	value	of	a	debit	account	is	zero	or	a	debit	amount
Returns	0	if	the	value	of	a	credit	account	is	zero
Returns	"0"	if	the	account	reference	is	missing	or	if	a	specified
account	cannot	be	found



Arguments
Argument Description

field	name The	name	of	a	field	from	the	General	Ledger	fiscal	sets	with
an	optional	fiscal	designator	prefix	and	optional	fiscal
year	suffix	(separated	from	the	field	name	with	a	period).

The	fiscal	designator	prefix	can	be:

A.	Actual	amount
R.	Rollup	amounts.	R	must	be	the	first	character	and
can	be	used	with	other	prefixes

Tip:	In	Excel,	if	you	use	the	FR	PASTE	screen	to	add
the	FRAMT	function	to	a	statement,	select	the	Use
Rolled	Up	Amounts	check	box.

P.	Provisional	amounts
Q.	Quantities	(either	actual	or	provisional,	depending	on
the	report	type)
QA.	Actual	quantities
QP.	Provisional	quantities
1	to	5.	Budget	set	number
The	number	of	available	budget	sets	varies	by	product
edition.

2	in	Sage	300	Standard	ERP
3	in	Sage	300	Advanced	ERP
5	in	Sage	300	Premium	ERP

Note:	If	no	prefix	is	supplied,	the	default	report	setting	is
used	(either	actual	or	provisional,	depending	on	the	type	of
report).	Similarly,	if	the	fiscal	prefix	is	"Q"	or	"RQ,"	actual	or
provisional	quantities	are	returned,	depending	on	the	type	of
report.
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The	fiscal	year	suffix	can	be:

YYYY.	A	specific	fiscal	year,	such	as	2010
Ln.n	years	ago	relative	to	the	current	fiscal	year;	for
example,	L1	is	last	year,	and	L2	is	2	years	ago
Nn.n	years	in	the	future	relative	to	the	current	fiscal
year;	for	example,	N1	is	next	year,	and	N2	is	the	year
after	next

Note:	If	no	suffix	is	supplied,	the	current	fiscal	year	is	used.

Example:	For	the	field	name	argument	ABALP.2008,
ABALP	is	the	combination	of	fiscal	set	prefix	and	field	name
referencing	the	actual	balance	for	the	current	period,	and
2008	is	the	fiscal	year	suffix.

account
reference

A	string	specifying	a	single	account	or	a	range	of	accounts.
See	About	Account	Number	References.

criteria
(Optional)

An	expression	that	imposes	selection	criteria	on	the
accounts	and	account	optional	fields.	The	account
reference	and	expression	together	determine	the	accounts
and	account	optional	fields	that	will	be	included	in	the
calculation.	See	About	Selection	Criteria	for	Filtering
Accounts.

currency
(Optional)

A	string	containing	the	currency	reference.	A	currency
reference	has	the	form	"CCC.T,"	where	CCC	is	a	3-
character	currency	code	(for	example,	CAD	for	Canadian
dollars,	or	USD	for	US	dollars),	and	T	is	the	currency	type
(also	known	as	the	currency	code	qualifier).

The	currency	type	can	be:

S.	Source	currency
E.	Functional	equivalent	of	the	source	amount
F.	Functional	currency	total	(including	functional
equivalents	of	all	source	amounts)



R.	Reporting	currency	total	(includes	reporting
equivalents	of	all	source	amounts)

Note:	This	option	is	only	available	if	you	select	the
Euro	as	your	functional	currency	and	specify	a
different	reporting	currency	in	Company	Profile.

Note:	If	no	currency	is	supplied,	functional	(home)	currency
is	used.

Fiscal	Set	Field	Names
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Examples
The	following	examples	show	the	differences	between	the	return	values
for	the	FRAMT	and	FRCREDIT	functions.

Account	Type Value FRAMT
Return	Value

FRCREDIT
Return	Value

Credit 100	CR 100 100

Credit 0 0 0

Debit 0 0 blank

Debit 100	CR -100 100

Debit 100	DR 100 blank

Related	Topics
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FRDEBIT	Function
This	function	is	the	same	as	FRAMT	Function,	except	that	it	returns
values	for	only	those	accounts	that	have	debit	amounts	(balances	or	net
changes)—regardless	of	whether	the	account	is	a	debit	or	credit	account.

Note:	This	function	can	retrieve	budget	and	provisional	amounts,
calculate	balances,	and	include	rollup	amounts	and	rollup	members
accounts.



Syntax
FRDEBIT(field	name,account	reference,	criteria,

currency)

Tip:	Use	the	criteria	argument	to	restrict	this	function	to	debit	(DR)
account	types.

FRDEBIT	returns	the	debit	value	of	the	account,	with	the	following
exceptions:

Returns	blank	if	the	value	of	a	credit	account	is	zero	or	a	credit
amount
Returns	0	if	the	value	of	a	debit	account	is	zero
Returns	"0"	if	the	account	reference	is	missing	or	if	a	specified
account	cannot	be	found



Arguments
Argument Description

field	name The	name	of	a	field	from	the	General	Ledger	fiscal	sets	with
an	optional	fiscal	designator	prefix	and	optional	fiscal
year	suffix	(separated	from	the	field	name	with	a	period).

The	fiscal	designator	prefix	can	be:

A.	Actual	amount
R.	Rollup	amounts.	R	must	be	the	first	character	and
can	be	used	with	other	prefixes

Tip:	In	Excel,	if	you	use	the	FR	PASTE	screen	to	add
the	FRAMT	function	to	a	statement,	select	the	Use
Rolled	Up	Amounts	check	box.

P.	Provisional	amounts
Q.	Quantities	(either	actual	or	provisional,	depending	on
the	report	type)
QA.	Actual	quantities
QP.	Provisional	quantities
1	to	5.	Budget	set	number
The	number	of	available	budget	sets	varies	by	product
edition.

2	in	Sage	300	Standard	ERP
3	in	Sage	300	Advanced	ERP
5	in	Sage	300	Premium	ERP

Note:	If	no	prefix	is	supplied,	the	default	report	setting	is
used	(either	actual	or	provisional,	depending	on	the	type	of
report).	Similarly,	if	the	fiscal	prefix	is	"Q"	or	"RQ,"	actual	or
provisional	quantities	are	returned,	depending	on	the	type	of
report.
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The	fiscal	year	suffix	can	be:

YYYY.	A	specific	fiscal	year,	such	as	2010
Ln.n	years	ago	relative	to	the	current	fiscal	year;	for
example,	L1	is	last	year,	and	L2	is	2	years	ago
Nn.n	years	in	the	future	relative	to	the	current	fiscal
year;	for	example,	N1	is	next	year,	and	N2	is	the	year
after	next

Note:	If	no	suffix	is	supplied,	the	current	fiscal	year	is	used.

Example:	For	the	field	name	argument	ABALP.2008,
ABALP	is	the	combination	of	fiscal	set	prefix	and	field	name
referencing	the	actual	balance	for	the	current	period,	and
2008	is	the	fiscal	year	suffix.

account
reference

A	string	specifying	a	single	account	or	a	range	of	accounts.
See	About	Account	Number	References.

criteria
(Optional)

An	expression	that	imposes	selection	criteria	on	the
accounts	and	account	optional	fields.	The	account
reference	and	expression	together	determine	the	accounts
and	account	optional	fields	that	will	be	included	in	the
calculation.	See	About	Selection	Criteria	for	Filtering
Accounts.

currency
(Optional)

A	string	containing	the	currency	reference.	A	currency
reference	has	the	form	"CCC.T,"	where	CCC	is	a	3-
character	currency	code	(for	example,	CAD	for	Canadian
dollars,	or	USD	for	US	dollars),	and	T	is	the	currency	type
(also	known	as	the	currency	code	qualifier).

The	currency	type	can	be:

S.	Source	currency
E.	Functional	equivalent	of	the	source	amount
F.	Functional	currency	total	(including	functional
equivalents	of	all	source	amounts)



R.	Reporting	currency	total	(includes	reporting
equivalents	of	all	source	amounts)

Note:	This	option	is	only	available	if	you	select	the
Euro	as	your	functional	currency	and	specify	a
different	reporting	currency	in	Company	Profile.

Note:	If	no	currency	is	supplied,	functional	(home)	currency
is	used.

Fiscal	Set	Field	Names
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Examples
The	following	examples	show	the	differences	between	the	return	values
for	the	FRAMT	and	FRDEBIT	functions.

Account	Type Value FRAMT
Return	Value

FRDEBIT
Return	Value

Debit 100	DR 100 100

Debit 0 0 0

Credit 0 0 	

Credit 100	DR -100 100

Credit 100	CR 100 blank

Related	Topics
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FRFISCAL	Function
This	function	returns	a	date	(as	a	string)	from	the	fiscal	calendar	in
Common	Services.



Syntax
FRFISCAL(option,	fiscal	year,	fiscal	period,

formatted)



Arguments
Argument Description

option The	period	or	quarter	date.

Valid	parameters	are:

Start:	Start	date	of	the	period
End:	End	date	of	the	period
QStart:	Start	date	of	the	quarter
QEnd:	End	data	of	the	quarter

fiscal	year
(Optional)

Valid	parameters	are:

YYYY:	A	specific	4-digit	fiscal	year,	such	as	2010
Ln:nyears	ago,	relative	to	the	current	fiscal	year;	for
example,	L1	is	last	year,	and	L2	is	2	years	ago
Nn:nyears	in	the	future,	relative	to	the	current	fiscal
year;	for	example,	N1	is	next	year,	and	N2	is	the	year
after	next

If	not	specified,	assumed	to	be	the	current	year.

fiscal
period
(Optional)

Fiscal	period	number	from	1	to	12.	If	not	specified,	the
current	period	is	used.

Note:	This	field	is	an	integer	so	is	not	enclosed	in	quotation
marks.

formatted
(Optional)

Indicates	whether	the	return	value	should	be	formatted
according	to	the	presentation	defined	in	the	view.	If	omitted,
the	default	is	"Formatted."	Use	one	of	the	following
constructs:

"FORMATTED",	"F",	or	"FMT"
"UNFORMATTED",	"U",	or	"UNFMT"





Examples
Statement Return	Value

=FRFISCAL("Start") 11/01/2009

=FRFISCAL("Start","","O","U") 20081101

=FRFISCAL("Start","L1",
VALUE(FR("Period")),"F")

11/01/2008

Related	Topics
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FRPOST	Function
This	function	retrieves	account	and	transaction	detail	information	from
posted	G/L	transactions.	It	can	also	retrieve	transaction	optional	fields
and	account	optional	field	data	for	the	account	specified	in	the
transaction	record.

Details	can	be	consolidated	or	not	consolidated.	That	is,	if	the	result	of
FRPOST	(or	FRACCT	Function)	is	derived	from	more	than	one
transaction,	and	if	the	result	is	from	an	optional	field	of	type	Integer,
Number,	or	Amount,	you	can	print	a	consolidated	total	that	sums	up	all
values	from	the	retrieved	optional	fields	or	print	the	value	of	the	first
retrieved	record	that	has	an	optional	field	value.

If	an	optional	field	name	is	specified	as	is,	or	[C]	is	appended	to	the
field	name,	a	consolidated	total	is	printed.
If	[U]	is	appended	to	the	specified	optional	field	name,	only	the	first
optional	field	value	is	reported.



Syntax
FRPOST(field	name,	account	reference,	criteria,

formatted)

The	function	can	retrieve	data	from	all	G/L	account	fields	and	account
optional	fields	defined	for	FRACCT	Function,	It	can	also	reference
transaction	optional	fields	defined	in	G/L	Setup,	and	the	following
G/L	transaction	fields:

Transaction
Field	Name

Description

DEFCURNCOD Default	currency	code

FISCALYR Fiscal	year

FISCALPERD Fiscal	period

SRCECURN Source	currency	code

SRCELEDGER Source	ledger	code

SRCETYPE Source	type	code

POSTINGSEQ Posting	sequence	number

CNTDETAIL Detail	count

JRNLDATE Journal	date

BATCHNBR Batch	number

ENTRYNBR Journal	entry	number

TRANSNBR Journal	transaction	number

CONSOLIDAT Consolidation	occurred	on	post

JNLDTLDESC Journal	detail	description

JNLDTLREF Journal	detail	reference

TRANSAMT Journal	transaction	amount	(functional	amount)

TRANSQTY Journal	transaction	quantity



SCURNAMT Journal	source	currency	amount

RATETYPE Currency	Rate	Table	type

RATEDATE Date	of	currency	rate	selected

CONVRATE Currency	rate	for	conversion

RATEOPER Currency	rate	operator



Arguments
Argument Description

field	name The	name	of	a	field	from	the	G/L	account	record,	including
account	and	transaction	optional	fields.

Note:

Account	optional	fields	have	an	A.	prefix
Transaction	optional	fields	have	a	T.	prefix

account
reference

A	string	specifying	a	single	account	or	a	range	of	accounts.
See	About	Account	Number	References.

criteria An	expression	that	imposes	selection	criteria	on	the
accounts.	The	account	reference	and	expression	together
determine	the	accounts	that	will	be	included	in	the
calculation.	See	About	Selection	Criteria	for	Filtering
Accounts.

formatted
(Optional)

Indicates	whether	the	return	value	should	be	formatted
according	to	the	presentation	defined	in	the	view.	If	omitted,
the	default	is	"Formatted."	Use	one	of	the	following
constructs:

"FORMATTED",	"F",	or	"FMT"
"UNFORMATTED",	"U",	or	"UNFMT"



Examples

Statement Return	Value

=FRPOST("TRANSAMT",
"1000","(POSTINGSEQ	=
100)","U")

Retrieves	unformatted	transaction
amounts	for	Account	1000	that
have	a	posting	sequence	number
of	100.

=FRPOST("TRANSAMT",
"1000","(JRNLDATE	=
20100110)","U")

Retrieves	the	unformatted
transaction	amount	from	Account
1000	from	January	10,	2010.

=FRPOST("ACCTDESC","1000") Retrieves	the	account	description
from	Account	1000.

=FRPOST("T.QTY","4000") Retrieves	the	transaction	optional
value	for	QTY	for	Account	4000	for
the	inquired	period.

Note:	Account	numbers	and	transaction	date	are	shown	in	the
examples;	however,	this	information	can	be	set	in	the	report
specification—the	account	number	in	column	A,	and	other	criteria,	such
as	the	transaction	date,	in	column	B.

Related	Topics
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FRRATE	Function
This	function	returns	the	exchange	rate,	as	a	multiplier,	for	converting
amounts	from	source	to	functional	currency.	If	the	exchange	rate	is
defined	as	a	divisor,	Sage	300	ERP	provides	its	reciprocal.



Syntax
FRRATE(functional	currency,	source	currency,

rate	type,	rate	date,	option)



Arguments
Argument Description

functional
currency

Functional	(home)	currency	code

source
currency

Source	currency	code

rate	type Rate	type	code

rate	date
(Optional)

If	the	period	end	date	is	not	specified,	Financial	Reporter
will	use:

The	period	end	date	defined	in	the	report	specification
The	session	date,	if	the	report	is	not	generated	from	a
report	specification

The	date	is	specified	as	DATE(YYYY,MM,DD).	Note	that
the	DATE()	spreadsheet	function	returns	the	serial
number	of	the	date.

option
(Optional)

This	argument	is	only	required	for	handling	exchange	rates
for	euro-member	currencies	that	use	the	Euro	Conversion
Rates	table,	such	as	francs	or	schillings.

Use	one	of	the	following	parameters	to	choose	which	part	of
the	currency	exchange	rate	(from	euro-member	currency	to
non-euro-member	currency)	you	want	the	function	to
provide:

RF	returns	the	floating	portion	value	of	the	exchange
rate—the	portion	not	fixed	between	the	euro	and	non-
euro-member	currencies.	RF	returns	a	"1"	if	the
currencies	are	euro-member,	and	the	year	is	greater	or
equal	to	1999.

RC	returns	the	composite	exchange	rate—the	effective
rate	between	a	non-euro	currency	and	a	euro-member



currency.	This	is	the	default	if	no	value	is	specified.

Note:

For	non-euro	currencies,	RC	will	look	up	the	rate	in	the
Currency	Rate	table.
If	the	source	and	functional	currencies	are	both	euro-
member	currencies,	RC	will	return	the	rate	from	the
Euro	Conversion	Rates	table.
If	the	functional	currency	is	the	euro,	and	the	source	is
not	a	euro-member	currency,	RC	will	return	the	effective
exchange	rate	between	the	two	currencies.



Examples
Some	of	the	following	example	use	the	spreadsheet	function
DATEVALUE.	This	function	converts	a	textual	representation	of	a	date
(such	as	the	date	string	returned	by	FRFISCA)	to	a	serial	number,	which
FRRATE	accepts.

Statement Return	Value

=FRRATE("USD","CAD","AV") .75

=FRRATE("USD","CAD","SP",
DATE(2009,10,31))

.75

=FRRATE("USD","CAD","SP",
DATEVALUE(FRFISCAL("Start")))

.75

=FRRATE("ATS","EUR","AV",
DATEVALUE(FRFISCAL("Start")),"RC")

13.760300

=FRRATE("USD","ATS","AV",
DATEVALUE(FRFISCAL("Start")),"RF")

Note:	This	function	returns	the	floating
exchange	component	between	the
Austrian	schilling	and	the	US	dollar.	In
this	case,	this	is	the	euro	to	US	dollar
exchange	rate.

.88274



Related	Topics
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FRSDESC	Function
This	function	returns	the	account	segment	name	from	the	General
Ledger	segment	codes	table,	given	a	segment	number	and	code.



Syntax
FRSDESC(segment	number,	segment	code)



Arguments
Argument Description

segment	number G/L	segment	number,	from	1	to	10

segment	code G/L	segment	code



Examples
In	the	following	examples,	segment	1	is	the	department	segment.	The
third	example	shows	how	to	use	the	FR	function	to	return	the	segment
code	for	the	current	report.

Statement Return	Value

=FRSDESC(1,"USEAST") Eastern	United
States

=FRSDESC(1,"SALES") Sales	Department

=FRSDESC(1,FR("CurAcSegVal1")) Sales	Department

Related	Topics

javascript:mc133.Click()


Home	>	Financial	Reporter	>	Designing	Financial	Statements	>	Financial	Reporter	Functions
FRTRNA	Function



FRTRNA	Function
This	function	retrieves	net	amounts	and	net	quantities	from	posted
transactions	for	the	period	that	you	specify.	It	retrieves	actual	values	and
summary	totals	(by	both	account	and	transaction	fields),	and	allows	drill
down	to	associated	transactions.

Like	FRAMTA	Function,	it	displays	debit	amounts	as	positive	numbers
and	credit	amounts	as	negative	numbers.

Note:	FRTRNA	does	not	calculate	balances,	and	does	not	include
provisionally	posted	transactions.



Syntax
FRTRNA(field	name,	account	reference,	criteria,

currency)



Arguments
Argument Description

field	name The	name	of	a	field	from	the	General	Ledger	fiscal	sets	with
an	optional	fiscal	designator	prefix	and	optional	fiscal
year	suffix	(separated	from	the	field	name	with	a	period).

The	fiscal	designator	prefix	can	be:

A.	Actual	amount
Q.	Quantities
QA.	Actual	quantities

Note:	If	no	prefix	is	supplied,	the	default	report	setting	is
used	(actual).

The	fiscal	year	suffix	can	be:

YYYY.	A	specific	fiscal	year,	such	as	2010
Ln.	n	years	ago	relative	to	the	current	fiscal	year;	for
example,	L1	is	last	year,	and	L2	is	2	years	ago
Nn.	n	years	in	the	future	relative	to	the	current	fiscal
year;	for	example,	N1	is	next	year,	and	N2	is	the	year
after	next

Note:	If	no	suffix	is	supplied,	the	current	fiscal	year	is	used.

account
reference

A	string	specifying	a	single	account	or	a	range	of	accounts.
See	About	Account	Number	References.

criteria
(Optional)

An	expression	that	imposes	selection	criteria	on	the
accounts	and	on	transaction	fields,	including	account	and
transaction	optional	fields.	The	account	reference	and
expression	together	determine	the	accounts	and	additional
data	that	will	be	included	in	the	calculation.	See	About
Selection	Criteria	for	Filtering	Accounts.
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currency
(Optional)

A	string	containing	the	currency	reference.	A	currency
reference	has	the	form	"CCC.T,"	where	CCC	is	a	3-
character	currency	code	(for	example,	CAD	for	Canadian
dollars,	or	USD	for	US	dollars),	and	T	is	the	currency	type.

The	currency	type	can	be:

S.	Source	currency
E.	Equivalent	source	amount	in	the	functional	currency
F.	Functional	currency	total	(including	functional
equivalents	of	all	source	amounts)
R.	Reporting	currency	total
If	the	currency	code	is	functional,	R	includes	reporting
equivalents	of	all	source	amounts.
If	the	currency	code	is	not	functional,	R	provides
equivalent	amounts	in	the	reporting	currency.

Note:	If	no	currency	is	supplied,	functional	(home)	currency
is	used.

Fiscal	Set	Field	Names

Related	Topics
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FRTRNCR	Function
This	function	is	similar	to	FRCREDIT	Function,	and	retrieves	net	totals
(credit	amounts	only)	from	transactions.	It	retrieves	actual	values	and
summary	totals	(by	both	account	and	transaction	fields),	and	allows	drill
down	to	associated	transactions.

Note:	This	function	cannot	retrieve	budget	or	provisional	amounts,
calculate	balances,	or	include	rollup	amounts	or	totals.



Syntax
FRTRNCR(field	name,	account	reference,

criteria,	currency)

Tip:	Use	the	criteria	argument	to	restrict	this	function	to	credit	(CR)
transactions.



Arguments
Argument Description

field	name The	name	of	a	field	from	the	General	Ledger	fiscal	sets	with
an	optional	fiscal	designator	prefix	and	optional	fiscal
year	suffix	(separated	from	the	field	name	with	a	period).

The	fiscal	designator	prefix	can	be:

A.	Actual	amount
Q.	Quantities
QA.	Actual	quantities

Note:	If	no	prefix	is	supplied,	the	default	report	setting	is
used	(actual).

The	fiscal	year	suffix	can	be:

YYYY.	A	specific	fiscal	year,	such	as	2010
Ln.	n	years	ago	relative	to	the	current	fiscal	year;	for
example,	L1	is	last	year,	and	L2	is	2	years	ago
Nn.	n	years	in	the	future	relative	to	the	current	fiscal
year;	for	example,	N1	is	next	year,	and	N2	is	the	year
after	next

Note:	If	no	suffix	is	supplied,	the	current	fiscal	year	is	used.

account
reference

A	string	specifying	a	single	account	or	a	range	of	accounts.
See	About	Account	Number	References.

criteria
(Optional)

An	expression	that	imposes	selection	criteria	on	the
accounts	and	on	transaction	fields,	including	account	and
transaction	optional	fields.	The	account	reference	and
expression	together	determine	the	accounts	and	additional
data	that	will	be	included	in	the	calculation.	See	About
Selection	Criteria	for	Filtering	Accounts.
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currency
(Optional)

A	string	containing	the	currency	reference.	A	currency
reference	has	the	form	"CCC.T,"	where	CCC	is	a	3-
character	currency	code	(for	example,	CAD	for	Canadian
dollars,	or	USD	for	US	dollars),	and	T	is	the	currency	type.

The	currency	type	can	be:

S.	Source	currency
E.	Equivalent	source	amount	in	the	functional	currency
F.	Functional	currency	total	(including	functional
equivalents	of	all	source	amounts)
R.	Reporting	currency	total
If	the	currency	code	is	functional,	R	includes	reporting
equivalents	of	all	source	amounts.
If	the	currency	code	is	not	functional,	R	provides
equivalent	amounts	in	the	reporting	currency.

Note:	If	no	currency	is	supplied,	functional	(home)	currency
is	used.

Fiscal	Set	Field	Names

Related	Topics
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FRTRNDR	Function
This	function	is	similar	to	FRDEBIT	Function,	and	retrieves	net	totals
(debit	amounts	only)	from	transactions.	It	retrieves	actual	values	and
summary	totals	(by	both	account	and	transaction	fields),	and	allows	drill
down	to	associated	transactions.

Note:	This	function	cannot	retrieve	budget	or	provisional	amounts,
calculate	balances,	or	include	rollup	amounts	or	totals.



Syntax
FRTRNDR(field	name,	account	reference,

criteria,	currency)

Tip:	Use	the	criteria	argument	to	restrict	this	function	to	debit	(DR)
transactions.



Arguments
Argument Description

field	name The	name	of	a	field	from	the	General	Ledger	fiscal	sets	with
an	optional	fiscal	designator	prefix	and	optional	fiscal
year	suffix	(separated	from	the	field	name	with	a	period).

The	fiscal	designator	prefix	can	be:

A.	Actual	amount
Q.	Quantities
QA.	Actual	quantities

Note:	If	no	prefix	is	supplied,	the	default	report	setting	is
used	(actual).

The	fiscal	year	suffix	can	be:

YYYY.	A	specific	fiscal	year,	such	as	2010
Ln.	n	years	ago	relative	to	the	current	fiscal	year;	for
example,	L1	is	last	year,	and	L2	is	2	years	ago
Nn.	n	years	in	the	future	relative	to	the	current	fiscal
year;	for	example,	N1	is	next	year,	and	N2	is	the	year
after	next

Note:	If	no	suffix	is	supplied,	the	current	fiscal	year	is	used.

account
reference

A	string	specifying	a	single	account	or	a	range	of	accounts.
See	About	Account	Number	References.

criteria
(Optional)

An	expression	that	imposes	selection	criteria	on	the
accounts	and	on	transaction	fields,	including	account	and
transaction	optional	fields.	The	account	reference	and
expression	together	determine	the	accounts	and	additional
data	that	will	be	included	in	the	calculation.	See	About
Selection	Criteria	for	Filtering	Accounts.

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);


currency
(Optional)

A	string	containing	the	currency	reference.	A	currency
reference	has	the	form	"CCC.T,"	where	CCC	is	a	3-
character	currency	code	(for	example,	CAD	for	Canadian
dollars,	or	USD	for	US	dollars),	and	T	is	the	currency	type.

The	currency	type	can	be:

S.	Source	currency
E.	Equivalent	source	amount	in	the	functional	currency
F.	Functional	currency	total	(including	functional
equivalents	of	all	source	amounts)
R.	Reporting	currency	total
If	the	currency	code	is	functional,	R	includes	reporting
equivalents	of	all	source	amounts.
If	the	currency	code	is	not	functional,	R	provides
equivalent	amounts	in	the	reporting	currency.

Note:	If	no	currency	is	supplied,	functional	(home)	currency
is	used.

Fiscal	Set	Field	Names

Related	Topics
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FRTRN	Function
This	function	retrieves	net	amounts	and	net	quantities	from	posted
transactions	for	a	specified	period.	It	retrieves	actual	values	and
summary	totals	(by	both	account	and	transaction	fields),	and	allows	drill
down	to	associated	transactions.

FRTRN	is	similar	to	FRAMT	Function,	but	FRTRN	retrieves	totals	from
transaction	history,	whereas	FRAMT	retrieves	totals	from	account	history.

Note:	This	function	cannot	retrieve	budget	or	provisional	amounts,
calculate	balances,	or	include	rollup	amounts	or	totals.



Syntax
FRTRN(field	name,	account	reference,	criteria,

currency)

Note:	FRTRN	returns	0	if	no	transactions	are	retrieved	from	transaction
history.



Arguments
Argument Description

field	name The	name	of	a	field	from	the	General	Ledger	fiscal	sets	with
an	optional	fiscal	designator	prefix	and	optional	fiscal
year	suffix	(separated	from	the	field	name	with	a	period).

The	fiscal	designator	prefix	can	be:

A.	Actual	amount
Q.	Quantities
QA.	Actual	quantities

Note:	If	no	prefix	is	supplied,	the	default	report	setting	is
used	(actual).

The	fiscal	year	suffix	can	be:

YYYY.	A	specific	fiscal	year,	such	as	2010
Ln.	n	years	ago	relative	to	the	current	fiscal	year;	for
example,	L1	is	last	year,	and	L2	is	2	years	ago
Nn.	n	years	in	the	future	relative	to	the	current	fiscal
year;	for	example,	N1	is	next	year,	and	N2	is	the	year
after	next

Note:	If	no	suffix	is	supplied,	the	current	fiscal	year	is	used.

account
reference

A	string	specifying	a	single	account	or	a	range	of	accounts.
See	About	Account	Number	References.

criteria
(Optional)

An	expression	that	imposes	selection	criteria	on	the
accounts	and	on	transaction	fields,	including	account	and
transaction	optional	fields.	The	account	reference	and
expression	together	determine	the	accounts	and	additional
data	that	will	be	included	in	the	calculation.	See	About
Selection	Criteria	for	Filtering	Accounts.
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currency
(Optional)

A	string	containing	the	currency	reference.	A	currency
reference	has	the	form	"CCC.T,"	where	CCC	is	a	3-
character	currency	code	(for	example,	CAD	for	Canadian
dollars,	or	USD	for	US	dollars),	and	T	is	the	currency	type.

The	currency	type	can	be:

S.	Source	currency
E.	Equivalent	source	amount	in	the	functional	currency
F.	Functional	currency	total	(including	functional
equivalents	of	all	source	amounts)
R.	Reporting	currency	total
If	the	currency	code	is	functional,	R	includes	reporting
equivalents	of	all	source	amounts.
If	the	currency	code	is	not	functional,	R	provides
equivalent	amounts	in	the	reporting	currency.

Note:	If	no	currency	is	supplied,	functional	(home)	currency
is	used.

Fiscal	Set	Field	Names

javascript:void(0);


Examples
Statement Return	Value

=FRTRN("NETLQ","1000") Net	transactions	for	the	last	quarter	for
account	1000

=FRTRN("NET#P","1000") Net	transactions	for	inquired	period	for
account	1000

=FRTRN("NETQTD","1000") Net	transactions	for	the	quarter	to	date
for	account	1000

Related	Topics
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FR	Function
This	function	can	retrieve	G/L	Option,	company,	and	fiscal	calendar	data;
runtime	parameter	values;	and	statement	print	options.



Syntax
FR(option,	formatted)



Arguments
Argument Description

option The	name	of	a	field	from	the	Company	Profile,Fiscal
Calendar,	or	G/L	Options	screens;	or	a	specified	runtime
parameter	or	print	option.

formatted
(Optional)

Indicates	whether	the	return	value	should	be	formatted
according	to	the	presentation	defined	in	the	view.	If	omitted,
the	default	is	"Formatted."	Use	one	of	the	following
constructs:

"FORMATTED",	"F",	or	"FMT"
"UNFORMATTED",	"U",	or	"UNFMT"

Option	can	be	one	of	the	following:

G/L	Options	fields

Runtime	parameters	and	print	options
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Examples
Statement Return	Value

=FR("Coname") The	Garden	Inc.

=FR("End") 4/30/02

Related	Topics
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Account	Master	and	Transaction	Fields
Use	selection	criteria	expressions	with	account	master	fields	and	account
optional	fields	(defined	in	G/L	Setup),	and	with	transaction	fields	and
transaction	optional	fields	(defined	using	FRPOST).

Account	Master	Fields

Transaction	Fields
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Account	Master	Fields
You	can	use	a	selection	criteria	expression	with	any	of	the	fields	in	the
general	ledger	account	master	(listed	below).

Many	values	can	be	expressed	in	more	than	one	way.	For	example,	the
quantity	switch	can	be	1	or	"Yes"	if	the	account	keeps	quantities,	or	0	or
"No"	if	it	does	not.	A	criteria	expression	for	this	field	can	look	like	either	of
the	following:

QTYSW	=	1

QTYSW	=	"Yes"

FR	Paste	always	supplies	the	text	value	of	G/L	account	master	fields
("Yes"	in	the	above	example).	If	you	want	to	see	the	non-text	values	and
the	text	values	of	these	fields,	see	the	Object	Information	for	the
GLACCOUNT	view	in	the	Macro	Editor.

Note:	If	a	field's	value	is	text,	you	must	enclose	field	values	in	quotation
marks.	If	the	text	contains	a	space,	it	is	best	to	enclose	values	in	a
second	set	of	quotation	marks:	ACCTDESC	=	""Accounts
Receivable%"".

To	retrieve	account	optional	fields,	add	the	prefix	A.	before	a	field	name
(for	example,	A.ACCTID).	Be	sure	to	include	the	period	after	the	prefix.

The	following	table	shows	G/L	account	data	field	names:

Name Field	Contents

ACCTID Account	number,	including	all
segments.

CREATEDATE Date	the	account	was	created.	Dates
are	specified	as	"yyyymmdd".



ACCTDESC Account	description.

ACCTTYPE Account	type	I,	B	or	R	for	income
statement,	balance	sheet,	or	retained
earnings	account.

ACCTBAL 1	for	normal	debit;	2	for	normal
credit.

ACTIVESW "ACTIVE"	or	"INACTIVE".

CONSLDSW "Do	not	consolidate	journals"	or	0	if
transactions	are	not	consolidated;
"Consolidate	journals"	or	1	if
transactions	are	consolidated	on
posting

QTYSW "Yes"	or	1	if	quantities	are	used	with
account;	"No"	or	0	if	not.

UOM The	unit	of	measure	if	quantities	are
used.

ALLOCSW If	account	can	be	reallocated:	"Yes"
or	1	is	yes;	"No"	or	0	is	no.

ACCTOFSET Account	number	for	reallocation.

ACCTSRTV Allocation	transaction	source	code.

MCSW Multicurrency	switch:	"Yes"	or	1	is
yes;	"No"	or	0	is	no.

SPECSW If	posting	is	in	all	or	specific	source



currencies.	"All	currency"	or	1	is	all;
"Specific	curency"	or	0	is	specified.

ACCTGRPCOD Account	group	code.

CTRLACCTSW If	account	is	a	control	account.
"Control	account"	or	1	is	yes;	"Non
control	account"	or	0	is	no.

SRCELDGID Source	ledger	if	control	account	(e.g.
AR,	AP).	(Reserved	field)

ALLOCTOT Total	of	different	allocation	rates
(100).

ABRKID Account	structure	code.

YRACCTCLOS Year	of	the	last	close.

POSTOSEGID The	account	segment	by	which	the
account	is	closed.

DEFCURNCOD Default	currency	code	for	the
account.

ACCTFMTTD Formatted	account	number.

ACSEGVALn Account	segment	value	01	to	10.

ACCTSEGVAL Account	Segment	Code

ACCTGRPCPY Account	group	COPY.	A	copy	of	the
group	code	that	is	a	string	instead	of
an	integer.



ROLLUPSW Rollup	switch.	If	unformatted,	1	if
account	is	a	rollup	account,	0	if	not.	If
formatted,	"Yes"	or	"No".

Related	Topics
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Transaction	Fields
Transaction	fields	include	account	master	fields	and	account	optional
fields	defined	in	G/L	Setup,	and	the	following	transaction	fields	and
transaction	optional	fields	defined	in	FRPOST.

To	retrieve	account	optional	fields,	add	the	prefix	A.	before	a	field	name
(for	example,	A.ACCTID).	To	retrieve	transaction	optional	fields,	add
the	prefix	T.	before	the	field	name	(for	example,	T.QTY).	Be	sure	to
include	the	period	after	these	prefixes.

For	more	information,	see	Account	Master	Fields	and	FRPOST	Function.

Name Contents	of	the	Field

FISCALYR Fiscal	Year

FISCALPERD Fiscal	Period

SRCECURN Source	Currency	Code

SRCELEDGER Source	Ledger	Code

SRCETYPE Source	Type

POSTINGSEQ Posting	Sequence	Number

CNTDETAIL Detail	Count

JRNLDATE Journal	Date

BATCHNBR Batch	Number

ENTRYNBR Journal	Entry	Number



TRANSNBR Journal	Transaction	Number

CONSOLIDAT Consolidation	in	Posting

JUNLDTLDESC Journal	Detail	Description

JNLDTLREF Journal	Detail	Reference

TRANSAMT Journal	Transaction	Amount

TRANSQTY Journal	Transaction	Quantity

SCURNAMT Journal	Source	Amount

RPTAMT Journal	Reporting	Amount

RATETYPE Date	of	Currency	Rate	Selected

RATEDATE Date	of	Currency	Rate

CONVRATE Currency	Rate	for	Conversion

RATEOPER Currency	Rate	Operator

Related	Topics
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Financial	Reporter	Tutorial
In	this	tutorial,	you	will	learn:

1.	 How	to	use	the	Financial	Statement	Designer	to	construct	financial
statements.

2.	 How	specification	files	generate	financial	statements.
3.	 How	to	use	tools	such	as	FR	Paste	and	FR	View.

Before	you	create	new	statements	or	modify	existing	specification	files
(such	as	those	included	with	General	Ledger),	read	and	perform	the
exercises	in	this	tutorial	to	familiarize	yourself	with	the	product.

Note:

The	lessons	in	this	tutorial	use	sample	data	included	with	System
Manager.	For	information	about	how	to	install	and	refresh	sample
data,	see	the	System	Manager	help	and	documentation.
The	lessons	in	this	tutorial	assume	that	you	are	using	Microsoft
Excel	2007	or	later.

Overview

Lesson	1:		Using	Formulas	to	Retrieve	G/L	Data

Lesson	2:	Using	FR	Paste	to	Insert	Formulas

Lesson	3:		Creating	a	Financial	Report	Specification
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Financial	Reporter	Tutorial
In	this	tutorial,	you	will	learn:

1.	 How	to	use	the	Financial	Statement	Designer	to	construct	financial
statements.

2.	 How	specification	files	generate	financial	statements.
3.	 How	to	use	tools	such	as	FR	Paste	and	FR	View.

Before	you	create	new	statements	or	modify	existing	specification	files
(such	as	those	included	with	General	Ledger),	read	and	perform	the
exercises	in	this	tutorial	to	familiarize	yourself	with	the	product.

Note:

The	lessons	in	this	tutorial	use	sample	data	included	with	System
Manager.	For	information	about	how	to	install	and	refresh	sample
data,	see	the	System	Manager	help	and	documentation.
The	lessons	in	this	tutorial	assume	that	you	are	using	Microsoft
Excel	2007	or	later.



About	the	Statement	Designer
You	use	the	Financial	Statement	Designer	to	create,	edit,	and	test
financial	statements	and	financial	statement	specifications.	It	provides
add-in	programs	that	you	use	in	Microsoft	Excel	to	retrieve	and
manipulate	Sage	300	ERP	data.

Note:	Financial	Reporter	relies	on	the	capabilities	of	Microsoft	Excel	to
create	financial	statements	using	Sage	300	ERP	data.	For	more
information	about	using	Excel,	refer	to	the	Excel	help	or	documentation.

The	Financial	Statement	Designer	can	interpret	a	"report	specification"	(a
set	of	instructions	for	creating	a	report)	and	generate	a	financial	report.
When	you	open	the	Financial	Statement	Designer,	Sage	300	ERP	opens
an	Excel	spreadsheet	using	a	macro	that	adds	Financial	Reporter
commands	and	functions.

For	more	information,	see	G/L	Statement	Designer.



About	Report	Specification	Files
A	report	specification	file	is	a	spreadsheet	with	specific	commands	and
functions	that	Financial	Reporter	uses	to	produce	a	financial	statement.
For	example,	it	can	specify	the	following	information:

Data	to	include	in	each	column	of	a	financial	statement.
Which	accounts	will	be	reported	in	each	row	or	group	of	row.
Print	layout	for	the	statement.

Statement	specifications	are	generalized,	so	the	same	specification	file
can	be	used	over	and	over	again	to	produce	financial	statements	for
different	departments	and	different	time	periods.	For	example,	a	single
specification	file	can	print	balance	sheets	for	any	department	in	your
company	as	of	the	last	day	of	any	fiscal	period	in	your	fiscal	year.	For
more	information,	see	About	Financial	Reporter.

Next	topic:	Lesson	1:	Using	Formulas	to	Retrieve	G/L	Data



Home	>	Financial	Reporter	>	Financial	Reporter	Tutorial	>	Lesson	1:		Using	Formulas	to
Retrieve	G/L	Data



Lesson	1:	Using	Formulas	to	Retrieve	G/L	Data
This	lesson	introduces	Statement	Designer	functions	and	demonstrates
how	to	construct	basic	statements	that	extract	financial	data	from	your
general	ledger.

Before	you	start

Exercise	1:	Adding	Basic	Account	Information

Exercise	2:	Adding	Column	Totals	and	Formatting	Columns

After	creating	your	financial	statement

Next	topic:	Lesson	2:	Using	FR	Paste	to	Insert	Formulas
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Home	>	Financial	Reporter	>	Financial	Reporter	Tutorial	>	Lesson	2:	Using	FR	Paste	to	Insert
Formulas



Lesson	2:	Using	FR	Paste	to	Insert	Formulas
This	lesson	introduces	FR	Paste,	an	extremely	useful	command	that	you
can	use	to	quickly	create	formulas,	look	up	account	numbers,	or	define
account	selection	criteria.

Exercise	1:	Applying	the	FRACCT	Function

Exercise	2:	Applying	the	FRAMT	Function

Next	topic:	Lesson	3:		Creating	a	Financial	Report	Specification

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);


Home	>	Financial	Reporter	>	Financial	Reporter	Tutorial	>	Lesson	3:		Creating	a	Financial
Report	Specification



Lesson	3:		Creating	a	Financial	Report
Specification
This	lesson	introduces	the	FR	Paste	Function	screen,	and	demonstrates
how	to	use	it	to	create	a	financial	report	specification	and	then	generate	a
report	that	compares	current	assets	to	current	liabilities	in	the	sample
General	Ledger.

Exercise	1:	Adding	a	Comment

Exercise	2:		Creating	a	Default	Specification	Row

Exercise	3:		Adding	Column	Headings

Exercise	4:		Adding	Account	Reference	Lines	to	the	Statement

Exercise	5:		Setting	the	Spec	Range	for	the	Statement

Exercise	6:		Generating	the	Statement

More	Suggested	Exercises
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Home	>	Financial	Reporter	>	Troubleshooting	Financial	Reporter



Troubleshooting	Financial	Reporter
Find	frequently	asked	questions,	troubleshooting	tips,	and	information	on
error	messages	you	may	encounter	when	using	Financial	Reporter.

FAQ	and	Troubleshooting

Error	Messages



Home	>	Financial	Reporter	>	Troubleshooting	>	FAQ	and	Troubleshooting



Financial	Reporter	FAQ	and	Troubleshooting

How	Do	I...
Create	an	FR	report	with	drilldown	that	doesn't	show	the	FR	code

Enlarge	the	Spec	range

Exclude	accounts	from	a	range	in	FR

Generate	reports	from	specifications

Turn	off	comments	when	Drilldown	is	selected

Print	recurring	column	headings	at	the	top	of	each	page	when	the
report	has	multiple	pages

Set	grid	lines	and	tab	breaks

Set	the	Spec	range
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Troubleshooting
I'm	getting	error	messages

Nothing	happens	when	I	click	OK	on	the	Financial	Statement
Generator

I	can't	view	some	account	descriptions	in	financial	reports

The	report	date	appears	in	short	date	format	even	when	Excel	cell
format	is	set	to	long	date

The	bottom	of	the	report	is	missing	when	printed

Related	Topics
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Home	>	Financial	Reporter	>	Troubleshooting	>	Error	Messages



Financial	Reporter	Error	Messages
Financial	Reporter	error	messages	fall	into	two	general	categories:

Error	messages	printed	on	financial	statements.	These
messages	report	problems	in	formulas	and	report	specifications,
such	as	an	account	reference	with	too	many	account	code	segments.
If	Financial	Reporter	encounters	a	problem	when	generating	a
financial	statement,	it	inserts	a	message	in	the	report,	and	then
continues	to	generate	(and	print)	the	rest	of	the	statement.
Error	messages	displayed	by	Financial	Reporter.	This	messages
appear	when	you	attempt	to	open	Financial	Reporter	screens,	or
when	report	generation	is	canceled,	and	may	appear	under	the
following	conditions:

If	Sage	300	ERP	cannot	start	Microsoft	Excel.
If	the	computer	runs	out	of	memory	(RAM).
If	Financial	Reporter	cannot	continue	to	generate	the	report.	(For
example,	this	may	happen	if	the	text	or	formula	in	a	specification
cell	is	too	long.)

The	following	tables	describe	these	error	messages	and	possible
solutions.



Error	Messages	Printed	on	Financial	Statements
Error	Messages	Printed	on	Financial	Statements

Message Description

"Invalid	account	reference	in
cell.
<cell	location	L>	:	<cell	value
V>"

The	account	reference	you	entered	in
column	A	is	incorrect	because	it	does
not	match	the	requirements	for	column	A
cells.

"Invalid	selection	criteria	in
cell.
<cell	location	L>	:	<cell	value
V>"

You	entered	an	incorrect	selection
criteria	in	this	cell.	Follow	the	criteria	in
column	B	to	refine	the	account	selection
(for	example,	a	filter	that	restricts	the
range	of	accounts	to	a	particular
account	group,	account	type,	or	account
name).

"Invalid	zero-suppression
formula	in	cell.
<cell	location	L>	:	<cell	value
V>"

You	entered	an	incorrect	definition	for	a
zero	-suppression	formula	in	this	cell.
Follow	the	criteria	in	column	C	to
determine	which	lines	are	to	be
excluded.

"Invalid	detail	level	in	cell.
<cell	location	L>	:	<cell	value
V>"

You	entered	an	incorrect	consolidation
switch	in	this	cell.	Follow	the	criteria	in
column	D	for	consolidating	account
ranges.

"Invalid	formula	or	expression
in	cell.
<cell	location	L>	:	<cell	value
V>"

This	is	a	general	message	indicating
that	a	formula	or	expression	at	the
stated	cell	location	cannot	be	interrupted
by	FR	in	generation.



Invalid	specification	line	type
in	cell.
<cell	location	L>	:	<cell	value
V>

Invalid	spec	line	definition	at	cell	location
L	with	value	V	(not	a	comment	line,	or
valid	default	line,	or	body	line).

"FR	cannot	further	generate
any	line	for	the	worksheet."

Generated	lines	are	almost	over
spreadsheet	limit.	Report	generation	has
been	stopped.

"Invalid	consolidation	of
posted	transactions	on
specification	in	row	<Row	R>.
Consolidated	details	cannot
be	generated	using	the
combination	of	detail	level
and	sorting	order."

The	specified	consolidation	method	for
posted	transactions	on	the	spec	lines	in
row	R	must	match	with	a	specific	sorting
order.

For	more	information,	see	About	Columns	in	Report	Specifications.



Error	Messages	when	Starting	G/L	Statement
Designer	or	Running	Print	Financial	Statements
Error	Messages	When	Starting	G/L	Statement	Designer	or	Running	Print

Financial	Statements

Message Description

"Error	in	creating	Excel	object." Make	sure	Microsoft	Excel	is
installed.

"Page	Break	Preview	is	not	available
in	Print	Financial	Statements
(GL9100).	Please	go	to	Statement
Designer	(GL9200)	to	use	this
function."

The	Print	Financial	Statements
feature	does	not	support	Page
Break	Preview.	Use	the	G/L
Statement	Designer	instead.

"There	are	no	printers	installed.	One
is	required	when	print	destination	is
Printer	or	Preview."

You	must	install	a	printer	before
you	can	view	output	or	choose
a	print	destination.

"FileSystemObject	object	model
cannot	be	initiated.	Please	make	sure
that	Scripting	type	library	is	properly
installed	in	Windows	System."

Cannot	find	Microsoft	Scripting
Runtime	Object	-	required	when
starting	FR.



Error	Messages	when	Starting	Financial
Reporter

Error	Messages	when	Starting	Financial	Reporter

Message Description

"cmdStart	:	<error	message>" If	you	receive	error	messages	that
are	in	this	format,	you	may	need	to
reinstall	Microsoft	Excel,	or
General	Ledger,	or	System
Manager.	After	reinstalling,	restart
the	system,	and	then	check	to	see
if	the	problem	has	disappeared.

If	the	problem	cannot	be	resolved
by	reinstalling	these	programs,
contact	your	system	administrator.

"Initializing	FR	Error	(<	error	id>J):
Failure	in	starting	Statement
Designer."

Failure	to	start	Statement
Designer.

"Initializing	FR	Error	(<error	id>):
Failure	in	starting	Print	Financial
Statements."

Failure	to	start	Print	Financial
Statements.

"Internal	error,"	"Insufficient
memory,"	or	"System	error."

Write	down	the	message,	exit
applications	and	Windows,	restart
your	computer,	and	then	try	the
task	again.

"Incorrect	procedure." Most	error	messages	pertaining	to
incorrect	procedures	arise	when
other	tasks	have	locked	the	system



or	company	database.	Wait	for	the
other	task	to	complete,	and	then
try	again.

Related	Topics
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General	Ledger	Screen	Guides

Financial	Reporter

Accounts

Periodic	Processing

Reports

Setup

Transactions



Home	>	Screen	Guides	>	Financial	Reporter	Screens



Financial	Reporter	Screens
Use	the	G/L	Print	Financial	Statements	screen	to	print	financial
statements,	and	use	the	G/L	Statement	Designer	to	create	custom
financial	statement	specifications.

Print	Financial	Statements

Statement	Designer



Home	>	Screen	Guides	>	Financial	Reporter	>	Print	Financial	Statements



G/L	Print	Financial	Statements	Screen
To	open	this	screen

Fields	and	controls

Pop-up	screens

Related	tasks

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);


Overview
Use	the	G/L	Print	Financial	Statements	screen	to	print	standard	or
custom	financial	statements	for	your	general	ledger	data.

You	can	select	one	of	several	statement	specifications	included	with
General	Ledger	to	print	a	standard	financial	statement.

You	can	also	select	a	statement	specification	that	you	have	created	and
saved	using	the	Financial	Statement	Designer.

The	Print	Financial	Statements	screen	displays	a	variety	of	options	that
you	can	use	to	print	a	report.

Important!	Printing	using	the	Statement	Designer	is	not	the	same	as
printing	using	the	Print	Financial	Statements	screen.

For	more	information,	see	About	Printing	Financial	Statements.

Related	Topics
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Home	>	Screen	Guides	>	Financial	Reporter	>	Statement	Designer



G/L	Statement	Designer
To	open	this	screen

Related	tasks
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Overview
Use	the	Statement	Designer	to	create	or	edit	a	report	specification	for
generating	financial	statements.

When	you	open	the	Statement	Designer	screen	and	then	click	the	Start
button,	Sage	300	ERP	starts	Microsoft	Excel	with	the	Financial	Reporter
add-in.

Important!	This	add-in	is	available	only	when	you	start	Excel	from	the
Statement	Designer.

The	Financial	Reporter	add-in	is	a	set	of	commands	that	you	select	from
the	FR	menu	on	the	Microsoft	Excel	ribbon.	For	more	information,	see
FR	Menu	Commands.

Tip:	Turn	on	manual	calculation	in	Excel	so	that	formulas	are	not
updated	automatically.	You	can	recalculate	FR	commands	at	any	time
by	pressing	the	F9	key.



Using	the	Statement	Designer	to	Design
Financial	Statements
For	information	on	using	the	Statement	Designer	to	create	custom
financial	statements,	see	Designing	Financial	Statements.

For	a	series	of	short	lessons	on	using	the	Statement	Designer,	see
Financial	Reporter	Tutorial.

For	information	on	the	fields	that	you	can	use	in	financial	statements,
see:

Account	Master	Fields
Transaction	Fields



Including	Information	in	Printed	Financial
Statements
You	can	include	the	following	options	when	printing	financial	statements
from	the	G/L	Financial	Statement	Designer	by	clicking	FR	>	FR	View	on
the	menu	bar:

Report	Options
Audit	Information
Formulas
DrillDown	Information



Report	Options
When	you	select	Report	Options,	the	first	page	of	the	financial
statement	displays	the	following	information:

Statement	name
Fiscal	year	and	period
Report	type	(actual	or	provisional)
Account	processing	and	sorting	order
Account	selection	ranges



Including	DrillDown	Information
On	the	G/L	Print	Financial	Statements	and	Statement	Designer	screens,
you	can	select	the	DrillDown	Information	option	to	add	drilldown	link
comments	to	the	generated	report.

For	more	information,	see	About	FR	Drilldown.



Including	Audit	Information
The	Audit	Information	option	is	available	only	when	using	FR	View	in
the	Statement	Designer—it	is	not	available	on	the	G/L	Print	Financial
Statements	screen.

When	you	select	Audit	Information,	the	statement	includes	information
from	the	control	information	columns	of	the	spreadsheet	(columns	A
through	D),	as	well	as	the	report	columns	that	are	usually	printed.



Including	Formulas
The	Formulas	option	is	available	only	when	using	FR	View	in	the
Statement	Designer—it	is	not	available	on	the	G/L	Print	Financial
Statements	screen.

Usually,	when	you	generate	a	report	from	a	financial	report	specification,
Financial	Reporter	inserts	balances	and	net	amounts	from	the	database
into	the	generated	financial	report.	However,	if	you	select	Formulas,
Financial	Reporter	creates	a	financial	report	from	the	specification	with	a
formula	for	each	general	ledger	balance	or	net	that	appears	in	the	final
report.	You	can	then	update	that	financial	report	with	current	database
values	by	recalculating	the	spreadsheet	(pressing	F9).

The	most	common	type	of	report	that	is	composed	only	of	formulas	is
one	that	keeps	financial	ratios.

Note:	Spreadsheets	with	formulas	are	much	larger	than	standard	report
specifications—and	they	are	less	flexible.

Financial	Reporter	automatically	refreshes	General	Ledger	data	the	next
time	you	load	the	linked	spreadsheet	in	the	Statement	Designer.	You	can
also	use	the	G/L	Print	Financial	Statements	screen	to	recalculate	and
print	the	report.

If	you	want	to	change	the	report	(for	example,	by	adding	new	accounts	in
the	chart),	you	must	regenerate	the	report	to	incorporate	the	changes	in
your	statement.

Tips:

To	save	the	linked	spreadsheet,	save	the	file	under	another	name,
and	then	remove	the	report	specification	from	the	renamed
spreadsheet.
Keep	financial	ratios	in	a	formula	sheet.



Related	Topics
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Home	>	Screen	Guides	>	Accounts	Screens



Accounts	Screens
Use	General	Ledger	Accounts	screens	to	set	up	and	maintain	the
General	Ledger	accounts	that	make	up	your	chart	of	accounts.

Account	History	Inquiry

Account	Permissions

Accounts

Budget	Maintenance

Chart	of	Accounts

Create	Accounts

Fiscal	Set	Comparison

Source	Currency	Inquiry

Transaction	History



Home	>	Screen	Guides	>	Accounts	>	Account	History	Inquiry



G/L	Account	History	Inquiry	Screen
To	open	this	screen

Related	tasks
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Overview
Use	the	G/L	Account	History	Inquiry	screen	to	display:

Actual	and	quantity	information	for	prior	years,	including	the	opening
and	closing	account	balances	and	the	net	changes	and	balances	for
each	fiscal	period.
Total	quantity	and	total	net	change	information	for	the	fiscal	year.
G/L	transaction	details	for	a	period	(by	double-clicking	on	the	period
for	which	you	want	more	information).

Rollup	Accounts
If	the	account	you	select	is	a	rollup	account,	you	can	view	each	account
separately	or	roll	up	the	balances.	Rolled	up	amounts	appear	in	the	Net
Change	and	Balance	columns	when	you	select	the	Use	Rolled	Up
Amounts	option.

Related	Topics
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Home	>	Screen	Guides	>	Accounts	>	Account	Permissions



G/L	Account	Permissions	Screen

Important!	G/L	Account	Permissions	is	part	of	G/L	Security,	an	option
that	you	select	on	the	Account	tab	of	the	G/L	Options	screen.	The	G/L
Account	Permissions	icon	appears	in	the	G/L	Accounts	folder	only	after
you	select	the	Use	G/L	Security	option,	and	then	close	and	reopen	the
company	database.

To	open	this	screen

Fields	and	controls

Related	tasks
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Overview
Use	the	G/L	Account	Permissions	screen	to:

Define	account	access	permissions	for	individual	Sage	300	ERP
users.

Note:	Depending	on	the	Default	Access	setting	(on	the	Account
tab	of	the	G/L	Options	screen),	you	use	the	Account	Permissions
screen	mainly	to	grant	access	to	accounts,	or	to	restrict	access.

Related	Topics
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Home	>	Screen	Guides	>	Accounts	>	Accounts



G/L	Accounts	Screen
To	open	this	screen

Fields	and	controls

Related	tasks
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Overview
Use	the	G/L	Accounts	screen	to:

Add	new	accounts	to	the	general	ledger.
Change	information	for	existing	accounts.
Delete	accounts	which	you	no	longer	need.
Print	the	chart	of	accounts.

Depending	on	the	options	you	select,	this	screen	can	include	several
tabs	of	information	about	the	general	ledger	account	you	are	adding	or
displaying.

Note:

To	see	multicurrency	options,	you	must	purchase	and	install	Sage
300	ERP	Multicurrency.
To	use	optional	fields,	you	must	purchase	and	activate	Sage	300
ERP	Transaction	Analysis	and	Optional	Field	Creator.
To	maintain	quantity	and	currency	information	for	an	account,	you
must	select	the	options	for	the	company	in	the	G/L	Options	screen.



Allocation	Tab
This	tab	appears	when	you	select	the	Auto	Allocation	option	on	the
Detail	tab	for	an	account.

Options	you	select	on	the	Allocation	tab	determine	how	General	Ledger
distributes	the	balance	of	an	account	when	you	run	Create	Allocation
Batch	(in	the	G/L	Periodic	Processing	folder).



Currency	Tab
This	tab	is	available	only	if	the	Multicurrency	option	is	selected:

On	the	Company	Profile	screen	in	Common	Services.
On	the	G/L	Options	screen.
For	the	account	on	the	Detail	tab	of	this	screen.

The	Currency	tab	lets	you	specify	which	currencies	are	valid	for	the
account.



Details	Tab
The	Detail	tab	appears	when	you	open	the	G/L	Accounts	screen,	and	it
contains	the	key	information	that	every	account	requires.

Options	you	select	on	this	tab	determine	whether	certain	other	tabs
appear	for	the	account.



Optional	Fields	Tab
The	Optional	Fields	tab	appears	only	if	you	use	Transaction	Analysis	and
Optional	Field	Creator.

You	can	use	this	tab	to	assign	an	unlimited	number	of	optional	fields	to
the	account	to	store	additional	information	that	your	company	wants	to
track.

Any	optional	fields	that	are	set	up	for	automatic	insertion	on	accounts
appear	on	the	tab,	along	with	their	default	values.

You	can	include	these	account	fields	on	the	report	when	you	print	the
long	form	of	your	chart	of	accounts.	You	can	also	use	these	optional
account	fields	as	selection	criteria	when	printing	your	chart	of	accounts,
trial	balances,	transaction	listings,	and	source	journals.



Rollup	Tab
This	tab	appears	when	you	select	the	Rollup	option	on	the	Detail	tab.
Use	it	to:

Create	relationships	between	accounts	that	can	be	used	for
classification,	budgeting,	and	reporting.

Creating	a	relationship	between	accounts	lets	you	consolidate	(roll
up)	account	balances	and	quantities	(if	the	account	maintains
quantities)	to	provide	a	summary	balance	similar	to	the	consolidation
options	provided	in	Financial	Reporter.

Change	a	rollup	account	to	a	non-rollup	account	by	clearing	the
Rollup	option	on	the	Details	tab.



Subledger	Tab
This	tab	appears	when	you	select	the	Control	Account	option	on	the
Detail	tab.

Use	the	Subledgers	tab	to	specify	which	subledgers	use	the	account	as	a
control	account.



Transaction	Optional	Fields	Tab
The	Transaction	Optional	Fields	tab	appears	only	if	you	use	Transaction
Analysis	and	Optional	Field	Creator.

You	can	use	this	tab	to	add	an	unlimited	number	of	optional	fields	for
additional	information	that	you	want	to	include	with	transactions
processed	for	a	selected	account.

Transaction	details	that	use	the	account	will	include	the	optional	fields	on
this	tab,	whether	you	enter	the	transactions	through	Journal	Entry,	Create
Allocation	Batch,	Create	Revaluation	Batch,	or	the	Create	Recurring
Entries	Batch	screen,	or	you	create	them	for	General	Ledger	in	a	Sage
300	ERP	subledger.	If	you	use	exactly	the	same	optional	fields	in	the
subleders,	optional	field	information	passes	from	the	subledgers	to
General	Ledger.

Related	Topics
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Home	>	Screen	Guides	>	Accounts	>	Budget	Maintenance



G/L	Budget	Maintenance	Screen
Open	General	Ledger	>	G/L	Accounts	>		Budget	Maintenance.
To	open	this	screen

Fields	and	controls

Related	tasks
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Overview
Use	the	G/L	Budget	Maintenance	screen	to:

Enter	and	display	budget	information	for	each	G/L	account.
If	your	General	Ledger	has	multicurrency	accounts,	enter	budget
amounts	for	each	of	the	currencies	you	use.

You	can	maintain	up	between	one	and	five	budget	sets	for	each	account,
depending	on	your	edition	of	Sage	300	ERP.	If	you	are	using	Sage	300
Premium	ERP,	you	can	create	up	to	five	optional	budgets	for	an	account.

Note:	You	cannot	add,	change,	or	delete	information	contained	in	a
locked	budget	set.	(The	Posting	tab	on	the	G/L	Options	screen	tells	you
which	budget	sets,	if	any,	are	locked.)

Related	Topics

javascript:mc148.Click()


Home	>	Screen	Guides	>	Accounts	>	Chart	of	Accounts



G/L	Chart	of	Accounts	Screen
To	open	this	screen

Related	tasks
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Overview
Use	the	G/L	Chart	of	Accounts	screen	to:

List	all	the	accounts	in	the	general	ledger,	in	account	number	order,
beginning	with	the	account	you	specify.

View	detailed	information	for	a	selected	account.	More...

Print	the	chart	of	accounts.
List	rolled	up	account	balances	(instead	of	viewing	individual
accounts).

Related	Topics

javascript:void(0);
javascript:mc149.Click()


Home	>	Screen	Guides	>	Accounts	>	Create	Accounts



G/L	Create	Accounts	Screen
To	open	this	screen

Fields	and	controls

Pop-up	screens

Related	tasks
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Overview
Use	the	G/L	Create	Accounts	screen	to	create	accounts	automatically
based	on	the	characteristics	of	an	existing	set	of	accounts.	You	can
generate	new	accounts	for:

A	range	of	accounts
A	range	of	account	groups
A	specific	segment	code

Related	Topics

javascript:mc150.Click()


Home	>	Screen	Guides	>	Accounts	>	Fiscal	Set	Comparison



G/L	Fiscal	Set	Comparison	Screen
To	open	this	screen

Related	tasks
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Overview
Use	the	G/L	Fiscal	Set	Comparison	screen	to	display	account	information
for	two	fiscal	sets,	to	compare	the	net	changes	or	period	balances.

You	can	compare	actual,	quantity,	provisionally-posted	and	budget	fiscal
sets,	in	any	combination	you	choose.

For	multicurrency	accounts,	you	can	specify	amounts	posted	in	a
particular	currency,	displaying	the	source-currency	amounts,	the
functional	equivalent	of	the	source,	or	the	reporting	currency	(this	option
is	only	available	if	the	euro	is	your	functional	currency	and	you	specified
a	reporting	currency	on	the	Company	Profile	screen	in	Common
Services).

The	program	also	displays	the	monetary	difference	between	the	two	sets,
and	the	difference	as	a	percentage	of	the	second	set.

If	the	account	you	select	is	a	rollup	account,	the	Use	Rolled	Up
Amounts	option	appears.	You	can	select	it	to	view	the	balances,	net
changes,	and	quantities	of	the	member	accounts	rolled	into	a	single
account.

Related	Topics

javascript:mc151.Click()


Home	>	Screen	Guides	>	Accounts	>	Source	Currency	Inquiry



G/L	Source	Currency	Inquiry	Screen
To	open	this	screen

Related	tasks
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Overview
Use	the	G/L	Source	Currency	Inquiry	screen	to:

Display	all	source-currency	account	balances	for	a	multicurrency
account,	as	well	as	the	equivalent	amounts	in	the	functional	currency.
Display	all	reporting-currency	account	balances	for	a	multicurrency
account.

Note:	If	the	euro	is	your	functional	currency	and	you	specified	a
reporting	currency,	this	screen	displays	a	column	with	amounts
shown	in	the	reporting	currency.

Display	source-currency	account	balances	for	rollup	accounts.	Rolled
up	amounts	appear	in	the	Source	Balance	and	Equivalent	Balance
columns	when	you	select	the	Use	Rolled	Up	Amounts	option.
Drill	down	to	Transaction	History	to	show	individual	transactions.

Related	Topics

javascript:mc152.Click()


Home	>	Screen	Guides	>	Accounts	>	Transaction	History



G/L	Transaction	History	Screen
To	open	this	screen

Pop-up	screens

Related	tasks
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Overview
Note:	For	an	Intercompany	Transactions	company	this	screen	is	called
ICT	G/L	Transaction	History	Inquiry	and	has	an	extra	field,	labeled
Company.

Use	the	G/L	Transaction	History	screen	to:

Display	all	transactions	posted	to	selected	account	in	a	particular
year	and	fiscal	period	(unless	transactions	were	consolidated).

Tip:	You	can	use	filters	to	restrict	the	list	to	transactions	with	a
particular	source	code	or	source	currency	(if	you	have	a
multicurrency	ledger).

Information	displayed	for	each	transaction	includes:

Fiscal	period
Date
Source	code
Reference	and	description
Functional	currency	for	posted	amounts	and	source	currency	(if	you
have	a	multicurrency	ledger)
Reporting	currency	amount.

The	Reporting	option	is	available	only	in	multicurrency	ledgers	if	the
euro	is	your	functional	currency	and	you	specified	a	reporting
currency.

Quantity
Exchange	rate,	rate	type	and	rate	date	(if	you	have	a	multicurrency
ledger)
Batch	number,	entry	number	and	transaction	number
Optional	fields

If	you	do	not	specify	a	source	code	or	currency,	the	program	lists	the
displayed	transactions	first	by	year	and	period,	then	in	order	by



currency,	source	ledger,	source	type,	posting	sequence,	and	detail
record	number.

Displays	rollup	amounts.	If	Use	Rolled	Up	Amounts	is	selected	and
the	Go	button	clicked,	all	transactions	posted	to	an	account	in	a
particular	year	and	fiscal	period	as	well	as	the	rollup	member
transactions	will	be	displayed.	A	new	Members	field	appears	in	the
table	and	displays	the	rollup	member	or	rollup	account	to	which	the
transaction	was	posted.

Related	Topics

javascript:mc153.Click()


Home	>	Screen	Guides	>	Periodic	Processing	Screens



Periodic	Processing	Screens
Use	General	Ledger	Periodic	Processing	screens	to	perform	tasks	that
are	part	of	your	regular	period‐end	procedures,	such	as	clearing	history,
creating	general	ledger	batches,	and	deleting	inactive	records.

Clear	History

Consolidate	Posted	Transactions

Create	Allocation	Batch

Create	New	Year

Create	Recurring	Entries	Batch

Create	Revaluation	Batch

Period	End	Maintenance



Home	>	Screen	Guides	>	Periodic	Processing	>	Clear	History



G/L	Clear	History	Screen
To	open	this	screen

Related	tasks

javascript:void(0);
javascript:void(0);


Overview
Use	the	G/L	Clear	History	screen	to:

Clear	all	information	for	printed	posting	journals.
Clear	information	for	deleted	and	posted	batches	(up	to	and	including
the	batch	number	you	specify).

Warning!	Information	and	statistics	that	match	the	criteria	you	specify
are	deleted	permanently.

Clear	history	at	the	end	of	a	fiscal	year	or	as	needed.

Related	Topics

javascript:mc154.Click()


Home	>	Screen	Guides	>	Periodic	Processing	>	Consolidate	Posted	Transactions



G/L	Consolidate	Posted	Transactions	Screen
To	open	this	screen

Related	tasks

javascript:void(0);
javascript:void(0);


Overview
Use	the	G/L	Consolidate	Posted	Transactions	screen	to	reduce	detail	in
reports	by	consolidating	(combining)	details	in	the	accounts	for	which	you
do	not	need	a	permanent	record	of	every	transaction.

For	information	about	general	considerations	and	the	effects	of
consolidation,	see	About	Consolidating	Transactions.

Related	Topics

javascript:mc155.Click()


Home	>	Screen	Guides	>	Periodic	Processing	>	Create	Allocation	Batch



G/L	Create	Allocation	Batch	Screen
To	open	this	screen

Related	tasks
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Overview
Use	the	G/L	Create	Allocation	Batch	screen	to	create	a	batch	of
transactions	that	allocates	balances	in	accounts	that	use	the	Auto
Allocation	option	to	other	accounts,	and	creates	the	offsetting	details.
General	Ledger	calculates	the	amounts	to	distribute	to	each	account
based	on	the	information	entered	on	the	Allocation	tab	on	the	G/L
Accounts	screen	for	the	source	accounts.

Related	Topics

javascript:mc156.Click()


Home	>	Screen	Guides	>	Periodic	Processing	>	Create	New	Year



G/L	Create	New	Year	Screen
To	open	this	screen

Related	tasks
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Overview
Use	the	G/L	Create	New	Year	screen	to:

Create	and	post	a	batch	of	transactions	to	close	income	and	expense
accounts	and	enter	the	opening	account	balances	for	the	new	fiscal
year.

Note:	Opening	balances	for	the	new	fiscal	year	for	balance	sheet
and	retained	earnings	accounts	are	the	same	as	the	previous	year's
closing	balances.	Income	and	expense	accounts	have	opening
balances	of	zero.

Change	the	current	fiscal	year	to	the	next	year.



Single-	and	Multi-Segment	Account	Numbers
If	you	use	single-segment	account	numbers,	all	accounts	are	closed	to
the	default	closing	account	specified	on	the	G/L	Options	screen.	If	you
use	multi-segment	account	numbers,	you	provide	information	on	three
separate	screens	to	specify	the	retained	earnings	account	to	which	an
account	is	closed.	More...

javascript:void(0);


Posting	to	Closed	Years
After	creating	a	new	year,	you	may	continue	to	post	transactions	to	the
year	you	have	just	closed.	Whenever	you	post	to	a	closed	year,	General
Ledger	will	also	create	all	appropriate	closing	entries	to	update	retained
earnings.

Note:	Each	income/expense	account	is	closed	automatically	to	a
retained	earnings	account	at	year	end.

Related	Topics

javascript:mc157.Click()


Home	>	Screen	Guides	>	Periodic	Processing	>	Create	Recurring	Entries	Batch



G/L	Create	Recurring	Entries	Batch	Screen
To	open	this	screen

Related	tasks
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Overview
Use	the	G/L	Create	Recurring	Entries	Batch	screen	to	create	a	journal
entry	batch	consisting	of	a	single	recurring	entry	or	a	range	of	recurring
entries.

If	a	recurring	journal	entry	has	already	been	scheduled,	you	can	also
create	a	batch	using	the	Reminder	List.	For	information	about	using	the
Reminder	List,	see	the	System	Manager	help.

Related	Topics

javascript:mc158.Click()


Home	>	Screen	Guides	>	Periodic	Processing	>	Create	Revaluation	Batch



G/L	Create	Revaluation	Batch	Screen
To	open	this	screen

Fields	and	controls

Related	tasks
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Overview
Use	the	G/L	Create	Revaluation	Batch	screen	to	revalue	the	functional-
currency	equivalents	of	each	specified	source-currency	amount	using	the
exchange	rate	you	enter.

When	you	create	a	revaluation	batch,	General	Ledger:

Recalculates	the	functional-currency-equivalent	values	of	source-
currency	account	balances	at	new	exchange	rates.
Creates	a	transaction	for	the	difference	between	the	old	functional-
currency-equivalent	and	the	new	value,	posting	the	difference	to	the
account	being	revalued	and	to	the	unrealized	exchange	gain/loss
accounts	or	to	the	recognized	exchange	gain/loss	accounts.

The	revaluation	code	assigned	to	an	account	determines:

The	rate	type	that	is	used	to	display	the	default	exchange	rate.
The	source	code	to	assign	to	revaluation	transactions.
The	exchange	gain/loss	accounts	to	which	exchange	differences	are
posted.

For	more	information,	see	About	Revaluation.

Related	Topics

Related	Topics
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Home	>	Screen	Guides	>	Periodic	Processing	>	Period	End	Maintenance



G/L	Period	End	Maintenance	Screen
To	open	this	screen

Related	tasks
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Overview
Use	the	G/L	Period	End	Maintenance	screen	to:

Delete	unneeded	accounts,	transaction	details,	and	fiscal	sets.
Reset	the	current	batch	number	to	1.

Warning!	Period-end	maintenance	permanently	deletes	information
from	General	Ledger.	Before	performing	period-end	maintenance,	back
up	your	data.

You	can	perform	period-end	maintenance	after	creating	a	new	year	at	the
end	of	a	fiscal	year,	or	as	needed.

Note:

All	period-end	maintenance	activities	are	optional,	and	can	be	done
at	any	time.
If	G/L	Security	is	turned	on,	note	that	period-end	functions	do	not
check	account	permissions.	For	example,	you	can	delete	inactive
accounts,	even	if	you	do	not	have	account	permission.

Related	Topics

javascript:mc161.Click()


Home	>	Screen	Guides	>	Reports	Screens



Reports	Screens
Use	General	Ledger	Reports	screens	to	print	reports	of	general	ledger
transactions	and	maintain	your	audit	trail.

Account	Groups

Account	Structures

Batch	Listing

Batch	Status

Chart	of	Accounts

Optional	Fields

Options

Posting	Journals

Recurring	Entries

Revaluation	Codes

Segment	Code	Report

Source	Codes	Report

Source	Journal	Profiles

Source	Journals	Report

Transaction	Details	Optional	Fields

Transactions	Listing

Trial	Balance



Home	>	Screen	Guides	>	Reports	>	Account	Groups



G/L	Account	Groups	Report
To	open	this	screen

Related	tasks
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Overview
The	G/L	Account	Groups	report	lists	account	group	codes,	along	with
their	descriptions,	sort	codes,	and	group	categories.

The	printed	report	includes	columns	for:

Sort	Code
Account	Group	ID
Description

Related	Topics

javascript:mc162.Click()


Home	>	Screen	Guides	>	Reports	>	Account	Structures



G/L	Account	Structures	Report
To	open	this	screen

Related	tasks
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Overview
The	G/L	Account	Structures	report	lists:

The	account	structure	codes	in	the	range	you	selected.
The	description	for	each	code.
The	segments	included	in	each	account	structure,	in	the	order	they
appear.

Every	account	you	define	must	have	at	least	one	structure	code.

Related	Topics

javascript:mc163.Click()


Home	>	Screen	Guides	>	Reports	>	Batch	Listing



G/L	Batch	Listing	Report
To	open	this	screen

Related	tasks
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Overview
The	G/L	Batch	Listing	report	lists	posted	and	unposted	batches	of
general	ledger	transactions.

To	enforce	a	strict	audit	trail,	select	the	Force	Listing	Of	Batches	option
on	the	G/L	Options	screen.	This	option	prevents	you	from	posting
batches	that	are	unlisted.

Note:

Some	printing	options	are	not	available	or	are	restricted	for
Intercompany	Transactions	(ICT)	companies.	More...

javascript:void(0);


Information	Printed	on	This	Report
The	following	information	is	printed	at	the	top	of	the	report:

The	range	of	batch	numbers,	source	ledgers,	and	batch	creation
dates	for	the	batches	that	you	printed.
Whether	the	report	includes	batches	that	have	already	been	listed.

Batch	type.	More...

Batch	status.	More...
Account	description.

Report	Body
The	body	of	the	report	lists	batches	sequentially.	For	each	batch,	the
report	lists	the	batch	number,	the	batch	description,	the	creation	date,	the
status,	the	batch	type,	all	entries	in	the	batch,	the	batch	total,	and	the
account	description.	More...

Optional	fields	that	were	posted	with	details	are	printed	for	each	entry,	if
you	chose	to	include	optional	transaction	fields	on	the	report.

The	report	also	identifies	entries	within	posted	batches	that	were	not
posted	successfully.

Related	Topics
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Home	>	Screen	Guides	>	Reports	>	Batch	Status



G/L	Batch	Status	Report
To	open	this	screen

Related	tasks
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Overview
The	G/L	Batch	Status	report	lists	information	about	General	Ledger
batches,	including	the	debit	and	credit	totals,	the	number	of	entries	and,
for	printed	batches,	the	number	of	outstanding	errors.

The	report	also	lists	the	batch	descriptions,	to	let	you	track	the	original
entry	of	transactions.



When	to	Print
Print	the	report	as	part	of	the	transaction	entry	cycle,	to	discover	batches
for	which	you	need	to	print	or	reprint	listings	before	posting,	and	batches
that	contain	errors.



Information	Printed	on	This	Report
The	following	information	is	printed	on	the	report:

The	range	of	batch	numbers,	source	ledgers,	and	batch	creation
dates	for	the	batches	that	you	want	printed.
Whether	the	report	includes	batches	that	have	already	been	listed.
The	batch	type.
The	status	of	the	batches	you	chose	to	print.
For	each	batch,	the	report	lists	the	batch	number,	the	batch
description,	the	source	ledger,	the	number	of	entries	(unless	posted),
the	creation	date,	the	last	edit	date,	the	status,	the	batch	type,	the
posting	sequence,	the	number	of	reported	errors,	and	the	batch	totals
(amounts	and	quantities).
A	batch	summary	at	the	end	of	the	report	lists	the	number	of	batches
of	each	status:	number	of	batches,	number	of	entries,	and	total	debits
and	credits.

Related	Topics

javascript:mc165.Click()


Home	>	Screen	Guides	>	Reports	>	Chart	of	Accounts



G/L	Chart	of	Accounts	Report
To	open	this	screen

Related	tasks
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Overview
The	Chart	of	Accounts	Report	lists	all	or	a	range	of	General	Ledger
accounts	according	to	the	selection	criteria	and	the	sort	and	format
criteria	you	specify.

At	printing	time,	you	can	select	accounts	by	account	number,	segment,
account	group,	account	sorted	group,	or	optional	field.	Then	specify	the
type	of	report	and	range	of	entries,	either	accounts	or	segments,	you
want	to	print.



Information	Printed	on	This	Report
The	following	information	is	printed	on	the	report:

The	range	of	account	numbers,	segment	codes,	account	groups,	or
account	sorted	group	you	specified	for	the	report.
The	order	in	which	accounts	are	listed,	by	account	number,	segment,
account	group,	or	account	sorted	group.
The	type	of	information	you	are	printing.	More...
For	a	Rollup	Account	report,	the	report	displays	all	rollup	accounts,
all	of	their	directly-related	rollup	member	accounts,	and	a	Yes/No	field
to	indicate	if	those	rollup	member	accounts	are	themselves	rollup
accounts.

Related	Topics

javascript:void(0);
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Home	>	Screen	Guides	>	Reports	>	Optional	Fields



G/L	Optional	Fields	Report
To	open	this	screen

Related	tasks
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Overview
The	G/L	Optional	Fields	report	lists	separately	the	optional	fields	set	up
for	accounts	and	transaction	details.



When	to	Print
Print	this	report	whenever	you	need	a	listing	of	all	the	optional	fields	set
up	for	General	Ledger.



Information	Printed	on	This	Report
For	each	optional	field	code,	the	following	information	is	printed	on	the
report:

Description
Default	value
Whether	the	optional	field	is	required
Whether	the	optional	field	is	set	for	automatic	insertion	in	new
accounts

Related	Topics
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Home	>	Screen	Guides	>	Reports	>	Options



G/L	Options	Report
To	open	this	screen

Related	tasks

javascript:void(0);
javascript:void(0);


Overview
The	G/L	Options	report	lists	the	options	selected	and	information	entered
on	the	G/L	Options	screen,	including	the	following:

Account	number	segments	defined	for	your	ledger,	and	the
descriptions	associated	with	those	segments.
Which	(if	any)	budget	sets	are	locked.
Posting	preferences.

Related	Topics

javascript:mc168.Click()


Home	>	Screen	Guides	>	Reports	>	Posting	Journals



G/L	Posting	Journals	Report
To	open	this	screen

Related	tasks

javascript:void(0);
javascript:void(0);


Overview
The	Posting	Journal	is	the	record	of	every	entry	that	is	posted	to	General
Ledger	accounts.	It	is	an	essential	part	of	the	audit	trail,	linking	the	batch
listings	to	the	G/L	Transactions	listing.

If	you	selected	the	Allow	Provisional	Posting	option	on	the	G/L	Options
screen,	you	can	post	provisional	transactions.

You	can	print	the	journal	in	account	number	order	or	in	posting	sequence
order.	(All	batches	posted	at	one	time	are	assigned	the	same	posting
sequence	number.)	You	can	also	select	the	range	of	posting	sequences
to	print.

Once	you	have	printed	the	journal	to	a	printer	or	file,	you	can	clear	the
data	for	the	posting	sequences	printed,	but	you	do	not	have	to	clear	the
journal	between	posting	sequences.	You	can	keep	adding	to	it	with	each
posting	until	you	are	ready	to	change	the	fiscal	year,	when	you	must	clear
the	entire	journal.

The	G/L	Create	New	Year	screen	also	produces	a	posting	journal	that
shows	the	entries	generated	to	close	revenue	and	expense	accounts.



Information	Printed	on	This	Report
The	report	includes	the	range	of	posting	sequences	in	the	report,	and	the
sorting	order	(either	by	posting	sequence	or	account	number).

The	following	information	is	listed	for	each	detail:

The	batch	number	and	entry	number.	Like	the	posting	entry	number,
these	numbers	remain	with	the	posted	transactions	unless	you
consolidate.	The	numbers	let	you	track	transaction	details	back	to	the
original	batch	listings.
All	details	and	comments	that	appeared	on	the	batch	listing	and	were
successfully	posted	in	this	sequence.

The	journal	includes	the	original	details	which	are	consolidated	on
posting.	The	consolidated	entries	are	listed	in	the	summary	at	the
end	of	the	report.

Comments	appear	on	this	journal,	but	not	on	the	G/L	Transactions
Listing	or	on	source	journals.

Optional	transaction	fields	posted	with	journal	entry	details,	if	you
chose	to	print	them.
The	number	of	posting	entries	in	this	posting	sequence.
In	multicurrency	ledgers,	you	can	print	both	source-currency	and
functional-currency	information.

After	printing,	the	Posting	Journal	Errors	Report	lists	all	entries	containing
errors,	together	with	the	number	of	the	new	batch	into	which	they	were
placed.	These	entries	must	be	corrected,	and	then	posted	again.

Note:	If	the	posting	journal	has	been	printed	and	the	Reprint
Previously	Printed	Journals	option	was	not	selected,	the
corresponding	Posting	Journal	Errors	report	will	not	print.



Related	Topics

javascript:mc169.Click()


Home	>	Screen	Guides	>	Reports	>	Recurring	Entries



G/L	Recurring	Entries	Report
To	open	this	screen

Related	tasks

javascript:void(0);
javascript:void(0);


Overview
The	G/L	Recurring	Entries	report	lists	recurring	journal	entries	set	up
using	the	G/L	Recurring	Entries	screen.



Information	Printed	on	This	Report
The	following	information	is	printed	on	the	report:

Recurring	entries	by	code
Which	account(s)	codes	pertain	to
Type	and	frequency	of	schedule
Optional	fields	entered	with	transaction	details,	if	you	choose	to
include	them

Related	Topics

javascript:mc170.Click()


Home	>	Screen	Guides	>	Reports	>	Revaluation	Codes



G/L	Revaluation	Codes	Report
To	open	this	screen

Related	tasks

javascript:void(0);
javascript:void(0);


Overview
The	G/L	Revaluation	Codes	report	lists	each	of	the	revaluation	codes	in	a
range	you	specify,	along	with	the	description	and	other	information
entered	to	define	the	code	on	the	G/L	Revaluation	Codes	screen.

Note:	You	define	revaluation	codes	only	if	you	have	a	multicurrency
ledger	and	if	you	plan	to	revalue	source-currency	amounts	automatically
using	the	G/L	Create	Revaluation	Batch	screen.



Information	Printed	on	This	Report
The	following	information	is	printed	on	the	report:

The	range	of	revaluation	codes	selected	for	the	report.
The	revaluation	code	and	description.
The	rate	type	you	want	the	G/L	Create	Revaluation	Batch	screen	to
use	as	a	default	for	generating	revaluation	transactions.
The	source	code	to	be	assigned	to	details	generated	by	the	G/L
Create	Revaluation	Batch	screen	using	the	revaluation	code.
The	accounts	to	which	the	exchange	gains	and	losses	are	posted.

Related	Topics

javascript:mc171.Click()


Home	>	Screen	Guides	>	Reports	>	Segment	Code	Report



G/L	Segment	Codes	Report
To	open	this	screen

Related	tasks

javascript:void(0);
javascript:void(0);


Overview
The	G/L	Segment	Codes	report	lists	information	about	a	range	of
segment	codes	you	specify.



Information	Printed	on	This	Report
For	each	segment,	the	following	information	is	printed	on	the	report:

All	or	a	range	of	codes	defined	for	the	segment.
The	code	descriptions,	and	the	numbers	and	descriptions,	of	the
retained	earnings	accounts	to	which	the	segment	codes	are	closed.

Related	Topics

javascript:mc172.Click()


Home	>	Screen	Guides	>	Reports	>	Source	Codes	Report



G/L	Source	Codes	Report
To	open	this	screen

Related	tasks

javascript:void(0);
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Overview
The	G/L	Source	Codes	report	lists	a	range	of	source	codes,	along	with
the	description	entered	on	the	G/L	Source	Codes	screen	for	each	code.

Each	transaction	entered	in	General	Ledger	(or	in	subledgers)	must
include	a	source	code	to	identify	the	type	of	transaction.	For	example,
GL-AD	could	identify	all	adjustments	entered	in	General	Ledger,	and	GL-
CA	might	identify	all	cash	payments.

Source	codes	add	flexibility	to	your	general	ledger,	because	you	define
them.	You	can	select	and	print	lists	of	posted	transaction	details	by
source	codes,	using	the	G/L	Source	Journal	report.



Information	Printed	on	This	Report
The	following	information	is	printed	on	the	report:

The	range	of	codes	you	selected.
Each	source	code	and	its	description.
The	number	of	source	codes	printed	on	the	report.

Related	Topics

javascript:mc173.Click()


Home	>	Screen	Guides	>	Reports	>	Source	Journal	Profiles



G/L	Source	Journal	Profiles	Report
To	open	this	screen

Related	tasks
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Overview
This	report	lists	all	or	a	range	of	the	source	journal	definitions	that	have
been	added	to	General	Ledger.

Source	journals	allow	you	to	list	posted	transactions	that	were	entered
with	particular	source	codes.	The	source	journal	lists	the	source	codes
included	in	the	journal,	as	well	as	the	default	report	used	to	print	the
journal.



Information	Printed	on	This	Report
The	following	information	is	printed	on	the	report:

The	range	of	journal	profiles	in	the	report.
The	journal	names.
The	source	codes	included	in	the	report.

Related	Topics

javascript:mc174.Click()


Home	>	Screen	Guides	>	Reports	>	Source	Journals	Report



G/L	Source	Journals	Report
To	open	this	screen

Related	tasks

javascript:void(0);
javascript:void(0);


Overview
Source	journals	list	the	details	of	posted	transactions	for	the	source
codes	that	you	included	in	the	source-journal	definition,	and	in	the	order
you	specify	at	print	time.

In	other	words,	the	journal	profile	specifies	the	type	of	transaction,	but
you	refine	the	detail	selection	at	print	time.	The	result	is	a	very	flexible
report	for	tracing	all	kinds	of	transactions,	originating	in	any	of	the
subledgers.

You	specify	the	source	codes	that	appear	in	a	report	in	the	source	journal
profile.	When	you	print	the	source	journal,	you	specify	the	following
settings:

The	sorting	order	of	the	report	(by	account	number,	account
segment,	account	group,	or	account	sorted	group).
The	ranges	of	account	numbers,	segment	codes,	account	groups,	or
account	sorted	groups.
The	ranges	of	fiscal	periods,	references,	dates,	posting	sequences,
and	batch	numbers.

Source	journals	can	include	up	to	50	source	codes	for	each	journal.	If
you	have	less	than	50	source	codes	in	your	ledger,	you	could	print	all
transactions	posted	on	a	particular	date	or	with	a	particular	reference
code.



Information	Printed	on	This	Report
The	following	information	is	printed	on	the	report:

The	name	of	the	journal.	(Journals	are	identified	by	name.)
The	ranges	you	specified	for	each	column	of	the	report.
Details	listed	in	the	order	indicated	by	the	columns.
The	total	debits	and	credits	of	all	details	printed.
Optional	fields	posted	with	transaction	details,	if	you	choose	to
include	them.

If	you	use	multicurrency	accounting,	you	can	print	amounts	for	the
report	in	both	the	source	currency	and	the	functional	currency,	or	in
reporting	currency	only.

Note:	The	Reporting	option	is	available	only	in	multicurrency
ledgers	if	the	euro	is	your	functional	currency	and	you	specified	a
reporting	currency.

Related	Topics

javascript:mc175.Click()


Home	>	Screen	Guides	>	Reports	>	Transaction	Details	Optional	Fields



G/L	Transaction	Details	Optional	Fields	Report
To	open	this	screen

Related	tasks
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javascript:void(0);


Overview
Use	the	G/L	Transaction	Details	Optional	Fields	report	to	select	and	print
transactions	that	use	specified	optional	transaction	fields	and	optional
field	values.

The	report	lists	posted	transactions	that	include	the	specified	optional
transaction	fields	whose	values	fall	within	the	specified	range	of	values
for	the	selected	accounts.



Information	Printed	on	This	Report
The	following	information	is	printed	on	the	report:

The	range	of	optional	fields	and	values,	account	numbers,	segment
codes,	account	groups	or	account	sorted	groups	you	specified	for	the
report.
The	order	in	which	accounts	are	listed,	by	account	number,	segment,
account	group,	or	account	sorted	group.
The	following	transaction	information	about	posted	transaction	details
that	meet	the	specified	criteria:

Posting	sequence
Batch	number
Year	and	period
Optional	field	codes	and	values
Debit	or	credit	amount
Quantity
Unit	of	measure

The	total	of	the	details	posted	to	each	account.
In	multicurrency	ledgers,	amounts	in	both	source	and	functional
currency,	or	in	functional	currency	only.

Related	Topics

javascript:mc176.Click()


Home	>	Screen	Guides	>	Reports	>	Transactions	Listing



G/L	Transactions	Listing	Report
To	open	this	screen

Related	tasks

javascript:void(0);
javascript:void(0);


Overview
The	G/L	Transactions	Listing	report	lists	the	net	changes,	balances	and
transaction	details	for	accounts	in	a	range	of	fiscal	periods	you	specify.



When	to	Print
Print	this	report	before	consolidating	posted	transactions	and	before
printing	financial	statements.	You	can	view	the	same	details	(ordered	and
extracted	by	different	criteria)	with	the	source	journals.	Because	posted
transactions	can	be	consolidated,	this	listing	may	not	show	all	the	details
that	were	entered	in	batches:

Transactions	can	be	consolidated	during	posting.	(Set	posting
consolidation	on	the	G/L	Accounts	screen.)
You	can	consolidate	transactions	after	posting	using	the	Consolidate
Posted	Transactions	screen.

A	consolidated	transaction	created	during	posting	retains	the	posting
sequence	number	on	the	G/L	Transactions	Listing,	so	the	consolidated
amount	can	be	traced	through	the	posting	journal	to	the	batch	listings.

Transactions	that	are	consolidated	after	posting	are	consolidated	by
fiscal	period	and	source	code,	but	not	by	posting	sequence	number.	The
description	in	this	case	is	"Consolidated."



Information	Printed	on	This	Report
The	following	information	is	printed	on	the	report:

Whether	you	included	accounts	with	no	activity	(and	no	opening
balance).
Whether	you	printed	adjustment	entries	or	closing	entries.	(You	can
print	these	entries	only	if	you	are	printing	data	from	period	12	or	13—
whichever	is	the	final	period	of	the	year.)
The	order	of	the	report:	either	by	account	number,	segment,	account
group	or	account	sorted	group.
The	ranges	of	account	numbers,	segments,	and	account	groups,	or
account	sorted	groups.
The	year	and	range	of	fiscal	periods.
The	last	year	closed.
The	last	posting	sequence	used.	The	sequence	number	identifies	all
transactions	posted	together.	Each	time	you	post	transaction
batches,	the	posting	sequence	number	increases	by	1.
Any	optional	fields	that	were	used	with	the	transactions,	if	you	chose
to	print	optional	transaction	fields.
Balances	and	net	changes	for	each	account	over	the	selected	period.
Posting	sequence	and	batch-entry	numbers.

For	each	account,	the	report	lists:

The	account	number,	description,	and	opening	balance.
Details	posted	to	the	account	in	the	specified	periods.
The	period,	source	code,	date,	reference,	posting	sequence,	batch
number,	entry	number,	and	debit	or	credit	amount.
The	net	change	for	the	account,	and	the	period	closing	balance.
If	you	chose	Use	Rolled	Up	Amounts,	the	report	lists	the
transactions	of	a	rollup	account	and	all	of	its	rollup	member	accounts
(at	any	level),	rolled	up	into	a	single	amount	for	each	transaction.

If	you	use	multicurrency	accounting,	you	can	print	amounts	in	both



source	and	functional	currencies	(on	letter,	legal,	or	A4	paper	sizes).	You
can	also	print	the	report	in	functional	currency	only.	The	report	includes:

Source-currency	opening	balances.	For	multicurrency	accounts,
the	report	lists	the	opening	account	balance	in	each	source	currency.
Functional-equivalent	figures.
Functional-currency	opening	balances.
Consolidated	details.	When	the	account	is	consolidated,	a	separate
transaction	is	created	for	each	currency,	as	well	as	for	the	other
consolidation	options	(source	code,	fiscal	period).
Change	in	balance	by	currency.	The	report	shows	the	change	in
the	account	balance	in	the	last	period	specified,	by	source	currency.

Note:

If	you	select	the	Sort	Transactions	By	Transaction	Date	option,	all
transactions	are	sorted	by	date	within	the	accounting	periods.
You	can	print	the	report	in	the	reporting	currency	only	if	you	use	the
euro	as	your	functional	currency	and	have	specified	a	reporting
currency.

Related	Topics

javascript:mc177.Click()


Home	>	Screen	Guides	>	Reports	>	Trial	Balance



G/L	Trial	Balance	Report
To	open	this	screen

Related	tasks

javascript:void(0);
javascript:void(0);


Overview
The	G/L	Trial	Balance	report	prints	the	balance	for	each	account	in	the
range	of	accounts,	segments,	account	groups,	account-sorted	groups,	or
optional	fields	in	the	general	ledger	as	of	the	fiscal	period	you	specify.



Report	Formats
You	can	print	seven	different	trial	balance	report	formats.	More...

The	report	format	is	a	single-spaced	listing	of	the	accounts	and	their
balances.

The	worksheet	format	is	a	double-spaced	listing	of	General	Ledger
accounts,	including	columns	for	you	to	make	the	adjusting	entries.

Tip:	The	worksheet	format	is	particularly	useful	at	month	end	and	year
end.

You	can	also	print	a	shorter	version	of	the	report	or	worksheet	that	omits
accounts	with	no	activity.

Note:

The	Provisional	formats	are	available	only	if	the	Allow	Provisional
Posting	option	is	selected	on	the	Posting	tab	of	the	G/L	Options
screen.
The	Quantity	Report	format	is	only	available	if	the	Maintain
Quantities	option	is	selected	on	the	Account	tab	of	the	G/L	Options
screen.
All	reports	except	worksheets	can	be	printed	with	balances	as	of
year/period	or	net	changes	.

javascript:void(0);


Information	Printed	on	This	Report
The	following	information	is	printed	on	the	report:

The	fiscal	period	and	range	of	accounts,	segments,	account	groups,
or	account	sorted	groups	you	chose	to	print.
The	ordering	of	the	report	(either	by	account	number,	segment,
account	group,	or	account	sorted	groups).
Debit	and	credit	account	balances	in	separate	columns.
Additional	columns	on	the	worksheet	for	manual	adjustments	when
you	are	preparing	financial	statements.
The	total	debits	and	credits	for	all	accounts	listed	on	the	report,	and
the	amount	by	which	the	report	is	out	of	balance	(if	you	printed	a
range	of	accounts).
The	amounts	and	quantities	(if	applicable)	of	a	rollup	account	and	all
of	its	rollup	member	accounts	(at	any	level),	rolled	up	into	a	single
amount	or	quantity.	(Rollup	member	account	amounts	are	included
only	once	in	the	rolled	up	amounts.)
The	net	balance	of	all	revenue	and	expense	accounts	included	on
the	report,	stated	as	Net	Income	(Loss)	For	Accounts	Listed.	If	you
include	all	revenue	and	expense	accounts,	the	figure	will	be	the	net
income	to	date.

Related	Topics

javascript:mc178.Click()


Home	>	Screen	Guides	>	Setup	Screens



Setup	Screens
Use	General	Ledger	Setup	screens	to	set	up	accounts,	options,	and
security	authorizations	that	determine	how	General	Ledger	processes
transactions	and	interacts	with	other	Sage	300	ERP	modules.

Account	Groups

Account	Structures

Optional	Fields

Options

Recurring	Entries

Revaluation	Codes

Segment	Codes

Source	Codes

Source	Journal	Profiles



Home	>	Screen	Guides	>	Setup	>	Account	Groups



Account	Groups
To	open	this	screen

Related	tasks

javascript:void(0);
javascript:void(0);


Overview
You	use	account	groups	to	classify	account	balances:

On	the	financial	statements	that	come	with	Financial	Reporter.
In	the	Income	Statement	and	Balance	Sheet	snapshots	that	you	view
in	the	Sage	300	ERP	portal.

Related	Topics

javascript:mc179.Click()


Home	>	Screen	Guides	>	Setup	>	Account	Structures



G/L	Account	Structures	Screen
To	open	this	screen

Fields	and	controls

Related	tasks

javascript:void(0);
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javascript:void(0);
javascript:void(0);


Overview
You	use	the	Account	Structures	screen	to	define	account	structure	codes
that	are	used	to	format	account	numbers.

The	structure	specifies:

Which	segments	appear	in	the	account	number.
The	order	in	which	the	segments	appear.

You	must	assign	an	account	structure	to	each	account	that	you	add	to
General	Ledger.	(You	specify	which	account	structure	an	account	uses
when	you	add	the	account	using	the	G/L	Accounts	screen.)

For	more	information,	see	About	Account	Structures.

Related	Topics

javascript:mc180.Click()


Home	>	Screen	Guides	>	Setup	>	Optional	Fields



G/L	Optional	Fields	Screen
To	open	this	screen

Fields	and	controls

Related	tasks

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);


Overview
If	you	use	Transaction	Analysis	and	Optional	Field	Creator,	use	the	G/L
Optional	Fields	screen	to	define	optional	fields	for	use	in	General	Ledger.

You	can	define	two	types	of	optional	fields:

Account.	These	optional	fields	let	you	extend	the	type	and	amount	of
information	that	you	can	store	with	accounts.	For	several	General
Ledger	reports,	you	can	choose	optional	fields	as	criteria	for	selecting
the	accounts	to	include	on	the	report.
Transaction	Details.	These	optional	fields	let	you	store	additional
information	with	transaction	details.

Note:	If	the	G/L	Optional	Fields	screen	is	open,	other	users	cannot	run
any	processes	in	General	Ledger.	Also,	you	can	modify	optional	field
records	only	when	all	other	users	have	left	General	Ledger,	and	all
other	General	Ledger	screens	are	closed.

After	you	define	optional	account	fields	and	optional	transaction	fields	for
General	Ledger,	you	can	use	the	G/L	Accounts	screen	to	assign	them	to
specific	accounts.

You	can	print	the	G/L	Optional	Fields	Report	to	create	a	list	of	the
optional	fields	you	have	defined	for	General	Ledger.

Related	Topics

javascript:mc181.Click()


Home	>	Screen	Guides	>	Setup	>	Options



G/L	Options	Screen
To	open	this	screen

Fields	and	controls

Related	tasks
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Overview
After	setting	up	your	general	ledger,	you	use	the	G/L	Options	screen	to:

Add	or	change	the	contact	name,	telephone	number,	and	fax	number
for	your	general	ledger.
Specify	account	settings,	such	as	multicurrency,	account	groups,	and
default	closing	account.
Turn	on	G/L	Security	and	specify	the	default	user	access	to	General
Ledger	accounts.
Specify	a	default	source	code	for	journal	entries.
Specify	options	for	posting,	budget	sets,	history,	and	statistics.
Set	up	account	segments.



Account	Tab
On	this	tab,	you	specify	settings	that	determine	how	accounts	are
processed	in	General	Ledger.

Generally,	you	change	account	settings	only	after	year-end	closing.



Company	Tab
On	this	tab,	you	specify	the	contact	name,	telephone	number,	and	fax
number	for	General	Ledger.

To	change	the	company	name	and	address,	or	to	change	the	contact
name,	telephone	number,	and	fax	number	at	the	company	level,	use	the
Company	Profile	screen	in	Common	Services.

Note:	The	Multicurrency	option	appears	on	this	tab	only	if	you	select
the	Multicurrency	option	on	the	Company	Profile	in	Common	Services.



Posting	Tab
On	this	tab,	you	specify	General	Ledger	posting	options.	You	can	change
the	options	specified	here	at	any	time.

You	can:

View	and	change	the	default	budgeting,	batch-editing,	and	posting
settings	for	General	Ledger.
View	the	posting	information	that	is	maintained	by	General	Ledger.
Specify	a	source	code	to	use	as	the	default	for	journal	entries.

This	tab	also	displays	statistical	information	about	batch	posting	activity
for	the	current	fiscal	year.



Segments	Tab
On	this	tab,	you	identify	account	number	segments	to	specify	which
portions	of	the	account	number	can	be	used	to	close	the	income	and
expense	accounts	at	year	end.

You	can:

Specify	the	structure	code	that	appears	as	the	default	when	you	add
new	accounts.
Specify	during	setup	which	segment	in	your	account	numbers
represents	the	account	code.	You	cannot	change	this	setting	later.
Specify	during	setup	which	character	you	use	to	separate	account
segments.	(You	cannot	change	this	delimiter	later.)
Define	the	segments	(divisions	or	portions)	you	use	in	your	General
Ledger	account	numbers.

Related	Topics

javascript:mc182.Click()


Home	>	Screen	Guides	>	Setup	>	Recurring	Entries



G/L	Recurring	Entries	Screen
To	open	this	screen

Fields	and	controls

Related	tasks
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Overview
Use	the	G/L	Recurring	Entries	screen	to	set	up	journal	entries	for
transactions	that	recur	on	a	periodic	basis.

On	this	screen,	you	can:

Add,	edit,	and	delete	recurring	journal	entries.
Enter	transaction	details	for	an	entry.
Specify	an	existing	schedule	or	create	a	new	one	to	specify	when
recurring	entries	are	processed.
View	current	credit	and	debit	totals	for	your	entry,	along	with	the
amount	(if	any)	by	which	the	entry	is	out	of	balance.

Related	Topics
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Home	>	Screen	Guides	>	Setup	>	Revaluation	Codes



G/L	Revaluation	Codes	Screen
To	open	this	screen

Fields	and	controls

Related	tasks
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Overview
Use	the	G/L	Revaluation	Codes	screen	to	set	up	revaluation	codes.	You
assign	these	codes	to	multicurrency	accounts	to	specify	how	to	revalue
functional	currency	balances	when	exchange	rates	change.

Note:	Because	you	can	assign	only	one	rate	type	to	each	revaluation
code,	you	must	create	a	separate	revaluation	code	for	every	rate	type
you	use.

After	you	set	up	revaluation	codes,	you	can	use	the	G/L	Accounts	screen
to	assign	these	codes	on	an	account	basis	to	each	of	the	currencies	that
can	be	posted	to	an	account.

For	more	information,	see	About	Revaluation.

Related	Topics
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Home	>	Screen	Guides	>	Setup	>	Segment	Codes



G/L	Segment	Codes	Screen
To	open	this	screen

Fields	and	controls

Related	tasks
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Overview
Use	the	G/L	Segment	Codes	screen	to:

Enter	a	list	of	valid	segment	codes	for	each	of	the	segments	you	use
in	account	numbers	(other	than	the	account	segment).
Assign	a	separate	closing	account	for	each	segment	code	in	the
table.

For	example,	if	your	account	numbers	include	a	Department	segment,
you	would	use	the	Segment	Codes	table	to	enter	the	codes	and
descriptions	of	each	of	the	departments	in	your	company.

If	you	close	income	and	expense	accounts	at	year	end	by	department,
you	could	specify	a	separate	closing	account	for	each	department	code
you	add.

For	more	information,	see	About	Segment	Codes.

Related	Topics
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Home	>	Screen	Guides	>	Setup	>	Source	Codes



G/L	Source	Codes	Screen
To	open	this	screen

Related	tasks
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Overview
Use	the	G/L	Source	Codes	screen	to	add	new	source	codes	and
descriptions,	change	descriptions,	and	delete	codes	that	are	no	longer
needed.

Source	codes	are	used	in	General	Ledger	to	identify	the	source	(or	type)
of	transaction	details.	You	can	print	source	journals	that	include	all
transactions	with	particular	source	codes.

You	define	source	codes	before	you	enter	and	post	accounting
transactions.

For	more	information,	see	About	Source	Codes.

Tip:	For	each	source	code	you	use,	enter	a	description	that	you	will
recognize	later,	such	as	"Accounts	Payable	checks."

Related	Topics
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Home	>	Screen	Guides	>	Setup	>	Source	Journal	Profiles



G/L	Source	Journal	Profiles	Screen
To	open	this	screen

Fields	and	controls

Related	tasks
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Overview
Use	the	G/L	Source	journal	Profiles	screen	to:

Add	new	source	journals.
List	the	source	codes	used	in	each	source	journal,	or	modify	or
delete	existing	journal	definitions.

Source	journals	select	and	print	posted	transaction	details	according	to
transaction	source	codes.



Predefined	Source	Journal	Definitions
General	Ledger	comes	with	three	source	journal	report	definitions:

GLSJ01F.RPT.	Lists	only	the	functional-currency	value	of
transactions.	This	is	a	single-currency	or	functional-currency-only
version	of	the	source	journal.
GLSJ01S.RPT.	Lists	the	source-currency	and/or	the	functional-
currency	value	of	transactions.	This	is	the	full	multicurrency	version
of	the	source	journal.
GLSJ1SA.RPT.	Use	this	report	when	you	want	to	print	source-
currency	reports	on	A4	paper.

Related	Topics
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Home	>	Screen	Guides	>	Transactions	Screens



Transactions	Screens
Use	General	Ledger	Transactions	screens	to	enter	and	post	batches	of
journal	entries,	and	to	review	and	edit	transaction	information	before
posting.

Batch	List

Journal	Entry

Post	Batches



Home	>	Screen	Guides	>	Transactions	>	Batch	List



G/L	Batch	List	Screen
To	open	this	screen

Related	tasks
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Overview
The	G/L	Batch	List	screen	posted	and	unposted	General	Ledger	and
intercompany	batches.	Use	this	screen	to:

Create	a	new	batch
View	the	transactions	in	a	batch
Select	a	batch	for	editing,	deleting,	printing,	posting,	or	provisional
posting.

Note:	Provisional	posting	is	not	available	for	Sage	300	ERP
Intercompany	Transactions	(ICT)	companies.

Print	batch	listings	and	batch	status	reports
Print	posting	journals	(double-click	the	Posting	Sequence	column)
Print	posting	error	reports	(double-click	the	Number	of	Errors
column)

Tip:	If	other	users	are	posting	batches	or	editing	batch	information,	click
the	Refresh	button	to	see	changes.



Viewing	Batches	and	Batch	Information
You	can	use	the	following	fields	and	options	on	this	screen	to	specify
batches	to	view:

Batch	Number.	Select	a	batch	number	to	highlight	the	row	for	that
batch	in	the	table.
Source	Ledger.	View	batches	from	a	single	subledger.
Show	Posted	and	Deleted	Batches.	View	or	hide	posted	and
deleted	batches.

Batch	information	appears	in	the	table.	More...

javascript:void(0);
javascript:void(0);


Setting	Batches	Ready	To	Post
Double-click	the	Ready	To	Post	column	when:

You	are	finished	editing	a	batch	and	want	to	prevent	further	changes.
You	are	ready	to	post	the	batch	of	transactions.

Note:

Batches	that	are	set	Ready	to	Post	cannot	be	edited.
You	cannot	use	the	G/L	Post	Batches	screen	to	post	batches	that
are	not	set	Ready	to	Post.
On	the	G/L	Batch	List	screen,	you	can	select	a	batch,	and	then	click
the	Post	button	to	post	a	single	batch,	even	if	the	batch	has	not
been	set	Ready	to	Post.
You	cannot	post	to	an	account	if	the	Post	To	Account	field	on	the
G/L	Accounts	screen	is	set	to	Prohibited	for	that	account.

Related	Topics
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Home	>	Screen	Guides	>	Transactions	>	Journal	Entry



G/L	Journal	Entry	Screen
To	open	this	screen

Fields	and	controls

Related	tasks
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Overview
Use	the	G/L	Journal	Entry	screen	to:

Create	new	batches
Add	journal	entries	to	existing	batches
Change	and	delete	journal	entries
View	and	reverse	posted	batches	or	entries
Add	intercompany	transactions	for	a	Sage	300	ERP	Intercompany
Transactions	(ICT)	company.
Drill	down	on	posted	and	unposted	entries	that	originated	in	other
Sage	300	ERP	ledgers	to	view	source	transactions.

For	more	information	about	General	Ledger	journal	entries	and	batches,
see	About	Transaction	Processing	in	General	Ledger.



Customizing	the	G/L	Journal	Entry	Screen
You	can	customize	the	information	on	the	G/L	Journal	Entry	screen	as
follows:

Drag	columns	in	the	transaction	list	to	arrange	them	in	the	order	in
which	you	want	to	view	or	enter	information.
Click	File	>	Customize	to	hide	fields.
Click	Settings	>	Auto	Clear	to	streamline	data	entry	by	creating	a
new	entry	when	you	click	Add.
If	you	want	to	use	the	G/L	Journal	Detail	entry	screen	to	view	and	edit
an	entry	(instead	of	viewing	and	editing	the	entry	in	the	table),	select
the	entry,	and	then	press	F9



Editing	Journal	Entries	and	Batches
The	following	conditions	apply	when	editing	journal	entries	and	batches:

You	cannot	edit	entries	in	batches	that	are	set	Ready	to	Post	(see
the	Status	field	at	the	upper	right	side	of	the	screen).

Note:	You	use	the	G/L	Batch	List	screen	to	set	batches	Ready	to
Post.

You	cannot	edit	entries	in	batches	that	have	been	deleted	or	posted.
However,	you	can	automatically	create	a	reversing	entry	in	a	new
batch.
You	can	edit	batches	that	have	been	provisionally	posted,	and	then
post	the	revised	batches.
You	can	edit	imported	batches	only	to	the	degree	you	specify	for	the
Edit	Imported	Entries	option	on	the	Posting	tab	of	the	G/L	Options
screen.

You	can	allow	editing	of	all	fields,	the	fiscal	period	only,	or	prevent
any	editing.

Related	Topics

Fields	and	controls
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Home	>	Screen	Guides	>	Transactions	>	Post	Batches



G/L	Post	Batches	Screen
To	open	this	screen

Related	tasks

Use	the	G/L	Post	Batches	screen	to:

Post	batches	of	transactions	to	General	Ledger.

Note:	You	cannot	post	to	accounts	for	which	the	Post	To	Account
field	on	the	G/L	Accounts	screen	is	set	to	Prohibited.

Post	batches	of	intercompany	transactions	to	the	respective
originating	company	and	destination	company	general	ledgers	(if	you
use	Sage	300	ERP	Intercompany	Transactions).
Provisionally	(temporarily)	post	transactions	to	General	Ledger	so
you	can	test	their	effects	on	your	ledger	before	posting	them
permanently.

For	more	information	about	posting	batches	and	processing	transactions,
see	About	Transaction	Processing	in	General	Ledger.

Related	Topics
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#
1099	Form
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A
A/R	Invoice	Type

Account	Description

Account	Groups

Account	Number	Segment	Overrides

Account	Number	Segments

Account	Number	Structures

Account	Segment

Account	Set

Account	Status

Account	Types

Accounting	Equation

Accounting	Method

Accounting	Period

Accounts	Payable

Accrual

Accrual	Carry-Over	Date

Accrual	Method

Accrual-Basis	Accounting	Method

Accrued	Expenses

Activating	taxes

Activation

Active	Order

Actual	Fiscal	Sets

Adjustment	Period
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Adjustments

Advance

Allocated	Tips

Allocation	Account

Annual	Maximum

Annualization

Assets

Audit	Trail

Authentication	Method

Automatic	Reversal
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B
Backdated	Document

Bad	Debts

Balance	Sheet

Base	Account

Base	Deductions

Base	Earnings

Base	Hours

Base	Taxes

Base	Wage	Multiplier

Basic	Account	Information

Basic	Project	style

Batches

Benefit

Billing	Type

Billings	And	Costs	Accounting	Method

Budget	Fiscal	Sets
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C
Calculation	Base

Calculation	Methods

Calculator

Capture

Cardholder

Carrying	Over	Vacation,	Sick,	and	Compensatory	Time	Accruals

Carry-Over

Cash	Advance

Cash	Benefit

Cash	Flow	Statement

Cash	Method

Category	(Payroll)

Category	Percentage	Complete	Accounting	Method

Ceiling

Chart	of	Accounts

Class	Codes

Classified	Statements

Clearing	Exchange	Gain	or	Loss

Close	to	Segment	/	Account

Closing	Account

Closing	Period

Closing	the	Books

Common	Stock

Company	Database
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Company	Desktop

Company	Profile

Compensatory	Time

Completed	Project	Accounting	Method

Consolidated	Batch

Control	Account

Corporation

Cost	Accounting

Cost	Center	Overrides

Cost	Center	Segments

Cost	of	Goods	Manufactured

Cost	of	Goods	Sold

Cost	Plus	project

CPRS

Credit

Currencies

Currency	Rate	Type

Currency	Rates

Currency	Table

Current	Assets

Current	Liabilities

Custom	(and	Local)	Taxes

Customization	Directory

CVC

CVV
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D
Database

Database	ID

Date	Matching

Debit

Decimal	Places

Deduction

Default	Closing	Account

Default	Currency

Default	Hours

Default	Rate	Type

Default	Source	Code

Delimiter	Character

Depreciation

Detail	and	Consolidated	Posting	Options

Detailed	Batch

Details

Direct	Labor	Costs

Distribution	Accounts

Distribution	Code

Distribution	Set

Dividend

Drilldown
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E
Earning/Deduction

Earning/Deduction	Frequencies

Earning/Deduction	Type

Earnings

Effective	Date

Employee	History

Employee	Level	Security

Employee	Selection	List

EMU

Equity

Euro	Conversion	Rates

Euro	Currency

Euro	Option

Exchange	Gain	or	Loss

Exchange	Rate

Expense	Reimbursement

Expenses

Expiration	Date

Exporting
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F
Factory	Overhead

Federal	and	State	Taxes

Financial	Statements

Finder

Fiscal	Calendar

Fiscal	Periods

Fiscal	Sets

Fiscal	Year

Fixed	Assets

Fixed	Price	project

FOB	Point

Foreign-Currency	Bank

Functional	Currency

Functional	Currency	Code

Functional-Currency	Equivalent

Future	Order
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G
G/L	Batch

General	Ledger	Account

GIFI

Gross	Pay

Gross	Profit	on	Sales
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History
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I
Importing

Income

Income	Statement

Integration	Access	Pack

Integrity	Check

Intercompany	Transactions	Company

Inventory

Invoice	Type
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Journal

Journal	Entry
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K

L
Labor	Hours	Percentage	Complete	Accounting	Method

LanPak

Ledger

Level

Liabilities

Local	and	Other	Custom	Taxes

Long-Term	Liabilities
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M
Macro

Maintain	Quantities

Manual	Check

Matching	Concept

Merchant

Merchant	ID

Miscellaneous	Charge

Multicurrency	Accounting

Multicurrency	Bank

Multicurrency	Fiscal	Sets

Multicurrency	G/L	Account
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N
Net	Pay

Normal	(Account)	Balance

Number	of	Fiscal	Periods
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O
Optional	Fields

Original	Invoice

Override	Segments	(Payroll)

Overtime	Rate	Multiplier

Overtime	Schedule

Owner	Equity
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P
Partnership

Pay	Factors

Payroll	Class	Codes

Payroll	Distribution	Accounts

PCI

Period	Minimum	and	Period	Maximum

Periods	Per	Year

Picking	Slip

Posting

Posting	to	Previous	Years

Pre-authorization

Preferred	Stock

Prepaid	Expenses

Price	List

Processing	Code

Profile	ID

Profit

Profit	and	Loss	Statement

Profit	Center

Project	Percentage	Complete	Accounting	Method

Project	Type

Provisional	Fiscal	Sets

Provisional	Posting

Provisional	Posting	Journal
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Q
Quantities	in	G/L	Accounts

Quantity	Fiscal	Sets

Quarter	With	4	Periods

Quote
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R
Rate	Type

Rate	Operation

Rates

Realization

Realized	Exchange	Gain	or	Loss

Reallocation	Account

Recognized	Exchange	Gain	or	Loss

Reconcile	(Bank)

Record

Record	of	Employment

Recurring	Transaction

Refund

Remit-to	Location

Repayment	Deduction

Reported	Tips

Reporting	Currency

Restart	Record

Retainage	Accounting

Retainage	Invoice

Retained	Earnings

Revaluation

Revaluation	Codes

Revenues

Reversed	Unrealized	Exchange	Gain	or	Loss

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);


Rollup	Account
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S
Sage	Virtual	Terminal

Salary	and	Wages

Salary	and	Wages	Payable	Account

Sale

Sales

Sales	Table

Sample	Account	Segments

Schedule	Code

Schedule	Reports

Schedule	Transactions

Script

Security	Group

Segment	Codes	Validation

Selection	List

Service	Years

Services

Session	Date

Settlement

Settlement	Rate

Settling	Transactions

Shareholders

Shareholders'	Equity

Shift	Differential	Rate

Shift	Differential	Schedule
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Changes	in	General	Ledger	6.0
General	Ledger	6.0	includes	the	following	new	features	and
improvements:

Changes	in	Processing	to	Respect	New	Fiscal	Period	Locks
Fiscal	periods	are	now	locked	separately	for	each	Sage	300	ERP
program	in	Common	Services'	Fiscal	Calendar.	Although	this	change
does	not	affect	the	way	you	enter	transactions	in	General	Ledger,	you
should	note	the	following	points:

The	program	checks	the	status	of	a	fiscal	period	when	you	enter
dates	or	when	you	add	transactions.
If	a	fiscal	period	is	locked	for	General	Ledger,	but	not	for	another
Sage	300	ERP	program,	you	may	be	able	to	generate	transactions
for	General	Ledger	in	the	other	program,	but	not	post	them	in
General	Ledger.

However,	this	situation	is	unlikely	if	you	create	and	post	General
Ledger	batches	for	outstanding	transactions	in	other	programs	before
locking	General	Ledger.

Revised	Account	Groups
In	Version	6.0,	we	modified	the	standard	set	of	account	groups	that
comes	with	Sage	300	ERP	program.

To	use	the	sample	reports	that	come	with	Financial	Reporter	with
your	own	data,	your	accounts	must	be	assigned	to	the	same
standard	account	groups.

To	use	the	new	"snapshots"	that	are	available	in	the	Sage	300	ERP
Portal,	all	your	accounts	must	be	assigned	to	account	groups	and	all
account	groups	must	be	assigned	to	group	categories.

If	you	don't	want	to	use	general	ledger	data	snapshots,	you	don't
need	to	remap	existing	accounts	to	new	account	groups.

If	you	have	not	used	account	groups	previously,	note	that	the	G/L
Account	Groups	screen	appears	only	if	the	Use	Account	Groups



option	is	selected	on	the	G/L	Options	screen.

New	Group	Categories
Group	categories	organize	your	accounting	information	especially	for
presentation	in	the	Sage	300	ERP	Portal.	The	new	Income
Statement	and	Balance	Sheet	snapshots	retrieve	data	from	group
categories	that	are	linked	to	your	general	ledger	accounts	through
account	groups.

If	you	plan	to	use	the	general	ledger	snapshots,	you	must	first:

a.	 Ensure	that	all	account	groups	are	assigned	to	an	appropriate
category	from	the	new	set	of	group	categories.	(Assign	group
categories	using	the	G/L	Account	Groups	setup	screen.)

b.	 Ensure	that	all	general	ledger	accounts	are	assigned	to	appropriate
account	groups.	(Assign	account	groups	to	group	categories	using
the	G/L	Account	Groups	setup	screen.)

Rollup	Accounts	for	All	Editions
Rollup	accounts	are	now	available	for	all	editions	of	Sage	300	ERP.
Previously,	rollup	accounts	were	available	only	for	Sage	300
Premium	ERP.

New	FR	Sample	Statements
Financial	Reporter	includes	a	new	set	of	sample	statements	that	use
the	new	account	groups.

If	you	want	to	use	the	new	sample	statements	with	your	own	data,
you	must	ensure	that	your	accounts	use	the	new	standard	account
groups.	(If	you	use	different	account	groups,	you	must	customize	the
report	forms	so	that	they	use	your	account	groups.)

If	you	do	not	want	to	use	the	new	set	of	sample	financial	statements,
you	can	continue	to	use	the	statements	that	shipped	with	earlier
versions.

New	Portal-Related	Security	Authorizations
Two	new	authorizations—Balance	Sheet	Snapshot	and	Income
Statement	Snapshot—allow	users	to	view	and	configure	the	Balance



Sheet	snapshot	and	the	Income	Statement	snapshot	in	the	Sage	300
ERP	Portal.

The	new	Accpac	Inquiry	authorization	allows	users	to	query	General
Ledger	data	using	Inquiry	in	the	Sage	300	ERP	Portal.	If	they	also
have	Export	General	Ledger	Data	authorization,	they	can	print	or
export	the	results	of	these	queries.



Upgrading	from	an	Earlier	Version?
If	you	are	upgrading	from	version	5.5,	see	Changes	in	General
Ledger	5.6.
If	you	are	upgrading	from	version	5.4,	see	Changes	in	General
Ledger	5.5.
If	you	are	upgrading	from	version	5.3,	see	Changes	in	General
Ledger	5.4.



Changes	in	General	Ledger	5.6
Sage	300	ERP	5.6	includes	enhancements	to	the	G/L	Trial	Balance	and
G/L	Transaction	Listing	reports.

G/L	Trial	Balance	Report—You	can	now	print	reports	that	show	net
changes	for	a	specific	period.
G/L	Transactions	Listing	Report—The	report	includes	the	new
options	Include	Balances	And	Net	Changes	and	Include	Posting
Sequence	And	Batch-Entry	Numbers.	You	can	also	sort	all
transactions	by	date	within	the	accounting	periods	in	the	G/L
Transactions	Listing	reports.



Upgrading	from	an	Earlier	Version?
If	you	are	upgrading	from	version	5.4,	see	Changes	in	General
Ledger	5.5.
If	you	are	upgrading	from	version	5.3,	see	Changes	in	General
Ledger	5.4.



Changes	in	General	Ledger	5.5
General	Ledger	5.5	includes	the	following	new	features	and
improvements:

The	most	sophisticated	treatment	of	currency	revaluation	on	the
market.
With	this	version,	exchange	gains	and	losses	are	treated	as
permanent	or	temporary,	depending	on	the	exchange	Gain/Loss
Accounting	Method	specified	for	your	Sage	300	ERP	system	in	the
company	profile.

Under	the	Recognized	Gain/Loss	accounting	method,	fluctuations	in
exchange	rates	are	considered	to	be	permanent.	Exchange	gains
and	losses	are	recognized	when	foreign	currency	monetary	items	are
revalued	or	settled	using	the	exchange	rate	in	effect.

The	Revaluation	process:

Calculates	new	functional-currency	values	for	each	specified
source	currency	using	the	specified	exchange	rates.
Creates	a	batch	with	revaluation	transactions	that	will	adjust	the
original	functional-currency	values	to	new	functional-currency
values	for	the	specified	account(s).
Uses	posting	dates	to	select	open	documents	for	revaluation,	so
that	revaluation	adjustments	are	posted	to	G/L	accounts	in	the
correct	fiscal	year/period.

Note:	Exchange	gains	and	losses	are	included	in	the	determination
of	net	income	for	the	current	period.	They	appear	on	the	income
statement,	and	they	are	taxable	immediately.	They	are	not
automatically	reversed	in	the	next	fiscal	period.

When	you	select	the	Recognized	Gain/Loss	method,	new	labels	for
G/L	account	fields	appear	on	the	G/L	Revaluation	screen,	as	follows:

Unrealized	Exchange	Gain	Account	changes	to	Exchange	Gain
Account.



Unrealized	Exchange	Loss	Account	changes	to	Exchange	Loss
Account.

To	revalue	a	G/L	account,	you	must	assign	revaluation	codes	for
each	currency	used	in	the	account.

Before	upgrading	to	version	5.5,	or	later,	from	an	earlier	version,
you	should	process	and	post	your	revaluation	batches	prior	to
upgrading	General	Ledger.	You	cannot	activate	General	Ledger	if
you	have	unprocessed	revaluation	transactions.
If	you	decide	to	switch	to	the	Recognized	Gain/Loss	accounting
method,	later,	you	should	post	any	batches	you	created	under	the
Unrealized	and	Realized	Gain/Loss	accounting	method.

For	steps	for	changing	the	accounting	method,	see	Switching	the
Accounting	Method	for	Foreign	Currency	Translation	.

The	most	sophisticated	treatment	of	currency	revaluation	on	the
market.
Keep	more	segments,	account	structures,	budgets,	and	years	of
history.

Information	Stored	by	Product	Edition
	 Sage	300

Standard	ERP
Sage	300

Advanced	ERP
Sage	300

Premium	ERP

Account
Segments

up	to	3	accounts
segments

up	to	4	account
segments

no	change

Account
Structures

up	to	3	account
structures

up	to	4	account
structures

no	change

Budgets up	to	2	budgets up	to	3	budgets no	change

Years	of
History

keep	7	years	of
history

keep	7	years	of
history

no	change

Custom	account	groups.
Sage	300	Standard	ERP	lets	you	define	custom	account	groups.	This
feature	was	previously	supported	in	only	Sage	300	Advanced	ERP
and	Sage	300	Premium	ERP.



No	separate	license	for	G/L	Security.
You	do	not	need	a	separate	license	for	G/L	Security.	(See	About
General	Ledger	Security.)	Since	version	5.5,	it	is	installed	with
General	Ledger	and	is	activated	when	you	activate	General	Ledger.

To	use	G/L	Security,	select	the	Use	G/L	Security	option	on	the
Account	tab	of	G/L	Options,	then	close	and	reopen	your	company
database.	You	can	then	use	the	G/L	Account	Permissions	screen,
which	becomes	available	in	the	G/L	Accounts	folder,	to	assign
permissions.

Rollup	accounts.
If	you	use	Sage	300	Premium	ERP,	you	can	designate	an	account	as
a	rollup	account	to	which	you	can	add	member	accounts.	You	can
create	multiple	levels	of	account	relationships.	For	more	information,
see	About	Rollup	Accounts.

The	following	reports	have	been	updated	to	include	rollup
information:

G/L	Chart	of	Accounts	Report

The	Rollup	Accounts	report	is	an	additional	selection	in	the
Report	Format	field	on	the	Chart	of	Accounts	report;	it	displays	all
rollup	accounts	and	their	directly-related	rollup	member	accounts.
The	Rollup	Accounts/Rollup	Accounts	report	on	the	Chart	of
Accounts	report	displays	the	member	accounts	only	if	it	has
parent	rollup	accounts.
The	Fiscal	Set	Comparison	Report	has	an	option	to	include	rolled
up	amounts.

G/L	Transactions	Listing	Report
G/L	Trial	Balance	Report

Rollup	commands	in	FRAMT,	FRAMTA,	FRDEBIT,	FRCREDIT.
The	rollup	command	has	a	prefix	of	R	(for	example,
FRAMT("RBALP").
New	consolidation	switch:	RD	(for	rollup	account	detail)	to	show
only	the	top-level	rollup	accounts	within	the	selected	range.



The	following	screens	let	you	display	rollup	amounts:

G/L	Account	History	Inquiry	Screen
G/L	Source	Currency	Inquiry	Screen
G/L	Transaction	History	Screen
G/L	Fiscal	Set	Comparison	Screen
G/L	Budget	Maintenance	Screen

For	instructions	on	creating	rollup	accounts,	see	Adding	a	Rollup
Account.

New	Financial	Reporter	reports.
Balance	Sheet	summaries

Financial	Analysis	statements

Income	Statement	summaries

See	Sample	Financial	Statements	for	further	information	about	these
new	reports.

Enhanced	multi-user	entry	and	posting.
You	cannot	post	a	batch	if	it	is	being	edited	by	another	user,	or	if
data	is	being	imported	or	generated	for	the	batch.
Batches	can	be	posted	concurrently.
Multiple	users	can	now	add	entries	in	the	same	batch.	If	multiple
users	add	the	same	entry	at	the	same	time,	General	Ledger
attempts	to	assign	the	entries	to	separate	batches.

Separate	security	authorizations	for	Journal	Posting	and
Journal	Entry.
To	enable	clearer	separation	of	duties,	when	a	user	is	assigned
Journal	Posting	rights	only,	the	system	will	not	automatically	assign
Journal	Entry	rights	to	them.

New	batch	options	for	recurring	entries.
The	G/L	Create	Recurring	Entries	Batch	Screen	has	been	enhanced
to	include	options	for	creating	the	recurring	entries	in	a	new	batch	or
appending	to	an	existing	batch.
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New	Dashboard	security	authorization.
Dashboard	security	authorization	lets	you	customize	the	dashboard
website.	If	you	have	access	to	G/L	Dashboard,	you	can	access	any
dashboard	pages	that	are	based	on	data	stored	in	General	Ledger.

See	the	System	Manager	help	for	information	about	using
dashboards.



Upgrading	from	an	Earlier	Version?
If	you	are	upgrading	from	version	5.3,	see	Changes	in	General
Ledger	5.4.



Changes	in	General	Ledger	5.4
General	Ledger	5.5	includes	the	following	new	features	and
improvements:

Changes	to	product	and	edition	names.
ACCPAC	Advantage	Series	General	Ledger	is	now	Sage	Accpac
ERP	General	Ledger.

The	Enterprise	Edition	is	now	Sage	Accpac	ERP	500.
The	Corporate	Edition	is	now	Sage	Accpac	ERP	200.
The	Small	Business	Edition	is	now	Sage	Accpac	ERP	100.

Changes	to	General	Ledger	account	groups.
You	can	now	create	an	unlimited	number	of	your	own	account
groups	to	assign	to	General	Ledger	accounts.
You	can	change	the	descriptions	of	the	standard	account	groups
that	are	shipped	with	G/L	to	personalize	them	for	your	own
business.
You	can	now	delete	account	groups	you	created	or	delete	any	of
the	standard	ones	shipped	with	G/L	that	you	are	not	using.
There	is	a	new	standard	blank	account	group,	with	the	description,
"Unclassified	Account	Group",	with	Sort	Code	ZZZZZZZZZZZZ.	If
you	do	not	wish	to	specify	the	account	group	when	creating	an
account,	you	can	choose	this.
When	you	convert	from	ACCPAC	Plus	for	DOS,	if	you	do	not	select
the	Use	Account	Groups	option	on	the	G/L	Conversion	window,	all
accounts	converted	will	have	a	blank	account	group,	which	is	the
default	account	group.	However,	the	existing	16	account	groups
from	01	to	16	will	still	be	created.
If	you	want	to	print	a	set	of	common	account	groups	but	not	other
account	groups	in	reports,	you	can	now	give	the	same	sort	code	to
all	account	groups	in	the	set,	specify	printing	by	sort	code	order,
and	then	choose	the	sort	code	of	that	set.
You	can	sort	statements	by	Account	Sorted	Group	and	select



account	groups	by	Sort	Code	Range	in:

The	G/L	Print	Financial	Statements	report,	and	in
The	FR	View	function	of	the	G/L	Statement	Designer.

Enhancements	to	General	Ledger	reports.
You	can	now	exclude	accounts	with	no	activity	when	printing	the
G/L	Chart	of	Accounts	report.
You	can	sort	the	following	reports	by	the	sort	code	of	account
groups	when	you	select	the	option,	"Select	Account	Groups	by	Sort
Code	Range":

Chart	of	Accounts	report
Trial	Balance	report
Transactions	Listing	report
Source	Journal	report
Transaction	Details	Optional	Fields	report

The	G/L	Batch	Listing	report	now	includes	the	General	Ledger
Account	Description,	and,	for	a	multicurrency	database,	if	you
select	Functional	Currency,	you	can	also	include	Reference	and
Description	details	and	Comments.

This	is	also	the	case	when	you	select	the	Source	and	Functional
currency	option;	however,	if	you	then	select	the	Letter/A4	paper
type,	you	cannot	include	Reference,	Description,	and	Comments
details,	as	those	options	will	not	be	available.

Improved	consolidation	in	Financial	Reporter.
FR	can	consolidate	by	\\acctgroup	(account	group)	and	by
\\acctgroupsort	(account	sorted	group).
Improvements	to	optional	fields.
You	can	set	an	optional	field	as	Required	without	also	requiring	a
default	value.	(You	must	also	set	the	Auto	Insert	option	for	the
required	optional	field	to	Yes.)
Optional	fields	now	appear	in	the	list	of	fields	displayed	when	you
use	Finders.



Preview	new	year.
You	can	view	the	year	to	be	created	on	the	G/L	Create	New	Year
screen.

Automatic	refresh	of	information	on	Inquiry	screens.
We	have	removed	the	Go	button	from	the	G/L	Account	History
Inquiry,	Source	Currency	Inquiry,	and	Transaction	History	forms.
General	Ledger	displays	results	automatically	when	you	change	any
input	field.



Print	for	Financial	Statements	Screen
To	open	this	screen

Related	tasks
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Overview
Use	the	G/L	Print	for	Financial	Statements	screen	when	printing
statements	in	Financial	Reporter	to:

Specify	the	printer	on	which	to	print	the	statement.
Select	the	size	of	paper	that	best	accommodates	the	statement.
Specify	the	orientation	of	the	statement	(portrait	or	landscape).
Specify	the	number	of	copies	to	print.

Related	Topics
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G/L	Create	Accounts	Preview	Screen
To	open	this	screen

Related	tasks
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Overview
Use	the	G/L	Create	Accounts	Preview	screen	to:

Display	a	list	of	accounts	that	the	program	will	add	to	your	chart	of
accounts	when	you	click	Process	on	the	G/L	Create	Accounts
screen.

Change	the	accounts	before	you	add	them	permanently	to	your	chart
of	accounts.

Note:	If	you	have	not	yet	processed	an	account,	No	appears	in	the
Processed	field.

Related	Topics
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G/L	Journal	Entry	Inquiry	Screen
To	open	this	screen

Fields	and	controls

Related	tasks
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Overview
Note:	When	you	inquire	on	a	journal	entry	from	the	G/L	Transaction
History	screen,	the	G/L	Journal	Entry	screen	appears,	displaying	the
details	of	the	selected	transaction.

Look	up	the	details	of	a	transaction	selected	on	the	G/L	Transaction
History	screen.

Related	Topics
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